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Welcome to Bryce 7
Welcome to Bryce® 7.  This is where ideas become reality.  Bryce is one of the leading 3D program used 
by desktop artists, animators, Web designers, and multimedia producers. Bryce is ideal for creating 3D 
graphics for magazines, ads, and virtually any illustration that would benefit from the powerful 3D impact 
of a realistic perspective.
Bryce animation features include animations for video and multimedia. Bryce key-event and timeline-
based animation help to create incredibly realistic, fully animated 3D worlds where rivers rush through 
gorges, the sun sets over the ocean, or mist evaporates to reveal flocks of birds soaring between 
mountain peaks. Bryce is also an invaluable tool for interactive multimedia.

What is Bryce?

Bryce is a stand-alone application that the creation and animation of three-dimensional virtual 
environments.
Create a multitude of environments, from the ivory beaches of Tahiti, to the silvery rings of Saturn. The 
Bryce user interface contains all the tools needed.
For example, Bryce includes controls for managing infinite skies that set everything from time of day to 
the color and frequency of clouds. Using the sky controls, allows the user to set light direction, 
sun/moonlight, atmospheric depth haze (with intensity and color), height fog (with height, intensity, and 
color), and multiple sky color components.
Use Bryce controls to create a wide variety of objects to populate any environment. Terrain Editor helps 
create an infinite number of custom terrains, which then create landscapes.
The realism of a Bryce environment largely depends on the materials applied to the objects in the scene. 
Materials are complex combinations of textures and values. The Materials Lab allows the combination of 
textures and channel values that simulate any material found in the real world, (and a few that are not!)
Create an environment and then, add a fourth dimension - time. Use Bryce's animation tools to set up 
landscapes that move and materials that change over time.

What is New in Bryce 7?

• New and Improved Light Lab 
• New Lights: 

o New Distant 
o Spotlight 
o Parallel 
o Cluster 
o Dome 
o 3D Fill Lights 

- Distant 
- Round Parallel 
- Square Parallel 
- Sphere Dome 
- Cube Dome 
- Sphere Fill 
- Cube Fill

• Specular and Diffuse Intensity settings 
• True Ambience Optimization 
• Newly Designed True Ambience 
• Cast Shadow Intensity Control 
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• Lens Flair 
• Sky Lab Improvements 

o Added control over cloud settings 
o IBL – Image Based Lighting (IBL) 

- Use rendered skies as IBL light probe 
- Added capability for HDRI images 
- Saturation 
- Transparency 
- Save full-range image in HDRI formats (OpenEXR) 
- HDRI from inside 
- HDRI and Bryce Clouds can co-exist 
- Cast shadow settings 
- Soft Shadows 
- Specular map settings 
- Background Depth of Field (DOF) 
- Saturation Control for Image Based Light

o Powerful Sun – 
- Added intensity settings 
- Control over specularity from the sun 
- Control over shadow softness

• New Instancing Lab 
o True Instancing 

- Create copies of objects using a single object’s geometry. 
- Create larger scenes than every before 
- Use less memory and system resources 
- Add more objects than ever in your scenes 
- Create instances with: 
- Adjust size 
- Determine Density 
- Set Divergence angle 
- Change distribution 
- Change the objects randomness setting 
- Adjust the seed setting. 
- Brush Editor Parameters 
- Scale 
- Rotation 
- Random Seed 
- Proportion

• Material Lab Improvements 
o Displacement values have been added

• Render Option Improvements 
o Light Settings 
o TA rays per hit 
o TA Legacy Mode 
o Boost Light

• New Import & Export Options 
o FBX import/export( primitives, meshes, lights, picture objects ) 
o COLLADA import/export (primitives, meshes, lights, picture objects) 
o Updated Studio bridge (can detect DAZ Studio installations on user’s machine) 
o Tree and meta-ball export dialogs
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How this Manual is Set Up
Introduction to Bryce

• This manual starts with a quick introduction to the main Bryce interface and an overview of the 
different palettes, labs, and, tools.

Reference Section
• The next part of the manual is a reference section that goes through each menu, palette, lab, and 

dialog box to show how to use each function.  Numerous examples are provided as well.
Commands, shortcut, and modifier keys are in bold text so they can be easily located on each page.

• The Mac command is always shown first, followed by a slash. When the command is the same, 
only one is shown.

o For example: Cmd/Ctrl+N, Cmd/Ctrl+Shift+A, Ctrl+Opt/Alt+M
• Commands are given in all capital letters.

o For example: I not i, or L not l
Practical Application

• The third part of the manual provides some practical applications for some of the basic functions 
discussed in the reference section.

Appendices
The appendices provide quick access to a listing of all shortcut keys and modifiers, an acronym 
listing, glossary, known issues, and a few troubleshooting items.

System Requirements
Windows®

Pentium® Processor or Compatible
Windows NT® 4 (Service Pack 6)
Windows 2000® (Service Pack 2)
Windows XP
700 MHz (1 GHz or faster recommended)
512 MB RAM min (1 GB recommended)
OpenGL compatible graphics card with at least 128 MB of onboard
  (Drivers supporting OpenGL 1.1 recommended)- -
100MB free hard drive space for installation (500 recommended)
32-bit graphics color depth
CD-ROM drive

Macintosh®

Power Macintosh®
700 MHz (1 GHz or faster recommended)
Mac® OS X 10.3.9 or above
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512 MB RAM min (1 GB recommended)
OpenGL compatible graphics card with at least 128 MB of onboard
  (Drivers supporting OpenGL 1.1 recommended)
100MB free hard drive space for installation (500 recommended)
32-bit graphics color depth
CD-ROM drive

Macintosh® Intel

Macintosh® Pro, MacBook® Pro, or current iMac®
1.8 GHz Core Duo or faster
Mac® OS X 10.4.8 or above
512 MB RAM min (1 GB recommended)
OpenGL compatible graphics card with at least 128 MB of onboard
  (Drivers supporting OpenGL 1.1 recommended)
100MB free hard drive space for installation (500 recommended)
32-bit graphics color depth
CD-ROM drive

Note: Bryce 6.0 will not function installed on a UNIX partition under Mac OS X.

Installing Bryce
Macintosh® 

1. For the disk version, insert the Application CD into the CD-ROM drive. When the directory comes 
up, click on the Bryce Setup icon.

2. For the electronic version, download: Bryce_7.x.x.x_Mac32.zip (application), BryceContent-
7.x.x.x.zip (Bryce Content), BryceLightning_7.x.x.x.zip (Render Client), & if Pro version was 
purchased, BryceProContent_7.x.x.x.zip (Additional Bryce Content). 

3. Double-click each zip to extract the Bryce installers.
4. Double-click the Bryce_7x.x.x_Mac32 installer.
5. Click Next on the Welcome screen.
6. Read and accept the license agreement.  (Note: The installation will abort if the agreement is not 

accepted.)
7. Click Next.
8. Select an installation directory, or click Next to install to the default directory.
9. If a previous version of Bryce is installed, there is an opportunity to uninstall on this step.  (It is 

advised to uninstall previous versions to avoid conflict.)
10. Bryce 7 is now installed.
11. Choose to: Launch Bryce, View the Bryce Wiki Documentation, or Download a free copy of DAZ 

Studio.
12. Click Finish.
13. Click OK on the Bryce/DAZ Studio Bridge restart notification window.  (Note: The Bridge will not 

work correctly until the computer has been rebooted.)
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Macintosh® Content Installation
1. Double-click the BryceContent_7.x.x.x_Mac installer.
2. Click Next on the Welcome screen.
3. Read and Accept or Decline the license agreement. (Note The installation will abort if the 

agreement is not accepted.)
4. Decide whether to install Content for All Users.
5. Select an installation directory, or click Next to install to the default directory.
6. Click Next.
7. Click Next again to proceed with the installation.
8. Click Finish at the end of the installation process.
9. Follow the same procedures to install the ProContent.  (Pro version only)
10. The first time Bryce is started it will require Name and Serial number.

Windows®
1. For the disk version, insert the Application CD into the CD-ROM drive. When the directory comes 

up, click on the Bryce Setup icon.
2. For the download version, double-click the Bryce 7 Installer icon to install Bryce 7.
3. Answer the Question whether or not to uninstall any previous versions of Bryce. (Note: It is best 

to uninstall previous versions to avoid conflict.)
4. If Yes is selected, a confirmation pops up.  Confirm uninstall.
5. Click OK when uninstall completes.
6. When the splash screen appears, click Next. 
7. Read and Accept or Decline the license agreement. (Note The installation will abort if the 

agreement is not accepted.)
8. Choose Yes or No to creation of a Desktop Icon for Bryce.
9. Click Next.
10. Click Next to accept the default installation directory C:\Program Files\DAZ 3D\Bryce7 OR choose 

a destination directory and click Next.
11.  Click Next to verify the install.
12. Wait for the installer to complete.
13. Read Installation Notes and click Next.
14. Choose to: Launch Bryce, View Bryce Documentation, Download a free version of DAZ Studio 3. 

(Opens a download page.)
15. Click Next. 
16. Installation is complete.

Windows® Content Installation
1. Click Next on the Welcome screen.
2. Read and Accept or Decline the license agreement. (Note The installation will abort if the 

agreement is not accepted.)
3. Choose whether or not to install Content for All Users.
4. Click Next to accept the default installation directory OR choose a destination directory and click 

Next.
5. Verify installation, click Next.
6. Click Finish on the Installation Complete screen.
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Managing Content
Managing Bryce content is quite easy to do. All content, accessed from within the Bryce libraries, must be 
located in the Presets folder, while extra content can be stored anywhere on your computer or external 
devices.
To add, delete, import, or export presets to the libraries, or to add new categories to the libraries, refer to 
"Using the Preset Libraries."
After installing files, decide whether to load them immediately into Bryce, store them somewhere for later 
use, or archive them to disc.
Files purchased and downloaded directly from DAZ are installed to a specific structure.   Files purchased 
elsewhere may not be in any specific folder structure. Unzip these files into a folder and either import 
them into Bryce, or organize them into storage folders.

Below is the folder structure used for Bryce packages at DAZ:

Content Light Gels Package Name

Vendor Name Package Name Materials*

Models*

Objects*

Scene Files*

Templates

Textures

Presets Trees Vendor or Package Name

Scene 
Files

Vendor Name Package Name*

Skies Vendor Name Package Name*

* These folders are eliminated if only one type of item is provided. 
This same structure can be used store files downloaded from other sites, or create a custom structure.

DAZ Support & Services
DAZ is committed to providing quality customer service and support that is easy to access and convenient 
to use, while fostering one-to-one customer relationships.
For question about the features and functions of DAZ applications or operating systems, see the user 
manual or online Help for the product you are using. Updates and technical information are also available 
in the Release Notes.
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Registering DAZ Products

Registering DAZ products is important. Registration provides timely access to the latest product updates, 
valuable information about product releases and access to free downloads, articles, tips and tricks, and 
special offers.
For more information about registering a DAZ product, see the online Help for the product or see 
http://www.daz3d.com on the Internet.

Technical Support

DAZ provides the following support options for Bryce:
• FAQs: http://www.daz3d.com/i.x/faq/0/-/?
• Online Forums: http://forums.daz3d.com

Customer Service

DAZ Customer Service provides prompt and accurate information about DAZ product features, 
specifications, pricing, availability, and services. DAZ Customer Service does not provide technical 
support. Access Customer Service support as follows:

• World Wide Web: Access general customer service and product information at: 
http://www.daz3d.com/i.x/contact/0/-/? 

• Email: Send specific customer-service questions to DAZ Customer Service representatives by 
visiting http://www.daz3d.com/i.x/contact/contact_form/-/?  .  

• Online Manual: Find this manual online at: 
http://artzone.daz3d.com/wiki/doku.php/pub/software/bryce/start

• Updates to the manual are available on the downloads page at: 
http://www.daz3d.com/i.x/support/downloads/-/?product=bryce

Copyright and Trademark Information
Copyright © 2005-2011 DAZ 3D, Inc. All rights reserved.
This software is the property of DAZ 3D, Inc. and is copyrighted. Any reproduction in whole or in part is 
strictly prohibited. 
"DAZ" and "Bryce" are trademarks or registered trademarks of DAZ 3D, Inc in the United States and/or 
other countries. 
"QuickTime" is a trademark of Apple Computer, Inc.
"Poser" is a trademark of e frontier America, Inc. and e frontier, Inc.
All other brand and product names, fonts, and company names and logos are trademarks or registered 
trademarks of their respective companies.

©2003-2011 DAZ 3D, Inc. 7

http://www.daz3d.com/
http://www.daz3d.com/i.x/support/downloads/-?product=bryce
http://artzone.daz3d.com/wiki/doku.php/pub/software/bryce/start
http://www.daz3d.com/i.x/contact/contact_form/-
http://www.daz3d.com/i.x/contact/0/-
http://forum.daz3d.com/index.php
http://www.daz3d.com/i.x/faq/0/-


Bryce 7 Artist Guide 03 Jan 2011

Introduction to Bryce
Before starting, learn about the Bryce Interface. This section contains the various components of the 
Bryce interface and their use.  Click on links provided on each page to go directly to the section that gives 
more information about that component.
The Reference Section gives detailed descriptions on each Bryce function along with plenty of images 
and examples.

The Bryce Interface

The image below shows the Bryce Workspace along with captions showing the names of each area.

The Bryce Window

Bryce's default environment consists of the Menu Bar, the Working window, the Control palette, and the 
Tool palettes. By default, the Bryce environment replaces the screen whenever the application launches. 
However, the operating system's standard menus and windows are still accessible.
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The Menu Bar

The Bryce Menu Bar contains five menus: the File menu, the Edit menu, the Objects menu, the Links 
menu, and the Help menu. These menus provide access to several Bryce functions and editors.
Refer to the "The Menu Bar" for more information on using the Menu Bar. 

The Working Window

The Working Window, or viewport, is the area, which displays all the objects in the Bryce scene. It is the 
work area where objects, lights, planes et cetera, are set up to create environments and scenes.
The view shown in the Working window is from a "camera" which is moved around for different views and 
angles. The Working window also has several display modes that allow one to view a scene as a 
wireframe, a rendered object, a combination of both, or as OpenGL. Refer to "Display Modes" for more 
information.

Nano-Preview

The Nano-Preview displays a rendered preview of the working scene as shown in the figure below. As the 
scene changes, the Nano-Preview adjusts to match those changes.  The Nano-Preview shows immediate 
adjustments to object position or other properties affecting the final look of the scene.

Use the preset viewing positions to see a scene from different angles, or use the Memory Dots to store 
and retrieve any favorite camera positions. Refer to "Nano-Preview" for more on working with the Nano-
Preview.
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View Controls

The View Control adjusts the view of a scene without moving the camera. Using this control shows the 
scene from the top, bottom, left, right, front, or back. It can also continuously rotate the scene, showing it 
from any angle. 
Refer to "Using the View Control" for more on using the View Control.

Camera Controls

Camera Controls change the position of the camera specifically along the X, Y, and Z-axes. The Camera 
Trackball moves the camera in any direction, and along any axis.
Refer to "Camera Controls" for more on moving the camera.

Render Controls

The Render Controls render the scene to see all the materials and lighting effects which have been 
added. The center button starts the rendering process and the other buttons control rendering options. 
Refer to "Render Controls" for more on rendering.

Text Display Area

The area just below the Render Controls is reserved for momentary display of text information. When 
hovering over interface elements, this area displays the name of the interface element, and in some 
cases, it also displays the element's current settings. The Text Display Area also displays information 
about the total number of polygons in an object or a scene, and information about current control settings. 
Refer to "The Text Display Area" for more on this area. 
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Tool Tips

Bryce has Tool Tips. These are pop-up texts giving a description of any tool, object or icon, when hovered 
by the mouse pointer.

The Palettes
Bryce uses a series of palettes to manage tools and controls: the Create Palette, Edit Palette, Sky & Fog 
Palette, Advanced Display Palette, Selection Palette, and Animation Controls. These palettes allow the 
creation of objects, editing objects, creating skies and fog, controlling the display of a scene, selecting 
objects, and animating objects. Refer to "The Palettes" for more on using the different palettes. 
Beside the title of each of the three tool palettes (the Create palette, Edit palette, and Sky & Fog palette) 
is a small triangle that opens the different Preset Libraries available in Bryce. 
Refer to "The Bryce Preset Libraries" for more on Preset Libraries.

The Create Palette

The Create Palette contains tools for creating infinite planes, terrains, stones, primitive shapes, derivative 
primitives, 2D Picture objects, and lights. 
Refer to "The Create Palette" for more on the Create Palette.
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The Edit Palette

The Edit Palette contains tools for editing object materials and resizing, rotating, repositioning, aligning, 
and randomizing objects. 
Refer to "The Edit Palette" for more on the Edit Palette.

The Sky & Fog Palette

The controls available on the Sky & Fog Palette allow one to add shadows, fog, and haze, and set the 
altitude, frequency, and amplitude of clouds. The Sky & Fog Palette also gives control of the color of 
clouds in the sky and the position of the sun and moon. 
Refer to "The Sky & Fog Palette" for more on the Sky & Fog Palette.

The Advanced Display Palette

The Advanced Display Palette contains tools for controlling the display of the interface and 
enabling/disabling the Nano-Preview and Plop Render features. The Advanced Display 
appears on the right side of the Working window. 
Refer to "The Advanced Display Palette" for more on using the Advanced Display palette tools.

The Animation Palette

The Animation Controls on the Animation Palette allow the set up of key frames and editing of 
the timeline for animation sequences. These controls can be used to preview an animation, add 
and delete key frames, and access the Advanced Motion Lab. 
Refer to "Animation" for more on using the Animation Controls.

The Selection Palette

The Selection Palette contains tools for selecting specific types of objects in a scene. This palette does 
not show in the default, working window. To view it, use the Time/Selection Palette toggle at the far 
bottom right of the working window.  This toggles the Animation Controls with the Selection Palette. 
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Refer to "The Selection Palette" for more on selecting objects.

The Time/Selection Palette Toggle

The Time/Selection Palette Toggle switches between the Selection Palette and Animation Controls. 
Simply click on the toggle to switch between the palettes.

Displaying Submenus & Pop-ups

Inverted or sideways triangle icons in the interface indicate a menu or fly-out item available, which 
contains options pertinent to the item closest to it. For example, in the Create Palette, there are triangle 
icons next to each tool in the palette. These triangles access the additional options for the tools. 
To display a submenu, click on the triangle icon and the popup menu will display in a fly-out.

Laboratories & Editors
Bryce has several Laboratories and Editors to apply materials and image textures to objects, adjust 
lighting, build terrains and textures, modify trees, and adjust animations. 

The Advanced Motion Lab

The Advanced Motion Lab fine-tunes animations. Create an animation using the Animation Controls, and 
then use the tools available in this lab to control the speed at which objects move along a motion path, 
adjust the position of key frames, and preview any changes. 
Refer to "The Advanced Motion Lab" for more on animating scenes and using the Advanced Motion Lab.
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The Light Lab

The Light Lab allows the changes to the default Bryce light settings.  Set the intensity of the light, the 
edge softness, whether the light casts shadows or not, the color, add a light gel, and set the falloff 
options.
Refer to "The Light Lab" for more on working with lights.
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The Materials Lab

The Materials Lab is where materials get created and tweaked. By combining up to four texture 
components on the materials grid, one can create incredibly complex surfaces that can bring any scene to 
life. 
Two types of materials can be created here.  The first is Surface materials, which define the surface 
properties of an object.  The second is Volume materials, which define the properties of both an object's 
volume as well as its surface. When creating volume materials, the settings in the Materials Lab change. 
Some of the surface material settings are replaced by volume effects settings. 
Refer to "The Materials Lab" for more on the Materials Lab and "Understanding Volume Material 
Channels" for more on Volume materials.
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The Sky Lab

The Sky Lab controls the atmosphere, from adding stars and comets to cloud cover and fog. The left side 
of the Sky Lab changes depending on the palette selected, while the right side shows a preview of the 
sky, access to the sky library, and the overall sky settings. Animation controls are also available at the 
bottom of the lab. 
Refer to "The Sky Lab" for more on editing the sky settings. 

• The Sun & Moon tab provides the ability to affect the stars, sun, and moon, including setting the 
intensity of shadows, soft shadows, and the ambient and sky dome colors.

• The Cloud Cover tab takes care of your clouds, including motion, height, and whether they cast 
shadows or not.
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• The Atmosphere tab provides the ability to add fog and haze, rainbows, and volumetric world 
density and quality.
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• The IBL tab provides the ability to add an HDRI image to the scene.
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The Terrain Editor

The Terrain Editor controls all terrain objects in the scene. The editor contains tools for painting and 
refining terrain objects. The Terrain Editor also has a real-time preview to see instant result of any 
changes. 
Refer to "The Terrain Editor" for more on the Terrain Editor.
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The Tree Lab

The Tree Lab controls any changes to the default Bryce trees. Set the attributes of the branches and 
trunk, choose foliage shape, leaf distribution, tree shape, and apply textures. 
Refer to "The Tree Lab" for more on generating trees.

Adjusting Editor Settings
The editors have unique interfaces for adjusting individual settings by using a variety of tools, including 
controls, fields, knobs, and component indicators. To get the most out of each editor, it is important to 
know how these elements work.

Using Slider Controls

Slider controls set a value for an element within an editor. For example, in the Sky Lab, the Cloud Cover 
control sets the amount of clouds in a scene.
To adjust the value of a control using the slider: 

• In the Materials Lab, pull the sliders in and out from the top or side of the panels.

• In other labs, slide the highlighted portion of the control to the left or right, or the small sliders 
above and below the oval sliders when available.
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Using Fields

Fields are located in dialogs and in controls. A field allows the entry of a precise numerical value.
• To adjust the value of a text or numeric field: 

• Click in the field and type a value. Press the Enter key or click outside the field to accept 
the values.

• To adjust the value of a control using a field: 
• Click the numerical value to the right of the control's slider. The field will activate. 

• Click in the field and type a value.

Using Knobs

Some of the editors in Bryce contain knobs. Knobs can perform many different functions, such as 
randomizing or saving elements. To activate the knob's function, click the knob.
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Using Buttons

Buttons come in different shapes and sizes, ranging from dots to markers to radio buttons. Buttons are 
activated, or selected, by clicking them.

Using Component Indicators

Some of the editors contain component indicators. When combining several components to create a 
composite element, such as a texture, the component indicator show which component is currently being 
manipulated.
When working with materials, blend material components by turning on multiple component indicators 
simultaneously. Refer to "Combining Components" for more on using the component indicators to blend 
material components.

To turn a component indicator on or off, click the component indicator.

Using Color Swatches

Color swatches are used to change the color of items in a scene. They come in several shapes and are 
accessed by clicking on the swatch, either with or without pressing a modifier key.

Access different color pickers by pressing a modifier key when clicking on a color swatch. 

Mac Color Pickers
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The Mac OS Color Pickers are accessed from Bryce by pressing Ctrl+Opt and clicking any color dot or 
swatch. 
This opens the Colors dialog with five Pickers: 

• Color Wheel
• Color Sliders
• Color Palettes
• Image Palettes
• Crayons

Besides the standard OS controls, each Picker has several things in common. At the top is a long color 
bar, which is the current picked color. The Magnifying Glass icon next to it allows the selection of a 
magnified color from anywhere on the current screen. At the bottom are the preset boxes, which are 
loaded by click, drag the top color bar to any preset box. Expand/collapse the presets by dragging the 
small center dot.
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• To use the Color Wheel, click on the color and adjust the brightness of the color from the right 
hand slider.

• The Color Slider Picker selects a color via four different color schemes: Gray Scale, RGB, CYMK 
or HSB, accessed from the popup menu. Values can be set by adjusting the sliders or by typing 
in the numeric values.

• The Color Palettes Pickers allows a color to be selected from a number of different preset 
"swatch" palettes. These include the System and Web Safe color lists. User Color lists are 
created by selecting New from the popup and dragging colors into the main window. There are 
also options for renaming and removing colors and lists.
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• Most of the time the Image Palette is used to display a Spectrum image, which can be clicked on 
to select a color. A user image can also be loaded from the bottom popup and stored 
permanently in the picker. The new image can be selected from the top popup.

• The Crayon Picker shows 64 standard crayon colors. Clicking on one selects the color and 
displays the crayon color name at the top.
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There are also several 3rd party color pickers to be found online.

Win Color Pickers

Besides the basic Bryce Color Picker, there are two additional color pickers available for Windows users:
• Left-click on a color swatch to access the default color picker  then move the eyedropper over 

the gradient color sections and click to select a color.

• Press Alt and click on a color swatch to activate the alternate color picker. Left click on the 
picker names to change to that color picker. Left click in the numeric fields to manually enter a 
value or drag on the sliders for each color bar. 

• Default is RGB Color Picker
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• HSV Color Picker

• HLS Color Picker

• CMY Color Picker

• Press Alt+Ctrl and click on a color swatch to get the Windows Color Picker. Select a basic color 
by clicking on the swatches, select a color from the gradient panel then adjust the luminosity by 
dragging the triangle on the side bar, or enter numeric values in the HSL and RGB fields.
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The Preset Libraries
Bryce has several libraries of presets that can make creating scenes easier. There are five preset libraries 
available in Bryce:

• The Preset Objects Library  - Add ready-made objects to a scene.
• The Preset Materials Library - Add a wide variety of materials to your objects.
• The Sky & Fog Preset Library  - Contains pre-made skies to add to any scene and quickly 

create an environment.
• The Textures Preset Library - contains pre-set textures created in the Deep Texture Editor.
• The Brush Preset Library - contains several brush shapes along with the ability to reselect the 

default Terrain brush. 
Refer to "The Preset Libraries" for more on using the different libraries. 

Reference Section
The following sections provide detailed descriptions and usage instructions for each menu, palette, 
library, laboratory, and editor in Bryce.

Menu Bar

The Menu Bar is located at the top of the Bryce Working Window. In versions 5 and 5.5, this menu was 
hidden until the mouse moved to the top of the window. Bryce now has the menu fully visible at all times.

File Menu

Access all file related functions in the File Menu. Left-click on "File" to access this menu.
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New Document

The New Document command closes the current Bryce scene file and opens a new blank scene. Save 
any unsaved changes when prompted. Any unsaved changes will be lost. This action will also clear and 
reset the Undo/Redo stack.
To create a new document: 

1. Select File > New Document from the menu or press Ctrl+N or, on the PC only, set the 
NumLock, then press Ctrl+decimal (on numpad).

2. Select whether to save the current scene, not to save it, or to cancel creating a new document.

3. Once the current scene has either been discarded or saved, the Document Setup dialog will 
come up. The current document settings are automatically selected in the dialog. 
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4. Enter values in the Document Resolution fields.

This is the absolute size of the working space expressed in pixels. Enter any values desired, 
although it is recommended not to exceed the available screen space if avoidable. Work small 
and render larger if necessary. The values in the Aspect Ratio fields will update automatically as 
needed.

5. Enter values in the Document Aspect Ratio fields.

These fields represent the Document Resolution as a ratio. Depending on the type of work, it may 
be more convenient to enter values here rather than in the resolution fields above. For instance, 
many video formats, as well as the standard 13" screen, are 3:4 aspect ratios.

The values in the Document Resolution fields will update automatically if the Aspect Ratio 
changes.

6. Enable the Constrain Proportions button to preserve the current Aspect Ratio as the resolution 
changes.

7. Select whether to enable Anti-Aliasing and whether to use Normal or Superfine settings.

These settings can always be changed later in the Render Settings.
8. Enable Report Render Time to view the render report once a render is completed. 
9. Select a Render Resolution from the list.

This resolution sets the absolute size of the rendered image, expressed in pixels as a multiple of 
the document size.
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Bryce has the ability to work in one size while building a scene, and then render that scene in a different 
size. For example, working at Bryce's default size but rendering four times larger for print or four times 
smaller for a Web page. Rather than resetting the document resolution every time it renders (thereby 
affecting the wireframe workspace), simply set a separate size for rendering. Think of Document 
Resolution as input and Render Resolution as output.

The default resolution is 540 x 405, and the default aspect ratio is 4:3.

Document Setup

The Document Setup command brings up the Document Setup dialog where the dimensions and aspect 
ration of the current document will be selected. This same dialog comes up when you create a new 
document.
To setup the document:

1. Choose File > Document Setup from the menu or press the Render button or press Ctrl-Alt-N. 
The Document Setup dialog will come up.  

2. Enter values in the Document Resolution fields.

This is the absolute size of the working space expressed in pixels. Enter any values desired, 
although it is recommended not to exceed the available screen space if avoidable. Work small 
and render larger if necessary. The values in the Aspect Ratio fields will update automatically as 
needed.

3. Enter values in the Document Aspect Ratio fields.

These fields represent the Document Resolution as a ratio. Depending on the type of work, it may 
be more convenient to enter values here rather than in the resolution fields above. For instance, 
many video formats, as well as the standard 13" screen, are 3:4 aspect ratios.

The values in the Document Resolution fields will update automatically if the Aspect Ratio 
changes.
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4. Enable the Constrain Proportions button to preserve the current Aspect Ratio as the resolution 
changes.

5. Select whether to enable Anti-Aliasing and whether to use Normal or Superfine settings.

These settings can always be changed later in the Render Settings.
6. Enable Report Render Time to view the render report once a render is completed. 
7. Select a Render Resolution from the list.

This resolution sets the absolute size of the rendered image, expressed in pixels as a multiple of 
the document size.

Bryce has the ability to work in one size while building a scene, and then render that scene in a different 
size. For example, working at Bryce's default size but rendering four times larger for print or four times 
smaller for a Web page. Rather than resetting the document resolution every time it renders (thereby 
affecting the wireframe workspace), simply set a separate size for rendering. Think of Document 
Resolution as input and Render Resolution as output.

The default resolution is 540 x 405, and the default aspect ratio is 4:3.

Document Presets

To set up the document using presets, click one of the preset aspect ratios displayed along the right side 
of the dialog.
These presets are aspect ratios for many useful document types. The pixel values in the Document 
Resolution fields are either absolute (as in Legal or Letter paper sizes) or based on the available screen 
resolution (as in Maximum Recommended or Square)
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Animation Setup

The Animation Setup command brings up the Animation Setup dialog to set up the time settings for an 
animation.
To set up the Animation:

1. Choose File > Animation Setup from the menu or press Cmd/Ctrl+Shift+N. The Animation 
Setup dialog will come up.

There are three parts to this dialog. The top part indicates where the animation is right now, the 
middle part is for the length (duration) of the animation, and the bottom part is to control the 
playback and the time readout displays.

2. Set the animation time settings: 
 Current - As mentioned above, this shows where the current animation is in time and the 

current frame number. The triangle next to Current brings up a popup menu to set the 
working range of the animation, for example, to work on minutes 5 through 9 in the 
scene. 

 Working Range Low - Select to set the start of the working range, set either the time or 
the frame number. 

 Working Range High - Select to set the end of the working range, set either the time or 
the frame number.
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 Frame # - Shows the frame number of the current frame. 
 FPS (Frames per Second) - Sets the frames per second for the animation. Lower frame 

rates render faster but can produce a jerky animation while a higher frame rate will 
product a more smooth animation. 

 Duration - Shows the current duration of the animation and allows you to add more time 
to extend the length of the animation by either entering the time in the fields or entering a 
number in the Frame # field. 

 Frame # - Shows the total number of frames in the current animation. 
 Scale - Select to switch the Duration fields from setting the total time of the 

animation to setting the scale instead. 
 Extend or Clip - Select to switch the Duration fields back to setting the total time 

of the animation. 
 Play - Provides options you can use to alter the preview of the animation. 

 Once - plays the animation only once 
 Repeat - plays the animation continuously 
 Pendulum - plays the animation forwards then backwards, then forwards, 

continuously 
• The Play Mode can be set in the Timeline Options menu.
• Display - Select whether to display the animation in SMPTE Time or as a Frame Count.
• The Display Mode can also be set in the Timeline Options menu.

Open File

The Open command opens a pop-up to select a previously saved scene to open and work on in Bryce. A 
standard Open File dialog box appears, allowing navigation to the folder containing the desired file for 
opening. Note that this will clear any existing scene, though Bryce will prompt to save any work performed 
on the current scene before the next one is loaded. This action will also clear and reset the Undo/Redo 
stack.
To open a previously saved scene file:

1. Choose File > Open from the menu or press Ctrl+O or, on the PC only, set the NumLock, then 
press Ctrl+/ (divide on numpad). The Open File dialog will come up. The scene will also open by 
double-clicking on the Bryce scene file itself although this will open the file in a new copy of 
Bryce.
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2. Navigate to the folder where the scene file is located and select it. If the scene file is from an 
earlier version of Bryce, choose the file type from the Files of type pull-down menu, then locate, 
and select the scene file.

 
3. Click on Open to open the scene in Bryce. This may take some time depending on the size of the 

file, and the capabilities of the system running Bryce.

Merge

The Merge command allows Bryce to merge a second scene into the currently loaded scene. A standard 
Open File dialog box appears, to allow navigation to the folder containing the desired file and select it for 
opening. Save any work performed on the current scene opening the next scene. Work is not lost in the 
current scene if the save option is not selected. This action will also clear and reset the Undo/Redo stack.
Objects from the opening scene are placed in the current scene at the same absolute coordinates that 
they previously occupied. Some information from the opening scene is discarded, such as family names.
This feature is quite useful for large scenes where the computer cannot handle the size of the full size of 
the scene. The scene can be split up into multiple scene files, and then merged prior to rendering. Once 
the files are merged, the camera will revert to the current Director's view so save the camera setting of 
the original scene before merging the files.
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To merge two scenes:
1. Load first scene file.

2. Choose File > Merge. A dialog appears prompting you to save the current scene.

Choose an option. By choosing to Save the current scene, Bryce will save the scene before doing 
anything else. The Open dialog will then come up.
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3. Use the dialog controls to locate the file to merge and click on Open.

4. The file selected is merged with the current scene.

5. To merge additional scenes, choose File > Merge again.

Note: Holding the Opt/Alt key while performing this function will merge only the sky from the incoming 
scene

©2003-2011 DAZ 3D, Inc. 37



Bryce 7 Artist Guide 03 Jan 2011

Save / Save As

Use the Save and Save As commands to save the work prior to continuing work, merging, or closing the 
scene. Since the scene files can quickly become large and complex, save often. It is also helpful to save 
the files under multiple names to be able to revert to an earlier version if needed (for example, 
house01.br6, house02.br6, etc.). 
To save a file:

1. Choose File > Save or press Ctrl+S. The Save dialog appears.
2. Use the dialog controls to choose a location for your work and click Save.

To save a file under a different name:
1. Chose File > Save As or press Ctrl+Shift+S. The Save dialog appears.
2. Enter a new name and/or location in the fields provided and click Save.

A copy of your work is saved, leaving the original intact.

If the Image With Scene Open/Save preference is selected, Bryce saves both the scene data and the 
rendered image when it saves the file.

Revert to Saved

The Revert to Saved command erases the effects of changes made to a scene by reverting to the last 
saved version of that scene. All unsaved changes are discarded.
To revert a scene back to the saved version, choose File > Revert to Saved from the menu or press 
Ctrl+Opt/Alt+S.

Please note that using Revert to Saved can sometimes cause Bryce to crash and HDRI to stop 
working requiring you to restart Bryce to get it working again. The more memory intensive the scene 
is, the more likely a crash will occur on reverting. If this happens, use File > Open File to open the 
saved version instead of reverting to it. Of course, remember not to save the current scene when 
asked.

Open Image

The Open Image command allows you to open an image in Bryce in one of the following image types: 
• BMP (*.bmp) Windows®  Bitmap
• CompuServe® GIF (.gif) 
• DIB (*.dib) - Device Independent Bitmap 
• Enhanced Metafile (.emf) 
• FPix (*.fpi) - FlashPix Bitmap 
• FPX (*.fpx) - FlashPix Bitmap 
• JP2 (*.jp2) - JPEG-2000 JP2 File 
• JPE (*.jpe) - JPEG/JIFF Image 
• JPEG (.jpg) 
• MAC (*.mac)
• MacPICT (*.pct)
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• Photoshop® (.psd) 
• PIC (*.pic) 
• PNG (*.png) 
• PNGT (*.pnt)
• SGI (*.sgi)
• Targa (.tga) 
• TIFF (.tif) 

This is useful for loading an image to use as a modeling template or to add additional elements to a 
previous render without re-rendering the entire scene.
To open an image:

1. Choose File > Open Image from the menu. The Open File dialog will come up. 
2. Navigate to the folder where the image is located, select it, and click on Open. 

The image will be loaded into the scene.
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Save Image As

The Save Image As command saves the rendered image out of Bryce. Bryce will save out a series of 
images of a scene as it is built for use in tutorials or for compositing in a paint program (i.e., object, 
distance, and altitude masks).
Export images to the file formats as follows:

• Windows Bitmap (.bmp) 
• JPEG (.jpg) 
• Photoshop (.psd) 
• PICTURE (.pct) (Mac only) 
• TIFF (.tif) 

To save the current rendered image:
1. Render the scene.
2. Choose File > Save Image As from the menu. The Save As dialog comes up.
3. Navigate to the folder where you want to save the file, then enter a filename for the image.

4. Select a file type from the Save as type field. The default format is JPEG, however, for production 
work, the Bryce JPEG format is not recommended. Use BMP, PSD, or TIFF instead.
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5. If you select JPEG, select a compression value from the Compression field.

Please note that JPEG compression is not the best quality, so choose either High or Max Quality.
6. Click on Save to save the image to your computer. 

Export Image

The Export Image command allows you to save the rendered image out of Bryce. Unlike the Save Image 
As option, the Export Image option allows you to save out an image map for use on the web with 
embedded links or as a QuickTime VR file. 
To export an image:

1. Choose File > Export Image from the menu. The Save As dialog will come up.
2. Enter a file name in the Filename field.
3. Select a file format from the Save as type field then click on Save. 

Import Object

The Import Object command allows the import of objects in the following file formats:
• 3d Studio® Objects (.3ds) 
• 3d Studio® Project Files (.prj) 
• 3DMF (.3mf, .b3d, & .t3d) 
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• AutoCad® (.dfx) 
• Direct 3D (.x) 
• LightWave™ (.lwo or .lws) Both objects and scenes are supported. The camera, lights, and all 

objects (with material information) are imported. Versions 6 and up are not supported. 
• Portable Greyscale Map (.pgm) Used to import descriptions of heightfields (terrains) 
• Test Files (*.tst)
• TrueSpace™ (.cob *.scn) Object and Scene files
• USGS DEM (.dem) All forms of DEM files are supported 
• USGS SDTS (.ddf) This format is the new USGS format which will replace DEM files 
• VideoScape (.vsa) All versions are fully supported 
• VRML1.0 (.wrl) Imports all properties relevant to Bryce, including camera, light, and surface and 

material textures 
• Wavefront (.obj) Imports any textures referenced in the MTL file, if available 
• WCS Elev (.elev) 
• WorldToolKit® (.nff) 

To import an object:
1. Choose File > Import Object from the menu. The Open dialog will come up. 
2. Choose the drive and folder where the file is stored.
3. Select the file to import and click on Open. 

Note that when importing objects with an MTL file containing image references (exports from Poser 
are most often affected), if the pathname to the file is not in the MTL file or if the images are not in 
the same directory as the OBJ file, then you will be asked to locate each texture. Navigate to the 
folder(s) where the textures are located and select them when prompted. 
Two programs that help with this are Grouper and MeTaL Fixer - unfortunately for Mac users, these 
are PC only applications. See Appendix E for links to these programs.

Export Object

The Export Object command will export out terrains, symlats, and converted Boolean meshes from Bryce 
in the following formats:

• 3D Studio 3DS Files (.3ds) 
• AutoCAD DXF Files (.dxf) 
• COLLADA Export (*.dae)
• Direct3D Files (.x) 
• FBX Export (*.fbx)
• Infini-D Files (*.id4)
• Lightwave Files (.lws) 
• Lightwave Object (LWO2) (*.lws)
• Ray Dream Studio Files (.rds) 
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• TrueSpace Files (.cob) 
• VideoScape Files (.vsa) 
• VRML 1.0 Files (.wrl) 
• Wavefront OBJ Files (.obj) 
• WorldToolKit NFF Files (.nff) 

Exporting a file saves information, such as vertices, smoothed normals, UVs (texture coordinates), and 
texture maps.
Some file formats have limitations. For example, DXF does not support smooth normals or UVs. If the file 
format does not support texture embedding, each texture map is written as a separate image at the same 
location specified for the mesh file. The names of the images will start with the name you specified for the 
mesh file and include the name of the material. If UV information cannot be written, two texture maps are 
exported: one for the top part and one for the bottom.
When you export to a 2D format such as DEM or PGM, all the possible texture maps are generated.

Terrains, SymLats, & Converted Meshes

To export a terrain, symlat, or converted Boolean mesh:
1. Select an object or group to export. The group will not export if it contains a non-converted, Bryce 

primitive.
2. Choose File > Export Object from the menu. The Save As dialog comes up.
3. Enter a file name in the File name field.
4. Select a file format from the Save as type field and click on Save. The mesh will export. If 

materials or textures were applied to the mesh, they will be exported as well (512x512 pixels in 
size). Meshes exported as OBJ format will also have an MTL file generated.
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5. If exporting a terrain or symlat, the Export Terrain dialog will come up. Refer to "Exporting 
Terrains" for more information on exporting terrains. 

Rocks & Imported Meshes

1. The Export Object command is the same as for any other object, but with a shortened list of 
Export file options as seen here:

2. Select a file format from the Save as type field and click on Save. The mesh will be exported. If 
materials or textures were applied to the mesh, they will be exported as well. Meshes exported as 
OBJ format will also have an MTL file generated.

Render

The Render command immediately starts the scene render using the current render settings. Previously 
rendered scenes with no changes will begin the render form where they left off.  The render starts from 
the beginning if there are any changes made to a scene. 
To render a scene, choose File > Render from the menu or press Cmd/Ctrl+R. 

Note: If the Plop Render selection is active, then only the selected area will render.

Clear and Render

The Clear and Render command will start a render over from the top. This command does not clear the 
screen before starting the render over. 
To start a new render, choose File > Clear and Render, or click the Clear and Render control, or press 
Cmd/Ctrl+Opt/Alt+R.

Note: If the Plop Render selection is active, then only the selected area will render.

Render to Disk

The Render to Disk command renders the image directly to disk. This is the best choice for a very large 
image, because it allows the setting of the DPI and saves memory. In addition, rendering to disk is usually 
faster than rendering to screen (although this varies). 
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In addition to saving files to 2D formats (.bmp, .jpg, etc.), you can also save files to the following formats 
using Render to Disk: 

• Bitmap (*.bmp)
• HDR Image (*.hdr)
• HTML (.htm) 
• Open EXR (*.exr)
• Photoshop Files (*.psd)
• PNG (*.png)
• QuickTime VR (.mov) 
• TIFF Files (*.tif)

To render a scene to disk:
1. Choose File > Render to Disk. The Render to Disk dialog will come up.

The Output Size in Pixels, Print Resolution, and Output Size in Inches will show the current 
settings for the scene.

2. Change the Print Resolution to the dpi you need for the image; the Output Size in Inches will 
change to match the new dpi.
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3. To make the output larger, change either the Output Size in Pixels or the Output Size in Inches, 
adjusting either one will automatically update the other setting.

4. If rendering a QuickTime VR, select the button next to that option.

5. Click on the OK icon to accept the changes and the Save As dialog will come up. Select the file 
type and change the filename if needed, then click on Save.
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6. The Render Progress panel will come up displaying the progress of the render.

7. The render can be stopped by clicking on the Cancel icon. The following dialog will come up 
asking if verification to stop or resume the render.

8. Once the render has completed, find the image in the location specified in the Save As dialog. 

Note: If the render seems to stop in one place for a long time, clicking on the Progress Panel will 
sometimes "wake up" the render so it will continue.

Render Animation

Rendering an animation is a lot like rendering a still image. Each frame in the animation is processed 
exactly like a still image. The same rendering options used in still images apply here as well.
In addition to the standard still image rendering options, there are several settings for movie files.  These 
include choosing a file type, a compression option, and a range of frames to render. 
The Render Animation command has several formats: 

• AVI Movie 
• BMP Sequence 
• QuickTime Movie 
• RealMovie 

In addition, use the Render Animation dialog to "Render a Wireframe View" of a scene.
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To render an animation:
1. Choose File >Render Animation from the menu or press Opt/Alt+Shift+R. 

The Render Animation dialog will come up.

 By default, the Entire Duration is pre-selected. To render the Working Range, select that 
instead.

 The Start and End fields show the range of the animation to be rendered. Change these 
manually to render only a particular frame or range of frames. 

2. Click the triangle icon beside Output Module and select the type of output to render.

• On the Macintosh, you can render a scene as a QuickTime (MOV) file or as sequenced 
frame files.

• On the PC you can render your scene as a MOV, AVI file, or as sequenced frame files.
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3. Click on Edit and adjust the type of compression to use. The items listed in the Video 
Compression dialog depend on the Codec(s) on the system. Refer to the documentation that 
came with the system software for instructions on using a specific compression.

4. Click on Set and choose the drive and folder in which to save the file:
5. Type a filename and click on Save.
6. Click on Render to Network to use the Bryce Network Render and configure the network.

Refer to "Render on Network" for more on rendering an animation over a network.
7. Click on the OK icon to accept the settings and start the animation render. 

Render on Network

The Network Render, also known as Bryce Lightning, will render over a network of two or more 
computers using the Render Animation command.
Rendering complex scenes and animations requires a significant amount of computational power. Using 
only one computer, a complex scene or animation can take many hours to render. Take steps to 
decrease the time required to render such a scene, such as reducing the complexity of the scene, 
reducing the quality of the render, or upgrading the computing power of the computer.
The Network Rendering feature in Bryce lets will spread a rendering job over multiple computers, 
therefore, reducing the amount of time required to render a complex scene without sacrificing the 
complexity of the scene or the quality of the final rendered image or animation.
This is accomplished, by breaking a scene into smaller sections and sending each section to a separate 
computer to be rendered simultaneously. The more computers working on rendering a particular scene, 
the less time it takes to render the scene.

How Network Rendering Works 

To use network rendering, two or more computers must be connected by a TCP/IP network. One of the 
machines acts as a server that controls the other machines, sending them sections to be rendered and 
reassembling all of the rendered sections into the final image or animation. The other machines act as 
client machines, receiving and rendering their sections of the image and then sending the rendered 
section back to the server.
When rendering an animation over a network, by default, Bryce sends each frame of the animation to the 
client computers.
When rendering a single frame over a network with the Tile Optimization option turned on, Bryce divides 
the frame into tiles and sends the tiles to the client computers.
The server is the only computer that needs to have Bryce installed; the other computers can have either a 
licensed copy of Bryce installed, or you can install Bryce Lightning, an application included with Bryce that 
is specifically designed for network rendering.
To start a network rendering session, find the IP addresses of each of the client machines used in the 
network. Launching Bryce Lightning will display that information.
The next step is to open a scene on the server and select the network rendering option.
Configure the server by giving it the IP addresses of each client computer involved.
To render over a network:

1. First, make sure that Bryce Lightning is installed on each of the client machines. 
2. Choose File > Render Animation from the menu or press Opt/Alt+Shift+R.

The Render Animation dialog will come up.
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• By default, the Entire Duration is pre-selected. To render the Working Range, then select 
that instead.

• The Start and End fields show the range of the animation to be rendered. Change these 
manually to render only a particular frame or range of frames. 

3. Click the triangle icon beside Output Module and select the type of output to render.

Note: For an image (one frame), select Output Mode of BMP Sequence.
4. Click on Edit and adjust the type of compression to use.
5. Click on Set and choose the drive and folder location in which to save the file.
6. Type a filename and click on Save.
7. Click on Render to Network and click on the Configure button.

The Network Render Settings dialog comes up.
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8. Click on the Search button to have Bryce find the clients or enter the Client IP Address in the 
field and click on the Add button. If a firewall is active, permissions may need to be given to allow 
Bryce to access the network. Go ahead and let it. Please note that sometimes, Bryce will not be 
able find the clients so try again as needed. 

9. Once the clients have been located, click on the Select All button or click on the buttons next to 
each client in the Client List, which will participate in the render.

10. Click on the Update button to have Bryce check to see which clients are ready. 

The Client List shows either the IP address or the name of the client, if it is known to the system. 
All available clients get a Green Status. The client on which the server runs sometimes shows as 
not being available (this is the case here). This can be ignored. Sometimes none of the clients 
turn up green. Ignore it for now and check back later. 

Note: For single Picture network rendering, Use Tile Optimization must be enabled.  This is 
the default setting.

11. Click on the OK icon to accept the settings and start the animation render.
12. The following image shows that the Network Render is in full swing. All clients are shown as busy 

including the one that showed as unreachable earlier.
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13. Each render client will have a status dialog showing the status of the piece it is rendering.

14. To check on the render as a whole, choose File > Network Render Manager from the menu.
15. When the Render job is finished, all clients will show as Ready (green). After a few seconds, the 

Status will turn black with a white question mark.
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Render Wireframe View

To render a wireframe view of your scene:
1. Set up a scene and the document size. This type of render does not use DPI, so consider that 

when determining the render size.
2. Select any objects that are to be included in the wireframe render. (See image below.)
3. Choose File > Render Animation from the menu or press Opt/Alt+Shift+R. 
4. The Render Animation dialog will come up.

 By default, the Entire Duration is pre-selected. To render the Working Range, then select 
that instead.

 The Start and End fields show the range of the animation being rendered. Change these 
manually to render only a particular frame or range of frames.

 If no animation is set up, the fields will all have zeroes in them. For a wireframe render, 
this is okay.
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2. Click the triangle icon beside Output Module and select BMP Sequence from the list.

3. Click on Set and choose the drive and folder location in which to save the file:
4. Type a filename and click on Save.

5. Press the Shift key and click on the OK icon to accept the settings.
6. When asked if you want to stop or resume the render, click on Resume. 

7. The frame will render and the bitmap file will open in your default Picture editor. Take note in the 
image below, any objects selected in the scene will render selected as well.
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Network Render Manager

The Network Render Manager will monitor the progress of the network render. This will also monitor the 
status of individual client computers; pause rendering on a client computer; cancel rendering on a client 
computer; and add or remove client computers from the list of available clients. 
The scene will not be visible while rendering on the server. However, by going to the client computers, the 
section that client is rendering will be shown. The Network Render Manager displays a list of all network-
rendering jobs in progress, the state of each job, and its percentage complete. Use the Network Render 
Manager to change the settings of a network-rendering job.
To monitor a render using the Network Render Manager, choose File > Network Render Manager from 
the menu. From the Network Render Manager, monitor the progress of the network rendering jobs, view 
the status of the client computers working on a job, and pause or cancel a job.

To pause a network-rendering job:
1. Choose File > Network Render Manager from the menu.
2. Select the job to be paused.
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3. Click Pause.
To resume a network-rendering job:

1. Choose File > Network Render Manager from the menu. 
2. Select the paused job.
3. Click Run.

To cancel a network-rendering job:
1. Choose File > Network Render Manager from the menu.
2. Select the job to be cancelled.
3. Click Cancel.

To view the status of the client computers working on a job:
1. Choose File >Network Render Manager from the menu.
2. Select the network-rendering job.
3. Click Settings. This brings up the Network Render Settings dialog. Bryce will automatically verify 

the status of client computers in the Client List, except for those clients which have been 
manually disconnected. Click the Update button to have Bryce verify the status of the client 
computers in the Client List listed as unverified, unreachable, or disabled. The Status column in 
the Client List displays colored icons next to each client computer. 

Each color represents a different status: 
• Green = Ready: The client computer at that IP address is running Bryce Lightning and is 

available to receive a rendering job from the server. 
• Orange = Working: The client computer at that IP address is running Bryce Lightning and 

is processing a rendering job. 
• Red with horizontal bar = Locked: The client computer at that IP address is connected 

to another server, or an error has occurred on the client computer. 
• Red with lightning bolt = Unreachable: The client computer at that IP address is 

unreachable or is not running Bryce Lightning, the IP address is invalid, or the client 
computer does not have enough memory to render the job. 

• Black with question mark = Unverified: The Network Render Manager did not attempt 
to determine the status of the client computer at this IP address. This icon will only 
appear when you first add a client to the Client List. 

• Grey = Disabled: The client computer at that IP address the user and will not be used for 
the rendering job 

Page Setup

The Page Setup command sets the page settings for printing the current rendered image. 
On PCs, set whether to center the image on the page, how many copies to print, and what dpi to print. 
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To set up the page:
1. Choose File > Page Setup from the menu. The Page Setup dialog comes up.

2. Select whether to center the page on the paper, the number of copies, and the DPI setting. 
Please note that if you set a Custom DPI setting, increase the document size before printing, as a 
higher DPI will print the image smaller to accommodate the DPI. 

3. Click on OK to save the settings.
On Macs there are no options to set the dpi in the Page Setup.

Print

The Print command brings up the print menu for the connected printer in order to print the current working 
window. The Page Setup settings are used to print the image. This is a great way to print out the 
wireframe view of an image without having to do a screen capture. 
To print the current working window:

1. Set up the page using the Page Setup command.
2. Choose File > Print from the menu or press Ctrl+P. The Print dialog for the system will come up.
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3. Select a printer from the drop down menu and click on OK to print.

Printing to a Software Program

Adobe Acrobat Standard or Professional can print the working window to PDF, and then use the 
Snapshot Tool to copy the image and paste it into a paint program.
Print to any other program format available on the system, such as Canvas or SnagIt. Click on properties 
and set the dpi setting for the program (page setup does not seem to affect printing to a paint program). 
This may be under advanced settings. 
When using Canvas, close the program before printing. Bryce prints the image and then Canvas opens 
with the image in a new document. Canvas saves the image in slices, thus, merge the layers before trying 
to do any postwork on the image
If you use SnagIt, save the image to a file and not to the clipboard. Pasting to the clipboard will do so at 
72 dpi.
See Appendix E for links to the listed programs.

Recent Files

Between the Print and Quit items on the File menu, there are four slots for the four last saved scenes. 
Click one and it will load in Bryce as long as it is in the same location as where it was originally saved. If it 
moved, Bryce will notify that it cannot find the file.

Please note that any scenes that opened but not saved, will not be listed in the Recent Files listing. In 
addition, any scene files worked on before a program crash will not be listed either.
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Quit

The Quit command will close Bryce, but not before giving the chance to save the current scene, or to 
cancel closing Bryce. 
To exit Bryce:

1. Choose File > Quit from the menu or press Ctrl-Q. A dialog appears prompting you to save the 
current scene.

2. Select to not save the scene, to save the scene, or cancel the close. 

Edit Menu
The Edit accesses object-related functions. To access the Edit Menu, left-click on Edit.
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Undo

The Undo command undoes the last action performed on the objects, up to 16 steps. It does not affect 
changes made to the camera/view.
To undo the last performed action, choose Edit > Undo from the menu or press Cmd/Ctrl+Z.
Cmd/Ctrl+Z can also be used in the different laboratories, but the labs only undo the last step. By 
pressing Cmd/Ctrl+Z a second time, then the lab will redo the previous step (the one just reversed).

Redo

The Redo command redoes the last action previously undone on the objects, up to 16 steps. It does not 
affect changes made to the camera/view.
To redo an action, choose Edit > Redo from the menu or press Cmd/Ctrl+Shift+Z.

Cut

The Cut command removes the selected object or group from the scene and places it on the clipboard. 
The object can then be pasted back into the scene or into a new scene.
To cut an object from the scene:

1. Select the object(s) or group(s) you want to delete.
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2. Choose Edit > Cut or press Ctrl+X.

Copy

The Copy command copies the selected object(s) and places the copy on the clipboard ready to paste 
into the scene or into a new scene. 
When copying an item that is part of a group, using Copy/Paste will place the new object outside the 
group. Use Duplicate if you want the new object to be part of the group. 
To copy an object or group of objects:

1. Select an object, multiple objects, or group(s).
2. Choose Edit > Copy from the menu or press Cmd/Ctrl+C. 

Paste

The Paste command places any object currently in the clipboard, after using Cut or Copy, into the scene.
To paste an object:

1. Select an object or group and Copy or Cut it.
2. Choose Edit > Paste or press Cmd/Ctrl+V.

Clear

The Clear command removes the selected object(s) from the scene without placing it on the clipboard. 
This means that you cannot use Edit > Paste or press Cmd/Ctrl+V to paste the object back into the 
scene.
To clear an object(s) from the scene:

1. Select an object or objects.
2. Select Edit > Clear from the menu.

To undo the clear:
1. Choose Edit > Undo from the menu.

OR
2. Press Cmd/Ctrl+Z.

Copy Material

The Copy Material command copies the material on the current selected object so that it can be pasted 
onto another object using the Paste Material command. This is extremely useful when tweaking a material 
and quickly applying it to other objects without having to select it from the Materials Library each time. 
To copy a material:

1. Select an object that has the material applied to it that you want to copy.
2. Choose Edit > Copy Material or press Ctrl+Opt/Alt+C.
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Paste Material

The Paste Material command pastes the material copied using the Copy Material command, overriding 
the currently applied material.
To paste a material onto an object:

1. Select an object and copy the material using the Edit > Copy Material command.
2. Select another object and choose Edit > Paste Material from the menu or press Ctrl+Opt/Alt+V.

Copy Matrix

The Copy Matrix command copies an object(s) position, rotation, and size. The copied Matrix can then be 
copied on to another object using the Paste Matrix command to override the object's own position, 
rotation, and size. 
This function is especially useful when using the DAZ Studio link to import figures and item modifications 
are needed. Since Bryce literally deletes the object and replaces it, the object is loaded into Bryce at the 
default size, location, and rotation. Before going back into DS, copy the matrix of the object, then come 
back into Bryce and when the object has been reloaded, paste the matrix on to the imported DS object to 
restore it to the size, position, and rotation the previous version was at. 
One caveat though, changing the pose or clothing on the figure will not get exactly the same result as 
before because the matrix of the new object is different than the new one. In this case, it is better to use 
the 3D Transformation and size the object by a percentage each time.

To copy an object's matrix:

1. Select an object or group.
2. Choose Edit > Copy Matrix from the menu or press Opt/Alt+C.

Paste Matrix

The Paste Matrix command pastes the matrix copied using the Copy Matrix command, overriding the 
selected object(s) position, rotation, and size. 
To paste a matrix onto an object:

1. Select an object and copy the matrix using the Edit > Copy Matrix command.
2. Select another object and choose Edit > Paste Matrix from the menu or press Opt/Alt+V.

Duplicate

The Duplicate command duplicates the selected object(s) and places the copy directly into the scene. The 
duplicate is not placed on the clipboard so it cannot be pasted into the scene later. 
If the selected object is part of a group, then the new object will also be part of the group. If you do not 
want the new object to be part of the group, use Copy/Paste instead. 
To duplicate an object(s) or group(s):

1. Select the object(s) or group(s) you want to duplicate.
2. Choose Edit > Duplicate from the menu or press Cmd/Ctrl+D.
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Replicate

The Replicate command not only duplicates the selected object(s) or group of objects, but also the last 
3D transformations made on the objects. For example, move an object up and rotate it, Replicate will 
create a copy, then move it up, and rotate it the same amount. Each time an item is replicated, it moves 
and rotates the new object the same amount.
Replicate only duplicates the object one time. To replicate the object more than once, use Multi-Replicate 
instead. 
To replicate an object:

1. Select an object or group.
2. Perform any required 3D transformations on the selection. 
3. Choose Edit > Replicate from the menu or press Opt/Alt+D.

Example:
Here is a cube rotated:

Replicated once:

Replicated five times, notice how it only rotated the cube:
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Here's another cube, rotated and moved up: 

Replicated once:

Replicated five times, notice how it not only rotated the cube, but moved it up each time: 

Multi-Replicate

The Multi-Replicate command works the same way as Replicate but instead of just replicating the object 
once, it can replicate it multiple times. Either it can repeat the last transformations made on the object, or 
can change the settings manually to modify the replications.
To multi-replicate an object:

1. Select an object or group to replicate.
2. Choose Edit > Multi-Replicate from the menu or press Opt/Alt+Shift+D. The Multi-Replicate 

dialog will come up.
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3. Enter values in the following fields: 
• Quantity - Enter how many objects to replicate, if you need 10 objects total, enter 9 in 

the field. 
• Scale Translation - Select to apply the size percentage to the Offset amount, for 

example, if the size percentage is 90%, then the offset will be at 90% of the entered 
amount for each object. 

• Offset - Enter the amount to move the replicated objects on the X, Y, and/or Z-axis. 
• Rotate - Enter the amount to rotate the replicated objects on the X, Y, and/or Z-axis. 
• Size - Enter the percentage to re-size the replicated objects on the X, Y, and/or Z-axis, 

set at 100% to keep them the same size as the original.

• Scale Translation - enable to use this option
4. Click on the OK icon to close the dialog and complete the operation. 
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And here is the rendered example: 

Notes:
1. When the object is transformed prior to choosing Multi-Replicate, the fields are already populated 

with matching amounts.
2. If the object has not been moved, the Offset and Rotate fields will be at zero and the Size at 

100%.

Scale Translation

As mentioned on the Multi-Replicate page, selecting Scale Translation will apply the size percentage to 
the Offset amount, for example, if the size percentage is 90%, then the offset will be at 90% of the 
entered amount for each object.
For example, the dialog below shows that we want to replicate an object four times, offsetting each 
duplicate 30 BU along the X-axis, and reducing the size of each duplicate to 90% of the previous 
duplicate: 

And here is the result, notice how the cubes are all exactly the same space apart (30 BU):
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But, if we select Scale Translation:

Then the offset will be 90% of 30 BU for each duplicate: 

Random Replicate

New since Bryce 6, is the Random Replicate command. This function is similar to Multi-Replicate in that it 
replicates one or more objects. The difference is that each replication is random in placement and in the 
number which each object is replicated. Each time it repeats a replication, the number of each object 
replicated changes. 

• Quantity - Enter how many objects to create during the replication 
• Boundary - Enter the boundary, in BUs for where the replicated objects can be created around 

the original objects 
• Collision Detection - Select to enable collision detection when replicating objects
• Constrain Rotation to Y-axis - Select to constrain rotation to the Y-axis 
• Land Objects - Select to have objects Snap to Land after being replicated

Please note when replicating Bryce Trees or Terrains, the Constrain Rotation to Y-axis function is 
automatically selected. If deselecting Constrain Rotation to Y-axis when trees or terrains are selected, 
Bryce will still constrain the objects to the Y-axis.
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To use random replicate:
1. Create one or more objects
2. Select all the objects you want to replicate.
3. Choose Edit > Random Replicate from the menu or press Opt/Alt+R.
4. Enter the number of replications in the Quantity field
5. Enter the Boundary amount on the X, Y, and Z-axis (defaults to 200). 

• If you want the objects to be no more than 50 BU away from the originals, enter 100 (50 
BU both positive and negative). 

• If you want the objects to be no more than 200 BU away from the originals, enter 400 
(200 BU both positive and negative). 

6. To have the objects snap to land, select Land Objects.
7. To allow the objects to be rotated on the Y-axis only, (good for trees, houses, etc.), select 

Constrain Rotation to Y-axis.
8. Click on the OK icon to accept the changes and complete the operation. 

Examples: 

Basic Random Replication:
The following example replicates three objects (cube, sphere, and torus) 15 times with a boundary of 100 
on all axes:

And here is the result: 
• Sphere - Replicated four times 
• Torus - Replicated five times 
• Cube - Replicated six times 
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If the objects are all selected and grouped, the size of the group (Boundary) will be around 100 BUs (give 
or take a few BUs) based on the boundary selected in the dialog. 
After deleting the replicated objects and repeating the same Random Replication, a different combination 
of objects is created, for example:

• Sphere - Replicated seven times 
• Torus - Replicated four times 
• Cube - Replicated four times 

Land Objects:
The following image shows the result of the random replication with the Land Objects selected. Since the 
default plane is the "land," the objects all snap to it. The same thing will happen if the default plane has 
been deleted (underground plane is considered the "land").
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The following image shows the result of the random replication with the Land Objects selected and a 
terrain in the scene. Only the primitives were replicated, not the terrain.

This is especially useful for placing objects like trees and rocks around a terrain. The objects will snap to 
the terrain for a more natural look: 
(Okay, so primitives on a terrain are not "natural" but you get the idea.)

Constrain Rotation to Y-axis & Collision Detection:
The image below shows the result of the random replication with the Constrain Rotation to Y-axis and 
Collision Detection selected. Notice that the objects only rotate around the Y-axis - useful for placing 
trees, houses, people, etc. 

Select All

The Select All command will select all objects in the working window.
To select all objects, choose Edit > Select All from the menu or press Cmd/Ctrl+A. On the PC, you can 
also set the NumLock, then press Ctrl+1 key on the numpad.

Deselect All

The Deselect All command deselects all currently selected objects or groups in a scene. 
To deselect all selected objects or groups in a scene, choose Edit > Deselect All from the menu. 
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Invert Selection

The Invert Selection command will invert the selection by deselecting all currently selected objects in the 
scene and selecting all objects that were not previously selected.
To invert the selection, choose Edit > Invert Selection from the menu or press Ctrl+Shift+A.

Reset to Defaults

The Reset to Defaults command resets all menus, palettes, and the working window to their default 
factory position.
To reset the interface to the default settings, choose Edit > Reset to Defaults from the menu. 

Reset Palettes

The Reset Palettes command will reset all moved palettes back to their default position.
To reset all palettes, choose Edit > Reset Palettes from the menu.

Preferences

The Preferences command brings up the preferences palette where you can set how Bryce launches and 
saves. 

The Preferences dialog contains the following options:
• Launch to default state - opens Bryce to the default factory state OR to the saved Default.br6 

scene file. 
• Launch to previous state - opens Bryce to the last state Bryce was in before closing the 

program. 
• Image with Scene Open/Save - saves the rendered image with the scene and loads the image 

when the scene is loaded. 
• Create object within view - creates objects within the current view, this allows you to be 

anywhere in the scene and new objects will still be in view. 
• Create object at world center - creates objects at world center, no matter where the current 

camera view is at. 
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• Create objects with default material - creates objects with the default gray material. 
• Create objects with last used material - creates objects with the last material loaded manually 

through the Materials Library or Texture Editor. 
• Copy sky to new document - will copy the sky in the current scene to a new scene created by 

File > New Document. 
• Use Multiple monitors - New Feature support for Multi-Monitor use.

By setting application Preferences, Bryce can be made to suit personal needs and work flow. Bryce does 
not need to restart to make these changes take effect.
To set the application's launch state:

1. Choose Edit > Preferences. The Preferences dialog appears.
2. Enable either Launch to Previous State or Launch to Default State. 

• Launch to Previous State launches Bryce using the settings from the last session. 
• Launch to Default State launches Bryce using the default settings. 

To save images used in a scene with a file:
1. Choose Edit > Preferences. The Preferences dialog appears.
2. Enable Image with Scene Open/Save. With this option enabled, Bryce will automatically open or 

save a PICTURE or BMP file (PICTURE/BMP files are automatically appended with the 
extension), along with the scene file, every time it opens or saves. In most cases, this option 
should always be selected.

To control new object placement:
1. Choose Edit > Preferences. The Preferences dialog appears.
2. Enable either Create Objects Within View or Create Objects at World Center. 

• Create Objects Within View places newly created objects within the camera view, rather 
than at world center. 

• Create Objects at World Center places newly created objects at world center, regardless 
of whether they will be visible in your current camera view. 

Objects Menu
The Objects accesses object-related functions. To access this menu, left-click on Objects.
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Edit Object

The Edit Object command brings up the appropriate edit palette for the selected object. This only works 
on objects that have the   button next to the selected object. 
To edit an object:

1. Select an object in the scene.
2. Choose Objects > Edit Object from the menu or press Cmd/Ctrl+E. The editor for that object 

will come up. 

Object Selected Edit Palette

Terrain or SymLat Terrain Editor 

Torus Edit Torus

Tree Tree Lab

Rock, Imported Mesh * Edit Mesh

* Once the Edit Mesh dialog comes up for rocks and imported meshes, export the mesh by pressing 
Cmd/Ctrl+D. See "Exporting Rocks & Imported Meshes" for more on this.

Attributes

The Attributes command brings up the Object Attributes dialog. This same dialog panel comes up when 
pressing the   button next to the selected object.
To edit the object's attributes:

1. Select a group or object.
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2. Choose Objects > Attributes from the menu or press Cmd/Ctrl+Opt/Alt+E.
The Object Attributes dialog consists of three tabs: General, Linking, and Animation.

• The General tab is where the basic object attributes are set: object name, position, size, rotation, 
and display quality.

• The Linking tab contains options set up the link between two objects and set up the tracking link.
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• The Animation tab contains options for controlling the display of motion paths and setting the 
motion path type.

See "Working with Objects" for more on this dialog.

Convert Boolean to Mesh

The Convert Boolean to Mesh converts Boolean groups to mesh which can then be exported from Bryce 
and imported into other programs.
To convert a Boolean group to mesh:

1. Build an object using Boolean objects that are grouped together.
2. Choose Objects > Convert Boolean to Mesh from the menu or press Opt/Alt+Shift+C. The 

Boolean group is converted to a mesh.
3. Choose File > Export Object from the menu and export the converted mesh to finalize the 

conversion.
4. Choose File > Import Object from the menu to import the mesh.

See "Convert Boolean Icon" for information on using this feature.

Edit Material

The Edit Material command brings up the Materials Lab. This same editor comes up when pressing the 
button next to the selected object.
The Materials Lab is where materials are selected and applied to objects. By combining up to four 
texture components on the materials grid, onecan create incredibly complex surfaces that can bring a 
scene to life.
There are two types of materials:

• Surface materials - which define the surface properties of an object.
• Volume materials - which define the properties of an object's volume as well as its surface. 

When creating volume materials, the settings in the Materials Lab change. Some of the surface 
material settings are replaced by volume effects settings.

©2003-2011 DAZ 3D, Inc. 75



Bryce 7 Artist Guide 03 Jan 2011

To edit a material in the Materials Lab, select Objects > Edit Material from the menu or press 
Cmd/Ctrl+M. 
An object does not need to be selected in order to open the Materials Lab, however, to edit a material 
already applied to an object, select the object first.
Refer to "The Materials Lab" for more on the Materials Lab and "Understanding Volume Material 
Channels" for more on Volume materials.

Edit 2D Pictures

The Edit 2d Pictures command brings up the Pictures Editor. Access the Pictures Editor from the Create 
Palette, the Materials Lab, the Light Lab, and the Tree Lab as well.
To open the Pictures Editor, choose Objects > Edit 2d Pictures from the menu or press 
Cmd/Ctrl+Opt/Alt+M. It is not required to have to have an object selected to bring up the Pictures Editor 
this way.
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The Pictures Editor will come up:

Edit 3D Textures

The Edit 3D Textures command brings up the Deep Texture Editor (DTE).  Access the Deep Texture 
Editor from the Edit Palette, Materials Editor, Light Lab, Sky Lab, Tree Lab, and Terrain Editor as well.
To open the Deep Texture Editor, choose Objects > Edit 3D Textures from the menu or press 
Opt/Alt+M. An object does not need to be selected to bring up the Deep Texture Editor this way.
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Show Object As Box

The Show Object As Box command changes the selected object(s) or group as box(es). This is useful 
when you just want to work with the object's position but do not need more details.
To show objects as boxes, choose Objects > Show Object As Box from the menu or press 
Cmd/Ctrl+B. 

Show Object As Lattice

The Show Object As Lattice command changes objects shown as boxes back to wireframes.
To show objects as a wireframe, choose Objects > Show Object As Lattice from the menu or press 
Cmd/Ctrl+L.
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Group Objects

The Group Objects command groups two or more objects or groups into a single group.
As a scene becomes more complex, it will be necessary to group objects. Grouping allows the control a 
set of objects as a single unit. When performing a transformation on a group, all the objects are equally 
affected. When scaling a group, all the objects change size, or if rotating a group, all the objects rotate 
around a single axis.
Choosing objects to place in a group depends on how a scene is organized. For example, group the 
objects that comprise complex objects, like the walls and turrets of a castle. You can group objects to 
keep all the components of a complex object like a train engine together. Another way is to create groups 
to maintain the spatial relationships between objects when transforming them.
Create a group to maintain the spatial relationships between objects when transforming them, like the 
boards in a fence. Place as many objects as necessary in a group. Nest groups within groups. Nesting 
can be an easy way of managing scenes that are more complex.
Groups are essential to creating Boolean objects and converting them to a mesh. Boolean operations will 
not work unless the objects are part of a group. Groups cannot be created using a child object. If a child 
object is part of the selection the icon will not appear.
To create a new group:

1. Select all the objects and/or previous groups to group together.
2. Choose Objects > Group Objects from the menu or press Cmd/Ctrl+G. You can also click the 

 button next to the selected objects' bounding box.

To select objects within a group:
1. Hold down Cmd/Ctrl and click on an object inside the group-bounding box. A popup menu will 

come up listing all the objects under the mouse.
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2. Select the object desired from the menu.

Ungroup Objects

The UnGroup Objects command removes the grouping from the current selection. If the selection 
contains nested groups, continue to choose this command until all the groups are ungrouped, or until the 
ungroup control disappears.
The ungroup control (button) only appears when a group or a number of objects contained in a group is 
selected. Click this control and any group in the selection is ungrouped.
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To ungroup a selected group of objects:
1. Select all the groups you want ungrouped.

2. Choose Objects > UnGroup Objects from the menu or press Cmd/Ctrl+U. Alternatively, click 
the  button next to the selected groups' bounding box.

Break DAZ Studio Link

The Break DAZ Studio Link command breaks the link between Bryce and the object(s) imported through 
the DAZ Studio link.
Breaking the link allows modification of the mesh as needed, such as deleting meshes that are not seen 
in the scene. Attempting to the delete one of the meshes without breaking the link will delete the imported 
objects instead.
To break the link to DS:

1. Select the object group imported from DS.
2. Choose Objects > Break DAZ Studio Link from the menu.

Caution: Animations imported from Daz Studio do not break the link! Since the animation is stored in the 
corresponding .daz file and not in Bryce, this will delete the animation as well.
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Create Path

The Create Path command creates a default geometric path, which can then be used as a motion path for 
other objects.
A Geometric Path is an object that acts as a motion path for other objects. Geometric Paths do not render 
as objects. Think of these paths as railroad tracks. Objects can move along the track but they cannot 
move off it.
Control how an object is constrained to the path using the options in the Object Attributes dialog.
Edit Geometric Paths just like any other object. Rotate, position, or scale the path using the tools in the 
Edit palette. Edit a path by dragging its control points. This can change the geometry of the paths as well 
as the trajectory of any object attached to it.
Geometric Paths are especially useful when creating motion animations, as they can help create 
predictable and repeatable motion.
The other great thing about Geometric Paths is that they can have more than one object attached to 
them. This can be very useful if a number of objects are to move along the same trajectory.

Objects attached to the same path can be animated at different rates. Therefore, think of the objects as 
different trains on the same track, some trains are at the beginning of the track, others are in the middle, 
and some are at the end. All the objects attached to the path will have the same trajectory.
Objects can also be aligned differently to the same path. Therefore, objects may appear to tilt differently 
as they follow the same trajectory.
Since Geometric Paths are objects, they can also attach to other paths. Some very complex types of 
motion can be created using this technique. For example, one can simulate the motion of the solar 
system by attaching an object on a circular path to a circular geometric path. The object on the circular 
path would act like a moon orbiting a planet, which is also orbiting the Sun.
To create a geometric path, choose Objects > Create Path from the menu or press Opt/Alt+P. A default-
shaped path object appears in the scene.
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To convert a motion path into a geometric path object:
1. Select an object with a motion path.
2. Choose Objects > Create Path from the menu. This creates a path object with the same shape 

path you selected.
To link an object to a path:

1. Select the desired object to attach to the path.
2. Move the cursor over the Link icon that appears next to its bounding box.
3. Drag the linking control handle from the object to the path object.

Fly-around

The Fly-around command starts the wireframe view in the Working window to rotate allowing objects in 
the scene to be viewed from multiple angles.

• To start the scene fly-around, choose Objects > Fly-around from the menu or press 
Cmd/Ctrl+Y.

• To stop the scene fly-around, click in the Working window. 

Motion Lab

The Motion Lab command opens the Advanced Motion Lab (AML) where animations can be modified.
To open the AML, choose Objects > Motion Lab from the menu or press Cmd/Ctrl+T.
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Sky Lab

The Sky Lab command opens up the Sky Lab This is where you modify the sky.
To access the Sky Lab, choose Objects > Sky Lab from the menu or press Cmd/Ctrl+K.
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Preview Animation

The Preview Animation command shows a rendered preview of an animation either in the Nano-Preview 
window or as a storyboard depending on what was selected in the Preview Animation popup menu
To preview an animation, choose Objects > Preview Animation from the menu.

Links Menu
The Links Menu provides links to DAZ3D.com, Tech Support, and DAZ Tutorials.
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To change the links in the Bryce Links menu:
1. Locate the file "Bryce Links.txt" in your main Bryce folder. 
2. Open this file with a text editor. 
3. Type in a link name as you want to see it in the menu, followed by a comma (,) and two spaces, 

then on the same line type the URL in quotation marks such as "http://www.daz3d.com" 
4. To place a separator between links, type a dash between quotation marks ("-") 
5. Save the file to replace the existing one. 

Example:
"Tech Support", "http://www.daz3d.com/redirects/contact_us.php"
"Tutorials", "http://www.daz3d.com/redirects/bryce_tutorial.php"
"-", "-"
"How to change this menu...", "linksmenu.htm"

Now replace the links that are there or add new ones. 

Help Menu
The Help Menu provides links to the included help file and other helpful links.

To view the current version/build of Bryce, press and hold Cmd/Ctrl and choose Help > About Bryce.
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Customizing Bryce

Customizing Bryce

The Bryce interface can be customized to better suit one's personal workflow.   Reposition any palette, or 
choose to hide the entire interface and leave only the working window visible.

• Moving Palettes  
• Reset All Palettes  
• Display or Hide Palettes  
• Hide Interface  

Moving Palettes

Most of the palettes can be moved around the Bryce interface. Take advantage of some of the space 
around the Working Window and save time without clicking the buttons at the top of the window to change 
palettes.
To move the palettes: 

1. Move the cursor over the desired palette and press the Space Bar. The cursor will change to a 
hand.
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2. With the Space Bar still pressed, left-click-drag the palette to where desired.

3. Repeat for any other palettes. Using this technique, the Create, Edit, and Sky & Fog palettes can 
be active at the same time instead of having to click on each palette name each time.
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Note that the Time and Selection palettes cannot be moved separately. Continue to use the 
Time/Selection Toggle to switch between them. 

Reset All Palettes

To reset all the palettes to their original positions, select Edit > Reset Palettes from the menu or press 
Opt/Alt+Spacebar+click on any palette.
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Toggle Palettes

To keep the interface uncluttered, toggle through palettes with a keystroke:
• Ctrl+1 - Create palette 
• Ctrl+2 - Edit palette 
• Ctrl+3 - Sky & Fog palette 

The Palettes
Bryce uses a series of palettes to manage tools and controls: the Create Palette, Edit Palette, Sky & Fog 
Palette, Advanced Display Palette, Selection Palette, and Animation Controls. These palettes create 
objects, edit objects, create skies and fog, control the display of a scene, select objects, and animate 
objects. Refer to "The Palettes" for more on using the different palettes. 
Beside the title of each of the three tool palettes (the Create palette, Edit palette, and Sky & Fog palette) 
is a small triangle that opens the different Preset Libraries available in Bryce. Refer to "Preset Libraries" 
for more on Preset Libraries.
Click on the links below to go directly to that topic.

• Create Palette  
• Edit Palette  
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• Sky & Fog Palette  
• Advanced Display Palette  
• Time/Selection Palette  

Create Palette

The main tool for creating objects is the Create palette. This palette provides access to tools that create 
all the object types available in Bryce. The tools on the palette represent the type of object they create. 
The name of each tool appears in the Text Display Area and as a Tool Tip as you move your cursor over 
it. Click a tool and the object appears in the center of the workspace or scene depending on the 
preference setting.

To display the Create palette, click the  button at the top of the Bryce window.
To use a Create tool:

1. Display the Create palette by clicking on the Create button.

2. Click on the tool for the object type you want to create. The object appears in the working 
window.

The Triangle icon next to the Create button at the top of the Bryce window accesses the Object Presets 
Library.
Click on the links below to go directly to that topic.

• Objects Library  
• Primitives vs. Procedurals  
• Creating Primitives  
• Creating Infinite Planes/Slabs  
• Creating Terrains  
• Creating Symmetrical Lattices  
• Creating Trees  
• Creating Stones  
• Creating Metaballs  
• Creating 2D   Pictures  
• Creating Lights  
• Launch DAZ|Studio  

Objects Library
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The Preset Object Library contains all the preset objects distributed with Bryce as well as presets you 
add. Objects in the library are either 3D models or geometric paths. Use the Preset Objects Library to add 
ready-made objects to a scene.
Place objects from the library anywhere in the scene and edit them just like any other object.
Add and delete objects from the libraries, add and delete categories, and change the thumbnail preview 
image.
To access the Preset Objects Library: 

1. Click quickly on the triangle next to the Create button. Please note that holding down the mouse 
key for too long, the library will open, and then close immediately. To keep the library open, click 
quickly on the triangle icon. 

2. The Preset Objects Library will come up.

Bryce comes with two object preset category folders: Installed and User. The Installed preset category 
folder contains the presets installed with Bryce. The User preset category folder is empty by default and 
provides a quick way to save objects to the library.
To choose a preset category folder, click the triangle icon next to the preset category folder name at the 
bottom left of the Preset Object Library and choose a preset category folder from the drop-down menu. 
The Preset Object Library opens that preset category folder and displays the categories and presets 
found in that folder.
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Refer to "Libraries" for more information on adding/deleting categories and presets and updating the 
thumbnail previews.

Primitives vs. Procedurals

Bryce's Create palette will create two different types of basic objects: Primitives and Procedurals.
Primitives are basic geometric shapes such as the sphere, torus, cylinder, cube, pyramid, cone, plane, 
and disk. These shapes can be thought of as primary geometric building blocks, from which objects that 
are more complex are constructed.
Primitives also have derivative groups (such as the ellipsoid and squashed sphere, which are derived 
from the Sphere), which allow you to create different shapes without having to perform the 
transformations yourself.
Procedural objects are object that require special constructions, or "procedures," to create, such as 
terrains, trees, rocks, symmetrical lattices, and Metaballs. Procedures can include operations such as 
assigning materials, randomizing internal parameters, or assigning light properties.

Creating Primitives

Creating Primitives

Primitives are the primary geometric building blocks in Bryce. Create spheres, tori, cylinders, cubes, 
pyramids, cones, discs, and 2D faces.
By default, all Primitives are assigned a flat gray color.

Derivative Primitives 

Derivative Primitives are primitive objects whose shape is "derived" from basic geometric primitives.
Derivative Primitives were created so that you could skip some of the editing procedures on most of the 
basic primitives. For example, instead of elongating a cube to make it into a pillar, use the Stretched Cube 
derivative. Instead of shortening a cube to make it into a rectangle, use the Squashed Cube derivative.
To create a geometric primitive, click one of the primitive tools in the Create Palette.

• Sphere  
• Torus  
• Cylinder  
• Cube  
• Pyramid  
• Cone  
• 2D Disc  
• 2D Face  

Creating a Sphere
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To create a default Sphere, click on the Sphere tool in the Create palette:

The Sphere will be created with X, Y, and Z-size of 20.48 BU:

To create a Stretched Sphere, press Shift+click Sphere tool.
The Stretched Sphere will be created with X and Z-size of 20.48 BU and Y-size of 40.96 BU:

To create a Squashed Sphere, press Cmd/Ctrl+click Sphere tool.
The Squashed Sphere will be created with an X and Z-size of 20.48 BU and Y-size of 10.24 BU:

Creating a Torus

To create a default Torus, click on the Torus tool in the Create palette:

The Torus will be created with an X and Y-size of 20.48 BU, Z-size of 5.12 BU, and radius of 256:
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The torus has it is own editor which can be accessed by clicking the   button next to the torus.
See the "Torus Editor" for more information on using the editor.

Creating a Cylinder

To create a default Cylinder, click on the Cylinder tool in the Create palette:

The Cylinder will be created with an X, Y, and Z-size of 20.48 BU:

To create a Stretched Cylinder, press Shift+click Cylinder tool.
The Stretched Cylinder will be created with an X-size of 20.48 BU, Y-size of 40.96 BU, and Z-size of 
10.24 BU:

To create a Squashed Cylinder, press Cmd/Ctrl+click Cylinder tool.
The Squashed Cylinder will be created with an X and Z-size of 20.48 BU and Y-size of 5.12 BU:

Creating a Cube
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To create a default Cube, click on the Cube tool in the Create palette:

The Cube will be created with an X, Y, and Z-size of 20.48 BU:

To create a Stretched Cube, press Shift+click Cube tool.
The Stretched Cube will be created with an X-size of 10.24 BU, Y-size of 40.96 BU, and Z-size of 20.48 
BU:

To create a Squashed Cube, press Cmd/Ctrl+click Cube tool.
The squashed cube will be created with an X and Y-size of 5.12 BU and Z-size of 20.48 BU:

Creating a Pyramid

To create a default Pyramid, click on the Pyramid tool in the Create palette:

The Pyramid will be created with an X, Y, and Z-size of 20.48 BU:
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To create a Stretched Pyramid, press Shift+click Pyramid tool.
The Stretched Pyramid will be created with an X-size of 10.24 BU, Y-size of 40.96 BU, and Z-size of 
20.48 BU:

To create a Squashed Pyramid, press Cmd/Ctrl+click Pyramid tool.
The Squashed Pyramid will be created with an X and Z-size of 20.48 BU and Y-size of 5.12 BU:

Creating a Cone

To create a default Cone, click on the Cone tool in the Create palette:

The Cone will be created with an X, Y, and Z-size of 20.48 BU:

To create a Stretched Cone, press Shift+click Cone tool.
The Stretched Cone will be created with an X-size of 10.24 BU, Y-size of 40.96 BU, and Z-size of 20.48 
BU:
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To create a Squashed Cone, press Cmd/Ctrl+click Cone tool.
The Squashed Cone will be created with an X and Y-size of 10.12 BU and Z-size of 40.96 BU, it will also 
be lying on its side:

Creating a 2D Disc

To create a default, vertical Disc, click on the Disc tool in the Create palette:

The Disc will be created with an X and Y-size of 20.48 BU and Z-size of 0 BU:

To create a horizontal Disc, press Cmd/Ctrl+click Disc tool:

Creating a 2D Face

To create a default, vertical 2D Face, click on the 2D Face tool in the Create palette:
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The 2D Face will be created with an X and Y-size of 20.48 BU and Z-size of 0 BU:

To create a horizontal 2D Face, press Cmd/Ctrl+click 2D Face tool:

Creating Infinite Planes

Creating Infinite Planes/Slabs

An Infinite Plane object extends in all directions to infinity. Create cloud, water, and ground planes. 
When creating a plane in Bryce, it appears as a finite plane to make it easier to position, but when the 
scene is rendered the plane extends infinitely in all directions. Though procedurally the three infinite plane 
types are different, they are all considered Infinite Planes, for the purpose of selecting with the Selection 
tools. 
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An Infinite Plane is a plane object that has no depth. An Infinite Slab is a plane object that has depth. The 
Infinite Plane has no effect on objects above it or below it; an Infinite Slab can affect objects within it. For 
example, anything placed within the slab's depth will be affected by the slab's volume color.
Slabs are often used to create water. When creating a water slab, the water is created with realistic 
volume. This means that if an object is sunk into the water, it will be affected by the colors or textures 
assigned to the slab's volume.
The realistic look of a water slab depends almost entirely on the material assigned to it. The Volume color 
plays an essential role in creating realistic water effects.
Click on the links below to go directly to that topic.

• Creating a Ground Plane  
• Creating a Water Plane  
• Creating a Cloud Plane  

Creating a Ground Plane

Ground Planes are created at ground level. By default, all new scenes open with an infinite Ground Plane.
• To create a Ground Plane, click the Ground Plane tool in the Create palette.
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OR
• Left-click-hold on the Ground Plane and choose Surface from the menu:

Once the plane appears in the scene, it can be edited like any other object. Use the Ground Plane to add 
ground to any environment.
The Ground Plane is created with a gray color, as are all Bryce primitives. Once a texture is assigned, the 
Ground objects (as well as all other primitive objects) will inherit the texture assigned to the previous 
object.

Ground Slab

• To create a Ground Slab, press Alt+click Ground Plane tool
OR

• Left-click-hold on the Ground Plane and choose Volume from the menu:

The Ground Slab will be created with the base of the slab at the same level as the default Ground Plane: 
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The slab depth can be modified by clicking on the  button and changing the Y-size from the default 
20.48 BU:

Here the Y-size has been changed to 50 BU: 
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A Ground Slab usually has an opaque material applied to it so it cannot affect objects placed within it. W 
cloud material is applied however, it becomes a fog object that affects the ground below it and any objects 
placed in it
Examples:

• Ground Plane by itself:

• Ground Slab added with foggy material applied:

Creating a Water Plane

Water Planes are created just a bit higher than ground level. That way, if you have already created 
ground and terrains, you can easily place a water plane into your scene and immediately see the terrains 
peeking out from the water.

• To create a Water Plane, click the Water Plane tool in the Create palette:

OR
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• Left-click-hold on the Water Plane tool and choose Surface from the menu:

The Water Plane will be created with the plane above the default Ground Plane: Once the plane appears 
in the scene it can be edited like any other object.

Water Planes are created with a water texture randomly chosen from the Waters Preset Materials Library. 
Change this material by selecting a different preset or creating a new material.

Water Slab

• To create a Water Slab, press Opt/Alt+click Water Plane tool
OR

• Left-click-hold on the Water Plane tool and choose Volume from the menu:

The water slab will be created with the Ground plane halfway between the top and bottom of the slab:
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The slab depth can be modified by clicking on the  button and changing the Y-size from the default 
20.48 BU:

Creating a Cloud Plane

• To create a Cloud Plane, click on the Cloud Plane tool in the Create palette:

OR
• Left-click-hold on the Cloud Plane tool and choose Surface from the menu:

Once the plane appears in the scene, it can be edited like any other object.

Cloud planes are created with a cloud texture randomly chosen from the Clouds > Infinite Planes 
Preset Materials Library. Change this material by selecting a different preset or creating a new material.

Cloud Slab

• To create a Cloud Slab, press Alt+click on the Cloud Plane tool in the Create palette:
OR

• Left-click-hold on the Cloud Plane tool and choose Volume from the menu:
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The volume Cloud Plane will be created:

Creating Terrains

Terrain Objects define the landscape of the scene. They represent the landforms of any scene: 
mountains, deserts, islands, or even floating cities. In Bryce, a Terrain Object is a height map that 
determines the shape of your landscape.
Bryce creates a terrain's shape by converting brightness values in grayscale images into a height map. 
White areas in the image result in the highest altitudes and black areas result in the lowest. These maps 
are called grayscale-to-height maps (G2H). The Terrain Editor (TE) generates the grayscale images that 
are used to create terrain objects and can also use grayscale images created in a paint program and 
imported into the TE. 
Customize a Terrain object in the Terrain Editor.

• To create a Terrain, click on the Terrain tool in the Create palette: 

A randomly generated Terrain appears in the scene with X and Z-size of 81.92 and Y-size of 20.48:
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To modify the Terrain, click on the  button next to the selected terrain to enter the Terrain Editor.

Creating Symmetrical Lattices

A Symmetrical Lattice (or SymLat) is a terrain object that has a mirror image of itself fused at its base. 
When one-half of the lattice is modified, the corresponding changes are applied to the mirrored half.

The Symmetrical Lattice can be a great timesaving tool. Instead of creating symmetrical shapes by 
duplicating and aligning two halves, just create one-half of a lattice and the object is duplicated 
automatically . Symmetrical Lattices are edited as Terrains, using the Terrain Editor.
Many advanced types of objects can be created using the Symmetrical Lattice object. Any object that is 
symmetrical can be created by painting its shape in the Terrain Editor.
The Ladybird in the image below was created using several Symmetrical Lattice objects for the legs, 
head, thorax, body, and antennae. The shell is a terrain.
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To create a Symmetrical Lattice, click the Symmetrical Lattice tool in the Create palette: 

Creating Trees

Creating Trees

The Tree Object tool creates natural-looking tree shapes that can be assigned materials, shaped, and 
positioned throughout a scene.
The Tree Object can be customize it in the Tree Lab. Control the size and texture of the tree trunk, the 
thickness and number of branches, and the type of foliage and its frequency, randomness, and color. 
Import images to be used for the trunk or foliage texture. Control how gravity affects the tree, making 
branches bend and leaves droop to varying degrees.
Once loaded, a tree object can be customized it in the Tree Lab.

• To create a Tree, click on the Tree tool in the Create palette: 
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A randomly generated Tree appears in the scene:

To modify the Tree, click on the  button next to the selected Tree to enter the Tree Lab.
Click on the links below to go directly to that topic.

• Access Pre-Generated Trees  
• Saving Tree Presets  

Access Pre-Generated Trees

Bryce includes a library of pre-generated Trees, accessed using a modifier key.
To access these presets, press the Opt/Alt+click Tree tool, a File Open dialog will come up to select 
one of the .bto tree presets to load in the scene.
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Saving Tree Presets

To save a Tree preset to the Tree Library folder, select the tree then press the Ctrl+click Tree tool, a file 
save dialog will come up to name the Tree and save it.

Please note that when saving a tree this way, only the material applied to the trunk and branches are 
saved along with the tree information. Any material applied to the leaves is lost.
To save the tree with materials intact, and to ensure that the tree is not randomized on loading, save the 
tree to the Objects Library.

Creating Stones

The Stone Object tool creates random, natural-looking stone shapes that can be assigned materials and 
positioned throughout your scene.

• To create a Stone Object, click the Stone Object tool in the Create palette: 

Each time the Stone Object tool is clicked, a different shaped mesh is generated. The image below shows 
examples of some of the possibilities:
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Stone Objects are mesh based, and can be smoothed or un-smoothed using the Edit Mesh dialog. See 
"Mesh Editor" for more information on smoothing and un-smoothing meshes. 
Stones are assigned random textures automatically from the Stones Preset Materials Library.
Since Stones are essentially clumps of meshes, their realism is highly dependent on the textures 
assigned to them. For example, assigning a flat texture with no bumpiness to a Stone, the results will not 
be very Stone like. Try to assign rocky textures to stones.
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Creating Metaballs

Creating Metaballs

Metaballs are spheres that blend into each other based on proximity. With Metaballs, a wide variety of 
realistic-looking shapes can be created and customized. Metaballs allow quick creation of fluid shapes 
that are otherwise time-consuming or even impossible to create using primitives and Boolean operations.
When in the Wireframe view, Metaballs are represented as simple spheres. To see how the Metaballs will 
blend, either look at the Nano-Preview or render the image.

• To create a Positive Metaball, click on the Metaball tool in the Create palette:

The Metaball will be created with X, Y, and Z-size of 20.48 BU (although the actual Metaball is much 
smaller than that):
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• To create a Negative Metaball, press Shift+click Metaball tool. 
The Negative Metaball looks just like the positive one, even down to the Attributes being set to Neutral. 
To tell the difference, render the scene to see the effect of the Negative Metaball on the Positive 
Metaball(s).
If the metaball looks like the image below (created by pressing N+click Metaball tool), then it will act like 
a Positive Metaball, even though it looks like a negative object:
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Two rendered Positive Metaball compared to a Negative and Positive set:

Blend Metaballs of different sizes for more control over the resulting shape. To blend Metaballs, simply 
place the Metaballs close to each other. The closer together they are, the more they will blend into each 
other. The farther apart they are, the more they will resemble distinct spheres.

• Level of Attraction   - Find out more about metaballs and how they attract or repel each other.
Change the shape of Metaballs in your scene to get different effects. For example, squash or stretch a 
Metaball, changing the surface area that blends into nearby Metaballs. Two oval Metaballs will give you a 
different blend result than two spherical Metaballs.
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For Metaballs to blend smoothly, they must have the same material.  Blending two Metaballs with differing 
materials will not always get a smoothly blended result - unless that is the desired effect, it is best to keep 
the materials consistent.

Metaballs can also be grouped - see "Grouping Metaballs" for more on this.

Level of Attraction

Metaballs have a default "level of attraction" starting from the center of the Metaball and decreasing as it 
moves towards the outside edge.
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Using a scale of 0 to 1, the center of the Metaball has an attraction level of 1 while the outer radius of the 
Metaball has an attraction level of 0. 

The level of attraction can be increased by duplicating one of the Metaballs.

Notice how the level of attraction increases or decreases: 
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Duplicating the Metaball again increases the level of attraction even more:

Grouping Metaballs

Metaballs can be grouped together to prevent other Metaballs from affecting them.
In the example below, two positive Metaballs (green and red), are grouped and placed next to a positive 
and negative Metaball.
The ungrouped Positive Metaball is affected by the Negative Metaball, but the grouped Metaballs are not. 
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If we ungroup the red and green Metaballs, the other Metaballs, both positive and negative, then can 
affect them.

Please note that grouped metaballs cannot be rendered with an object mask.
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Creating 2D Pictures

A Picture Object is a 2D Picture applied to a 2D finite plane. The object is a Picture on a frame. The 
Frame is a 2D plane, meaning that it has no depth. If viewed from the side, it disappears.
Using a Picture Object is a quick way of creating very complex-looking objects. The only limitation is that 
they can be viewed from only one angle, so the front of the Picture Object must always be facing the 
camera.

The Alpha channel of the object can be used to create transparencies in the Picture Object.
This object was created using a 2D Picture Object (top). However, when the camera, the 2D nature of the 
object is obvious (bottom).

A good way of ensuring that the 2D Picture Object never appears distorted is to have it track the camera.

Alpha Channels and Picture Objects 

The Picture used as a Picture Object must have an Alpha channel in order to make areas of the image 
transparent.
The Alpha channel of the Picture images specify visible and invisible portions of the Picture texture.
For example, clipping out a Picture's background so that only the main object in the Picture is visible. This 
is what the car image looks like with (top) and without (bottom) an alpha channel applied.
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The shadow cast by the image will be in the shape of the Picture's Alpha channel, which gives a more 
realistic look.
To create a Picture Object:

1. Click the Picture Object tool (Leo) in the Create palette to open up the Pictures dialog.

2. Click on an image square to load an image.

3. If the image is not in the library, either: 
• Click the Combination Load button above the first box. The load image dialog appears. 

Use the dialog controls to locate the Picture desired and click Open.

OR 
• In another application, copy the Picture desired to the clipboard. Access the Pictures 

dialog and click the Paste button.

OR 
• Click on a blank square. The load image dialog appears. Use the dialog controls to 

locate the Picture desired and click Open. 
4. When loading a new Picture into the Pictures dialog, the main image is loaded into the first box, 

its alpha channel is loaded into the second box, and the combination is loaded into the third. If the 
image did not have an alpha channel, load a mask separately by clicking on the Load button 
above the second box:
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5. Invert the alpha channel by clicking the Invert button.

6. Click the OK icon to exit the dialog. Bryce creates a 2D plane and maps the image onto it as a 
texture. The Picture Object is created with the same aspect ratio as the original Picture.
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Creating Lights

Creating Lights

There are two types of lights in Bryce - natural and direct. The sun provides natural lighting while direct 
lighting is provided by light sources.
There are twelve types of lights in Bryce: Radial, Spot, Round Parallel, Square Spot, and Parallel, Distant, 
Round Parallel, Square Parallel, Sphere Dome, Cube Dome, Sphere Fill and Cube Fill.
Create as many light sources as needed. The only limit is the system's memory. Creating additional lights 
(or light sources) may add significantly to the render time of a scene. The size, position, and orientation of 
a light source can be edited exactly like any other object.
Lights may be linked to specific objects so that a light source moves as the object moves. Also, set a light 
to track an object. When it is tracking an object, the light reorients itself so that it is always facing the 
object no matter where it moves. Linking and tracking are quick ways of animating light positions.
Light attributes can be edited in the Light Lab.
Click on the links below to go directly to that topic.

• Radial Lights  
• Spotlights  
• Round Parallel Lights  
• Square Spotlights  
• Parallel Lights  
• Distant Light  
• Round Parallel Light  
• Square Pa  rallel Light  
• Sphere Dome Light  
• Cube Dome Light  
• Sphere Fill Light  
• Cube Fill Light  
• Apply Gradient  

Radial Lights

Radial Lights throw light equally in all directions. Use this as a general light source, and remember that 
you can make these lights as tiny as you like and use as many as you need.
To create a Radial Light, left-click on the Radial Light tool in the Create palette.

A Radial Light will be loaded into the scene.
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The example below shows how a radial light works in a scene.

Spotlights

Spotlights throw light along a cone-shaped path, creating the classic "stage spot" effect.
To create a Spotlight, left-click on the Spotlight tool in the Create palette.

A Spotlight will be loaded into the scene.
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The example below shows how a spotlight works in a scene.

Round Parallel Lights

Round Parallel Lights produce cylindrical tubes of light and cast circular spots where the light falls.
To create a Round Parallel Light, left-click on the Round Parallel Light tool in the Create palette.
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A Round Parallel Light will be loaded into the scene.

The example below shows how a round parallel light works in a scene.

Square Spotlights

Square Spotlights are the same as spotlights, except they cast light along a pyramid-shaped path, 
creating a square spot where the light falls. 
To create a Square Spotlight, left-click on the Square Spotlight tool in the Create palette.
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A Square Spotlight will be loaded into the scene.

The example below shows how a square spotlight works in a scene.

Parallel Lights

Parallel Lights cast parallel rays, resulting in no spatial distortion of shadows. This type of light is very 
useful for creating specific shadow patterns, or when used with gels, for creating a slide projector.
To create a Parallel Light, left-click on the Parallel Light tool in the Create palette.
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A Parallel Light will be loaded into the scene.

The example below shows how a parallel light works in a scene.

New Light Features in Bryce 7

Distant Lights

See: Distant Lights in Light Lab Section.

True Parallel Lights

See: True Parallel Lights in Light Lab Section.

Dome Lights

See: Domel Lights in Light Lab Section.

Fill Lights

See: Fill Lights in Light Lab Section.
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Apply Gradient

Apply a gradient file (.grd) created in another program by pressing Shift then clicking on the light tool. The 
Open File dialog comes up to locate and select a gradient file. Click on Open, and then the light source is 
created with the gradient applied.

Launch DAZ Studio

Bryce includes DAZ Studio (DS) as a plug-in. DS is a complete virtual photo studio used to create scenes 
by adding and positioning figures, clothing, props, materials, lights, and more. Once created, select one or 
more objects in a DS scene.  Exiting DS automatically brings these objects into Bryce, where they just like 
any other Bryce object. Animations can also be imported from DAZ Studio.
To launch DS from within Bryce, click on the Launch DAZ Studio button located at the right side of the 
Create palette: 

Refer to "Working with DAZ Studio & Poser" for more on importing objects and animations from DS and 
Poser.
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Edit Palette

The Edit palette contains tools for editing object materials and resizing, rotating, repositioning, aligning, 
and randomizing objects. 

To display the Edit palette, click the  button at the top of the Bryce window. 
The transformation tools let you perform all the object transformation operations available in Bryce. The 
tools act as interactive controls. Drag over the tool, to perform the operation of the tool on the selected 
object. 
To select a tool: 

1. Click the Edit button at the top of the Bryce window to display the Edit Palette. 

2. Select an object. 
3. Drag over the tool to perform a transformation operation or click on the edit tools.

The Triangle icon next to the Edit button at the top of the Bryce window lets you access the Preset 
Materials Library. 
To open the Preset Materials Library, click quickly on the triangle icon next to the Edit button at the top of 
the Bryce window. Please note, holding down the mouse key for too long will open the library, which will 
then close immediately. To keep the library open, click quickly on the triangle icon. 

Click on a tool below to learn more about it:
• Edit Materials  
• Resize Tool  
• Rotate Tool  
• Reposition Tool  
• Align Tool  
• Randomize Tool  
• Edit Terrain/Object  
• Convert Selection To  
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Edit Materials

The Edit Materials tool brings up the Materials Lab by default when it is clicked on and no objects are 
selected.

Clicking on the triangle next to the tool brings up a popup menu allowing one to select whether to edit 2D 
Picture or 3D Solid Textures. 

It is not necessary to have an object selected before using the Edit Materials tool. This is useful to add 2D 
Pictures to the Picture Editor or just making new materials in the Materials Lab.  If an object is not 
selected before clicking on the tool, then the selected material or 2D Picture editor will be opened. 
To use the Edit Materials tool: 

• Edit 3D Solid Textures: 
1. Take sure the Edit palette is visible. If it is not, click the Edit button at the top of the 

Bryce window. 

2. Click on the Edit Materials tool to open up the Materials Lab.

OR 
3. Click on the triangle next to the Edit Materials tool and choose Edit 3D Solid Textures 

from the menu. 
• Edit 2D Picture Textures: 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the 
Bryce window. 

2. Click on the triangle next to the Edit Materials tool and choose Edit 2D Picture 
Textures from the menu. The Picture Editor will come up. 
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Resize Tool
Resize Tool 

Use the Resize Tool to resize objects along one or all of the three axes. Objects are resized from their 
origin point. 

When an object is created, it appears at a default size. Once placed in the scene, resize it to make it 
proportional to the other objects in the scene. 
The Resize Tool has seven different states. As you move the pointer over the tool, each state becomes 
active. The different states let you resize the object along different axes.  

• Resizing along the Y-axis increases/decreases the object's height.
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• Resizing along the X-axis increases/decreases the object's width. 

• Resizing along the Z -axis increases/decreases the object's depth. 

There are four ways of resizing objects in Bryce: 
1. using the Resize tool to resize an object along different axes 
2. using the 3D Transformation dialog which lets you enter precise values to resize objects 
3. using the control points on the object's bounding box to interactively resize the object  
4. using the Object Attributes dialog to numerically resize the object  

Objects are measured in Bryce Units. When you resize an object, you are increasing or decreasing its 
size based on unity size. When you resize an object to 150%, you are sizing it to 150% of unity. 
Clicking the triangle icon to the bottom right of the Resize tool brings up a popup menu with various 
options for manipulating objects. 

• Resize on the X-Axis  
• Resize on the Y-Axis  
• Resize on the Z-Axis  
• Resize in All Directions  
• Spatial Options  
• Undo Resize Operation  
• Flipping Objects  
• 3D Transformations  
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Resize on the X-Axis 

To resize from the right-hand X-axis: 
1. Move the cursor over the right-hand X-axis on the Resize tool. 

2. Hold down the left mouse button and drag right - the object scales larger towards the right. 

3. Drag left and the object scales smaller towards the left. 

To resize from the left-hand X-axis: 
1. Move the cursor over the left-hand X-axis on the Resize tool.
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2. Hold down the left mouse button and drag right - the object scales larger towards the left.

3. Drag left and the object scales smaller towards the right. 

To resize in both directions on the X-axis: 
1. Move the cursor over the left or right-hand X-axis on the Resize tool.

2. Press Opt/Alt and drag right to scale the object larger on the X-axis or left to scale the object 
smaller on the X-axis. 
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Hold down Shift to constrain the resize increments to 50% intervals when increasing/decreasing the size 
of the object. 

Resize on the Y-Axis 

To resize from the top on the Y-axis: 
1. Move the cursor over the top of the Y-axis on the Resize tool. 

2. Hold down the left mouse button and drag right - the object scales larger upwards.
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3. Drag left and the object scales smaller towards the ground. 

To resize from the bottom on the Y-axis:
1. Move the cursor over the bottom of the Y-axis on the Resize tool. 

2. Hold down the left mouse button and drag right - the object scales larger downwards. 
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3. Drag left and the object scales smaller going up.  

To resize in both directions on the Y-axis: 
1. Move the cursor over the top or bottom of the Y-axis on the Resize tool. 

2. Press Opt/Alt and drag right to scale the object larger on the Y-axis or left to scale the object 
smaller on the Y-axis. 

3. Hold down Shift to constrain the resize increments to 50% intervals when increasing/decreasing 
the size of the object. 
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Resize on the Z-Axis 

To resize from the front-side Z-axis: 
1. Move the cursor over the front of the Z-axis on the Resize tool. 

2. Hold down the left mouse button and drag right - the object scales larger towards the front.  

3. Drag left and the object scales smaller towards the back.  

To resize from the back-side Z-axis: 
1. Move the cursor over the back of the Z-axis on the Resize tool. 
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2. Hold down the left mouse button and drag right - the object scales larger towards the back.

3. Drag left and the object scales smaller towards the front. 

To resize in both directions on the Z-axis: 
1. Move the cursor over the back or front of the Z-axis on the Resize tool. 

2. Press Opt/Alt and drag right to scale the object larger on the Z-axis or left to scale the object 
smaller on the Z-axis. 
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3. Hold down Shift to constrain the resize increments to 50% intervals when increasing/decreasing 
the size of the object. 

Resize in All Directions 

To resize an object in all directions: 
1. Click the center of the Resize tool. 

2. Hold down the left mouse button and drag right to increase the size of the object. 
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3. Drag left to decrease the size of the object.

Undo Resize Operation (Unscale)

To undo resize operations: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window. 

2. Select an object. 
3. Click the triangle icon next to the Resize tool and choose Unscale from the menu. This will 

reset the object back to its original size, no matter how many scaling operations were made to the 
object. 
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Flipping Objects 

Flipping is not the same as rotating an object 180°. Flipping mirrors an object along an axis instead of 
rotating it. 
This option is extremely useful for placing copies of objects that are exact opposites of each other, such 
as towers on the side of a building. 
To flip an object: 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 

2. Select an object or group of objects. If you want all the objects to flip together, group them before 
flipping. 

3. Click the triangle icon next to the Resize tool and choose a flip option from the menu: 
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• Flip X: inverts your object's dimensions along the X-axis. 

• Flip Y: inverts your object's dimensions along the Y-axis.

• Flip Z: inverts your object's dimensions along the Z-axis. 

3D Transformations

Sometimes you will need precise control over the size of your object. The 3D Transformations dialog lets 
you enter specific resize values for a selected object. All transformations you enter in this dialog are 
performed in World Space regardless of the spatial option you chose for the Resize tool. 
Resize values are expressed as a percentage of the current size of the selected object. 
You cannot enter negative numbers in this dialog. 
Resizing numerically is especially useful when importing objects from other programs (i.e., DAZ Studio & 
Poser) that come in small. See "Working with DS & Poser" for more information
To resize an object numerically:

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window.

2. Select an object. 
3. Click the triangle icon below the Resize tool and choose 3D Transformations from the menu.
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The 3D Transformations dialog appears. 

4. Enter a percentage in one or all of the axis fields. The percentage determines the new size of the 
object based on its original size. For example, to double the object's size in all directions, enter 
200 in the X, Y, and Z fields. To resize along a single axis, enter values in only one axis field. 

5. Click on the OK icon to accept the changes.
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Here is the result of the above changes on a sphere: 

The Object Attributes dialog showing that the X and Z-axis have doubled in size:  

Since you are dealing with World Space transformations in this dialog, if you resize an object along only 
one or two axes you may unintentionally skew the object's shape. 
To resize the object without skewing it, use the numeric entry fields in the Object Attributes dialog. Using 
this dialog can resize the object based on its original position, with no unintentional skewing.
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Rotate Tool
Rotate Tool 

Use the Rotate tool to rotate objects in 3D space. Objects can be rotated in World Space, Object Space, 
or Camera Space. 

Most objects have a specific up, down, left, right, back, and front associated with them when you create 
them. 
When you place the object in a scene, its orientation may need to be altered to achieve a desired effect. 
For example, an airplane that is taking off should be tilted upwards or tilted downward when it is 
descending. The Rotate tool has three states. As you move the cursor over the tool, one of the states 
becomes active. The different states let you rotate the object around different axes.

• Rotating along the X-axis: 
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• Rotating along the Y-axis: 

• Rotating along the Z-axis: 

There are four ways of rotating objects in Bryce: 
1. using the Rotate tool to resize an object along different axes 
2. using the 3D Transformations dialog, which lets you enter precise rotation angles 
3. using the object's control points to interactively rotate the object 
4. using the Object Attributes dialog to numerically rotate the object 

Clicking the triangle icon to the bottom right of the Rotate tool brings up a popup menu with various 
options for manipulating objects. 

• Rotate on the X-Axis  
• Rotate on the Y-Axis  
• Rotate on the Z-Axis  
• Spatial Options  
• Undo Rotate Operations  
• 3D Transformations  
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Rotate on the X-Axis 

To rotate on the X-axis: 
1. Move the cursor over the X-axis on the Rotate tool. 

2. Hold down the left mouse button and drag right - the object rotates on the X-axis in the 
negative direction. 

3. Drag left and the object rotates on the X-axis in the positive direction. 

4. Hold down Shift to constrain the rotate increments to 45-degree intervals when rotating the object. 

Rotate on the Y-Axis 

To rotate on the Y-axis: 
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1. Move the cursor over the Y-axis on the Rotate tool. 

2. Hold down the left mouse button and drag right - the object rotates on the Y-axis in the 
positive direction.

3. Drag left and the object rotates on the Y-axis in the negative direction.

4. Hold down Shift to constrain the rotate increments to 45-degree intervals when rotating the object. 

Rotate on the Z-Axis 

To rotate on the Z-axis: 
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1. Move the cursor over the Z-axis on the Rotate tool. 

2. Hold down the left mouse button and drag right - the object rotates on the Z-axis in the 
negative direction.

3. Drag left and the object rotates on the Z-axis in the positive direction.

4. Hold down Shift to constrain the rotate increments to 45-degree intervals when rotating the object. 

Spatial Options 

Objects can be rotated using any of the three spatial definitions: World, Object, or Camera. The definition 
you choose depends on the effect you wish to create. 
To choose a spatial option for rotation: 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window.
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2. Click the triangle icon next to the Rotate tool and choose an option from the menu:

• Object Space: rotates your selection relative to itself.
• World Space: rotates your selection in absolute world coordinates.
• Camera Space: rotates your selection relative to the camera 

The three spatial options are also available for the Resize and Reposition tools. When you select Object, 
World, or Camera space for the Rotation tool, it is also set for the other two tools. The option you choose 
in the Edit palette does not affect the 3D Transformations dialog. 

Undo Rotate Operations 

To undo rotate operations: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.

2. Select an object. 
3. Click the triangle icon next to the Rotate tool and choose Unrotate from the menu. This will 

reset the object back to its original rotation, no matter how many rotation operations have been 
made to the object. 
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3D Transformations

In a complex scene, orienting objects may require more precision than the Rotation tool offers. The 3D 
Transformations dialog lets you enter specific rotation angles for a selected object. 
All transformations performed using this dialog use World Space coordinates regardless of the spatial 
option you chose for the Rotate tool.  
Rotation values are expressed as degrees, with 360° being a single full rotation. Since rotations are 
relative, you may enter negative values and cumulative values (greater than 360° or less than -360°). 
To rotate an object numerically:  

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window.

2. Select an object. 
3. Click the triangle icon next to the Rotate tool and choose 3D Transformations from the menu.

The 3D Transformations dialog appears. 

4. Enter a degree value in one or more of the Rotate fields. The degrees determine the angle of 
rotation. For example, to rotate an object 45° around Y, enter 45 in the Rotate Y field. To rotate 
around other axes, just enter values in the appropriate fields. 
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And here is the result of the above changes on a cylinder:  

Since you are dealing with World Space transformations, objects are rotated with respect to the World 
Space X, Y, and Z axes. 

Reposition Tool
Reposition Tool 

Use the Reposition tool to reposition objects along any of three axes. 
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The composition of your scene depends on the position of the objects relative to other objects. In most 
cases, you will need to use the Reposition tool in conjunction with the Resize and Rotation tools to create 
the desired relationships. 

• Repositioning along the Y-axis moves the object up and down on the Y-axis. 

• Repositioning along the X-axis moves the object along the X-axis. 

• Repositioning along the Z-axis moves the object along the Z-axis. 

Positioning applies to objects, groups, and families as well as lights and the camera. In this section the 
term "object" also refers to the camera and lights. 
There are four ways of positioning objects in Bryce: 

1. using the Reposition tool to move objects along a specific axis 
2. using the 3D Transformation dialog to enter specific offset positions 
3. by dragging the object to a different location 
4. by using the arrow keys to nudge objects. 

Clicking the triangle icon to the bottom right of the Reposition tool brings up a popup menu with various 
options for manipulating objects. 

• Repositioning on the X-Axis  
• Repositioning on the Y-Axis  
• Repositioning on the Z-Axis  
• Spatial Options  
• Undo Reposition Operations  
• 3D Transformations  
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Repositioning on the X-Axis 

To reposition on the X-axis (World Space): 
1. Move the cursor over either end of the X-axis on the Reposition tool. 

2. Hold down the left mouse button and drag right - the object moves towards the right.
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3. Drag left and the object moves towards the left. 

You can see the results of moving the object by clicking on the  button and bringing up the Object 
Attributes dialog. 

• Moving the object by dragging right on the X-axis increases the value in the X-position field.
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• Moving the object by dragging left on the X-axis decreases the value in the X-position field.

Remember that if Object or Camera Space is active, the object will move relative to the object or camera. 
So if using Object Space and the object has been rotated, it will move in the direction of the object's X-
axis.
Hold down Shift to constrain the reposition increments to 10.24 BUs (one-half of a Unity Unit). 

Repositioning on the Y-Axis 

To reposition on the Y-axis (World Space): 
1. Move the cursor over either end of the Y-axis on the Reposition tool. 
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2. Hold down the left mouse button and drag right - the object moves up.  

3. Drag left and the object moves down.  
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You can see the results of moving the object by clicking on the  button and bringing up the Object 
Attributes
dialog.

• Moving the object by dragging right on the Y-axis increases the value in the Y-position field.  
• Moving the object by dragging left on the Y-axis decreases the value in the Y-position field.  

Remember that if Object or Camera Space is active, the object will move relative to the object or camera. 
So if using Object Space and the object has been rotated, it will move in the direction of the object's Y-
axis.  
Hold down Shift to constrain the reposition increments to 10.24 BUs (one-half of a Unity Unit). 

Repositioning on the Z-Axis 

To reposition on the Z-axis (World Space): 
1. Move the cursor over either end of the Z-axis on the Reposition tool. 
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2. Hold down the left mouse button and drag right - the object moves towards the back. 

3. Drag left and the object moves towards the front. 
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You can see the results of moving the object by clicking on the  button and bringing up the Object 
Attributes dialog. 

• Moving the object by dragging right on the Z-axis increases the value in the Z-position field.  
• Moving the object by dragging left on the Z-axis decreases the value in the Z-position field. 

Remember that if Object or Camera Space is active, the object will move relative to the object or camera. 
So if using Object Space and the object has been rotated, it will move in the direction of the object's Z-
axis.  

Hold down Shift to constrain the reposition increments to 10.24 BUs (one-half of a Unity Unit). 

Spatial Options 

Objects can be repositioned using any of the three spatial definitions: World, Object, or Camera. The 
definition you choose depends on the effect you wish to create. 
To choose a spatial option for repositioning: 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 
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2. Click the triangle icon next to the Reposition tool and choose an option from the menu:

• Object Space: rotates your selection relative to itself. 
• World Space: rotates your selection in absolute world coordinates. 
• Camera Space: rotates your selection relative to the camera. 

The three spatial options are also available for the Resize and Rotate tools. When you select Object, 
World, or Camera Space for the Rotation tool, it is also set for the other two tools. The option you choose 
in the Edit palette does not affect the 3D Transformations dialog. 

Undo Reposition Operations 

To undo position operations: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window. 

2. Click the triangle icon next to the Reposition tool and choose Unreposition from the menu. 
This will reset the object back to its original position, no matter how many repositioning operations 
have been made to the object. 

©2003-2011 DAZ 3D, Inc. 163



Bryce 7 Artist Guide 03 Jan 2011

3D Transformations 

The most precise method of positioning objects is by using the 3D Transformations dialog. This dialog lets 
you enter specific offset values for a selected object.
All transformations performed using this dialog use World Space coordinates regardless of the spatial 
option you chose for the Reposition tool.
Offset values are expressed in Bryce units of measure. You may enter negative numbers in the 
Reposition fields. 
To reposition an object numerically: 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window.

2. Select an object.
3. Click the triangle icon next to the Reposition tool and choose 3D Transformations from the 

menu. 

The 3D Transformations dialog appears. 

4. Enter a value in one or all of the Offset fields. The value determines the number of Bryce units the 
object is offset from its current position. 
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And here is the result of the above changes on a cube:  

And the Object Attributes dialog showing the changes:
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Remember that since this dialog only performs transformations in World Space, you are moving the 
object relative to world X, Y, and Z coordinates. 

Align Tool
Align Tool 

Use the Align tool to align objects along their tops, bottoms, left sides, right sides, fronts, backs, or 
centers. 

Bryce's alignment features let you position several objects with respect to each other. Alignment 
transformations are performed with respect to the Grid. Bryce maintains an internal grid that is comprised 
of 3D cube increments, 20.48 x 20.48 x 20.48 Bryce units in size. 
The Align tool has ten states. As you move the pointer over the tool, the states become active. 
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The Grid is used for Snap To operations and acts as common reference for alignment operations. One 
grid unit is equal to unity size and unity position is always snapped to a position on the grid. 
Clicking the arrow icon to the bottom right of the Align tool brings up a popup menu with various options 
for aligning objects. 

• Align X  
• Align Y  
• Align Z  
• Align All  
• Snap To Options  
• Anchor & Non-Anchor-Based   

Aligning

Align X 

To align objects along the X-axis: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window. 
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2. Select two or more objects. 

3. Move the cursor over the Align tool. 
4. When the state you want to use is active, click the mouse button. 

The default alignment is "non-anchor based" which means that the tool aligns objects based on the 
bounding box of the selected objects. 
Examples: 

• Align X Left: 
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• Align X Center: 

• Align X Right: 

To align objects to a specific object, use Anchor-Based Alignment which aligns the selected objects to the 
first selected object. 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 

2. Click the Triangle icon to the bottom right of the Align tool and choose Anchor-Based 
Aligning from the menu. 

©2003-2011 DAZ 3D, Inc. 169



Bryce 7 Artist Guide 03 Jan 2011

3. Select the object you want to use as the align anchor. 
4. Select the remaining objects to align. 
5. Move the cursor over the Align tool. 
6. When the state you want to use is active, click the mouse button. 

The example below shows the selected objects aligned to the X Left edge of the sphere, which was 
selected first. 

Align Y 

To align objects along the Y-axis: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window. 

©2003-2011 DAZ 3D, Inc. 170



Bryce 7 Artist Guide 03 Jan 2011

2. Select two or more objects. Move the cursor over the Align tool. 

3. When the state you want to use is active, click the mouse button. 

The default alignment is "non-anchor based" which means that the tool aligns objects based on the 
bounding box of the selected objects. 
Examples: 

• Align Y Top: 
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• Align Y Center: 

• Align Y Bottom: 

To align objects to a specific object, use Anchor-Based Alignment which aligns the selected objects to the 
first selected object. 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 

2. Click the Triangle icon to the bottom right of the Align tool and choose Anchor-Based 
Aligning from the menu. 
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3. Select the object you want to use as the align anchor. 
4. Select the remaining objects to align. 
5. Move the cursor over the Align tool. 
6. When the state you want to use is active, click the mouse button. 

The example below shows the selected objects aligned to the Y Top edge of the sphere, which was 
selected first. 

Align Z 

To align objects along the Z-axis: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window. 
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2. Select two or more objects.  

3. Move the cursor over the Align tool. 
4. When the state you want to use is active, click the mouse button.  

The default alignment is "non-anchor based" which means that the tool aligns objects based on the 
bounding box of the selected objects. Examples: 

• Align Z Back:  
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• Align Z Center:  

• Align Z Front:  

To align objects to a specific object, use Anchor-Based Alignment which aligns the selected objects to the 
first selected object. 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 

2. Click the Triangle icon to the bottom right of the Align tool and choose Anchor-Based 
Aligning from the menu. 
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3. Select the object you want to use as the align anchor.  
4. Select the remaining objects to align. 
5. Move the cursor over the Align tool. 
6. When the state you want to use is active, click the mouse button.

The example below shows the selected objects aligned to the Z Back edge of the sphere, which was 
selected first. 

Align All 

To align objects to the center of the objects: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window. 
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2. Select two or more objects.

3. Move the cursor over the Align tool. 
4. When the state you want to use is active, click the mouse button.

The default alignment is "non-anchor based" which means that the tool aligns objects based on the 
bounding box of the selected objects. 
Example: 
Align All Center:

To align objects to a specific object, use Anchor-Based Alignment which aligns the selected objects to the 
first selected object. 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 

2. Click the Triangle icon to the bottom right of the Align tool and choose Anchor-Based 
Aligning from the menu. 
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3. Select the object you want to use as the align anchor.  
4. Select the remaining objects to align. 
5. Move the cursor over the Align tool. 
6. When the state you want to use is active, click the mouse button.

The example below shows the selected objects aligned to the center of the pyramid, which was selected 
first. 

Snap To Options

Snap To Options 

The Snap To Options let you automatically align objects to the grid, an anchor object, World Center, 
ground level, or to land on an object. 
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Click on the links on the right to learn more about each option:
 

• Snap to Grid  
• Snap Together  
• Snap to World Center  
• Snap to Ground  
• Snap to Land  

Snap to Grid 

The Grid can be used as a guide to help you precisely position objects in your scene. 
To snap objects to the Grid: 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 

2. Select an object or multiple objects.

3. Click the triangle icon next to the Align tool and choose Snap to Grid.
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The center of the object (or objects) will align to the nearest point on the grid. 

Please note that the Align to Grid option does not place the objects on the ground.
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Snap Together 

To snap objects together: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window. 

2. Select the object you want to use as the anchor object.  
3. Select the remaining objects to align. 

4. Click the triangle icon next to the Align tool and choose Snap Together. 

The X, Y, and Z centers of all selected objects are aligned to the X, Y, and Z center of the anchor 
object (in this case, the pyramid).
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Snap to World Center 

To snap an object to World Center: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.

2. Select an object or multiple objects. 

3. Click the triangle icon next to the Align tool and choose Snap to World Center.
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The selected object(s) moves to coordinates X=0, Y=0, Z=0, or World Center.

4. If needed, click the triangle icon next to the Align tool and choose Snap to Ground to bring 
the object(s) back to ground level. 

Snap to Ground 

To drop or lift objects to ground level: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.
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2. Select an object or multiple objects.  

3. Click the triangle icon next to the Align tool and choose Snap to Ground. (You can also click 
the up or down arrow at the bottom of the Object Control Palette, just remember that if an object 
is above another object, clicking the down arrow will snap the object to land on the one below it.)

The selected object (or objects) will move up or down as necessary to place the object on the 
ground even if that puts the object inside another object.
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Snap to Land 

The Snap to Land option lets you snap an object to any object directly below it, much like creating a 
gravity effect. 
When you activate the Snap to Land option, Bryce snaps the selected object to the top of any object 
directly below its center Y control handle. The second object must be directly below the Y-control handle, 
otherwise the object lands on the ground plane (see example). 
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In the right hand example, a corner of the selected object is over the "land" object, but since there are no 
objects directly under its Y control handle, the selected object lands on the ground. 
Landing operations work best with objects that have not been rotated and that have no sloped 
characteristics. 
This option can create many interesting effects. For example, you can quickly create falling rock 
animations by placing rock objects throughout your scene with a terrain below them in one frame. Then, 
in a different frame, select all the rocks and choose the Snap to Land option. When you run the animation, 
all the rocks will appear to fall onto the terrain. 
Another use of Snap to Land is when attempting to place trees on a terrain. Place the tree over the terrain 
then choose the Snap to Land option. The tree will drop to the terrain and you can then use the 
Reposition tool or Object Attributes dialog to lower the tree slightly to place the roots into the terrain. 
To snap an object to the top surface of an object below it: 

1. Make sure the Edit palette is visible. If it is not, click the Edit text button at the top of the Working 
window. 

2. Select an object that is above another object or above the ground plane.

3. Either click the triangle icon next to the Align tool and choose Snap to Land from the menu 
or click the Down arrow icon that appears next to the object's bounding box. 

The object will land on top of the object below it.
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Anchor & Non-Anchor-Based Aligning 

Bryce provides two options for aligning multiple objects: anchor-based aligning and non-anchor-based 
aligning.
Anchor-based aligning considers the first selected object to be the anchor of the aligning operation. All 
other objects are aligned to this object. 
With non-anchor-based aligning, objects are aligned to the bounding box of all the selected objects.
To choose an aligning option: 

1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 
window. 

2. Click the triangle icon next to the Align tool, and enable/disable Anchor-Based Aligning. 

See the following for examples of using Anchor-Based Aligning: 
• Align X  
• Align Y  
• Align Z  
• Align All  
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Randomize Tool
Randomize Tool 

Use the Randomize tool to scatter or disperse objects in 2D or 3D space. 

The Randomize tool is a great way of randomly dispersing objects throughout your scene without having 
to manually position each object. As you click the Randomize tool each of its states becomes active. 
Clicking the arrow icon to the bottom right of the Randomize tool brings up a pop-up menu with the 
options for randomizing objects. Click on any of the links on the right to learn more about that option.

• 2D Disperse  
• 2D Disperse Rotate  
• 2D Disperse Size  
• 2D Disperse Size/Rotate  
• 3D Disperse  
• 3D Disperse Rotate  
• 3D Disperse Size  
• 3D Disperse Size/Rotate  

2D Disperse 

Use 2D Disperse to disperse objects in 2D space. 

To disperse objects in 2D space: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.
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2. Select a number of objects. 

3. Either click the Randomize tool repeatedly until the mode you want to use is active or click the 
triangle icon next to the Randomize tool and choose the 2D Disperse mode from the menu. 

4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 

The objects will be dispersed along the 2D plane:  
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2D Disperse Rotate 

Use 2D Disperse Rotate to disperse and rotate objects in 2D space. 

To disperse and rotate objects in 2D space: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.

2. Select a number of objects. 

3. Either click the Randomize tool repeatedly until the mode you want to use is active or click 
the triangle icon next to the Randomize tool and choose 2D Disperse Rotate mode from the 
menu.
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4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 

The objects will be dispersed and rotated along the 2D plane:

2D Disperse Size 

Use 2D Disperse Size to disperse and resize objects in 2D space. 

To disperse and resize objects in 2D space:
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.
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2. Select a number of objects. 

3. Either click the Randomize tool repeatedly until the mode you want to use is active or click 
the triangle icon next to the Randomize tool and choose 2D Disperse Size mode from the menu. 

4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 
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The objects will be dispersed and resized along the 2D plane:

2D Disperse Size/Rotate 

Use 2D Disperse Size/Rotate to disperse, resize, and rotate objects in 2D space. 

To disperse, resize, and rotate objects in 2D space: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.  

2. Select a number of objects. 

3. Either click the Randomize tool repeatedly until the mode you want to use is active or click 
the triangle icon next to the Randomize tool and choose 2D Disperse Size/Rotate mode from 
the menu. 
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4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 

The objects will be dispersed, resized, and rotated along the 2D plane: 

3D Disperse 

Use 3D Disperse to disperse objects in 3D space. 

To disperse objects in 3D space: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.
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2. Select a number of objects. 

3. Either click the Randomize tool repeatedly until the mode you want to use is active or click 
the triangle icon next to the Randomize tool and choose 3D Disperse mode from the menu.

4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 

The objects will be dispersed along the 3D planes:
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3D Disperse Rotate 

Use 3D Disperse Rotate to disperse and rotate objects in 3D space. 

To disperse and rotate objects in 3D space: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.

2. Select a number of objects. 

3. Either click the Randomize tool repeatedly until the mode you want to use is active or click 
the triangle icon next to the Randomize tool and choose 3D Disperse Rotate mode from the 
menu. 
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4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 

The objects will be dispersed and rotated along the 3D planes: 

3D Disperse Size 

Use 3D Disperse Size to disperse and resize objects in 3D space. 

To disperse and resize objects in 3D space: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.
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2. Select a number of objects.

3. Either click the Randomize tool repeatedly until the mode you want to use is active or click 
the triangle icon next to the Randomize tool and choose 3D Disperse Size mode from the menu. 

4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 

The objects will be dispersed and resized along the 3D planes:
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3D Disperse Size/Rotate 

Use the 3D Disperse Size/Rotate to disperse, resize, and rotate objects in 3D space. 

To disperse, resize, and rotate objects in 3D space: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.

2. Select a number of objects. 
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3. Either click the Randomize tool repeatedly until the mode you want to use is active or click 
the triangle icon next to the Randomize tool and choose 3D Disperse Size/Rotate mode from 
the menu.

4. Click and drag over the Randomize Amount sphere. The Randomize Amount sphere is the 
green sphere to the top-right of the Randomize tool. 

The objects will be dispersed, resized, and rotated along the 3D planes: 
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Edit Terrain/Object 

The Edit Terrain/Object tool brings up the appropriate lab or editor depending on what object is selected. 
Unlike the Edit Materials tool, you must have an object selected in order to use this tool. 
To use the Edit Terrain/Object tool, select an object and click on the Edit Terrain/Object tool. 

• Terrain or SymLat - opens the Terrain Editor 
• Tree - opens the Tree Lab 
• Rock - opens the Edit Mesh dialog 
• Imported Mesh Object - opens the Edit Mesh dialog 
• Torus - opens the Edit Torus dialog
• Any Light - opens the Light Lab
• Any other object - nothing happens 

Convert Selection To 
The Convert Selection To tool in the Edit palette lets you convert any type of object into another type of 
object with a single click. You can change a square into a light, a terrain into a sphere, or an infinite plane 
into a cone. Any transformations or materials you applied to the original object are preserved through the 
conversion. Just remember that if the original object is larger or smaller than the default size of the object 
it is being converted to, then the converted object will reflect the size change. 
Conversions cannot be animated. You cannot have a box that turns into a cone over time. 
The Convert tool is above and to the right of the Edit Terrain/Object tool and looks like a double-headed 
arrow: 

To convert an object to another type of object: 
1. Select the object you want to convert.  
2. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.

'
3. Left-click-hold on the double-headed arrow in the top left corner of the palette and choose an 

object type from the palette that appears. 
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4. The selected object will be converted to the chosen object.  The image below shows a rotated 
cube that has been converted to a cylinder: 

The image below shows a cube converted to a torus (left) and a 2D square converted to a pyramid (right). 
Since the cube Z-size is longer than the default torus Z-size, the converted torus is stretched to match the 
original cube size. The same with the pyramid, which is squashed on the Z-axis to match the Z-axis of the 
2D square. 
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Sky & Fog Palette 

The controls available on the Sky & Fog Palette let you add shadows, fog, and haze, and let you set the 
altitude, frequency, and amplitude of clouds. The Sky & Fog Palette also lets you control the color of 
clouds in your sky and the position of the sun and moon. 
A Bryce sky defines the virtual environment of your scene. Unlike many other 3D applications, the Bryce 
virtual environment is not merely a backdrop; it is an infinite 3D representation of natural environmental 
phenomena. 
All of the elements in your sky interact with each other just as they would in the real world. Colors in your 
environment interact with everything in your scene just as they would in nature. For example, red sunlight 
is invisible until it strikes an object; then the object exhibits red highlights. If it is a blue object, it takes on a 
purple cast and so on. 
The colors in the sky change depending on the position of the sun, and how much moisture (Haze, Fog) 
is present in the atmosphere. All this, plus natural reflection, refraction, and more make the Bryce Sky & 
Fog Palette responsible for a great deal of the natural, or supernatural, look and feel of Bryce images. 
The objects in your scene may look incredibly realistic on their own, but when you add a sky, the scene 
becomes a window looking out into a real world. You can add even more realism to a sky by enabling one 
of the many environmental effects available for skies. Using these effects you can create night skies full of 
stars, or have a bright rainbow streaking across the roof of your world. One of the most spectacular 
effects is the Volumetric World effect. When this effect is enabled all the light in your scene appears as 
visible rays. This is similar to the effects of light shining through clouds on a hazy day. 
Like any other scene setting, skies can be animated. Any property of a sky can be changed at different 
points along the animation timeline. When the animation plays, the sky property will appear to change 
over time. Using this technique, you can create a scene that changes from day to night, or from clear to 
cloudy. 
The Sky & Fog Palette is where you will set up the attributes of your environment. The palette uses visual 
controls in the form of thumbnails to help you see how changing the value of an attribute affects your sky. 
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The name of the control you are adjusting appears in the Text Display area of the Control Palette. You 
can also use this area to help guide you if you prefer numeric precision, as when you are adjusting the 
setting of a control; this area displays the current control's value. 

Each control has at least one color swatch along the bottom of the thumbnail. These swatches are used 
to set the color for a given sky attribute, like cloud color or fog color. Next to the thumbnails are a series of 
controls that let you set the frequency and amplitude of clouds, set the position of the sun or moon, and 
store sky properties. You can see their effects in the Preview Area. 
The triangle icon next to the Sky & Fog button at the top of the Bryce window lets you access the Preset 
Skies Library. 
To open the Preset Skies Library, click quickly on the triangle icon next to the Sky & Fog button at the top 
of the Bryce window. Please note that if you hold down the mouse key for too long, the library will open, 
then close immediately. To keep the library open, click quickly on the triangle icon. 

Click on the links below to learn more about each option:
• Using the Control Thumbnails  
• Setting Palette Options  
• Saving Sky & Fog Settings  
• Randomizing Sky Settings  
• Working with Sky Modes  
• Setting Sky Attributes  
• Adding Fog & Haze  
• Clouds in Bryce  
• Sky Dome Color  
• Working with the Sun & Moon  

Using the Control Thumbnails 
The thumbnails in the Sky & Fog Palette are visual guides and are also used to set the attributes of the 
Sky & Fog effects. 
To change the intensity of an effect, drag to the left or right, up or down, inside the thumbnail to change 
the intensity of the effect. 
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To pick a color for an effect, click the color bar below the thumbnail. A color picker appears and your 
pointer changes to an eyedropper. 

While the eyedropper is active, you can select colors from anywhere in your scene, or even different parts 
of the interface. 

For more control after picking with the color picker, you can switch to HLS mode and adjust saturation or 
lightness (less saturated colors can make for more realistic fog and haze effects), or you can enter 
numeric values if you need to precisely match specific colors. 
For more on the different color pickers for both PC and Mac, refer to "Adjusting Editor Settings." 

Setting Palette Options

Setting Palette Options 

The Sky & Fog Palette options let you link the palette controls directly to your scene. 
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• Auto Update  
• Link Sun to View  
• Select Cloud Types  
• Reset Sky  
• Access Sky Lab  

 
 

Auto Update 

To link Sky & Fog attributes directly to your scene, click the triangle icon below the memory dots at the 
right edge of the palette and choose Auto Update from the menu. 

When this option is enabled, every change you make to the Sky & Fog Palette settings will start a render 
of your scene with the new sky settings. 
Unless you have selected a small region to be updated, every change you make will begin a completely 
new render. 
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Link Sun to View 

To link Sky & Fog attributes directly to your scene, click the triangle icon below the memory dots at the 
right edge of the palette and choose Link Sun to View from the menu. 

Select Cloud Types 

To select what cloud types to place in the scene or to choose spherical clouds, see the following pages 
for more information:

• Adding Cumulus Clouds  
• Adding Stratus Clouds  
• Spherical Clouds  
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Reset Sky 

To reset Sky & Fog Palette settings to their defaults, click the triangle icon below the memory dots at the 
right edge of the palette and choose Reset Sky from the menu. 

Access Sky Lab 

To access the Sky Lab, either click on the Sky Lab button or click the triangle icon below the memory dots 
at the right edge of the palette and choose Sky Lab from the menu. 
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Saving Sky & Fog Settings 
The Memory Dots in the Sky & Fog Palette let you store your favorite Sky & Fog settings. Using these 
dots you can safely explore many Sky & Fog configurations without losing your favorite settings along the 
way. 

The Memory Dots appear along the right side of the palette. 

The Memory Dots in the Sky & Fog Palette mirror those inside the Sky Lab. 

To save Sky & Fog settings in the Sky & Fog Palette, click on an empty dot (empty dots are gray). All the 
current Sky & Fog Palette and Sky Lab settings (except for IBL settings) are stored in the selected dot. 
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The dots let you store up to seven different sky settings.  

The uppermost dot, slightly separated from the rest, is a quick way to return to the default Bryce sky. 
There is no way to clear this dot. It will always contain the default Sky settings. 
Memory Dots are saved with the scene, but not between sessions, so you may want to save your favorite 
skies as presets before ending a Bryce session. 
When you click on a full dot to activate it, the saved setting becomes the current Sky. When you no longer 
need a saved sky setting, you can delete it by clearing the dot it is saved to. 

• To save a sky setting to a Memory Dots, click an empty dot. 
• Empty dots appear gray - 
• Full dots appear green (blue in Bryce 5/5.5, teal in Bryce 3/4) - 

• To return to the default sky, click the top Memory Dot. The sky returns to the default, regardless 
of how many changes you have made. 

• To switch between saved skies, click a full (green) dot.

Active dots appear green with a white dot in the middle - 
• To clear a full dot, Opt/Alt+click a full dot. The dot turns gray and a new sky setting can be 

saved to it. 
Please note that if you select a saved sky, then use the Sky Presets Library to change the sky, the 
Memory Dot you clicked to load the previous sky will still be active even though a different sky has 
been loaded. 

Randomizing Sky Settings
Randomizing skies is a very powerful way of exploring possibilities you may never find any other way. 
When you randomize the sky all the settings in the palettes are replaced by randomly generated values. 
To randomize your sky, click on the Randomize Sky button. 

When you click on the button, it will turn red to show it is being activated. 

Each time you click on the Randomize Sky button, a random sky is generated and applied to the scene.  
Remember, you can always return to the default settings by clicking on the top Memory Dot or choosing 
Reset Sky from the Sky & Fog Options menu. 
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Working with Sky Modes

Working with Sky Modes 

The Sky Modes act as the base of your sky. The Sky Modes control lets you set the base colors and light 
tones for your environment. There are four modes available: Soft Sky, Dark Sky, Custom Sky, and 
Atmosphere Off. As you switch between the modes, the thumbnail also changes to give you a preview of 
what the mode looks like. 
To select a Sky Modes, either:  

• Click the Sky Modes thumbnail to cycle through the four modes,  
• Drag left or right inside the thumbnail to cycle through the modes, or 
• Click the triangle icon next to the thumbnail and choose a mode from the menu. 

 

• Soft Sky  
• Darker Sky  
• Custom Sky  
• Darker Sky  
• Sky Mode Comparison  

Soft Sky 

Soft Sky is the default state of the sky. It features softer shades of blue and lighter tones
To set the sky to soft, click the triangle icon next to the Sky Mode thumbnail and choose Soft Sky from the 
menu. 

The thumbnail changes to the Soft Sky control. 

Darker Sky 

Darker Sky is a darker version of Soft Sky. It uses darker shades of color and tones. This mode is good 
for creating more brooding skies. 
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To set the sky darker, click the triangle icon next to the Sky Mode thumbnail and choose Darker Sky from 
the menu. 

The thumbnail changes to the Darker Sky control. 

Custom Sky 

Custom Sky lets you choose your own colors for the sky; this way you can create some truly alien 
environments. When this mode is selected, the standard behavior of colors in the sky with respect to sun 
position is disabled. 

To set custom sky colors:
1. Click the triangle icon next to the Sky Mode thumbnail and choose Custom Sky from the menu.

The thumbnail changes to the Custom Sky control. 

2. Click the Sky Color swatch and choose a color from the color picker. The Sky Color is the main 
sky color in this mode, regardless of sun position.
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3. Click the Sun Glow Color swatch and choose a color from the color picker. This is the color of 
the halo around the sun. 

4. Click the Horizon Color swatch and choose a color from the color picker. 

This color will, in certain cases, affect your scene below ground level if you have a haze setting of greater 
than zero. It will also impact the color of Stratus clouds near the horizon.  
In most cases, this will be the least obviously used color in your scene; unless you are making outer 
space scenes, in which case this could be very useful for you.

Sky Mode Comparison 

Comparison images between Sky Modes, using the "Standard Daylight" sky setting:
• Soft Sky: 
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• Darker Sky:

• Custom Sky: 

Atmosphere Off 

Atmosphere Off disables the standard sky color behaviors, relative to sun position, and uses a single 
color for the sky. This mode is useful when you need to render objects against a simple colored (or black 
or white) background. The Sun color still affects objects in this mode. If you have red sunlight, for 
instance, objects in your scene will reflect red light. 
To render objects against a plain background: 

1. Click the triangle icon next to the Sky Mode thumbnail and choose Atmosphere Off from the 
menu.

©2003-2011 DAZ 3D, Inc. 214



Bryce 7 Artist Guide 03 Jan 2011

The thumbnail changes to the Atmosphere Off control. 

2. Click the Atmosphere swatch and choose a color from the color picker. 

3. Drag left inside the Haze control and set the value to 0. This setting eliminates the suggestion 
of a horizon.

4. And the result as seen in the Nano Preview: 
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Setting Sky Attributes

Setting Sky Attributes

Once you have selected a Sky mode, you have the basis for your virtual environment. All the other 
atmosphere effects you add later will interact with the base mode.  
There are two other attributes that affect how all the other effects will appear: 

• Shadows   

and 
• Ambient Color  .  

Shadows 

All the objects in your scene cast shadows. Using the Shadow control you can set the intensity and color 
of all the shadows in your scene. 
As you change the value of the Shadow control, the brightness of shadows changes. In the images 
below, the shadow on the left is set to 25%, the one on the right to 90%. 

The Shadow control is not the only control for shadows. The position of shadows is dependent on the 
position of the sun. Since the sky interacts directly with objects in the scene, the color of the sun also 
affects the color of shadows. 
The object's material properties also affect the color of shadows. Semi-transparent or transparent objects 
with a transparency color will change the color of the object's shadow. In addition, volume materials can 
dramatically change the shape and color of shadows. Use the Shadows control to set the color and 
intensity of shadows in your scene. 
By default, the clouds in Bryce do not cast shadows. If you want the cloud layer to cast shadows on the 
ground below, enable the Cloud Shadows option. 
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To set shadow intensity: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Drag left or right inside the Shadow control thumbnail. Dragging left decreases the intensity 
and dragging right increases it. The cursor changes to a two headed arrow as you drag over the 
control. 

Keep an eye on the Text Display Area as you drag in the Shadow Control thumbnail. The 
numbers will change as you drag back and forth on the thumbnail. 

3.
You can also set the Shadow strength on the Sun & Moon tab in the Sky Lab.

Ambient Color 
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The Ambient Color is the color of all the light that surrounds the objects in your scene. Light from the sun 
interacts with ambient color to produce the color for both highlights and shadows. 
Ambient Color is used as the source color for material Ambience. The Ambient Color tints the surfaces of 
all objects in your scene that have some level of ambience. Any other color you apply to the object's 
surface is mixed with the Ambient Color to create the final surface color. For example, if the Ambient 
Color is red, any color you assign to an object's surface ambience is mixed with red. 
To set Ambient Color, click the color swatch below the Shadow control thumbnail and choose a color from 
the color picker.

For realistic effects, at noon, or in the afternoon, Ambient Color should be a little blue to get nice blue-ish 
shadows. At dawn, you can set Ambient Color to red or pink, and at night, you can set it to gray-blue.  

You can also set the ambient color by using the Ambient Color Swatch in the Sky Lab. 
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Adding Fog & Haze

Adding Fog & Haze 

Fog and Haze are two atmospheric effects that can add realistic depth to your scene. Fog can make 
objects appear to disappear the farther they get from the camera. Haze can add the illusion of a distant 
horizon. 
The Fog and Haze controls in the Sky & Fog palette let you control the color and intensity of these effects. 

 

Fog

Fog 

Fog can add an element of sensuality, mystery, and realism to your scenes. It acts like a thin layer of 
cloud close to the ground. 
Using Fog you can create the illusion of depth without having to add distant objects. Fog can create that 
sense of depth in the scene. 
Click on the links below to learn how to adjust these options:

• Fog Density  
• Fog Thickness  
• Fog Color  

 

Fog Density 
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To set the density/amount of Fog: 
1. Display the Sky & Fog palette by clicking the Sky & Fog text button. 

2. Drag horizontally inside the Fog thumbnail to increase or decrease the density of the fog in 
your rendered scene. Drag to the left to decrease the density of the fog and to the right to 
increase it.  

The density value is displayed in the Text Display Area of the Control Palette as you drag. 

You can also set the fog density on the Atmosphere tab in the Sky Lab. 

Examples:
• Fog Density = 3; Fog Thickness = 56 
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• Fog Density = 75; Fog Thickness = 56 

Fog Thickness 

To set Fog thickness/height: 
1. Display the Sky & Fog palette by clicking the Sky & Fog text button. 

2. Drag vertically inside the Fog control to increase or decrease the height of your fog. Drag up 
to increase the height and down to decrease it.

The thickness value is displayed in the Text Display Area of the Control Palette as you drag. 

You can also set the fog thickness on the Atmosphere tab in the Sky Lab. 

Examples: 
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• Fog Density = 5; Fog Thickness = 56 

• Fog Density = 5; Fog Thickness = 100 

Fog Color 

To set Fog Color: 
1. Display the Sky & Fog palette by clicking the Sky & Fog text button. 

2. Click the color swatch beneath the Fog thumbnail and choose a color from the color picker. 

3.
Fog color can also be set on the Atmosphere tab in the Sky Lab. 
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Examples: 
• Fog Color = White 

• Fog Color = Salmon 

Haze

Haze is the natural effect you see when a plane (like the ocean) stretches out towards the horizon. At this 
distant point a different color appears over the horizon and light becomes fuzzy. Haze creates the illusion 
of a distant horizon. 
The Haze control lets you set the intensity and color of the Haze effect in your Bryce scene. 
With haze set to zero, your horizon will have an unnaturally hard edge. Also note that the Cloud Altitude 
control will affect the height of this band of haze. The higher the altitude of the atmosphere, the wider the 
band of haze at the horizon. 
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Haze is applied to the entire scene equally and always appears at the horizon. 
Click on the links below to learn how to adjust these options:

• Haze Density  
• Haze Color  

Haze Density 

To set Haze density/intensity: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Drag horizontally inside the Haze thumbnail to increase or decrease the degree of haze in 
your scene.  Drag to the left to decrease the density of the haze and to the right to increase it. 

The density value is displayed in the Text Display Area of the Control Palette as you drag. 

You can also set the haze density on the Atmosphere tab in the Sky Lab. 

Examples: 
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• Haze Density = 8 

• Haze Density = 85 

Haze Color 

To set Haze color: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Click the color swatch beneath the Haze thumbnail and choose a color from the color picker.

Fog and Haze colors should be the same, or almost the same. For realism, the haze should be a 
little brighter and bluer than the fog. At nighttime, you have less illumination, so an effective 
nocturnal haze color could be dark blue-gray. 

Haze color can also be set on the Atmosphere tab in the Sky Lab. 
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Examples:
• Haze color = White  

• Haze color = Lavender 

Clouds in Bryce

Clouds in Bryce 

There are two kinds of clouds in Bryce: clouds in the environment and cloud planes. Clouds you add to 
your sky interact with the light in your scene. They can block out the light of the sun and change the color 
of the light that hits the objects in the scene. These clouds are infinitely distant so you cannot fly through 
the clouds in the sky. If you want to have this effect, use a cloud plane. Sky clouds can also cast shadows 
on the ground below. 
The clouds in this scene were created using Cumulus clouds from the Sky & Fog palette. 
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You can change the look of the clouds by editing the texture used to create them. By changing the 
texture, you can alter the shape and position of the clouds within the sky. Cloud planes are infinite planes 
that act as objects in your scene. They cast shadows and can interact with other objects. An infinite cloud 
plane was used to create the mist above the water in this scene. 

Both types of clouds can be animated. The clouds in the sky can be animated by changing their color, 
position or frequency, and cloud planes can be animated just like other objects. 
They can also be animated using the Cloud Motion controls. These controls let you set parameters for 
automatically animating clouds. Refer to "Animating Skies" for more on animating clouds. 

• Adding Clouds  
• Cloud Types  
• Cloud Cover  
• Cloud Height  
• Frequency & Amplitude  
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Adding Clouds 

The Sky & Fog Palette provides several controls that set the attributes of clouds in your sky. The Cloud 
Coverage, Cloud Altitude, and Cloud Frequency and Amplitude controls let you set the general 
appearance of your clouds. The Cloud Color sets the color of the clouds. 

You can add clouds to your scene in five easy steps: 
1. Select the type of cloud 
2. Adjust the cloud texture 
3. Set the cloud coverage and color  
4. Set cloud height 
5. Set the frequency and amplitude of clouds 

Cloud Types 

There are two types of clouds you can add to your Bryce environment: Cumulus and Stratus. 
Cumulus clouds are generally found at lower altitudes and appear thicker and fluffier. The sky in this 
scene uses Cumulus clouds. 

Stratus clouds appear at higher altitudes and appear thinner and wispier. The sky in this scene uses 
Stratus clouds. 

Refer to the following links to learn more about adding clouds:
• Adding Cumulus Clouds  
• Adding Stratus Clouds  
• Using Spherical Clouds  
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Adding Cumulus Clouds 

To add Cumulus clouds to a sky: 
1. If it is not already visible, display the Sky & Fog palette by clicking the Sky & Fog button at the 

top of the Bryce window. 

2. Click the triangle in the corner of the palette and choose Cumulus Clouds. 

Cumulus clouds are thicker, darker clouds at a lower altitude. These clouds will take on tints of Sunlight 
color, Ambient color, or Cumulus color. You can also choose either cloud type, or neither. Selecting 
neither cloud type creates a clear sky. 
Cumulus Clouds can also be enabled in the Sky Lab on the Cloud Cover tab: 

Adding Stratus Clouds 

To add Stratus clouds to a sky: 
1. If it is not already visible, display the Sky & Fog palette by clicking the Sky & Fog button at the 

top of the Bryce window.
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2. Click the triangle in the corner of the palette and choose Stratus Clouds.

Stratus clouds are bright white, thin, clean clouds that appear at high altitudes. These clouds are very 
responsive to Sunlight color and Sky Dome color, and less responsive to Cumulus color or Ambient 
color.  You can also choose both cloud types, or neither. Selecting neither cloud type creates a clear sky. 
Stratus Clouds can also be enabled in the Sky Lab on the Cloud Cover tab: 

Spherical Clouds

The default clouds in Bryce are fairly flat, like you would see over a desert. To get puffier clouds, a 
Spherical Clouds option is provided. This option basically consolidates high frequency clouds, creating 
rounder, more dense clouds.  
To enable spherical clouds: 

1. If it is not already visible, display the Sky & Fog palette by clicking the Sky & Fog button at the 
top of the Bryce window. 
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2. Click the triangle in the corner of the palette and choose Spherical from the menu. 

3.
Spherical Clouds can also be enabled in the Sky Lab on the Cloud Cover tab: 

Examples: 
• Stratus Clouds with Spherical Clouds disabled: 
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• Stratus Clouds with Spherical Clouds enabled:

• Cumulus Clouds with Spherical Clouds disabled:
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• Cumulus Clouds with Spherical Clouds enabled: 

Cloud Height 

The height of your clouds has an impact on the appearance of your sky. Greater heights will result in 
smaller, more distant cloud formations, as well as a thicker band of haze at the horizon. Lower heights 
result in larger, more languorous cloud formations and a thinner band of haze at the horizon. The Cloud 
Height controls in the Sky &Fog palette let you interactively set the height of the cloud layer in the sky. 
There are two things to remember when working with this control. 
First, the Cloud Height will affect the size of your Haze band if you have a haze setting greater than zero. 
The higher the altitude, the wider the haze region will be on the horizon. 
Second, remember to lower your altitude setting if you are creating a nighttime scene. Since high altitudes 
increase the size of the horizon Haze region, the sky will be too unnaturally bright for realistic night 
scenes. 
To set cloud height: 

1. If it is not already visible, display the Sky & Fog palette by clicking the Sky & Fog button at the 
top of the Bryce window. 

2. Drag horizontally inside the Cloud Height control thumbnail. Drag left to decrease altitude and 
right to increase it.
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The cloud height value is displayed in the Display Text Area of the Control palette as you drag.

You can also set the cloud height on the Cloud Cover tab in the Sky Lab. 

Examples:
• Cloud Height = 10% 

• Cloud Height = 90% 
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Cloud Cover 

Cloud Cover controls the quantity of clouds you can see in the sky. A high coverage means that there is a 
very dense cloud layer and a low setting means that there are very few clouds in the sky. 
Cloud Cover also indirectly controls the brightness of the environment. The more cloud coverage you 
have in a sky, the darker the environment since less sunlight can pass through the clouds. Adjusting 
cloud coverage changes the quantity of clouds but not the frequency. You can think of it as adjusting the 
volume on a radio without changing the station. 
The Cloud Coverage control in the Sky & Fog palette lets you interactively set the quantity of clouds in the 
sky. 
To set cloud coverage: 

1. If it is not already visible, display the Sky & Fog palette by clicking the Sky & Fog button at the 
top of the Bryce window. 

2. Drag left or right inside the Cloud Coverage control thumbnail. Drag left to decrease 
coverage and right to increase it. 

The cloud coverage value is displayed in the Text area of the Control palette as you drag. 

3. See "Cumulus Cloud Color."
You can also set the Cloud Coverage on the Cloud Cover tab in the Sky Lab. 
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Examples:
• Cloud Cover = 10% 

• Cloud Cover = 90% 

Cumulus Cloud Color 

Cumulus Cloud Color affects only the Cumulus Clouds, so if Cumulus Clouds are disabled, this color 
swatch will have no effect on the scene.
To set Cumulus Cloud color: 

1. If it is not already visible, display the Sky & Fog palette by clicking the Sky & Fog button at the 
top of the Bryce window. 

2. Click the color swatch beneath the Cloud Coverage thumbnail and choose a color from the 
color picker.
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3. Choose Cumulus from the Sky & Fog Options menu. 

Note: Cumulus Cloud color can only be selected in the Sky & Fog Palette. It cannot be set in the Sky Lab.

Examples: 
• Cumulus Cloud Color = White 

• Cumulus Cloud Color = Pink 
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Frequency & Amplitude

The Frequency and Amplitude control lets you set the types of cloud formation you will see in your sky. By 
combining these two controls, you can change your clouds from light and fluffy to dark and brooding. Use 
Frequency and Amplitude to control the types of cloud formations in your scene. 
This graph shows the effects of different Frequency and Amplitude settings on a sky. Frequency values 
range from 2 at the top to 150 at the bottom. The Amplitude values range from 50 at the left to 500 on the 
right. 

Frequency 

To set Cloud Frequency: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. In the Cloud Frequency and Amplitude control, drag horizontally to control the frequency of your 
cloud formations. 
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• Drag right, and the "spikes" will get closer together, resulting in smaller formations.

• Drag left for larger, more luxurious formations. 

The Text Display Area shows you the numerical value of the amplitude and frequency as you drag.

You can also set the cloud amplitude on the Cloud Cover tab in the Sky Lab. 

Amplitude 

To set Cloud Amplitude: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

• Drag vertically to control the amplitude of your cloud formations.

• Drag away from the horizontal center (up), and the spikes increase in height, resulting in 
formations with harder edges. 
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• Drag toward the horizontal center (down) for softer-edged formations. 

It is possible to invert the spikes. This means that you can exchange positive and negative spaces in your 
sky. If you invert the amplitude, everything that was previously clear sky will be clouds, while everything 
that was cloud will be clear sky. 
The Text Display Area shows you the numerical value of the amplitude and frequency as you drag.  

You can also set the cloud amplitude on the Cloud Cover tab in the Sky Lab. 

Sky Dome Color 

Sky Dome Color lets you create a color wash over your scenes, even if there is no sunlight present. This 
color simulates the natural effect that occurs when you have color in the sky even though the sun has set. 
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Sky Dome Color lets you create late afternoon or evening scenes. The Sky Dome Color control in the Sky 
& Fog palette lets you choose a color from either the color picker or the color dialog. 
For late afternoon and early evening realism, try using a touch of orange or yellow. This will create a cast 
of color over your entire scene, regardless of the position or color of the sun or moon. 
To set Sky Dome color: 

1. If it is not already visible, display the Sky & Fog palette by clicking the Sky & Fog button at the 
top of the Bryce window. 

2. Click the color swatch beneath the Cloud Height control thumbnail and choose a color from the 
color picker.

The Sky Dome Color can also be set on the Sun & Moon tab in the Sky Lab. 

Examples: 
• Sky Dome = Purple 
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• Sky Dome = Green 

Working with the Sun & Moon

The Sun

The sun is the source of all natural light in your scene. Its attributes have a profound effect on the look of 
your scene. The color of the sun affects all the colors of all the objects in the scene; Sunlight color tints all 
the other visible colors. 
The position of the sun controls the time of day in your scene. If the sun is above the horizon, it is day; if it 
is below, it is night, and if it is at the horizon, it is sunrise or sunset. 
The sun can be animated just like all the other elements of your Bryce scene. You can create time-
elapsed effects by changing the position of the sun over the course of an animation. Refer to "Animating 
Sun or Moon Position" for more on animating the sun.
See "Positioning the Sun" for more on positioning the sun.

The Moon

The moon is normally the most prominent object in the night sky. In a night scene, it provides all the 
natural light in the environment. Like the sun, the moon's attributes can greatly affect the final look of your 
scene. Its position in the sky affects all the angles and intensities of all the shadows in the scene. 
The brightness is affected by the illumination reflected off the earth. The brighter the earthshine, the 
brighter the moon appears. Unlike the sun, the moon has phases, which simulate the effects of the 
moon's shadow becoming more or less prominent during a month. 
The moon's position and phases can be animated using the Animation controls and the timeline. Refer to 
"Animating Sun or Moon Position" for more on animating the moon.
See "Positioning the Moon" for more on positioning the sun.
See also:

• Day and Night  
• Sunrise/Sunset  
• Sun/Moon Color  
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Positioning the Sun 

The sun position control sets the direction your natural light is coming from whether it is sunlight or 
moonlight. The position can be set using the Sun Control in the Sky & Fog palette. The control works like 
a trackball, with the sun (bright) at one end and the moon (dark) at the other. 

You can think of the control as a compass: if the highlight on the Sun Control sphere is positioned at 12 
o'clock, the light comes from the north, and so on. As you change the position of the sun, the "time of day" 
changes. When the sun position is closer to the edges of the control, the sun appears closer to the 
horizon, making the scene darker. When the sun is in the center of the control, the sun shines from 
directly above the sun, as if it would at high noon. 
The colors in your sky will change depending on the position of the Sun Control, or the "time of day..." just 
like in the real world. The angle of the shadows changes as the sun changes. If your object is shiny, and 
there are no other light sources, the position of the sun controls where the highlight appears. In this 
example, you can see the effects of the sun's position on several reflective and shiny objects. 
You can position the sun manually and with precision on the Sky & Fog Palette and in the Sky Lab. You 
can also position the sun numerically in the Sky Lab. 

• Positioning the Sun Manually  
• Positioning the Sun with Precision  
• Positioning the Sun Numerically  

Positioning the Sun Manually 

To position the sun manually: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Drag the larger highlight area in the Sun Position Controls to the position where you want the 
light to originate. You can position the sun on the horizon as you like by nudging the Sun Control 
until the light is visible in your scene. 
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Positioning the Sun with Precision 

To position the sun with precision: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Hold down Ctrl+Opt/Alt and double-click the Sun Control (either the sun or moon toggle can 
be active). 

Do not let up on the Ctrl+Opt/Alt keys. 

3. Continue holding down Ctrl+Opt/Alt and in the working window, click where you want to 
position the sun. A yellow asterisk will show up where you click indicating where you placed the 
sun. 
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4. And the result: 

Please note that if you move the sun using the Sun Position Control, the "wireframe" sun will not move 
with it but will stay where you clicked in the working window, even though the sun will move in the scene.

Positioning the Sun Numerically 

To position the sun numerically: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Click the Sky Lab button. The Sky Lab appears. 

3. If the sun is not showing, click the Day/Night toggle to display the sun icon. 

4. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field controls the east-
to-west position of the sun. The range is 0 to +360.
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5. Enter a value in to the Altitude field. The Altitude field controls the height of the sun relative to 
your scene. The range is -90 to +90. Positive values are above the horizon, negative values 
below.
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6. Check the results to see if any further changes are needed.

7. Click the OK icon to exit the dialog. 

Positioning the Moon 

The moon is positioned at the same time as the Sun. The two are always at opposite ends of the sky, so 
wherever the sun is positioned, the moon is directly opposite. In the Sun/Moon control on the Sky & Fog 
palette, the smaller highlight portion of the Sun Position trackball represents the moon's position.

You can position the moon manually and with precision on the Sky & Fog Palette and in the Sky Lab. You 
can also position the moon numerically in the Sky Lab. 

• Positioning the Moon Manually  
• Positioning the Moon with Precision  
• Positioning the Moon Numerically  
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Positioning the Moon Manually 

To position the moon manually: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Drag the larger highlight area in the Sun Position Controls to the position where you want the 
light to originate. You can position the moon on the horizon as you like by nudging the Sun 
Control until the light is visible in your scene. 

Positioning the Moon with Precision 

To position the moon with precision: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Hold down Ctrl+Opt/Alt and quickly double-click on the Sun Control (either the sun or moon 
toggle can be active). 

Do not let up on the Ctrl+Opt/Alt keys. 

3. While still holding down Ctrl+Opt/Alt , press the Shift key and, in the working window, click 
where you want to position the moon. A blue asterisk will show up where you click indicating 
where you placed the moon. If you have trouble placing the moon this way, place the sun, and 
then click on the Day/Night Toggle to switch to the moon. 
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And the result: 

Please note that if you move the moon using the Sun Position Control, the "wireframe" moon will not 
move with it but will stay where you clicked in the working window, even though the moon will move in the 
scene.

Positioning the Moon Numerically 

To position the moon numerically: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Click the Sky Lab button. The Sky Lab appears. 
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3. If the moon is not showing, click the Day/Night toggle to display the moon icon. 

4. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field controls the east-
to-west position of the sun/moon. The range is 0 to +360, and the default value is 60. The moon 
will be positioned exactly opposite these values, so you can invert them to position the moon 
numerically or place the Sun behind the camera so that the moon appears in front of it. 

5. Enter a value into the Altitude field. The Altitude field controls the height of the sun/moon relative 
to your scene. The range is -99 to +99. Positive values are below the horizon, negative values 
above.
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6. Check the results to see if any further changes are needed.

7. Click the OK icon to exit the dialog. 

Day and Night 

Your sky normally contains two bodies: the sun and the moon. There is always one body visible in your 
sky. At night, it is the moon and in the day, it is the sun. The two bodies are always connected, and 
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remain at opposite ends of the sky. As you move the sun, you are also moving the moon. This means that 
when the sun dips below the horizon in front of you, the moon is rising behind you. 
The link between the sun and the moon can be seen by positioning the sun at the horizon in front of the 
camera. If you turn the camera 180°, you will see the moon just rising over the horizon as well. 
To switch between night and day: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window.

2. Click the Day/Night toggle button in the top-left corner of the sun position controls. 

The Sun/Moon Control in the Sky & Fog Palette is linked to the same controls in the Sky Lab. 

Sunrise/Sunset 

You can create a sunset or sunrise by positioning the sun so that it is visible on your horizon. 
You can position the sun manually by using the Sun/Moon control, or numerically by specifying values in 
the Sky Lab. You can also position the sun exactly where you want it to appear in your scene. Sunsets or 
sunrises can be created by moving the sun closer to the horizon. 
The colors in the sky automatically change to create the illusion of the sunrise or sunset colors. You can 
also use the Sky Dome color to give your sunset/sunrise added color. 
For a more realistic sunset, you may want to link the fog and haze to the sun so that they react to the sun 
color as it approaches the horizon. Refer to "Blend with Sun" for more on this feature. 
You may also want to enable the Horizon illusion for the sun. This feature makes the sun appear larger as 
it approaches the horizon. Refer to "Sun/Moon Size" for more on this effect. 

Sun Color 

Light in nature is not usually visible until it strikes an object. When you are using normal light, a purple 
sunlight color will not paint your entire sky purple, but objects in your scene will reflect purple. When you 
are using Visible World, choosing purple will paint your entire scene purple. 
The grayscale bar at the bottom of the color palette lets you set the intensity of the sun. Black turns the 
sun off and white sets the sun to its brightest intensity. 

©2003-2011 DAZ 3D, Inc. 252



Bryce 7 Artist Guide 03 Jan 2011

To set the Sun Color: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sun Color swatch and choose a color from the color picker. You can also set the sun 
color in the Sky Lab: 

Advanced Display Palette 

The Advanced Display palette contains tools for controlling the display of the interface and 
enabling/disabling the Nano-Preview and Plop Render features. 
The Advanced Display appears on the far right side of the Working window. Click on the links on the right 
to learn more about each tool.
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• Marker Pen  
• Spray Rendering  
• Interface Max/Min  
• Background Paper  
• Nano Editor On/Off  
• Plop Render On/Off  
• Wireframe Attributes  
• Display Modes  
• Zoom In/Out  
• Pan Tool  

 

 

Marker Pen 

The Marker Pen adds the functionality of a white board to your scene. When you are using the Marker 
Pen, you can draw anywhere in the Bryce environment without affecting your scene. Deselecting the 
Marker Pen tool erases all the marker pen lines. 

To draw with the marker tool: 
1. Click the Marker Pen tool or press the M key. 

2. The Marker Pen tool will change to show a red tip:

and the cursor will change to look like the Marker Pen tool: 
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3. Left-click hold and drag the marker anywhere on your Bryce screen.

4. By default, the marker color is red and thin. To change the color and line size, see "Changing 
Marker Options."

To erase marker pen lines, click the Marker Pen tool again or press the M key again. 

Note: While the Marker Pen is active, you will not be able to access the Windows toolbar without doing 
one of the following: 

• clicking on the tool again to deselect it  
• pressing the Windows key 
• pressing the Escape key 

Changing Marker Options 

The default line color for the Marker Pen is red with the line being fairly thin, however, sometimes the 
color and/or thickness of the line needs to be different (for example, when explaining how to do 
something). Bryce provides a small palette with color swatches and a line bar where these options can be 
modified. 
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To change the Line Color and Size of the Marker Pen: 
1. Click the Marker Pen tool or press the M key.

2. Right-click+hold on the Marker Pen tool again. The Marker Palette will come up in the top left-
hand corner of the Bryce window.

3. While still holding down the right mouse button, drag the marker pen up to the palette and place 
the Marker cursor over the color swatch you want to use. 

4. Let up on the mouse, then left-click+hold and drag the marker anywhere on your Bryce screen.
5. Repeat to change the marker thickness but drag over the Line Thickness bar to increase or 

decrease the size. 
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Examples of color and size changes:

Remember that the marker lines disappear once you deselect the Marker Pen tool so if you want to save 
the sketches you made, you will need to make a screen capture and paste it into your paint program. 

Spray Rendering 

In addition to using the Render Controls, you can also paint an area of your scene to render it. Use Spray 
Rendering to preview a specific area of your scene. If you render the entire scene after doing a spray 
render of a specific section, that area will not be re-rendered. 

The Spray Rendering controls include five circular and five square spray nozzles. 
While in Spray Rendering Mode, use the one through five keys to select the circular spray sizes and the 
six through zero keys to select the square nozzles. 
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To render using Spray Rendering: 
1. Click the Spray Rendering tool on the Advanced Display palette. 

The tool will change to a spray can with a red tip: 

and the cursor will change to the Spray Can: 

2. Use the tool to paint over the area of your scene that you want to render.
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3. Adjust the brush size and shape using the 1 through 0 keys to more easily paint a larger or 
smaller area. 

You can also render a portion of your wireframe or rendered image to quickly see any modifications made 
to your scene. You can render from Wireframe mode or from Render mode. Spray Rendering from 
Wireframe mode is a preview render that is lost when you press the Escape key. Spray Rendering from 
Render mode is a true render and can be continued by using Resume Render.

Spray Rendering From Wireframe 

To spray render from Wireframe mode: 
1. Select the Default Wireframe mode from the Display Modes tool. 

2. Click the Spray Rendering tool on the Advanced Display palette. 

3. Use the tool to paint over the area of your scene that you want to render.

4. Press the Spray Rendering tool again or press the Escape key to dismiss this render and return 
to Wireframe mode. This does not affect any previous render.  

Spray Rendering From Render Mode 

To spray render from Render mode: 
1. Press the Escape key to switch from Wireframe to Render mode or select the Default Render 

mode from the Display Modes tool.
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Your rendered scene will be displayed. If the scene has not yet been rendered, you will see a 
blank "render."

2. Click the Spray Rendering tool on the Advanced Display palette. 

3. Use the tool to paint over the area of your scene that you want to render.
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4. Click the Spray Rendering tool to put the tool away and remain in render mode. 
5. Press Escape again to return to Wireframe mode yet not lose your paint rendered area.
6. If you Resume Render your scene, Bryce continues to render the un-rendered portions of your 

scene. 

Interface Max/Min 

When you first launch Bryce, the interface snaps to the edges of your Working window and other 
applications are hidden behind Bryce. This setup lets you work with an uncluttered desktop. 

Use the Interface Max/Min tool to increase or decrease the screen coverage of the Bryce window. The 
current size of the working window will determine the amount of "black space" around the minimized 
Bryce Window. 
The image below shows the minimized Bryce Window with the Working Window set to Default 540:405:  

In addition, the same window, maximized. If the Working Window is set to Max Recommended, you will 
not see much difference between minimum and maximum.  

©2003-2011 DAZ 3D, Inc. 261



Bryce 7 Artist Guide 03 Jan 2011

Background Paper 

The background texture of the working window can add a great deal to the overall look of the interface. It 
makes it easier to see wireframes and selected objects. 
To select a background texture, click the Background Paper button and choose a background from the 
menu (see examples at bottom of page). 
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Adding a background texture may slow down some machines so if you need more speed for any reason, 
select No Texture and you will get a simple, clean background with no texture.

To select a background color:   
1. Click the Background Paper button and choose Select Color from the menu. 
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2. Use the color picker to select a color.

3. Click on the OK icon to accept the color change, the background will change to the selected 
color.

To revert to the default gray, click on the Background Paper button again and choose Select Color from 
the menu. The default gray color will be selected.  Click on the OK icon to accept the color. 
Examples of Background Textures: 
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Paper Streak Paper

Gray Black

Grid Legal Pad

White Paper Grid
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Grain

 

 

Nano Editor On/Off 

Nano-Edit Mode activates the Nano-Editor which lets you perform camera transformations on a small 
preview of your scene, instead of the full scene. 
When this mode is active, the Nano-Editor appears any time you perform a camera transformation. The 
Nano-Editor window displays a small preview of your scene. The transformation is applied to the preview. 
When you close the editor, the transformation is applied to the full scene. 

Note: It may be useful to save the current camera setting before using the Nano-Editor, just in case you 
aren't happy with the results since using the Undo feature will not reset the camera view. 
 
The Nano-Edit Mode allows you to see the immediate effects of a transformation on a preview of your 
image. This mode is useful when you are working on a large scene as it saves on redraw time since only 
the preview window shows the changes instead of the entire Working Window. 
To activate Nano-Edit Mode: 

1. Click the Nano-Edit button on the Display palette. 

When the smaller square inside the icon (which represents an active Nano-Editor) is red, the 
Nano-Edit Mode is on; when it is white, it is off. 
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2. Move the cursor over any of the Camera Controls, left-click hold and drag on the control to 
reposition the camera. Let up on the control to apply the changes to the scene.  

3. Let up on the mouse and the changes will be applied to the scene.

To activate Nano-Edit Mode temporarily, hold down Opt/Alt+Spacebar before you perform 
transformations. The Nano-Editor appears only during the operation, and can be used without actually 
clicking on the camera controls. 

1. Press Opt/Alt+Spacebar and move the cursor over the working window. You will see the rotate 
cursor in the window: 

2. Left-click on the working window and rotate the scene just as if you were using the camera 
controls:
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3. Let up on the mouse and the changes will be applied to the scene.

Plop-Render On/Off 

If you have begun rendering your image, you can use the Plop-Render controls to render specific areas of 
your image. You can use this mode to see immediate the results of repositioning and transformation 
operations. 
Plop-Render mode is enabled by default but can be turned off using the Display palette. 
To enable/disable Plop-Render mode, click the Plop-Render On/Off toggle in the Display palette. When 
the small rectangle inside the icon (which represents an active Plop-Render tool) is red, Plop-Render 
mode is on. When it is white, the mode is off. 

To render an area of your scene: 
1. Make sure Plop-Render mode is enabled. 
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2. Begin rendering your scene by clicking the Render All button in the Render controls. 

3. To pause rendering, click the Render All button again, or click in the working window. 
4. Drag a marquee around an area of your image. The selection is outlined in a thin white line 

and is separated from the rest of the image by a drop shadow. A series of buttons appear beside 
the marquee selection.  

5. Click the top button that appears beside the selection, this is the Clear and Render button. You 
can interrupt the rendering by clicking the mouse.

6. To resume a render, click the second button (Resume Render) that appears beside the selection.

7. For additional Plop Render options, select one of the following:
• Zoom to Selection  
• Hide Selection  
• Collapse Selection  

Zoom to Selection

To scale the selected area to fill the working window, click the triangle icon beside the Render Controls 
and choose Zoom to Selection from the menu. 
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The command centers the selected portion of your wireframe scene and scales it up to fit your window. 
This is a pan and zoom operation and therefore does not affect your camera position, however, it will 
clear any previous render you performed.  
Note: You may want to save the camera position prior to performing this function so that you can view the 
entire scene after completing the plop-render.  

Hide Selection 

To hide the Plop-Render selection but still use it, click the triangle icon beside the Render controls and 
choose Hide Selection from the menu. 
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The frame around the selection will disappear but the selection can still be rendered without rendering the 
entire scene. 

Click on the Clear and Render button or on the Resume Render button in the Render controls: 

Do not click on the Render All button (large center one) as that will disable the Plop-Render and render 
the entire scene. 

Collapse Selection 

To remove the Plop-Render selection completely, click the triangle icon beside the Render Controls and 
choose Collapse Selection from the menu. 

This will remove the selection and you can render the full scene.  

Wireframe Attributes

When you are in Wireframe mode, there are several options you can set to make the display more 
helpful. 
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Disabling some of these options may speed up drawing time.
There are four Wireframe Attributes: 

• Depth Cue     
• Shadows On/Off     
• Underground On/Off   
• Resolution     

Depth Cue 

Depth cueing allows you to see which objects are further away from the camera based on how light or 
dark the mesh is and not on the size of the mesh. 

To use Depth Cue, left-click-hold on the Depth Cue control and drag up or down. 

The image below shows the default setting for depth cue. 

Drag up to increase the intensity of the depth cueing effect. 
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Drag down to decrease the intensity of the depth cueing effect. When depth cueing is active, the 
wireframe appears lighter the farther it is from the camera. 

If you hold down the Ctrl or Ctrl+Alt keys and click on the Depth Cue icon, Bryce will turn anti-aliased 
wireframes on or off.  
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Shadows On/Off 

In Wireframe mode, shadows are designed to help you determine object placement in your scene. For 
this reason, shadows appear when there is no ground plane, or when the object is below the ground 
plane. This feature may slow down your system when working with a complex scene on slower machines. 

By default, shadows are turned on in Bryce.
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To turn off Shadows: 
• Click the Shadows On button. 

• The tool will change to the Shadows Off button. 

• The shadows for the objects will disappear from the scene. 

To turn on Shadows: 
• Click the Shadows Off button. 

• The tool will change to the Shadows On button. 

©2003-2011 DAZ 3D, Inc. 275



Bryce 7 Artist Guide 03 Jan 2011

• The shadows for the objects will appear in the scene. 

Underground On/Off 

By default, any part of the scene below ground level is hidden for easy visualization and composition. 
However, you might overlook an object that is hidden underground. In addition, sometimes it is useful to 
see these objects especially when the scene does not use a ground plane, for example, space scenes. 

By default the underground is turned on.
To turn off the Underground: 

• Click the Underground On button. 

• The tool will change to the Underground Off icon. 
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• The scene will show the objects or parts of objects that are below ground level. 

To turn on the Underground: 
• Click the Underground Off button.

• The tool will change to the Underground On icon. 

• The scene will hide the objects or parts of objects that are below ground level. 
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Resolution 

Wireframe Resolution can be set manually to suit your preferences using the Resolution tool. Reduce the 
resolution if Bryce slows down when a large scene is being worked on. 

Click the Resolution tool and choose Static, Selected, or Motion. Then choose a resolution for the 
wireframe mode. 

• Static lets you define the resolution of the wireframe when the object is not moving and not 
selected. 

• Selected lets you define the resolution of the wireframe when the object is selected. 
• Motion lets you define the resolution of the wireframe when the object is being moved. 
• Selecting Auto LOD (Level of Detail) will allow Bryce to automatically force a box display of 

objects while moving objects or the camera if your computer cannot handle the selected settings. 
The new "Convert Boolean to Mesh" function depends on the Selected Resolution so if the Selected 
Resolution is set to 8, then the converted mesh will be "chunky" but if the Selected Resolution is set to 32, 
then the converted mesh will be much smoother. 
Below are examples of each setting, with the menu setting shown first and the result shown second. 

• Motion set to 8: 
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• Example of objects in motion at 8: 

• Static set to 16: 

• Example of static (non-selected) objects at 16: 
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• Selected set to 32: 

• Example of selected objects at 32: 

Display Modes 

The Display Mode tool, at the bottom-right corner of your Working window, toggles through the available 
display modes. This tool appears as a cube that is either wireframe or shaded, depending on the selected 
display mode. 

Types of Display Modes:
• Default Display Modes  
• OpenGL Display Modes  

Default Display Modes 

By default, the Display Mode tool lets you cycle through three display modes by clicking on the Display 
Mode tool multiple times: 
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• Default Wireframe, WireFrame, Lit WireFrame, Hidden Line, Wire Shaded, Wired Textured 
Shaded 

 
• Default Mixed 

• Default Rendered, Textured Shaded, Smooth Shaded 

Clicking and holding the mouse button on the Display Mode tool for a moment opens a menu allowing you 
select one of the default display modes without clicking multiple times on the Display Mode tool. Once you 
choose a type of mode (default or OpenGL) from the menu, clicking on the Display Modes icon will cycle 
through the available options.
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Examples: 
• Default Wireframe 

• Default Mixed 
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• Default Rendered 

OpenGL Display Modes 

Clicking and holding the mouse button on the Display Mode tool for a moment opens a menu allowing you 
select one of the following OpenGL display modes. 

Once you select an OpenGL Mode, clicking the Display Mode tool cycles through the available OpenGL 
Display Modes: 

• Texture Shaded
• Wireframe
• Lit Wireframe 
• Hidden Line
• Wire Shaded
• Smooth Shaded

To switch between display modes: 
1. Click on the Display Mode tool in the corner of the Working Window. 
2. Click the button until you are in the desired mode. There are seven modes available:
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• Texture Shaded uses OpenGL (if available) to show all objects with textures and 
shadows.

• Wireframe shows all objects as wireframes.
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• Lit Wireframe shows all objects as wireframes and displays areas of light and shadow.

• Hidden Line shows all objects as wireframes but hides portions of the objects that are 
not visible from the camera location/angle.

• Wire Shaded shows all objects as a solid while also displaying the wireframes.
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• Smooth Shaded shows all objects as a solid but does not display the wireframes. This 
preview mode is only available if your system contains hardware that supports OpenGL®. 
When this mode is active, your objects appear as flat shaded solids, without materials, 
instead of wireframes, and you can see the effects of light sources on object surfaces.

• Wire Texture Shaded uses OpenGL (if available) to display all objects with textures, 
shadows, and wireframes. 

Selecting Default Wireframe disables all advanced display modes. 

Note: If you have issues opening scene files, such as the scene taking a long time to open without any 
obvious reason or the scene crashing on opening, then check the display options to see if any of the 
OpenGL options are selected. If they are, change to one of the default display options and try opening the 
scene again. This is a possible solution and not the only reason why a scene may take a long time to 
open or cause Bryce to crash. 
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Zoom In/Out 

In Bryce, there is a difference between moving the camera and using the zoom tools. When you move the 
Camera, you are moving in 3D space. When you use the pan and zoom controls, you are transforming a 
2D projection of your 3D scene - your camera position does not change. 
When you use the Zoom tool, you are essentially making the 2D projection larger or smaller. Your camera 
position in 3D space does not change. 

• To zoom in, click on the Zoom In tool - Magnifying Glass with plus (+) sign. Bryce scales the 2D 
projection of your scene larger, creating the illusion of zooming into your 3D scene; your camera 
position remains unchanged.

Keyboard shortcut: plus (+) 
• To zoom out, click the Zoom Out tool - Magnifying Glass with minus (-) sign. Bryce scales the 2D 

projection of your scene smaller, creating the illusion of zooming out of your 3D scene. Your 
camera position remains unchanged. 

Keyboard shortcut: minus (-) 
• To zoom into a specific area, hold down Cmd/Ctrl+Spacebar and drag a marquee around an 

area of your scene. Your cursor changes to a Zoom tool and Bryce centers and scales up the 
area in the marquee to fit your window. See "Zoom to Selection" to see this in action.  

• To zoom using the mouse, hold down Cmd/Ctrl+Opt/Alt+Spacebar and drag the mouse left or 
right in your scene. 

Dragging left zooms in and dragging right zooms out. 
• To zoom numerically:  

1. Double-click the Trackball in the Control palette. The Camera & 2D Projection dialog 
appears. 

2. Enter a value in the Scale field. The default value is 100%. You can only zoom 
numerically when you are working in either Director's View or Camera View. 
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• To reset the zoom value, press the Opt/Alt key and click on the Zoom tool. The view of your 
scene resets to 100%. 

• To zoom in or out while rendering, see "Zoom While Rendering."

Zoom While Rendering 

The Zoom tool can also be used while the scene is rendering. This allows you to see more or less of the 
scene during the render without affecting the final render. 
To zoom while rendering: 

1. Set up the render size of the scene to a large size as needed. 
2. Click on the Render button. 
3. Once the render has started: 

• Click on the Zoom In tool or press the plus (+) key to zoom in. 
• Click on the Zoom Out tool or press the minus (-) key to zoom out.
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Examples: 
• Render large started:

• Zoomed out while rendering:
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The image may look odd but this is because the image is zoomed out. If you zoom in (see below), 
you will see that the image looks fine. 
• Zoomed in while rendering:

Pan Tool 

Panning works the same way as zooming. When you use the Pan tool, you are moving a 2D projection of 
your scene right and left, up and down, in front of the camera. The actual camera position in 3D space 
does not change. 
The Pan tool can be very useful when you need to move the horizon up or down without affecting the 
view of the scene like zooming in or out would do.
Note: It may be useful to save the current camera setting before using the Pan tool, just in case you aren't 
happy with the results since using the Undo feature will not reset the camera view. 
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The Pan tool can be used with or without the Nano-Editor. 
There are three ways to Pan: 

• Clicking on the Pan tool  
• Using the Spacebar and the Pan tool  
• Using the Camera & 2D Projection dialog  

Once you have finished looking around your scene, you can reset the Pan tool if needed.
To reset the Pan tool to the default view: 

• Mac: Press Opt+ left-click on the Pan tool.
• PC: Press Ctrl+Alt+left-click-drag on the Pan tool.

Using the Pan Tool 

To pan your scene using the Pan tool, left-click+hold on the Pan tool and drag over the tool in the 
direction you want your scene to move. 

• With the Nano-Editor On: 

If the Nano-Editor is on, you will see the preview window show up over the Pan tool button. The 
scene will pan inside the preview window and when you let up on the mouse, the scene itself will 
change to match the preview window. 

• With the Nano-Editor Off: 

If the Nano-Editor is off, the entire scene will move as you drag over the Pan tool button. When 
you let up on the mouse, the scene will stop at the same place where you panned to. 
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Using the Spacebar to Pan 

To pan your scene using the Spacebar, hold down the Spacebar and left-click+drag in your scene in the 
direction you want the scene to move. 

• With the Nano-Editor On: 

If the Nano-Editor is on, you will see the preview window show up over the working window where 
you clicked in the scene. The scene will pan inside the preview window and when you let up on 
the mouse, the scene itself will change to match the preview window. 

• With the Nano-Editor Off: 

If the Nano-Editor is off, the entire scene will move as you drag over the Pan tool button. When 
you let up on the mouse, the scene will stop at the same place where you panned. 
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Panning Numerically

To pan your scene numerically using the Camera and 2D Projection dialog: 
1. Double-click the Trackball in the Control palette. 

The Camera & 2D Projection dialog appears. 

2. Enter a value in the Pan V (Vertical) field (default value is 0). 
3. Enter a value in the Pan H (Horizontal) field (default value is 0). 
4. Click on the OK icon to close the dialog. 

The camera will move to the selected location.  
Note: You can only pan numerically when you are working in either Director's View or Camera View.

Time/Selection Palette

The Time/Selection Palette is located at the bottom of the Bryce window. 

Click on the toggle to switch between the Selection Palette and the Animation Controls.
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Click on the links below for more on each of these palettes:
• Time/Animation Palette  
• Selection Palette  

Animation Palette 

The Animation Palette contains controls that let you set up key frames and edit the timeline of your 
animation. 
These controls also let you preview your animation, add and delete key frames, and access the Advanced 
Motion Lab. Refer to the "  Animation  " section for more on using the Animation controls. 
While all animation palettes are almost the same, the one shown below is the one you see in the main 
working window. 

• Animating Transformations  
• Animating Materials  
• Animating Terrains  
• Animating Skies  

Animating Transformations 

When you are in Auto-Key mode, every transformation you apply to an object is recorded as a key frame. 
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In the Hierarchy area you can see where the key frames for these transformations appear in the timeline. 
By moving these key frames you can control the order in which transformations are applied. For example, 
you can take an object that grows larger and then moves left, and turn it into an object that moves left and 
then grows. Several animation techniques, like squash and stretch, can be simulated using 
transformations. 
See "Animating Transformations" for more on animating transformations. 

Animating Materials

The Materials Lab has its own set of animation tools that let you animate material properties. You can 
animate almost any property or texture. 

When you are animating between textures, Bryce interpolates between patterns and colors over time. 
You can have a rocky terrain turn into a desert during the course of your animation.  
Refer to "Animating Materials" for more on animating materials. 

Animating Terrains 

The Terrain Editor has a set of animation tools that let you animate a terrain over time. 
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You can animate the shape of the terrain or the filtering effects like Erosion or Mounds. Using these tools, 
you can create a terrain that changes shape as time passes. 
Refer to "Animating Terrains" for more on animating terrains. 

Animating Skies 

The Sky & Fog palette and the Sky Lab dialog have a number of controls that let you set the properties of 
your environment. By changing these properties over the course of an animation, you can animate your 
environment. For example, you can make clouds move or gradually change the time of day. 
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Refer to "Animating Skies" for more on animating skies. 

Selection Palette 

The Selection Palette contains tools for selecting specific types of objects in your scene. 

When first opening Bryce, the palette is not seen in the default Working window. 
To view it, use the Time/Selection Palette Toggle at the far bottom right of the Working window to replace 
the Animation Controls with the Selection Palette. 

Click on an option below to learn more on using the Selection Palette:
• Select by Type  
• Select All of Type  
• Select by Family  
• Select Options  
• VCR Controls  
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• Working in Solo Mode  

Select by Type 

The Select by Type icons let you select all the objects in your scene that are of a particular type. For 
instance, if you click on a sphere here, Bryce will select all spheres and sphere derivative objects in your 
scene. 
All of the selection controls below respect the previously described Shift-click techniques for multiple 
selections and de-selections. 
To select a specific object by type, hold down the cursor over the tool for the type of object you want to 
select and choose the name of the object from the menu that appears.  
By default, objects will be named with the object type followed by a sequential number based on when 
you placed that object in the scene, for example, Sphere To make it easier to select a particular object, 
you can give objects unique names that will appear in this menu. 

The selected object or objects will be selected. 

Select All of Type 

To select all objects of a specific type, hold down the cursor over the tool for the type of object you want 
to select and choose Select All of Type from the menu that appears. 
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All objects of the selected type will be selected. 

Select by Family 

To select objects by family:
1. Click the Families tool.

2. Choose the name of the family you want to select from the menu. 

All objects that have been set as a member of the selected family will be selected. For Mac users, 
if selecting by family crashes Bryce, make sure you have Bryce 6.1.13.1 or later installed.
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Select Options 

The Select Options menu on the Selection Palette allows additional selections to be made. From this 
menu you can select meshes, groups, and paths. You can also select all objects, select none, or invert 
the selection. 
Click on the links on the right to learn more about each option:

• Select Camera  
• Select Meshes  
• Select Groups  
• Select Paths  
• Select Web Links  
• Select Inverse  
• Select All  
• Select None  

 

 

Select Camera 

To select the camera, click the triangle icon next to the Selection Palette and choose Select Camera. 
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The camera will be selected.

This option is most useful when the camera has been hidden and cannot be selected any other way. 
Choosing this option will automatically unhide the camera if it was previously hidden via the Objects 
Attribute dialog.

Select by Mesh 

To select Mesh objects, click the triangle icon next to the Selection Palette and choose Select Meshes, 
then the particular mesh(es). 

• To select all meshes in the scene, choose Select All Meshes. 
• To select a specific mesh, choose that mesh from the listing.
• To select multiple meshes, press Shift while selecting the meshes from the listing.
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The selected mesh or meshes will be selected. 

Select by Group 

To select Group objects, click the triangle icon next to the Selection Palette and choose Select Group, 
then the particular group(s). 

• To select all groups, choose Select All Groups from the menu.
• To select a specific group, choose that group from the listing.
• To select multiple groups, press Shift while selecting groups from the listing.

©2003-2011 DAZ 3D, Inc. 302



Bryce 7 Artist Guide 03 Jan 2011

The selected group or groups will be selected. 

Select by Path 

To select Path objects, click the triangle icon next to the Selection Palette and choose Select Paths, then 
the particular path(s). 

• To select all paths in the scene, choose Select All Paths. 
• To select a specific path, choose that path from the listing.
• To select multiple paths, press Shift while selecting paths from the listing.
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The selected path or paths will be selected. 

Select Web Links 

To select objects that have a Web Link attached to them, click the triangle icon in the Selection Palette 
and choose Select Web Links from the menu. 
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All objects that have a web link associated with them will be selected. 
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Select Inverse 

There are two methods to select the inverse of the current selection.
To select all objects except a specific type: 

1. Click the tool for the object you want to exclude from the selection. All the objects of that type 
are selected.

2. Click the triangle icon in the Selection Palette and choose Select Inverse from the menu. 

3. The objects that were selected will be deselected while the objects that were not selected will 
now be selected.  
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You can also Select Inverse by doing the following:
1. Select the object(s) you do not want selected.

2. Press Shift and drag a marquee around the objects you want to be selected. Note that the 
marquee is not being dragged around all objects in the scene as we do not want the other two 
objects to be selected.
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The unselected objects within the marquee will be selected, while the object(s) that were selected 
will be deselected. The objects that were outside the marquee remain unselected.

Select All 

To select all the objects in your scene, click the triangle icon in the Selection Palette and choose Select 
All from the menu. 
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This will select all objects in the scene.  

Select None 

To deselect all selected objects, click the triangle icon in the Selection Palette and choose Select None 
from the menu. All selected objects in the scene will be deselected.
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This option is most useful when the boundaries of your objects overlap and you cannot find a spot in the 
working window to click on to deselect all objects.

VCR Controls 

The VCR Controls let you step through the various selection tools and activate Solo Mode. 
If the Selection palette is not showing, click the Time/Selection Palette Toggle in the lower-right corner 
of the Working window. 

The Selection Palette appears and the VCR Controls are on the far right of the Selection Palette. 

Click on an option below to learn how to use the VCR Controls:
• Step Sequentially Through Object Types  
• Step Sequentially Through Objects of Selected Object Types  
• Step Sequentially Through all Objects in Scene  
• Step Sequentially Through Families  

Step Sequentially Through Object Types 

To step forward and backward through the object types in your scene: 
1. Click on the larger forward arrow to step forward through object types within the current scene. 

The first object of its type is selected. 
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2. Click on the larger backward arrow to step back through object types. 

If you watch the Select By Type icons, the object type you are stepping to will highlight 
momentarily.

If you notice that Bryce is stepping through all objects in the scene instead of selecting the object type, 
click the triangle icon in the Selection Palette and deselect Alternate VCR Mode. 

Step Sequentially Through Objects of Selected Object Types 

To step forward and backwards through the object in a selected object type: 
1. Click on the smaller forward arrow to step forward through each object of the type in a selection. 

For example, use the large arrows to step to the first sphere created in the scene 

2. and then the smaller forward and backwards arrows to step through all other spheres in the 
scene. 

One advantage to making selections with this technique is that you can select objects within a Group. 
Simply clicking on a grouped object will not necessarily select the entire group; using the VCR Controls to 
select within a Group allows you to reposition objects or assign textures to objects within a Group without 
having to first Ungroup them. 
If you notice that Bryce is stepping through families instead of objects, click the triangle icon in the 
Selection Palette and deselect Alternate VCR Mode. 
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Step Sequentially Through all Objects in Scene 

To step sequentially through every object in your scene: 
1. Click the triangle icon in the Selection Palette and choose Alternate VCR Mode. 

2. Click the larger backward or forward arrow.  

3.

Step Sequentially Through Families 

To step sequentially through families: 
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1. Click the triangle icon in the Selection Palette and choose Alternate VCR Mode. 

2. Click the smaller backward or forward arrow. 

Working in Solo Mode 

Solo Mode is a very useful option when working in complex scenes. It allows you to isolate groups of 
objects without being distracted by other objects. Solo Mode also speeds up your work significantly as 
Bryce does not have to calculate and draw extraneous wireframe objects. 
To work in Solo Mode:  

1. Select an object, several objects, or group(s). 

2. Click the Solo Mode button in the center of the VCR Controls. 

The button color changes to red.
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3. Solo Mode will now be activated and the selected object(s) will show up in the working window 
without the rest of the scene showing. Modify the object(s) as needed.

4. Once you have completed the edits in Solo Mode, click on the red Solo Mode button to return to 
the full scene. Any changes you made to the camera while in Solo Mode will be reflected in the 
full scene so be careful about using the camera in Solo Mode. It may be useful to save the 
camera setting before entering Solo Mode. 

Control Palette 
The Control Palette contains tools for positioning the camera and viewing your scene. When working in 
Bryce, you position objects in three-dimensional space while looking at a two-dimensional display.  
You may find that your scenes become rather large and you might not be able to see the entire landscape 
in the Working Window. Bryce has several tools that can help you position elements and see every inch 
of your new world from all angles.  
You can also control how individual objects are displayed in the Working Window, and how your scene is 
displayed in the Nano-Preview. 
The tools available in the Control Palette are:  

• Nano-Preview     
• Camera Memory Dots     
• View Controls     
• Camera Controls     
• Render Controls     
• Text Display Area   
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These tools are found in the Control Palette located on the far left side of the Working Window. 

Nano-Preview 

The Nano-Preview is where your object is displayed before you render it. The Nano-Preview can display 
your scene from a number of different angles without affecting the position of the camera. 
To display your scene from different angles in the Nano-Preview, click the triangle icon below the Nano-
Preview and choose a preset display angle. The view of your scene does not change in the Working 
Window. 

To set Nano-Preview options, click the triangle icon below the Nano-Preview and choose a display option:
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• Sky Only previews only your sky settings. 
• Full Scene previews your actual scene. This is the default setting for the Nano- Preview.  
• Wireframe Only previews your wireframes only, as opposed to a rendered preview.  
• Auto Update will automatically update the preview render with every single change you make 

during your session. In most cases, this gives you almost immediate feedback after any action. 
On slower machines, or when working with highly complex scenes, you can deselect this option. 

• With this option deselected, you will need to click in the Nano-Preview window to update 
the render. 

• To set what view is shown in the Nano-Preview, select one of the View options: 
• Current View - will always show the same view as currently shown in the Working 

Window 
• Director's View - will always show the Director's View no matter what view is used in the 

Working Window Camera View - will always show the Camera's View no matter what 
view is used in the Working Window From Top - will always show the view from Top View 
no matter what view is used in the Working Window 

• From Right - will always show the view from Right View no matter what view is used in 
the Working Window 

• From Front - will always show the view from Front View no matter what view is used in 
the Working Window 

• From Left - will always show the view from Left View no matter what view is used in the 
Working Window 
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• From Back - will always show the view from Back View no matter what view is used in the 
Working Window 

• From Bottom - will always show the view from Bottom View no matter what view is used 
in the Working Window 

• Select either Fast Preview or Full Rendering to adjust the quality of the rendered preview. With 
Full Render selected, every pixel is ray-traced and anti-aliased. Fast preview mode skips pixels to 
achieve faster updates. This can cause small objects to be partially or completely missing. 

Camera Memory Dots 

You can use the preset viewing positions to see your scene from different angles or you can use the 
Memory Dots to store and retrieve your favorite camera positions. The Camera Memory Dots are located 
at the top left of the Working Window next to the Preview Window. 
The Camera Memory Dots are located at the top left of the Working Window next to the Preview Window. 

The dots let you store up to seven different views of your scene.  

The uppermost dot, slightly separated from the rest, is a quick way to return to the default Bryce camera 
position. 
There is no way to clear this dot. It will always contain the default Camera settings.  
Dot settings are saved with your scene file, so if you open a previously saved scene, your dot settings 
from the previous session remain in place.  
When you click on a full dot to activate it, the saved position becomes the current Camera View. When 
you no longer need a saved camera position, you can delete it by clearing the dot it is saved to.  

• To save a camera position to a memory dot, click an empty dot. 
• Empty dots appear gray - 
• Full dots appear green (blue in Bryce 5/5.5, teal in Bryce 3/4) - 

• To return to the default camera position, click the top memory dot. The view returns to the default, 
regardless of how many changes you have made. 

• To switch between saved positions, click a full (green) dot. 
• Active dots appear green with a white dot in the middle - 
• To clear a full dot, Opt/Alt-click a full dot. The dot turns gray and a new camera view can be 

saved to it.
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View Controls 

Bryce lets you view your scene from several preset positions: Top, Front, Side, Bottom, Right, Left, and 
Back. All these views, with the exception of the Perspective View, are special Orthogonal projections 
which allow perspective-free views well-suited for alignment operations. 
Refer to "Orthogonality and Views" for an explanation of how and why Bryce uses Orthogonal projections.

Select an option below for more information:
• Select Views & View Options
• Perspective Toggle
• Fly-Around View
• The View of Your Scene
• Setting Up the View of Your Scene

Orthogonality and Views 

When you view a scene from the side, front, top, or bottom using the Camera, you will see certain 
amounts of perspective distortions. These distortions can make precise visual alignments difficult. 
For instance, if you have a dozen cubes in different locations and you place the camera so that it looks 
down on the scene from above, you will find it very difficult to place the cubes on top of one another. 
Cubes further from the camera would be slightly smaller than cubes close to the camera, resulting in a 
confusing array of lines. 
The more complex the scene, the more confusing and difficult this kind of alignment becomes. If, for 
example, you viewed objects from above through a real-world camera, the perspective distortions would 
make alignment or placement difficult. 
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To solve this problem, Bryce uses a perspective free, drafting board kind of view in which like sized 
objects far away appear exactly the same as those up close. This perspective-free view is called an 
Orthogonal Projection. In Bryce, all views other than your Main View (that is, Top, Bottom, Right, Left, 
Front, and Back) are orthogonal projections. They are not generated by the camera, and so do not 
contain the perspective distortion that would necessarily come with a camera view. 

As a result, Camera Controls do not work in these views and will be shaded to show they are not 
available in these views. 

• Camera Controls in Director's or Camera View : 
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• Camera Controls in Orthogonal Views:  

You can, however, navigate within the orthogonal views using the Zoom and Pan tools. 
If you press the Render button while in an orthogonal view, Bryce will quickly set up the camera position 
you need and render your image. There may be slight differences between what you see in the wireframe 
projection and what you see in the rendered image as a result of the added perspective distortion in the 
rendered image. 

Select Views & View Options

The Select View control is an interactive way of cycling through the various preset views. The current 
position of the Select Views control indicates the view you are seeing in the Working window. 

• To switch views using the Select Views control, click or drag the Select Views control until you 
reach the view you are looking for. Every time you click the control, Bryce displays a different 
preset view (see images below). 

• To switch views using the Select Views control menu, click the triangle icon next to the Select 
Views control and select a view option: 

See "Orthogonal Views" for more on these views.
• To switch views using the keyboard, select a preset view shortcut: 
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• Director's View = ~ (apostrophe key, no Shift)
• Camera View = 1
• Top View = 2
• Right View = 3
• Front View = 4
• Saved views = 5 through 9

Perspective Toggle 

The Perspective Toggle allows you to quickly switch between the Director's and Camera Views without 
having to select the views from the View Control menu. 
The default view is the Director's View and the toggle shows as a director's chair.  

To change to the Camera View, click on the Perspective Toggle. The toggle will change to a camera and 
the scene view will switch to the current Camera View. 

To switch back to the Director's View, click on the toggle again. 
While in an Orthogonal View, the Perspective Toggle will be hidden. In order to switch to Director's View 
or Orthogonal View, select the view from the View Options menu. 

Fly-Around View 

You may have noticed a tiny circular icon above and to the right of the Select Views icon. If you click here, 
you will This view gives you a sense of context in your Bryce world. If you are working close to the 
ground, or stuck in the midst of a clump of trees, or you have lost a cube you know you created a half an 
hour ago, you can use the Fly-around View to see your entire scene all at once. 
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In Fly-around View, Bryce positions the Camera on an imaginary monorail track above and away from 
your scene so that you can see the whole scene from all sides as the camera moves around it. 

• To switch to Fly-around View, click the Fly-around View icon next to the Select Views control, or 
choose Objects > Fly-around, or press Cmd/Ctrl+Y. 

The Select View control changes to the Fly-around control. 

• To switch back to Camera view, click on the Select Views control icon next to the Fly-around 
control. 

• To change the angle of your scene in Fly-around view, drag your mouse in your scene. The 
scene rotates in the direction you drag.  

• To zoom in and out in Fly-around view, hold down the Cmd/Ctrl key and move the mouse up or 
down in the window - do not click in the scene, just move the mouse itself. Moving the mouse up 
zooms in and moving the mouse down zooms out. 

• To slow the Fly-around, hold down the Shift key. 
• To pause the Fly-around, press the Spacebar. Press the Spacebar again to resume the Fly-

around. 
• To end the Fly-around and return to the last active view, click anywhere in the Bryce window. The 

view switches back to the view that was active when Fly-around was activated. To end the Fly-
around and save the Fly-around position, press Return/Enter. The last Fly-around position 
becomes the new Current View. 

The View of Your Scene 

The view of your scene refers to the portion of the scene visible in the Working window. There are eight 
views of your scene available in Bryce: the Camera View, which is the view produced by the Camera in 
the scene; the Director's View, which shows your scene from the perspective of a director sitting outside 
of the scene; and the Orthogonal Views (Top, Bottom, Left, Right, Back and Front) which are perspective-
free views of your scene. 

Camera View

Camera View is produced by the Camera in 3D space, meaning that you can view your scene from 
anywhere within your Bryce environment - even from underneath it. The Camera View can be positioned 
using the positioning tools or by repositioning the Camera in the scene. 
The Camera has a wireframe, which can be dragged in the Working window and its motions recorded as 
an animation. However, the wireframe is visible only in the Director's View or one of the Orthogonal 
Views. 
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Director's View 

The Director's View gives you the freedom to look at your scene from any perspective while still being 
able to manipulate the Camera as an object. 
The Director's View motions are not recorded as part of an animation. This means that you can move to 
any position without inadvertently changing the view of your scene in the animation. 
The Director's View can also be an invaluable tool for animating the view of your scene. While in this 
view, you can select the Camera and reposition it anywhere in the scene to create camera motions. 
Director's View is the default view of the scene. 

Orthogonal Views

These six views let you see the scene from all sides. They do not show you any perspective, but you can 
see all the objects in the scene, including the camera. These views are only flat projections of the scene, 
so you cannot move around them using the camera controls. 

Setting Up View of Your Scene

Setting Up the View of Your Scene 
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There are eight different views of your scene available in Bryce: Camera View, Director's View, and the 
six Orthogonal Views. 
The Camera View and Director's View let you see the scene from any perspective, while the Orthogonal 
Views let you see projections of the scene from the top, bottom, left, right, front, and back.
See "Reset Views" to reset the views back to their default settings.
To choose a view: 

1. Click the triangle icon next to the View Controls icon. 

2. Choose a view from the menu. 

Camera View 

This view of your scene in the Working window is seen through the lens of the Camera object in your 
scene. 
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Since your scene exists in 3D, you can view it from any vantage point: above, below, or even from inside 
an object. To see from these different perspectives, you change the position of the Camera. The 
positioning tools available in the Control palette let you position the Camera along specific axes and 
change its orientation. 
As you create and position the objects in your scene, you can use the position and orientation of the 
camera (called Camera Space) as a reference for several transformation operations. You can rotate, 
position and resize objects using Camera Space.
When you have completed your scene, the Camera View can be used to create the final rendered image 
or animation. You can reposition the camera and render the scene from several different viewpoints. 
The camera can also be animated just like any other object. You can record changes in its position at 
different points along the timeline. When you run the animation, the view from your camera appears to 
change like the view seen from an airplane as it flies through a landscape.
When you are in Camera View, a small camera icon appears in the View control. 

To switch to Camera View, do one of the following: 
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1. Click the triangle icon next to the View Control icon and choose Camera View from the menu. 

2. Click or Click+drag over the View Control until the Camera icon appears. 
3. If Director's View is active, click on the Director's Chair icon (Perspective Toggle) to switch to 

Camera View. 

Director's View 

Director's View lets you view your Bryce environment through the eyes of a director sitting outside the 
scene and directing the action of all the objects - including the camera. The camera that generates the 
Director's View cannot be seen or positioned like an object. You have to use the positioning controls to 
move this view. Unlike the Camera View, the motion of this view cannot record as part of an animation. 
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When you are working on a still image, you can use Director's View to get a second perspective on your 
scene. You can also render the Director's View of your image. In a still image, you can use both the 
Director's View and the Camera View to get different perspectives of your scene. 
The real power of the Director's View becomes obvious when you are working on camera animations. 
Animating camera motions while in Camera View (top, image) can be tricky. However, in Director's View 
(bottom, image) you can see the camera as an object, which means that you can set up camera motion 
just as you would any other object. 
When you are in Director's View, a small director's control icon appears in the Select Views control. 

To switch to Director's View, do one of the following: 
1. Click the triangle icon next to the View Control icon and choose Director's View from the menu. 

OR
2. Click or Click+drag over the View Control until the Camera icon appears. 

OR
3. If the Camera View is active, click on the Camera icon (Perspective Toggle) to switch to Director's 

View. 
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Orthogonal Views 

There are six other views available through the View controls, but these views are not generated by any 
camera. The views (Top, Bottom, Left, Right, Back, and Front) are perspective-free views of your scene 
called orthogonal projections. When you are using one of these views, you cannot use the Camera 
controls. 
The Orthogonal Views are another way of seeing the camera as an object in the scene. This can be 
invaluable when you are animating the camera, or setting up a complex scene. Using the orthogonal 
views, you can quickly move to different views of your scene. These views also let you see the camera as 
an object. 

To switch to an Orthogonal View, do one of the following: 
1. Click the triangle icon next to the View Control icon and choose the Orthogonal View you want 

from the menu. 
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OR
2. Click or Click+drag over the View Control until the Orthogonal View you want appears. 

• From Top: select this option to view a perspective-free orthogonal projection of your 
scene as seen from above (based on absolute world coordinates). 

• From Right: select this option to view a perspective-free orthogonal projection of your 
scene as seen from the right (based on absolute world coordinates).

• From Front: select this option to view a perspective-free orthogonal projection of your 
scene as seen from the front (based on absolute world coordinates).
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• From Left: select this option to view a perspective-free orthogonal projection of your 
scene as seen from the left (based on absolute world coordinates).

• From Back: select this option to view a perspective-free orthogonal projection of your 
scene as seen from behind (based on absolute world coordinates).

• From Bottom: select this option to view a perspective-free orthogonal projection of your 
scene as seen from below (based on absolute world coordinates).

Reset Views 

To reset ALL views to their default setting, do one of the following: 
1. Click the triangle icon next to the Select Views control icon and choose Reset Views from the 

menu.

or 
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2. Press the Opt/Alt key and click on the Select Views icon. 

Caution: This option reverts all views back to their original Bryce defaults and not back to a previous view 
you set earlier. Once you reset the views, you cannot undo this option. In order to revert back to a 
previous view, save the view in a Camera Memory Dot then click on the dot later to revert to that view. 

Camera Controls 

You can think of the view of your scene as a window to a whole new world. The view you see through this 
virtual window is determined by the orientation and position of a camera. As you move the camera, you 
get a different view of your world. 

• Positioning the View of Your Scene
• Setting Camera Object Properties
• Using the Camera Axes Controls
• Banking Controls
• Field of View Controls
• Using the Trackball
• Positioning the Camera
• Camera Origin Point
• Aiming the Camera

Positioning the View of Your Scene

Positioning the View of Your Scene 

When you position a view, you are affecting the location and orientation of a camera, not the scene itself. 
The scale and position of objects remains constant.  Your view of the scene is the only change. 
The controls described in this section can be used to position either the Camera View or the Director's 
View. However, some controls, like the Trackball, are limited when you are in Camera View. 
Bryce has two sets of controls for positioning your view of the scene: the Trackball and the Camera 
Controls. The Trackball lets you adjust the position of the camera, as well as its orientation. The Camera 
Controls change the position of the camera along the X, Y, and axes.
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Camera Modes

Camera Modes 

The cameras in Bryce have four modes that affect the behavior of the Trackball:
• Trackball
• Center to Selection
• Tripod
• Free Camera

All four of the modes are available when you are in Director's View. 

The only mode available in Camera View is Free Camera. 

Trackball Mode 
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In Trackball Mode, the camera orbits around your scene. The center of the orbit, or origin, is the center 
point of a box that encompasses all the objects in your scene. 
As the size of your scene changes, so does the size of the box, which changes the box's center point. As 
a result, the center of rotation for the camera also changes as you change the size of your scene. In fact, 
in this mode the camera's center of rotation is constantly updated, so that it always remains in the center 
of the scene. 
To change to Trackball Mode: 

1. If the Camera View is active, click on the Camera Perspective Toggle to switch to Director's View. 

2. If any of the Orthogonal Views are active, click on the triangle next to the Select Views control 
and choose Director's View from the menu. 

3. Click on the triangle next to the Trackball and choose Trackball from the menu. 
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OR 
4. Double-click either the Trackball or one of the Camera Controls. The Camera & 2D Projection 

dialog appears. 
5. Click the Trackball mode button at the top of the dialog. 

6. Click on the OK icon to close the dialog. 
7. Use the Trackball to move the camera around your scene. The objects in the scene will remain in 

the center of the scene with the Director's View moving around the objects in a spherical orbit. 

If you move any of the objects so that the scene's bounding box is decreased or increased, the 
view rotation will decrease or increase to match. 

The image below shows a sphere to give an example of where the camera will potentially rotate 
around the entire scene: 

©2003-2011 DAZ 3D, Inc. 334



Bryce 7 Artist Guide 03 Jan 2011

Center to Selection Mode 

In this mode, the camera also orbits around the scene. The center of the orbit, in this mode, is a selected 
object. As the object moves, so does the camera's center of rotation. This mode is the best way of making 
sure that specific objects always remain in view. 
To change to Center to Selection Mode: 

1. If the Camera View is active, click on the Camera Perspective Toggle to switch to Director's View. 

2. If any of the Orthogonal Views are active, click on the triangle next to the Select Views control 
and choose Director's View from the menu. 
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3. Click on the triangle next to the Trackball and choose Center to Selection from the menu. 

OR 
4. Double-click either the Trackball or one of the Camera controls. The Camera & 2D Projection 

dialog appears. Click the Center To Selection mode button at the top of the dialog. Note that the 
Origin fields are not available while in this mode.
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5. Click on the OK icon to close the dialog. 
6. In the scene, select the object to rotate the view. If you do not select an object, (or objects), then 

the Center to Selection mode will work like the Trackball Mode. 

7. Use the Trackball to move the camera around your scene. The Director's View will rotate around 
the selected object in a spherical orbit. If you move the selected object, the view will move with it.

You can select another object to change which object the view centers around. 

The image below shows a sphere to give an example of where the camera will potentially rotate 
around the selected object: 
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Tripod Mode 

In Tripod Mode, the center of rotation is fixed at the center of the camera, so it actually pivots in place. As 
the name suggests, the camera acts as though it is on a tripod. It can rotate around, or tilt up and down, 
but it always remains in place. 
Use the Tripod mode in conjunction with the Eye Level Camera command to get a sense of height.
To change to Tripod Mode: 

1. If the Camera View is active, click on the Camera Perspective Toggle to switch to Director's View. 

2. If any of the Orthogonal Views are active, click on the triangle next to the Select Views control 
and choose Director's View from the menu. 
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3. Click on the triangle next to the Trackball and choose Tripod from the menu. 

OR 
4. Double-click either the Trackball or one of the Camera controls. The Camera & 2D Projection 

dialog appears. Click the Tripod mode button at the top of the dialog. 
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5. Click on the OK icon to close the dialog. 
6. Use the Trackball to rotate the camera. The Director's View will pivot around the current location 

of the Director's View camera. If you move the camera location, the view will move with it. 

Free Camera Mode 

In this mode, the camera is completely unconstrained. Its center of rotation can exist anywhere, from its 
center to a point somewhere in the scene. Since the placement of the camera's center of rotation is not 
limited, this mode can simulate any of the other modes. 
For example, if you place the camera's origin point in its center, it acts as though it is on a tripod. Refer to 
"Manually Positioning the Camera" for more on positioning the camera's origin point. 
To change to Free Camera Mode: 

1. If the Camera View is active, you are already in Free Camera Mode. 
2. To change to Director's View, click on the Camera Perspective Toggle to switch to Director's 

View. 

3. If any of the Orthogonal Views are active, click on the triangle next to the Select Views control 
and choose Director's View from the menu. 
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4. Click on the triangle next to the Trackball and choose Tripod from the menu. 

OR 
5. Double-click either the Trackball or one of the Camera Controls. The Camera & 2D Projection 

dialog appears. Click the Free mode button at the top of the dialog. 
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6. Click on the OK icon to close the dialog. 
7. Use the Trackball or Camera Controls to move the camera. The camera will move freely around 

the scene. 

Setting Camera Object Properties

Setting Camera Object Properties 

Since the Camera acts as an object, there are several object properties you can use to set how it is 
displayed, linked, or animated.
You can hide the camera wireframe to get a better view of objects in your scene. When you want to 
change the camera properties, you can display the hidden camera wireframe. You can also lock the 
position of the camera. 

• Hiding the Camera Wireframe
• Unhide the Camera Wireframe
• Locking the Camera Position
• Unlocking the Camera Position

Hiding the Camera Wireframe 

To hide the camera wireframe: 
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1. Switch to Director's View or an Orthogonal View so you can see the camera's wireframe. 

2. Select the Camera in the Working window.

3. Click the  icon that appears next to it. The Camera & 2D Projection dialog appears.  
4. Enable the Invisible option. 
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5. Click on the OK icon to close the dialog. The camera will now be hidden in the scene. 

Unhide the Camera Wireframe 

To display the hidden Camera Wireframe: 
1. If the Selection palette is not currently active, click the Time\Selection Palette Toggle at the 

bottom-right corner of the Working window to display the Selection palette. 

2. Click the triangle icon on the Selection palette and choose Select Camera. The camera will 
automatically be set to visible. 

Locking the Camera Position 

To lock the Camera Position: 
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1. Switch to Director's View or an Orthogonal View so you can see the camera's wireframe. 

2. Select the Camera in the Working window.

3. Click the  icon that appears next to its bounding box. The Camera & 2D Projection dialog 
appears.

4. Enable the Locked option. 

5. Click the OK icon to close. The camera position will now be locked so that the camera cannot be 
moved. 

Unlocking the Camera Position
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To unlock the Camera position: 
1. Switch to Director's View or an Orthogonal View so you can see the camera's wireframe. 

2. Select the Camera in the Working window.

3. Click the  icon that appears next to its bounding box. The Camera & 2D Projection dialog 
appears.

4. Disable the Locked option. 

5. Click the OK icon to close. The camera position will now be unlocked allowing you to move the 
camera. 
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Using the Camera Axes Controls

Using the Camera Axes Controls 

The Camera Axes Controls let you move the view of your scene along specific axes. When you are using 
these controls, the view does not tilt or rotate from its original position. It only moves up, down, back, or 
forward. The Camera Axes Controls affect your camera's location (Offset) only, not its orientation 
(Rotation). 
One thing to remember when using the Camera Axes Controls is that the movement along axes is 
affected by the current camera rotation/angle so Bryce will move along all affected axes in order to move 
the required amount along the selected axes. In the working window, however, the scene moves in the 
exact direction you selected. 

The Camera Axes Controls are not available if you are in any Orthogonal View. When unavailable, these 
controls turn dark grey. If you are in an Orthogonal View, you must use the Zoom and Pan tools for 
navigation. 
Refer to "Orthogonality and Views" for more on these views. 
There are three Camera Axes Controls available: 

• X-Y Camera Control
• X-Z Camera Control
• Y-Z Camera Control

X-Y Camera Control 

The X-Y Camera control provides control for horizontal and vertical motion. The sphere at the center of 
the camera control lets you move the camera along both the X and Y axes. The arrows let you constrain 
movement either horizontally or vertically. 
To move the camera along the X-axis: 

1. Move the mouse over the horizontal arrows on the X-Y Camera control until the cursor changes 
to an X with an arrow. 
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2. Left-click-hold on the arrow and drag right or up to move the camera in the +X direction. 
3. Drag left or down to move the camera in the -X direction. 

To move the camera along the Y-axis: 
1. Move the mouse over the vertical arrows on the X-Y Camera control until the cursor changes to a 

Y with an arrow. 

2. Left-click-hold on the arrow and drag right or up to move the camera in the +Y direction. 
3. Drag left or down to move the camera in the -Y direction. 

To move the camera along the X and Y-axes at the same time: 
1. Move the mouse over the center sphere on the X-Y Camera control until the cursor changes to a 

four-way arrow. 

2. Left-click-hold on the button and drag up, down, left, or right to move the camera on the positive 
and negative X and Y-axes. 

X-Z Camera Control 

The X-Z Camera control provides control for horizontal and depth motion. The sphere at the center of the 
camera control lets you move the camera in both the X and Z-axes. 
To move the camera along the X-axis: 

1. Move the mouse over the horizontal arrows on the X-Z Camera control until the cursor changes 
to an X with an arrow.

2. Left-click-hold on the arrow and drag right or up to move the camera in the +X direction. 
3. Drag left or down to move the camera in the -X direction. 
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To move the camera along the Z-axis: 
1. Move the mouse over the vertical arrows on the X-Z Camera control until the cursor changes to a 

Z with an arrow. 

2. Left-click-hold on the arrow and drag right or up to move the camera in the -direction. 
3. Drag left or down to move the camera in the +direction. 

To move the camera along the X and Z-axes at the same time: 
1. Move the mouse over the center sphere on the X-Z Camera control until the cursor changes to a 

four-way arrow. 

2. Left-click-hold on the button and drag up, down, left, or right to move the camera on the positive 
and negative X and Z-axes. 

Y-Z Camera Control 

The Y-Z Camera control provides control for vertical and depth motion. The sphere at the center of the 
camera control lets you move the camera in both the Y and Z-axis. 
To move the camera along the Y-axis: 

1. Move the mouse over the vertical arrows on the Y-Z Camera control until the cursor changes to a 
Y with an arrow. 

2. Left-click-hold on the arrow and drag right or up to move the camera in the +Y direction. 
3. Drag left or down to move the camera in the -Y direction. 

To move the camera along the Z-axis: 
1. Move the mouse over the horizontal arrows on the Y-Z Camera control until the cursor changes 

to a Z with an arrow. 
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2. Left-click-hold on the arrow and drag right or up to move the camera in the -direction. 
3. Drag left or down to move the camera in the +direction. 

To move the camera along the Y and Z-axes at the same time: 
1. Move the mouse over the center sphere on the Y-Z Camera control until the cursor changes to a 

four-way arrow. 

2. Left-click-hold on the button and drag up, down, left, or right to move the camera on the positive 
and negative Y and Z-axes. 

Camera Axes Control Options

Camera Axes Control Options 

The Camera Axes controls have options that let you move the camera to create specific views. 

To choose a Camera Axes control option, click the triangle icon next to the Camera Axes controls and 
choose an option from the menu:  
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• Center Scene
• Center Selection
• Eye-Level Camera
• Choose Camera to Director or Director to Camera to select either the Director or Camera View. 

See "Swapping Director's & Camera Views" for more on this option. 
• Edit Current Camera: Brings up the Camera & 2D Projection dialog that allows you to enter 

current camera information. This same dialog comes up when you double-click on the Trackball 
or Camera Axes controls. Refer to "Positioning the Camera Numerically" for more information. 

Center Scene

Selecting Center Scene from the Camera options menu rotates the camera so that all items in your scene 
are centered in the Working window. This option affects only the camera's rotation, not its offset. If you 
cannot see all the objects in your scene after using this option, try pulling your camera back a bit with one 
of the controls.
To center the scene:

1. Create a new scene or open a scene from disk.

2. Choose Center Scene from the Camera Options menu.

The camera will move to center the scene in the camera's view.
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Center Selection

Selecting Center Selection from the Camera Options menu rotates your camera so that any selected 
object or objects will be centered in your view. This option does not reposition the object itself, only the 
camera's rotation relative to the selected object.
To center the scene to the current selection:

1. Select an object in the scene.

2. Choose Center Selection from the Camera Options menu.
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The camera will move to center the selected object in the scene.

Eye-Level Camera

Selecting Eye-Level Camera from the Camera Options menu repositions the camera to just above ground 
level. Use this command (especially in conjunction with the Trackball's Tripod mode) to create the feeling 
of large, looming mountains or other objects. This is also effective in concert with the Field of View 
control.
To set the camera to eye-level:
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1. Create a new scene or open a scene from disk.

2. Choose Eye-Level Camera from the Camera Options menu.

The camera will move so that the camera is at "eye-level" or 5.12 BU above the ground.
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Swapping Director's & Camera Views

The Director’s View and the Camera View are interchangeable. So you can move the Camera View to the 
position of the Director’s View, or vice versa.
Even though you cannot directly position the camera that produces the Director’s View in the Working 
window, you can set up a Director’s camera position by dragging the Camera to a position in the scene 
and then swapping the Camera position with the Director’s View position.
To swap the Director’s View position for the Camera View position, click the triangle icon next to the 
Camera Axes controls and choose either Camera to Director or Director to Camera from the menu.

Banking Controls 

The Banking control sphere tilts your Camera (actually rotating the camera on the Z-axis), creating the 
effect of a tilted horizon. This control is great for creating tilted airplane cockpit views. Banking simulates a 
Roll action. 
Banking only works in Director's or Camera View. 
To bank the camera, 

1. Drag the Banking control, which is located to the top left of the Camera Trackball. 
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2. Drag right to bank to the right. 

3. Drag left to bank to the left.

Press Opt/Alt+click on the Banking control to reset it to normal. The normal (default) setting is zero. 

Field of View Control

Field of View Control 

The Field of View (FOV) control sphere acts like a zoom lens control, the higher the setting, the wider the 
field of view for your lens. 
Because you are admitting more information into your lens, it will create the illusion that objects are 
receding from view, or getting smaller. That is not the case. Since you are admitting more information, 
existing objects necessarily occupy a smaller percentage of space within your field of view. 
If you drag the Camera control to bring your "receding" objects back up to a larger area in your view, 
perspective distortion effects appear. This is particularly effective for creating broad, swooping cloud 
scenes. 
When you view the camera in Director's View or one of the Orthogonal Views, you will be able to see the 
camera's Field of View displayed as a 3D pyramid that extends from the camera wireframe. The large 

©2003-2011 DAZ 3D, Inc. 356



Bryce 7 Artist Guide 03 Jan 2011

triangle that extends from the camera's wireframe represents its field of view. As the field of view 
changes, so does the shape of the triangle. 

By default, the camera's field of view projection is visible.
Changing the Field of View only works in Director's or Camera View.
To increase/decrease the Camera's Field of View, drag the Field of View control, which is located to the 
top right of the Camera Trackball. 

• Drag right to increase the field of view. 
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• Drag left to decrease it. 

• Opt/Alt+click on the Field of View control to reset to normal. The normal, or default, setting is 60°.

To change the Field of View numerically, see "Set Field of View Numerically."

Displaying the Camera's Field of View 

To display the Camera's Field of View: 
1. Switch to Director's View or an Orthogonal View so you can see the camera's wireframe. 
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2. Select the Camera in the Working window.

3. Click the  icon that appears next to the camera object. The Camera & 2D Projection dialog 
appears. 

4. Enable the Show FOV option.
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5. Click on the OK icon to close the dialog. The Camera Field of View will now be visible.

Hiding the Camera's Field of View 

To hide the Camera's Field of View: 
1. Switch to Director's View or an Orthogonal View so you can see the camera's wireframe. 
2. Select the camera in the Working window. 

3. Click the  icon that appears next to the camera object. The Camera & 2D Projection dialog 
appears. 
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4. Disable the Show FOV option. 

5. Click on the OK icon to close the dialog. The Camera Field of View will now be hidden.

Using the Trackball 

The Trackball lets you rotate the camera around its origin point. The position of the origin depends on the 
Camera mode you select.
Refer to "Camera Modes" for more on these modes. 
The Trackball does not rotate the scene, it only changes the camera's location (Offset) and orientation 
(Rotation) relative to your scene. 
To move the camera using the Camera Trackball:

1. Move the cursor over the Camera Trackball control. The cursor will change to a cross with arrows 
on each end. 
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2. Left-click-hold and drag the mouse over the Camera Trackball control. The Camera Trackball 
control will turn a darker grey and as you drag the mouse, the view of your scene moves in the 
direction you drag.  

Positioning the Camera

Positioning the Camera 

The most precise way of positioning the view of your scene is by using the Camera & 2D Projection 
dialog. This dialog lets you enter values to set the camera position, the position of the camera's origin 
point, rotation, and field of view. The dialog can be used to adjust either the Camera View or the 
Director's View. When you display the dialog, you can see the numerical position of the camera and the 
position of its origin point. You can also see the active Camera Mode. 
There are different options available in the dialog depending on whether you are in Camera View or 
Director's View. When you are in Camera View, the only Camera Mode available is Free Camera. In 
addition, the Origin fields are only available if you are using Free Mode. 
Since the camera is an object, there are several more controls available when you are in Camera View. 
These controls let you set linking and animation options. Refer to "Camera Modes" for more information.

• Position Camera Numerically
• Rotate Camera Numerically
• Set Field of View Numerically
• Position Camera Manually

Position Camera Numerically 

To set the position of the camera numerically: 
1. To position the Director's View camera, double-click either the Trackball or one of the Camera 

controls. The Camera & 2D Projection dialog appears. 
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2. To position the Camera View camera, select the camera and click on the   icon next to the 
selected camera. The Camera & 2D Projection dialog appears. Make sure the General tab is 
active before continuing.
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3. Enter values in the Position X, Y, and fields. You can enter negative values here. 

4. Click on the OK icon to exit the dialog.
Technically, since the Bryce environment is infinite, the range is infinite as well, but higher values can 
create unpredictable results. 
The default values are 102.40, 30.72, and 102.40, respectively for the Director's View camera and 
-102.40, 30.72, 102.40, respectively for the Camera View camera. 

Rotate Camera Numerically 

To rotate the camera numerically: 
1. To rotate the Director's View camera, double-click either the Trackball or one of the Camera 

controls. The Camera & 2D Projection dialog appears. 
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2. To rotate the Camera View camera, select the camera and click on the   icon next to the 
selected camera. The Camera & 2D Projection dialog appears. Make sure the General tab is 
active before continuing

3. Enter values in the Rotate X, Y, and Z fields. Values are expressed in degrees. X, Y, and Z 
rotations are also known as Yaw, Pitch, and Roll. The rotation, or Roll field, displays the current 
value for the Banking control. You can enter negative values in these fields. The effective range is 
+/- 99. The default values for the Director's View camera are 0, -45, and 0°, respectively while the 
default values for the Camera View camera are 0, 135, and 0°, respectively.
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4. Click on the OK icon to exit the dialog.  

Set Field of View Numerically 

To set the Field of View (FOV) numerically: 
1. To set the FOV for the Director's View camera, double-click either the Trackball or one of the 

Camera controls. The Camera & 2D Projection dialog appears. 

2. To set the FOV for the Camera View camera, select the camera and click on the  icon next to 
the selected camera. The Camera & 2D Projection dialog appears. Make sure the General tab is 
active before continuing
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3. Enter a value in the Field of View field (FOV). The value in this field, expressed in degrees, 
describes current settings for the Field of View control. The effective range is 1 to 180°, and the 
default value is 60°. 

4. Click on the OK icon to exit the dialog.

Position Camera Manually 

You can manually position the camera by adjusting the position of the camera wireframe in the Working 
window. The camera wireframe is visible only when you are in Director's View or one of the Orthogonal 
Views. 
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In the Director's View or an Orthogonal View, you will see a blue Camera wireframe, which represents the 
location of your Camera. You can then drag the Camera wireframe to change the Camera position. The 
Nano-Preview updates to reflect your changes. 
There are two ways to manually position the camera:

• Select the camera an drag it to a new location
• Change to Camera View and use the Camera Controls to move the camera

To manually position the Camera by dragging: 
1. Change to the Director's View or one of the Orthogonal Views. 
2. Click on the Camera wireframe to select it.

3. Left-click-hold on the camera and drag it to the new position.

To manually position the Camera by using the Camera Controls: 
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1. Change to the Director's View or one of the Orthogonal Views. 

2. Click on the Camera wireframe to select it.

3. Select Camera View from the View Controls Options.
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The view will now switch to the view from the camera.

4. Use the Camera Axes Controls and the Trackball to move the view of the scene. Since the 
camera is selected, you are actually moving the camera around in the view.
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5. View the scene from the Director's View to see how the camera has moved.

Camera Origin Point

Camera Origin Point 

In its default state, the Camera's Origin Point is not visible and is located at its center. When the Camera's 
Origin Point is visible, it appears as a green dot in the center of the camera's wireframe. 

You can simulate any of the camera modes by dragging the Camera's Origin Point to different locations in 
the scene: 

• If you position the origin point in the center of the scene, the camera acts as though it is in 
Trackball mode. When you rotate the camera, it moves around the origin point.  

• If you position the origin point over an object in the scene, it acts as though it is in Center to 
Selection mode. When you rotate the camera object, it will pivot around the object under the 
origin point.  

• If you leave the origin point positioned at the center of the camera object, it acts as though it is in 
Tripod mode. 

Once you offset the origin point, all the camera's movements will be altered. If you offset the origin point, 
then switch to Camera View, the camera may not move as expected.

Display Origin Point 

To display the Camera's Origin Point: 
1. Switch to one of the Orthogonal Views or Director's View so you can see the camera wireframe.  
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2. Click the camera wireframe to select it. 

3. Click the  button that appears next to the camera's wireframe. The Camera & 2D Projection 
dialog appears. 

4. Click the General tab and enable the Show Origin Handle option. 

5. Click on the OK icon to accept the changes. The Camera's Origin Point will now be visible.

Position Origin Point Numerically 

To position the camera's origin point numerically: 
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1. To position the origin of the Director's View camera, double-click either the Trackball or one of the 
Camera controls. The Camera & 2D Projection dialog appears. Note that if in Trackball, Center to 
Selection, or Tripod mode, the Origin fields for the Director's camera are not active.

2. Select the button next to the Free mode, if needed to enable the Origin fields. 

3. To position the origin of the Camera View camera, select the camera and click on the  icon next 
to the selected camera. The Camera & 2D Projection dialog appears. Make sure the General tab 
is active before continuing.
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4. Before you can move the origin point, you will need to unlock the link between the Origin fields 
and the Position fields. If you change the Origin values while they are linked, you will be moving 
the camera and the origin point, which defeats the purpose.

Click on the red padlock icon next to the Origin and Position fields.

The icon will change to a gray padlock with the shackle open.
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You can now change the Origin values without moving the camera.
5. Enter values in the Origin X, Y, and fields. 

6. Click on the OK icon to exit the dialog. The new Origin Point location can be seen in the scene. 
Note that if you changed the Origin of the Director's Camera, then you will not see anything 
different until you actually try to move the camera.
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To reset the camera's origin point, hold down Shift and click the origin point or enter the Camera & 2D 
Projection dialog, unlock the padlock, set the Origin values to match the Position values, click on the 
unlatched lock to lock the fields, then click on OK to exit the dialog.

Position Origin Point Manually 

To position the Camera's Origin Point manually: 
1. In the Camera & 2D Projection dialog, display the Camera's Origin Point. 
2. Move the mouse over the camera origin point. The cursor changes to a four-way arrow. 

3. Drag the green point to a location in the scene.  

To reset the camera's origin point, hold down Shift and click the origin point. 

Aiming the Camera 

The only problem with positioning the Camera using the Orthogonal or Director's View is that the view 
from the Camera remains fixed as you adjust its location, so you may inadvertently lose the objects you 
were looking at when the position of the Camera changes. 
When you look at the Camera as an object, you will see that there is a control handle extending from the 
front of the object. This handle represents the Camera's current aim. By dragging this handle to a point in 
your scene, you can change the Camera's aim. 
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When you change the aim of the Camera, it rotates to face the new target, but remains in the same 
position. 
To change the Camera's aim in an orthogonal view: 

1. In the Working Window, click the triangle icon next to the View Control and choose top, left, right, 
bottom, front, or back from the menu. 
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2. Move the cursor over the end of the control handle. The cursor changes to a four-way arrow. 

3. Drag the end of the control handle to the point in you scene where you want the camera to aim. 
As you drag, the end of the handle changes to a red dot so you can see the aiming point better.

4. When the camera is pointing in the right direction, let go of the mouse button. The control handle 
will revert to its default size and the camera will be pointing in the direction you selected. 
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Render Controls

Once you have selected the rendering options you want to use and chosen a rendering mode, you are 
ready to start rendering. You render your entire image using the Render Controls or use the Plop Render 
Controls to render areas of your image. 
The Render Controls let you start and resume a rendering of your image. There are controls for enabling 
two types of fast renders. Use the Render Controls to control the rendering of your scene. 

Select an option below for more information:
• Render All
• Resume Render
• Clear and Render
• Preview Rendering
• Render Options
• Batch Rendering
• Patch Rendering
• Speeding Up Renders

Render All 

To start a rendering of the entire scene, click the Render All button or press Cmd/Ctrl+R. If you have 
already rendered any portion of your scene but not changed anything in the scene itself, the render will 
start where it left off earlier. If any settings were changed after stopping the render, this will start the 
render over from the top. 

You can interrupt any rendering by clicking the mouse anywhere in the Working window. 
Please note that when rendering to screen, you may experience reduced multi-tasking capabilities due to 
the way Bryce uses CPU time during rendering. You may want to reduce using other programs while 
rendering to screen, specifically during the anti-aliasing portion. 

Resume Render 
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To resume a rendering, click the Resume Render control or press Cmd/Ctrl+R . If any settings were 
changed after stopping the render, this will start the render over from the top. 

You can interrupt any rendering by clicking the mouse anywhere in the working window. 

Clear and Render 

To restart a rendering from the top, click the Clear and Render control or press Cmd/Ctrl+Opt/Alt+R. This 
control restarts a render of the scene or any selected region. 
Refer to "Plop-Render Mode" for more on rendering regions. 

You can interrupt any rendering by clicking the mouse anywhere in the Working window.  

Preview Rendering

Preview Rendering 

Preview Render Modes are accessed using the Render Controls or the Render Options dialog and 
provide lower quality renders that you can use to preview your image. 
There are two Preview Render Modes: 

• Textures On/Off
• Fast Preview

Fast Preview 

When Fast Preview Mode is enabled, the render engine ignores areas of low frequency and only ray-
traces areas of high frequency. This results in accelerated renders that are great for previewing during a 
session. However, it also results in some patchiness in certain mid-frequency areas, so it should not be 
used for final output. 

• To enable Fast Preview Mode, click the Fast Preview button in the Render Controls. 
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• When the button turns a silvery green, the mode is enabled.

• When the button is light green, the mode is off. 

• Alternatively, click the triangle beside the Render Controls and choose Render Options from the 
menu. 

• Select the Preview Render option to enable Fast Preview Mode; select the Full Render option to 
disable it. 

Textures On/Off 

When this mode is enabled, all textural parameters are disabled, including textures in the Materials 
Library and Materials Lab. 
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This mode performs the following procedures to speed up a render: 
1. Objects with properties like transparency, reflection, and bumpy textures are rendered in flat 

opaque shades.  
2. Fog, Haze and Clouds are disabled. 
3. Any item with a procedural texture is rendered with a color drawn from the ambient color channel 

in the Materials Lab. 
4. Any item with a simple color texture is rendered in that color. The Textures On/Off mode is 

available in any mode. 
• To enable Textures On/Off mode, click the Textures On/Off button in the Render Controls. 

• When the button turns a silvery green, the mode is enabled.  

• When the button is green, the mode is disabled. 

• Alternatively, click the triangle beside the Render Controls and choose Render Options from the 
menu. 
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• Click on the radio button/checkmark next to Render With Textures to enable the Textures Off 
mode. 

• Click the radio button next to Render With Textures to enable the Textures On mode. 

Render Options

Render Options Menu

Bryce offers a number of options and controls that let you control rendering. As you work on a scene, you 
can use settings that produce fast renders. When you are ready to produce your final image, you can 
choose settings that produce the highest quality image. 
The Render Options menu is available by clicking the triangle to the right of the Render Controls. 
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Once you click on the triangle, the menu comes up. Click on the links on the right to find out more about 
the different options.

• Render Quality
• General Render Options
• Optimizations
• Render Priority
• Render Options Dialog
• Post-Processing Options
• Render Reporting
• Projection Types
• Masking Modes
• Optics Options
• Document Setup

 

Render Quality

Render Quality 

The Render Quality options let you control the quality of the rendered image by setting the level of anti-
aliasing. Anti-aliasing removes the jaggies on the edges of objects within the image. In Bryce, Anti-
aliasing is performed using a super-sampling method. This means that for every pixel that is ray-traced, 
more than one ray is used to determine the pixel's color. The increase in rays increases the quality of the 
ray-traced object and the render time as well. 
Anti-aliasing can greatly improve the quality of your image, but it is time-consuming. It can also eliminate 
some desired roughness from high frequency textures. Anti-aliasing is performed on the last pass of the 
rendering process. 

• Turn AA Off for Single Object or Group
• Turn AA On for Single Object or Group

There are four quality modes available in Bryce: 
• Default 
• Regular 
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• Super 
• Premium

To set the quality mode: 
• Click the triangle icon beside the Render controls, point to Quality, and choose a quality mode 

from the menu. 

• Alternately, click the triangle icon beside the Render controls and click Render Options.

• Click one of the quality modes at the top-left corner of the dialog, then click on the OK icon to exit 
the dialog. 
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Default (No Anti-Aliasing) 

In this mode there is no Anti-Aliasing performed on the image. In the image below, you can see jagged 
edges around the sphere and around some of the spots. 

To turn on default render quality: 
• Click the triangle beside the Render Controls, point to Quality and select the Default (No AA) 

quality mode. 

To turn on default render quality using the Render Options dialog: 
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1. Click the triangle beside the Render Controls and click Render Options.

2. Select the Default (No Anti-Aliasing) quality mode. 

3. Click on the OK icon to exit the dialog. 

Regular (Normal Anti-Aliasing) 

In this mode, after the image is rendered, Bryce scans the entire bitmap to determine which areas require 
anti-aliasing. Only the areas of high concentration are anti-aliased. 

To turn on regular render quality: 
• Click the triangle beside the Render controls, point to Quality and select the Regular (Normal AA) 

quality mode. 
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To turn on default render quality using the Render Options dialog: 
1. Click the triangle beside the Render controls and click Render Options. 

2. Select the Regular (Normal Anti-Aliasing) quality mode. 

3. Click on the OK icon to exit the dialog. 

Super (Fine Art Anti-Aliasing) 
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In this mode, you can control the number of rays Bryce uses to trace every pixel in the image. Higher 
values produce a higher quality image, but can slow down the entire rendering process. You should 
probably only use this mode to render showcase type artwork - not normal working images. 
To turn on super render quality: 

• Click the triangle beside the Render controls, point to Quality and select the Super (Fine Art AA) 
quality mode. 

To turn on default render quality and set the number of rays per pixel using the Render Options dialog:
1. Click the triangle beside the Render controls and click Render Options. 
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2. Select the Super (Fine Art Anti-Aliasing) quality mode. 

3. Click the triangle beside Rays per pixel and choose a value from the pull-down list. The default 
value is 16.

4. Click on the OK icon to exit the dialog. 

Premium (Effect Anti-Aliasing)

Premium (Effect Anti-Aliasing) 
In this mode, you can use a variety of premium effects, such as Soft Shadows, Blurry Reflections, Blurry 
Transmissions, True Ambience, and Depth of Field. 
Premium effects include: 

• Soft Shadows 
• Blurry Reflections 
• Blurry Transmissions
• True Ambience 
• Depth of Field   

To turn on premium effects from the Render Options menu: 
1. Click the triangle beside the Render controls, point to Quality and select the Premium (Effect Art 

AA) quality mode. 
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2. Click the triangle beside the Render controls again to select a premium effect. All effects can be 
selected at the same time. 

To turn on premium effects, set the number of rays per pixel, and select a premium effect using the 
Render Options dialog: 
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1. Click the triangle beside the Render controls and click Render Options. 

2. Select the Premium (Effect Anti-Aliasing) quality mode. 

3. Click the triangle beside Rays per pixel and choose a value from the pull-down list. The default 
value is 64 for Premium effects. 
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4. Select a premium effect. 

5. Click on the OK icon to exit the dialog.
Soft Shadows 
When you adjust the softness of a shadow, you blur or sharpen the shadow's edges. Soft shadows blend 
more smoothly with the background. 
To enable Soft Shadows when rendering using the Premium Quality Mode: 

1. In Render Options, enable the Premium Quality mode, and then enable Soft Shadows. 

2. Ensure that Shadows is enabled under the Optics options. If this option is not selected, then 
shadows will not render. 
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3. Click on the OK icon to close the dialog. 
4. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

5. Click the Sky Lab button. The Sky Lab appears. 

6. Click the Sun & Moon tab. 

7. Enable the Sun/Moon Shadows option. If this option is not selected, then the objects in the scene 
will not cast any shadows. 

8. Enable the Shadow Softness option. 

9. Click the OK icon to exit the dialog. 
10. Render the scene. 

Examples: 
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• Soft Shadows disabled: 

• Soft Shadows enabled: 

• Difference between Soft Shadows with Normal AA and with Premium AA: 

Blurry Reflections 
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Blurry Reflections blurs reflections in glass, metal, and other reflective surfaces. 
To enable Blurry Reflections when rendering using the Premium Quality Mode: 

1. In Render Options, enable the Premium Quality mode, and then enable Blurry Reflections. 

2. Ensure that Reflections is enabled under the Optics options. If this option is not selected, then 
reflections will not be rendered. 

3. Click on the OK icon to close the dialog. 
4. Render the scene. 

Examples: 
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• Blurry Reflections disabled: 

• Blurry Reflections enabled: 

Blurry Transmissions 
Blurry Transmissions blurs the transmission of light, for example, when light passes through frosted glass.
To enable Blurry Transmissions when rendering using the Premium Quality Mode: 
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1. In Render Options, enable the Premium Quality mode, and then enable Blurry Transmissions. 

2. Ensure that Transmissions is enabled under the Optics options. 

3. Click on the OK icon to close the dialog. 
4. Render the scene. 

Examples: 
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• Blurry Transmissions disabled: 

• Blurry Transmissions enabled: 

True Ambience - Legacy

True Ambience, in Legacy mode, computes the ambient light for a surface using the color and intensity of 
nearby surfaces, resulting in color blending from one surface to another. 
To enable True Ambience when rendering using the Premium Quality Mode: 

1. In Render Options, enable the Premium Quality mode, True Ambience and then enable TA 
Legacy Mode. 
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2. Click on the OK icon to close the dialog. 
Render the scene. 
Examples: 
True Ambience disabled 

=
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True Ambience enabled 

Depth of Field

Depth of Field 

Depth of Field (DOF) lets you focus the camera on a particular object, blurring those closer and further 
away from the camera's focal point. You can control the Lens Radius and Focal Length numerically or 
you can have Bryce calculate these values based on a selected object. 
The Lens Radius determines how much or little of the scene is rendered with DOF. The larger this 
number, the more of the scene is blurred. The default Bryce Lens Radius is 0.10, which is usually too 
large for most renders. You will probably find that 0.01 or 0.02 is more than enough DOF. 
Focal Length determines the focus of the DOF - what the camera focuses on. You can set the focal length 
automatically by selecting an object and clicking on Set To Current Selection. To set the focal length 
manually, you need to determine how far the object is from the current camera. 

• Set Focal Length Automatically
• Set Focal Length Manually
• Depth of Field Examples

Set Focal Length Automatically 
To set the focal length automatically: 

1. Before entering the Render Options dialog, select an object or group in the scene to be the focus 
of the scene. 
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2. Click the triangle beside the Render Controls and click Render Options. 

3. In Render Options, enable the Premium Quality Mode, then enable Depth of Field. 

(Note: if the final render is too grainy, increase the Rays per pixel.) 
4. To set the Lens Radius, enter a value in the Lens Radius field. Remember that the larger this 

number is, the more of the scene will be blurred. 
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5. To set the Focal Length automatically click on the Set To Current Selection button. The Focal 
Length field will change based on the currently selected object. Make sure you have an object or 
a group selected before selecting this. 

6. To set the Focal Length manually, refer to "Setting Focal Length Manually." 
7. Click on the OK icon to close the dialog. 

Examples: 
• Depth of Field disabled: 
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• Depth of Field enabled, set to current selection (ladybug): 

Set Focal Length Manually 

To set the focal length manually (best if you have one than one object as the focal point):  
1. Before entering the Render Options dialog, make sure that the perspective camera is the current 

camera. If using the Director's Camera as the main view, click on the triangle next to the camera 
controls and choose Camera to Director from the Camera Options menu. 

2. Change the camera view to the top view (press the 2 key) and center the scene in the view.  
3. Create a cube, resize it along one axis, and rotate the cube until it lines up between the camera 

and the focal object/point. Continue resizing the cube until one end is at the center of the 
object/point and the other is at the tip of the camera focus. 
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4. Click on the  button next to the selected cube and note down the size of the side you resized, in 
this case, 102.2.
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5. Click the triangle beside the Render Controls and click Render Options. 

6. In Render Options, enable the Premium Quality Mode, and then enable Depth of Field. 

7. To set the Lens Radius, enter a value in the Lens Radius field. Remember that the larger this 
number is, the more of the scene will be blurred. 
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8. Enter the cube length you noted earlier into the Focal Length field. 

9. Click on the OK icon to close the dialog. 
10. Render the scene. 

One caveat here is that as an object moves further from the camera, the focal point that Bryce uses shifts 
from the object center to the edge of the object nearest the camera. You can check this out by selecting 
each object and setting the Focal Length automatically, then using a cube to check the distance between 
the camera and the object. 
This is also helpful for finding what the focal length would be between two objects or in the middle of a 
wasteland.

Depth of Field Examples 
Focal point of sphere 1 (closest to camera): 

• Lens Radius = 0.50 
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• Lens Radius = 0.10

• Lens Radius = 0.05

• Lens Radius = 0.01 

Random focal point:  
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• Lens Radius = 0.02, Focal Length = 200 

• Lens Radius = 0.10, Focal Length = 300  

• Lens Radius = 0.10, Focal Length = 400
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• Focal point of Sphere 5 (furthest from camera), set manually using a resized cube: 

Turn AA Off for Single Object or Group 

Sometimes a particular object or group needs to have the Anti-Aliasing turned off while leaving the rest of 
the scene with the AA turned on. This is especially useful for rocks or areas with grass and dirt that look 
better with no AA. 
To turn off AA for a single object or group: 

1. Select the object or group.  
2. Click the  button next to the object/group. The Object Attributes dialog will come up. 
3. Press Ctrl+Shift+Alt and click on the OK icon in the Object Attributes dialog. 
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4. Render the scene. The object with the AA turned off will have rougher edges than other objects.

Turn AA On for Single Object or Group 

To turn AA back on for a single object or group: 
1. Select the object or group.
2. Click the  button next to the object/group. The Object Attributes dialog will come up. 
3. Press Shift and click on the OK icon in the Object Attributes dialog.
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4. Render the scene. The object/group will render more smoothly.

General Render Options 

The General Render Options provide an alternate method of turning the Plop Render and Textures On or 
Off. 

• Full Render - turns Fast Preview off 
• Preview Render - turns Fast Preview on 
• Render With Textures - Turns Textures on or off 

See "Preview Rendering" for more on these options.

Optimizations 

Bryce includes several optimization options. These options change the mathematical algorithm used by 
Bryce to ray-trace your image depending on the contents of your scene. There are two types of 
optimization: BSP and Grid, and each has three levels of optimization to choose from. 
There are three Levels of Optimization to choose from for each of the above optimization types: 

• Minimal: This mode is best used for very simple scenes with less than five objects. In this mode, 
Bryce predetermines the areas where your objects reside and shoots rays only through that area. 

• Normal: This is the best mode for most scenes. In this mode, Bryce determines where your 
objects reside and then examines the concentration of objects within the larger area. This 
eliminates the computation of unnecessary rays. 

©2003-2011 DAZ 3D, Inc. 412



Bryce 7 Artist Guide 03 Jan 2011

• Aggressive: This is an extreme version of Minimal mode. It is best used for complex scenes with 
localized concentrations of objects. If you have imported DXF objects in your scene, this mode 
will speed up rendering considerably.

To set Optimization Options: 
1. Either click the triangle icon next to the Render Controls, choose Optimization from the menu, 

then the optimization type (BSP or Grid) and level. 

OR
2. Click the triangle beside the Render Controls and click Render Options. 

3. Choose an optimization type and level from the Render Options dialog. 

4. Click on OK to close the dialog. 
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Render Priority

New in Bryce 6.1 is the option to set the render priority on systems with multiple processors.
To set the render priority, click the triangle icon next to the Render Controls and Priority, then Low, 
Normal, or High. The default setting is Normal. 

This allows you to determine whether Bryce runs at maximum capacity or at a more restrained rate to 
allow you to work more easily with other CPU intensive applications at the same time. With this feature, 
you can have Bryce 6.1 run 170% faster than under Rosetta. 
If you only have a single processor, then you will not have this option available.

Render Options Dialog

The Render Options Dialog provides access to most of the render settings plus options to set the 
premium and optic effects.
To access the dialog, click the triangle icon next to the Render Controls and choose Render Options from 
the menu.

The Render Options dialog will come up.
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Setting Post-Processing Options 

Bryce includes two post-processing options to compensate for the differences between viewing images 
on a computer display and on paper. 

• 48 Bit Dithering: Helps you work around the limitations of computer displays. This process allows 
you to avoid color bands by smoothing. Evening skies or moon rings are good candidates for this 
option.

• Gamma Correction: Allows Bryce to compensate for some of the shortcomings of computer 
displays. Your images will be brighter and contain colors that are more true to nature. For many 
images, however, Gamma Correction will more than likely wash out your image more than you 
like, so if the image seems faded or washed out, turn off Gamma Correction and re-render. 

To set post-processing options: 
1. Either click the triangle icon next to the Render Controls and click the desired post-processing 

option 

OR 
2. Click the triangle icon next to the Render Controls and choose Render Options from the menu, 

and  

©2003-2011 DAZ 3D, Inc. 415



Bryce 7 Artist Guide 03 Jan 2011

3. Enable the desired post-processing options from the Render Options dialog. 

Render Reporting 

This option, when selected, produces a summary report when your image is finished rendering. 
The report tells you how long the render took, including the anti-aliasing pass. It also provides statistics on 
how many rays were shot to create the image and breakdowns for the different types of rays, including a 
per-pixel breakdown. 
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To produce a render report, do one of the following:
1. Click the triangle beside the Render Controls and choose Report Render Time. 

OR
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2. Choose File > Document Setup and enable Report Render Time in the dialog.

3. Once you have selected to report the render time, start your render. At the completion of the 
render, you will hear a short beep and the render report will be visible in the working window. 

4. Close the report by clicking on the OK icon. 

Projection Types

Projection Types 

There are two projection types available in Bryce: 
Perspective Projections: Renders a fully ray-traced color image, based on your current camera's position 
and view. 
360° Panorama Projection: Produces an image that looks as if your camera has a 360° lens. The left and 
right edges of the resulting image join seamlessly. 360° Panorama Projection is intended for use with the 
Bryce 360° scrolling screensaver, or QuickTime™ VR technology.

Perspective Projection 

Perspective Projection is the default rendering mode for Bryce. Unless you are rendering a panoramic 
image, this option should be selected. 
To select Perspective Projection from the Render Options menu: 
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• Click the triangle beside the Render Controls and select the Perspective Projection. 

To select Perspective Projection using the Render Options dialog: 
1. Click the triangle beside the Render Controls and select Render Options. 
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2. Select the Perspective Projection mode. 

3. Click on the OK icon to exit the dialog.  

360° Panorama Projection 

Rendered 360° images will have little resemblance to the wireframe, working window, behind it; this 
makes flipping back and forth between wireframe and bitmap modes during composition difficult. For this 
reason, it is recommended that you work in standard Perspective Render mode as you compose your 
image. 
For a good 360° panoramic image, you need a natural distribution of objects on all sides of the camera. 
To render a QuickTime VR Panorama, see "Creating Quicktime VR Panoramas."
To prepare a 360° panoramic render: 

1. While in Perspective Render mode, switch to the Top view using the View Controls and position 
objects around the camera. 

2. Display the Document Setup dialog using File > Document Setup and either select the Panorama 
preset aspect ratio or type in the dimensions that you want.
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3. The image below shows the dimensions for the default Panorama render: 

4. Do a quick test render in Perspective Render mode to check composition. Render from different 
views as needed.
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5. The horizon should be level at the vertical midpoint of your window. If it is not, double-click the 
Trackball, enter "0" in the Rotate X field and exit the dialog. 

6. Adjust your camera position and Y-rotation as needed. 
7. When you are ready to render, click on the triangle next to the Render Controls and choose 360 

Panoramic Projection from the menu. 
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OR 
8. You can also select the panoramic render by clicking the triangle beside the Render Controls and 

selecting Render Options. 
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9. In the Render Options dialog, click on the button next to 360 Panorama Projection. Note that 
when this option is selected, the mask options are not available. 

10. Click on the OK icon to close the dialog. 
11. Render the scene, and when the render is complete, save the image. 

Creating QuickTime VR Panoramas 

QuickTime VR allows you to take a 360° panoramic image, and make it into a VR Movie; this unique 
movie will display a 2D panoramic representation of your 3D world, and allow point and click navigation 
through the world. You can look up, down and around your rendered scene as though you were a camera 
on a tripod. 
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Further, QuickTime VR lets you create "Nodes," or hotspots in the movie where you can click and go to 
another linked movie. This means you can look around a landscape, and seeing an interesting rock 
formation in the distance, click on it to view the entire landscape from that new vantage point. 
These nodes can also contain "Object Movies;" another specialized technology from Apple that allows 
you to click and drag to, in effect, "pick up" any object in the VR movie and examine it from all sides, as if 
you literally picked it up and turned it around and around in your hands. 
The process of creating a panorama involves completing a few easy steps. 
To create QuickTime VR Panoramas: 

1. Choose Default in the Document Setup dialog. 
2. Click on the uppermost Views Memory Dot in the control palette, to make sure your camera is 

level.  
3. Set up your scene. The important thing to remember is that for a successful 360° scene, you 

need interesting objects all around your camera. The best way to work on this is to go to the Top 
View, and position objects all the way around the camera. 

4. Keep the Nano-Preview in Camera View mode to check your view while you are working in Top 
View. 

5. Drag the tip of the camera around in the Working window to check the view of your scene from all 
directions.  

6. Once you have a good distribution of objects in a visually interesting scene, switch back to 
Camera View and do a quick test render.  

7. After the render, make any required position changes. 
8. Choose File > Document Setup and select QTVR Panorama. This aspect ratio is optimized for 

use with Apple's Make QTVR Panorama tool, though many aspects will work. The preferred 
aspect is 13: Width must be divisible by 96, and height must be divisible by The QTVR Panorama 
option ensures that your image meets these criteria. 

9. Click the triangle icon next to the Render Controls and choose 360° Panorama from the menu. 
10. Click the Render button to do a quick test render. The panoramic render mode necessarily 

introduces some distortion into your image, and this may change the way you want your objects 
to appear.

11. Make any position changes you like. When you do a panoramic render, your wireframe scene will 
bear little resemblance to the rendered scene. This is why you should work on your scene in 
standard Default mode and switch to Panoramic rendering after everything is set up. 

12. Choose File > Render To Disk. The Render to Disk dialog appears.  
13. Leave the default settings. The Output Size in Pixels was set by the QTVR Panorama option in 

the Document Setup dialog. The Print Resolution defaults to 72dpi, which is the only acceptable 
setting for the screen-resolution VR movies; and the Output Size in Inches is extra information. 
However, you can use these features to your benefit if you need to print out a 2D version of your 
VR scene.

14. Click the OK icon. 
15. In the Save dialog, choose QuickTime VR, then click the Save button. 
16. Specify the location and file name for your rendered QuickTime VR panorama.  

To export a QuickTime VR Panorama: 
1. Follow the steps above through step 11. 
2. Click the Render button if you made any changes after your test render.  
3. When the rendering is done, choose File > Export Image and choose QuickTime VR from the list. 
4. Specify a location for the saved panorama, then click Save. 

Further VR Exploration 
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This is a quick way to get started with simple, single-node QTVR movie-making. To create movies with 
other embedded nodes, or to get deeper into the world of QuickTime VR, contact Apple Computer. 

Masking Modes

Masking Modes 

Bryce offers several rendering modes that can be used to create different effects. For example, the Mask 
Render Mode lets you produce an image that can be used as an Alpha Channel in other graphics 
applications.
To choose a mask mode, either click the triangle icon next to the Render Controls and choose a mask 
mode from the menu or click the triangle icon next to the Render Controls, click Edit Rendering, and 
choose a mask mode from the Render Options dialog. 
There are three different kinds of Mask Render Modes for rendering available in Bryce: 

• Object Mask 
• Distance Mask 
• Altitude Mask 

Object Mask 

In Object Mask mode, Bryce renders any selected objects as anti-aliased white shapes against a black 
background. You can use the resulting image as a mask or alpha channel in other 2D image editing 
programs. 
To render an object mask: 

1. Render the scene by rendering to screen or disk or as an animation.
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2. Select the object(s) or group(s) you want to mask out of the scene.

3. Click on the Render Options triangle next to the Render Controls and choose Object Mask from 
the menu.

Alternately, you can select the Object Mask option from the Render Options dialog. 
• Click on the Render Options triangle next to the Render Controls and choose Render 

Options from the menu. The Render Options dialog will come up.  
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• Enable the Object Mask option under Projection & Masking.

4. Render the scene. The selected object(s) or group(s) will render as white, with the non-selected 
objects and rest of the scene rendering as black. 

5. Save the mask render to disk.  
6. Open the original Perspective render and the mask render in your favorite paint program. 
7. Consult the Help file for the paint program on creating Alpha Channels from images and apply the 

mask as an alpha channel in the Perspective render.
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Invert the alpha channel if needed.

8. Once the mask has been applied as an Alpha Channel, modify the image as needed using the 
image and mask layers to select which sections to modify. 
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The final example image: 

Distance Mask 

This mode results in a grayscale image, with objects represented in shades of gray based upon their 
distance from the camera. Nearby objects are black, distant objects are white, and objects in between are 
progressive shades of gray. You can use the Distance Mask image to produce depth-of-field effects using 
a 2D graphics application.
This mode can be used to create several distance effects.
Distance Mask Render mode produces an image that can be used as a distance mask in most image-
editing applications. The Distance Render image contains grayscale representations of all the images in 
your scene. Objects closer to the camera appear black, while those furthest away appear white. The 
objects in between are various shades of gray depending on their distance from the camera.
This grayscale information can be used to create photographic depth of field effects. For example, if you 
take an image that has a lighthouse in the foreground and a fishing village in the background and render it 
using Distance Mask Render mode, you can take the image into Photoshop and create an image where 
the lighthouse is in sharp focus while the village is blurred.
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Do this by rendering the image as distance mask, using Distance Mask Render mode, and then using an 
image editing application to place the distance mask into the original image's alpha channel. Once the 
Distance Render is in the alpha channel, you can apply filters to create photographic depth of field.
To render a scene as a distance mask:

1. Render the scene by rendering to screen or disk or as an animation.

2. Click on the Render Options triangle next to the Render Controls and choose Distance Mask from 
the menu. 

Alternately, you can select the Altitude Mask option from the Render Options dialog. 
• Click on the Render Options triangle next to the Render Controls and choose Render 

Options from the menu. The Render Options dialog will come up.
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• Enable the Distance Mask option under Projection & Masking.

3. Render the scene. The scene will render in grayscale.

4. Consult the Help file for the paint program on creating Alpha Channels from images and apply the 
mask as an alpha channel in the Perspective render. You can also place the mask render in a 
new layer. Apply a Gaussian filter to the mask layer/channel and adjust the transparency if 
needed.
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Objects close to you will appear sharp while objects farther away will become progressively more out of 
focus. 
You can also invert the selection and apply Motion Blur to the image. In this case, objects in the 
foreground would be motion blurred, and the background would be sharp, as if you took a Picture from a 
moving car. 
You could determine very specifically which objects in your scene are in focus and which are not. Select 
the Distance Rendered alpha channel and remap the gray values in the Curves dialog in Photoshop. 
Remap black input to lighter output and the gray value of the desired focal object to black. 

Altitude Mask 

This mode results in a grayscale image, with objects represented in shades of gray based upon their 
height. You can use Altitude Mask images in the same way you can use Distance Mask images to create 
special effects in other applications. 
To render a distance mask: 

1. Render the scene by rendering to screen or disk or as an animation.

2. Click on the Render Options triangle next to the Render Controls and choose Altitude Mask from 
the menu. 
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Alternately, you can select the Altitude Mask option from the Render Options dialog. 
• Click on the Render Options triangle next to the Render Controls and choose Render 

Options from the menu. The Render Options dialog will come up.
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• Enable the Altitude Mask option under Projection & Masking.

3. Render the scene. The scene will render in grayscale.

4. Open the original Perspective render and Altitude render mask in your favorite paint program.
5. Consult the Help file for the paint program on creating Alpha Channels from images and apply the 

mask as an alpha channel in the Perspective render. You can also place the mask render in a 
new layer. Apply a Gaussian filter to the mask layer/channel and adjust the transparency if 
needed.

=

Optics Options

Optics Options 
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Bryce includes a number of Optics options that can help increase the realism of a rendered scene. While 
these options can be used by themselves, most of them work best when used with the other options 
enabled. 
The Optics options include: 

• Reflections
• Transmissions
• Refractions
• Shadows
• Maximum Ray Depth
• Total Internal Reflection

Examples of how the options work together: 
• Refractions only: 

• Transmissions only:

T
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• Reflections + Transmissions:

• Reflections + Transmissions + Refractions: 

• Reflections + Transmissions + Refractions + TIR:

Reflections
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Reflections 
Reflections let you choose whether to render reflections in a scene or not. Reflections are necessary for 
natural reflections in windows and metallic objects (like mirrors).  
The Maximum Ray Depth setting controls the number of reflections rendered.
To enable or disable Reflections: 

1. Click the triangle icon next to the Render Controls and select Render Options. 

2. Click on the Reflections option to enable or disable it. When a checkmark appears beside the 
option, it is enabled. When there is no checkmark, the option is off. 

3. Enable Shadows and set the Maximum Ray Depth. 

4. Click on the OK icon to accept the changes. 
5. Render the scene. 
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Examples: 
• Reflections Disabled: 

• Reflections Enabled: 

Total Internal Reflection 
Total Internal Reflection (TIR) lets you control the amount of TIR in a scene. When you have reflective 
objects such as prisms or mirrors in a scene, you can encounter situations where light rays bounce back 
and forth an infinite number of times within the object or between two objects. By limiting the TIR depth, 
you can produce realistic scenes that include a certain amount of TIR. This lets you avoid creating an 
infinite number of internal reflections, thus speeding up the rendering time. 
To enable or disable Total Internal Reflection: 
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1. Click the triangle icon next to the Render Controls and select Render Options. 

2. Since TIR is affected by the other Optics options, make sure they are enabled. When a 
checkmark appears beside the option, the option is enabled. When there is no checkmark, the 
option is off.

3. Click on the Total Internal Reflection (TIR) option to enable it. 
4. Type a value in the Maximum TIR Depth field or leave it at the default setting of 2.

5. Click on the OK icon to accept the changes.  
6. Render the scene. 

For a good explanation of TIR, go to Robin Wood's site, click on Tutorials and select General 3D from the 
list. In addition, Robin has a "Refraction Index of Various Substances for 3D modelers." Another site with 
a nice listing of refraction indices is 3D Lapidary where you can also download 3D models of gemstones 
in a variety of cuts (one of which is used in the examples below). 
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Examples: 
• TIR = 4  

• TIR = 8  

• TIR = 12 
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Transmissions 

Transmissions let you choose whether to render light transmissions in a scene. For transparent objects 
with a light source behind them, you must render transmissions for light to shine through the objects. 
The Maximum Ray Depth setting controls the number of reflections rendered.
To enable or disable Transmissions:

1. Click the triangle icon next to the Render Controls and select Render Options.

2. Click on the Transmissions option to enable or disable it. When a checkmark appears beside the 
option, it is enabled. When there is no checkmark, the option is off. 

3. Enable Shadows and set the Maximum Ray Depth. 
4. Click on the OK icon to accept the changes. 
5. Render the scene. 

Examples: 
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• Transmissions Disabled:  

• Transmissions Enabled:  

Refractions 

Refractions let you choose whether to render light refractions in a scene. When light is bent by an object, 
such as a prism or a glass of water, you can see distorted views of the environment behind or to the side 
of the object due to the refraction of light. For Bryce to render these refractions, you must enable this 
option. 
To enable or disable Refractions: 
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1. Click the triangle icon next to the Render Controls and select Render Options. 

2. Click on the Refractions option to enable or disable it. When a checkmark appears beside the 
option, it is enabled. When there is no checkmark, the option is off. 

3. Click on the OK icon to accept the changes. 
Render the scene. 
Examples: 

• Refractions Disabled: 
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• Refractions Enabled, without and with an object behind:

Shadows

Shadows 
Shadows lets you choose whether to render shadows in a scene. Enabling Shadows also enables the 
Maximum Ray Depth setting. 
To enable or disable Shadows: 
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1. Click the triangle icon next to the Render Controls and select Render Options. 

2. Click on the Shadows option to enable or disable it. When a checkmark appears beside the 
option, it is enabled. When there is no checkmark, the option is off. 

3. If needed, adjust the Maximum Ray Depth to control Reflections and/or Transmissions. 
4. Click on the OK icon to accept the changes. 
5. Render the scene. 

Examples: 
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• Shadows Disabled: 

• Shadows Enabled: 

Maximum Ray Depth 
Maximum Ray Depth lets you control the depth of rays during rendering. For example, if you place a 
series of transparent objects one in front of the other, the Maximum Ray Depth setting determines how 
many of these objects the light will pass through (transmissions). This setting also determines the number 
of times Bryce renders reflective "bounces" (reflections).  
To enable or disable Maximum Ray Depth: 

©2003-2011 DAZ 3D, Inc. 447



Bryce 7 Artist Guide 03 Jan 2011

1. Click the triangle icon next to the Render Controls and select Render Options. 

2. Click on the Shadows option to enable or disable it. When a checkmark appears beside the 
option, it is enabled. When there is no checkmark, the option is off. 

3. Enter a number in the Maximum Ray Depth field. Enter 0 in the field to disable Maximum Ray 
Depth. 

4. Click on the OK icon to accept the changes. 
5. Render the scene. See the following two pages for examples of using Maximum Ray Depth.

• Maximum Ray Depth and Reflections
• Maximum Ray Depth and Transmissions

Maximum Ray Depth and Reflections 
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Reflections are controlled by the material reflection setting and by the Maximum Ray Depth setting. Prior 
to Bryce 5, reflections were limited to six levels and this could not be lowered or raised. Bryce 5 
introduced the Maximum Ray Depth setting, which allows you to determine how many levels of reflection 
are rendered. Just remember when using this feature that the more levels of reflection you select, the 
more the render times are increased.  
The examples below use two "mirrors" set opposite each other with two spheres placed between the 
mirrors.  

For simplicity, "MRD" will be used instead of "Maximum Ray Depth." 
• With the MRD set to 4, Bryce renders four levels of reflection. The fifth level is not rendered and 

shows as black. 
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• With the MRD set to 6 (the default), Bryce renders six levels of reflection.

• With the MRD set to 15, we get fifteen levels.

• In addition, with the MRD set to 30, thirty levels are rendered...and so on. 

Maximum Ray Depth and Transmissions 
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Transmissions are controlled by the Maximum Ray Depth setting, which determines how far light travels 
through transparent objects. The levels rendered include each side of the object. So, if you use a cube, 
remember that it has two sides for transmissions to go through. If you use a 2D Face, only one side is 
used for transmissions. 
Just remember, when using this feature that the more levels of transmission you select, the more render 
times are increased. 
The examples below use five thin cubes placed one behind the other (remember, two sides per cube). 
For brevity's sake, "MRD" will be used instead of "Maximum Ray Depth." 

• With the MRD set to 5, Bryce renders five levels of transmission. Since the cubes have two sides, 
light only goes through the first two cubes and half of the third cube. The levels behind that render 
black. The edges of the cubes show the same levels of transmission depending on their 
placement. 

• With the MRD set to 8, you can see clearly through four complete cubes.
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• With the MRD set to 10, you can see clearly through all five cubes.

Document Setup 

The menu commands at the end of the Render Options menu are quick ways to resize your document. 
Values shown are expressed in pixels and are for customizing the size and aspect of your document and 
the resulting render.
The render resolution options control the resolution of your final image. These options do not affect the 
resolution of your working document; they affect only the final rendered image.
To choose a document size, click the triangle icon beside the Render Controls and choose a document 
size from the bottom of the menu.
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Render Resolution

To choose a render resolution:
1. Double-click any of the Render controls or choose File > Document Setup from the menu. 

2. Click one of the render resolutions at the bottom of the dialog. The selected resolution appears 
highlighted. 
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3. Click the OK icon. 

Batch Rendering 

Batch Rendering lets you render a number of files at the same time. This way, instead of rendering each 
scene as you create it, you can set up a number of scenes, save them, and then render them all at once 
at a convenient time.
To perform a batch render: 

1. Save a number of scenes to a folder, and then select the files. 
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2. Drag all the files to the Bryce application.

Bryce opens each file, renders it, saves it, and then opens and renders the next file. You can render any 
number of files this way. 
Mac users: Currently, Mac Bryce scene files must have the .BR7 extension (must be in all caps) in order 
for batch rendering to work correctly. If the files do not have the extension, Bryce 7 will render the default 
scene for the first queued scene file, then render the remaining scenes correctly. You must add the .BR7 
extension in the folder where the files are saved, not when saving the scene file. 

Patch Rendering 

Using the Plop-Render mode, you can do a patch render of image. Patch rendering involves the 
rendering of background and flat elements using normal rendering and then using the Plop-Render 
controls to render areas that contain more complex elements. 
There are two things you should remember when using patch rendering: 

1. Make sure you use the Clear and Render button when you make changes to a partially rendered 
image.

2. If you stop a rendering, make changes and then click Resume Render, you will end up with noise 
instead of an image.

If you change elements that do not affect a large area of your scene, you do not have to render the entire 
scene again. For example, if you render a scene with a floating sphere and then delete the sphere, you 
do not need to re-render the scene, only the area where the sphere was. 
To patch render your image:

1. Start a render as normal.
2. Let the rendering proceed for two or three passes and then click the mouse. 
3. Switch to Bitmap display mode.  
4. Drag a marquee around key portions of your scene and then render those areas using the Plop-

Render controls.
See "Plop Render On/Off" for more on using this option.

Speeding Up Renders 
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There are several techniques used to speed up the rendering process. These techniques are most useful 
when rendering animations, where you may have a large number of images to render.
You can greatly increase the speed of a render just by using the Preview Render modes. Here are the 
percentages of time it takes to a render a scene, containing complex materials and lights, using normal 
and preview modes.  

• Normal Render: 100% Fast Render: 41.7% Textures Off: 35.4%
• Fast Render w/Textures Off: 8.3%
• Fast, Textures Off, anti-aliasing Off: 2.1%

You can also speed up rendering using these techniques: 
• Limit the number of lights.
• Keep background objects simple.
• Limit the number of volume materials you apply.
• Limit the number of transparent and reflective objects.
• Limit the number of frames per second to 15 for QuickTime movies.
• Divide animations into smaller files and eliminate objects that will not be seen in the rendered 

frames.
• Turn off anti-aliasing when previewing animations.
• Group objects near each other to lessen how many objects Bryce has to calculate.

Text Display Area 

The area just below the Render Controls is reserved for momentary display of text information. When you 
pass your pointer over interface elements, this area displays the name of the interface element, and in 
some cases, it also displays the element's current settings. The Text Display Area also displays 
information about the total number of polygons in an object or a scene and information about current 
control settings. 
To display information about the interface: 

• Pass the pointer over any interface element.

The name of the element is displayed. In some cases, the element's current settings are also 
displayed. 

To display statistics about the objects in your scene: 
1. Switch to Wireframe display using the Display Mode tool. 
2. Pass the pointer over the Working window.  

• If no objects are selected, the Text Display Area displays a count of all of the objects in 
your scene, as well as a total polygon count.
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• If an object is selected, the Text Display Area displays object and polygon counts for the 
selected object. 

To display information about rendered images: 
1. Switch to Bitmap display using the Display Mode tool. If you have not rendered your image, the 

Working window is blank. 
2. Pass the pointer over the Working window. The Text Display Area shows the scene filename and 

image pixel size.
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Libraries
Libraries

Bryce contains several preset libraries where you can store objects, materials, skies, terrain brushes, and 
textures. The next several pages show how to add and delete presets, set up the preview, add and delete 
categories, and add presets to your scenes. 
New in Bryce 6 are the following for preset libraries: 

• Thumbnail preview sections expanded so more previews can be seen 
• Titles and descriptions can now contain more information
• Ability to add and delete preset categories from within the library 
• Sky Library now allows for multiple categories  
• Each category can now have more than 14 sub-categories

Types of Libraries:
• Pictures Editor
• Preset Libraries

Pictures Editor

Pictures Editor
The Pictures Editor in Bryce, also known as the Pictures Library, stores all the images available in Bryce 
and can be used to catalog Pictures. You can store and import any number of Pictures in the library that 
your system memory and disk space will allow.
The Pictures Editor has three, square previews at the top of the window. These three previews represent 
one image three different ways. The left image is the RGB information of the image, the middle one is the 
alpha channel, the right one is the combined image.
You can apply filters to each of the three parts independently, load new images, copy, and paste between 
the previews, save a Picture list, rename images, and delete images.
There are several ways of accessing the Picture Library. The method you use depends on how you are 
going to use the image.
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• Accessing the Pictures Editor
• Previewing Pictures
• Picture Thumbnails
• Loading Pictures into the Editor
• Copying/Pasting Pictures
• Deleting Pictures
• Renaming Pictures
• Inverting the Alpha Channel
• Selecting a Plug-In Folder
• Picture Lists

Accessing the Pictures Editor
Accessing the Pictures Editor

The Pictures Editor can be accessed from the following locations:
• The Objects Menu
• The Create Palette
• The Materials Lab
•  The Light Lab
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• The Tree Lab

From the Objects Menu

In the Objects menu, the Edit 2d Pictures command brings up the Pictures Library.
• To open the Pictures Library, choose Objects > Edit 2D Pictures from the menu or press 

Ctrl+Opt/Alt+M.

From the Create Palette

To access the Pictures Editor from the Create Palette:
1. Make sure the Create palette is visible. If it is not, click the Create button at the top of the Bryce 

window.

2. Click on the Picture Object tool (Leo object). The Pictures Editor will come up.

From the Materials Lab

To access the Pictures Editor from the Materials Lab:
1. Select an object.
2. Click on the  button next to the selected object. The Materials Lab will come up.
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3. In the Materials Lab, click on one of the columns in the grid to activate a component window:

4. In the component window, click on the P button in the bottom-left corner. The default moon 
texture appears in the window:

5. Click the Pink button at the top of the window, the Pictures Editor comes up.

From the Light Lab

To access the Pictures Editor from the Light Lab:
1. Select a light source.
2. Click the  button next to the selected light source. The Light Lab will come up.
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3. Click the radio button next to Use Gel, the Image and Procedural buttons will activate.

4. Click on the Image button. The Pictures Editor comes up.

From the Tree Lab

You can use a uniform color, an image, or a material as the texture for leaves of a tree. All the leaves will 
have the same texture; you cannot vary the texture of leaves.
To use an image texture:

1. Click the Image button at the bottom of the Branch/Trunk or Foliage section.

2. Click the Edit button to the right of the Image button. The Pictures Editor appears.
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Previewing Pictures
Previewing Pictures

The three most prominent items at the top of the library are the RGB Image (left), Alpha (middle), and 
Combined (right) preview windows. The first window displays the current Picture, the second window 
displays the alpha channel associated with the Picture, and the third displays the resulting Picture after 
the alpha channel has been combined with the Picture.

• Alpha Channels

Alpha Channels

Every image contains a number of channels that store data about the makeup of the Picture. For 
instance, channels can contain masks, colors, or bump information.
The Alpha Channel of an image is its second channel. The channel is like a grayscale map that 
accompanies an image used primarily as a "mask." Bryce ignores areas in the Alpha Channel that are 
black (appearing transparent) as it computes the Picture. Bryce recognizes and computes areas that are 
white (appearing opaque).
The most common use for alpha channels is to mask the contours of a 2D object, separating it from any 
unwanted background information. For instance, you may import a Picture of a dog. If you have created 
an Alpha Channel "mask" describing the area of the dog as white and the "non-dog" area as black, then 
unwanted cats and mail carriers in the original Picture's background is not seen in your rendered image. 
This example illustrates how the Alpha Channel mask (bottom) is used to eliminate the unwanted areas of 
an image.
In Bryce, Alpha Channels are used when your Picture is a component in a material. In this case, the alpha 
channel can be used to determine everything from the bumps in a material to how a surface property is 
applied on an object.
If you want to use the Picture in the library for multiple purposes, you will need to make sure that all the 
Pictures have an alpha channel.

Picture Thumbnails
Below the three preview windows are the Picture thumbnails that display a small preview of each Picture 
in the library. The gray thumbnails represent empty slots in the library. When you load images, they are 
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added to the first available gray slot. If there are a large number of Pictures in the library, you can use the 
scroll bar to scroll through all the thumbnails.
To display an image in the library, click on the Picture's thumbnail. The Picture and its associated alpha 
channel appear in the three preview windows at the top of the dialog.

Loading Pictures into the Editor
Loading Pictures Into the Library

You can load Pictures into the library to create your own custom library. Pictures can be loaded into any 
of the three preview windows. If you want to add a new Picture to the library, you need to load it into the 
last preview window, the Combined Image window.
When you load a Picture into the first window, you are loading only the Picture's RGB (Red, Green, and 
Blue) color information. The Picture loaded into the first preview window replaces the currently selected 
Picture in the library, so you are replacing a Picture in the library with the Picture you are loading. Be 
careful when replacing the RGB Image since this will replace the texture for all objects that currently use 
the same image.
When you load a Picture into the second window, you are loading only the Picture's alpha channel. The 
alpha channel determines which portions of the Picture are visible. The areas of the Picture that are 
transparent appear as a checkerboard pattern. Every Picture should have an alpha channel assigned to 
it. If the Picture does not have an alpha channel, the resulting Alpha image appears completely white.
If your Picture does not have an alpha channel, you can copy the image from the RGB Image window into 
the Alpha Channel window. This way your Picture will not appear completely opaque.
The Alpha channel you load does not have to necessarily match the image. You can create some 
interesting clipping effects by combining different alpha channels and images.

• Load New Picture
• Replace Picture
• Replace Alpha Channel

Load New Picture

To load a new Picture into the Library:
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1. Click an empty Picture slot in the bottom of the library where you want to load the new Picture. 
The Load dialog appears.

2. Use the dialog controls to locate the desired image and click Open.

3. The Picture's thumbnail appears in the Picture slot and the image and any alpha channel are 
loaded in the RGB Image and Alpha Channel windows.

Replace Picture

To replace the RGB information in a Picture:
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1. Click the thumbnail of the Picture you want to replace.

2. Click the Load button on top of the RGB Image window. The Load dialog appears.

3. Use the dialog controls to locate the desired image and click Open.

4. The Picture appears in the first preview window.

©2003-2011 DAZ 3D, Inc. 466



Bryce 7 Artist Guide 03 Jan 2011

Note: Replacing images over a previous image will not load any alpha channel layers. To load the 
alpha channel, load the replacement image into a new slot.

Replace Alpha Channel

To replace the Alpha channel information in a Picture: 
1. Click the thumbnail of the Picture you want to replace.

2. Click the Load button on top of the Alpha Channel window. The Load dialog appears.

3. Use the dialog controls to locate the desired image and click Load. The Picture's Alpha Channel 
appears in the second preview window.
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Copying & Pasting Pictures
Copying and pasting in the Pictures Editor works differently for each of the three image windows.
When you copy and paste into the first window, you are pasting only RGB color information, so if you 
copy an image from the Combined window, only the color information is pasted into the RGB window. As 
with loading, any changes you make in the RGB Image window affects the selected image.
When you copy and paste into the second window, you are working with only the Alpha Channel 
information, so any image you paste into this window will appear as an alpha channel image (that is, 
black and white). Any changes you make in this window affect only the selected image.
When you copy an image from the Combined window the entire image is placed on the clipboard. 
Depending on where you paste it, only a portion of the image may be used.
When you paste a Picture into the Combined window, it appears as a color image with transparent and 
solid areas. All Pictures are treated as color. So if you paste a Picture copied from the Alpha Channel 
window in this window, you will get an RGB representation of the alpha channel image. As well, any 
image pasted into this window creates a new Picture entry in the library.
To copy and paste RGB information in a Picture:

1. Click the Copy button below the RGB Image window.
2. Click the Paste button below the window where you want the RGB image to appear.

• If you paste the image into the Alpha Channel window,  it is desaturated and used as an 
alpha channel.

• If you paste it into the Combined Image window,  the RGB image becomes a new entry in 
the library. 

To copy and paste Alpha Channel information in a Picture: 
1. Click the Copy button below the Alpha Channel window. 
2. Click the Paste button below the window where you want the Alpha Channel information to 

appear.
 If you paste  the image into the RGB Image window, an RGB representation of the alpha 

channel is placed in the window.
 If you paste  it into the Combined Image window, an RGB representation of the alpha 

channel is placed in an empty slot in the library. 
To create a new Picture using RGB color information only: 

1. Click the Copy button below the RGB Image window. 
2. Click the Paste button below the Combined window. The RGB information is placed in an empty 

slot in the library. 
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To create a new Picture using Alpha channel information only: 
1. Click the Copy button below the Alpha Channel window. 
2. Click the Paste button below the Combined window. The alpha channel information is placed in 

an empty slot in the library.

Deleting Pictures
When you delete a Picture, you remove all the image information (including color and alpha channel) from 
the library.
To delete a Picture from the library:

1. Click the thumbnail for the Picture you want to delete.

2. Click the Delete button.

3. To delete all Pictures from the library, click Delete All.

Note: You cannot select more than one thumbnail at a time in the Pictures Editor.

Renaming Pictures
To rename an image:

1. Click the thumbnail of the image you want to rename.
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2. Click the Rename button.

3. The Rename Picture dialog will come up.

4. Type a new name for the image into the field and click on the OK icon.

5. Move the mouse over the image thumbnail and the new name will show up in the bottom left-
hand corner of the Pictures Editor.

Inverting the Alpha Channel
When you invert an alpha channel all the black areas become white and the white areas become black. 
This means that all the areas that were transparent now become solid and vice versa.
To invert an alpha channel, click the Invert button above the Alpha Channel window.
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Result:

Selecting a Plug-In Folder
You can apply filters to each of the three parts independently.
How to select a plug-in folder:

1. Click on the triangle to the right of the desired preview type. If a plug-ins folder has been 
previously selected, a pull-down menu appears that displays the available Photoshop filters. 

If, for some reason, the Photoshop filters cannot be found, or you wish to select a new plug-ins 
folder, choose Select Plug-ins Folder at the bottom of the menu.
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2. Select a folder for the plug-in and click on OK.

Picture Lists
A Picture List is a file that contains a group of Pictures. A Picture List can be used to store all the Pictures 
used in a given scene, or to store a series of
Pictures you use most often. You should also use a Picture list to store any Pictures you have used as 
part of a material.
To open a Picture list:

1. Click the Open List button at the bottom of the Picture Library. The Open dialog appears.
2. Use the dialog controls to locate the desired list and click Open. The Pictures in the list appear in 

the library.
3. To save a Picture list:
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4. Click the Save List button at the bottom of the Picture Library. The Save dialog appears.

5. Enter a name for the list and click Save. 

Name the list the same as the scene. This way, you can easily find the list that belongs to a 
specific scene.

Preset Libraries

Preset Libraries
In Bryce, the libraries provide quick access to objects, materials, textures, Pictures, brushes, and skies 
that can be added to the scene.
Bryce comes with two preset category folders in each library: Installed and User. The Installed preset 
category folder contains the presets that are installed with Bryce. The User preset category folder is 
empty by default.
Each preset category folder can contain as many preset categories as you want and each preset category 
can contain a virtually unlimited number of presets - at least as much as your computer can handle that is. 
You can also create additional preset category folders and preset categories to suit your needs.
In Bryce 6, the libraries were expanded to show more presets. This also allowed the preset titles and 
descriptions to contain more information, however, older presets copied into the preset libraries will still 
have the shorter titles and descriptions. See the issue in appendix c for more on this
All the libraries can be added to, deleted from, imported into, or exported out of in the same way. What 
differs is what is or is not selected and what gets added to the library.

• The Objects Library contains all the preset objects distributed with Bryce as well as presets you 
add. Objects in the library are either 3D models or geometric paths. Objects added to the library 
include any applied materials and textures. 

• The Materials Library contains all the material presets available in Bryce. 
• The Textures Library contains procedural 3D textures generated by Bryce in the Deep Texture 

Editor. 
• The Skies Library contains all the preset skies available in Bryce. You can apply them to your 

scene and edit them just as you would another sky.  
• The Brush Library contains all the brushes available for use in the Terrain Editor. 
• The Pictures Editor contains the current imported textures for use in the scene.

Using the Preset Libraries:
• Working with Categories & Presets
• Thumbnail Preview Options
• Using Presets

Working with Categories & Presets
Working with Categories & Presets
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Each library contains categories for presets with each category containing sub-categories which hold the 
actual presets.
Each library can contain as many categories as you want, each category can contain as many sub-
categories as you want, and each sub-category can contain as many presets as you want. The only limit 
is what your computer can handle. 
That being said, if sub-category gets too large and something happens, that sub-category could become 
corrupted and you will lose all the presets in that sub-category. So, a periodic backup of all preset 
categories might be a good thing to do.

• Changing Preset Category Folders
• Adding Categories
• Deleting Categories
• Adding Presets
• Deleting Presets
• Exporting Presets
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Changing Preset Category Folders

To change to a different preset category folder:
Open any of the Preset Libraries.

1. Click the triangle icon next to the preset category folder name at the bottom left of the Preset 
Library and choose a preset category folder from the drop-down menu.

2. The library opens that preset category folder and displays the categories and presets found in 
that folder. Click on any sub-category to access the presets stored there.

Adding Categories

Adding Categories

Bryce 6 adds the ability to add or delete sub-categories from within the libraries themselves. Of course, 
categories and sub-categories can also be added and deleted from within the directory folders 
themselves
As you add new categories, the category listing will continue to grow. Fourteen categories can be seen in 
the listing so if there are more than 14 categories, a scroll bar will be added to the listing allowing you to 
scroll up and down within the listing.
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There are three ways to add new categories to the libraries:
• By creating a new category inside a library
• By exporting presets out to a new category
• By creating new folders inside the Preset folder

Inside a Library

To add a preset category to the Preset Libraries from within the library:
1. Open any of the libraries.
2. Open the main category (i.e., Installed, User, etc.) to add the new preset category to.

3. Click on the plus sign (+) just above the category triangle:
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4. The Add Category dialog will come up, enter the new category name in the field:

5. The new category will be created, ready for new objects, materials, brushes, skies, or textures:

By Exporting

To add a preset category by exporting presets:
1. Open any Preset Library.
2. Select any preset object or multiple objects.
3. Click the Export button at the bottom of the dialog. The save file dialog appears.

4. Change directories to the category folder you want to add the new preset category to, enter a 
name for the file, and click Save. The file will be saved to the location you selected.
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5. Back in Bryce, the new preset category will now be in the selected category folder, ready for new 
presets to be added to.

Inside a Preset Folder

To add a preset category folder to any library:
1. Navigate to the folder where Bryce is installed.
2. Open the Presets folder.
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3. Open the preset folder where you want to add a new library category.

4. Create a new folder and give it a name.

5. In Bryce, open the library and click on the triangle next to the current category name at the 
bottom left of the library window. The new category will now be in the list.

6. Select the new category to open it, you can now add new presets to the category or create new 
sub-categories.
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7. If you go back into the library folder, you will see a preset file with the same name as the 
category. You can rename the file, duplicate it to create new sub-categories, or even delete them 
from the folder.

Deleting Categories

Deleting Categories

Bryce 6 adds the ability to add or delete sub-categories from within the libraries themselves. Of course, 
categories and sub-categories can also be added and deleted from within the directory folders 
themselves.

• Deleting Categories Inside a Library
• Deleting Categories Inside a Preset Folder

Inside a Library
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To delete a preset category folder from within any library:
1. Open any of the libraries.
2. Select the main category where you want to delete a preset category from.

3. Click on the minus sign (-) just above the category triangle:

4. The Confirm dialog will come up, choose Delete to remove the category from the library or Cancel 
to leave it in.

5. The category will be completely removed from the main category.

Inside a Preset Folder

Inside a Preset Folder

Both category folders and sub-category files (.mat, .obp, etc.) can be deleted from within the preset 
folders.
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• Deleting a Category Folder
• Deleting a Sub-Category File

Deleting a Category Folder

To delete a preset category folder from any library:
1. Navigate to the folder where Bryce is installed.
2. Open the Presets folder.
3. Open the preset folder where you want to delete a library category.

4. Select the category folder you want to delete and cut/delete it from the folder. When you return to 
Bryce, the category will be gone.

Deleting a Sub-Category File

To delete a preset sub-category from any library:
1. Navigate to the folder where Bryce is installed.
2. Open the Presets folder.
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3. Open the preset folder where you want to delete a library category.

4. Open the category folder containing the sub-category you want to delete.
5. Select the category you want to delete and cut/delete it from the folder. When you return to Bryce, 

the category will be gone.

Adding Presets

Adding Presets

You can add presets to any library by either clicking on the Add button or importing new presets.
• Adding Presets to the Objects Library
• Adding Presets to the Materials Library
• Adding Presets to the Skies Library
• Adding Presets to the Textures Library
• Adding Presets to the Brushes Library
• Importing Presets into any Library

Objects

You can add preset objects to the Object Presets Library. The Objects Library retains all Boolean, 
grouping, and textural properties of the objects placed within it.
When adding an object or group to the library, keep the following in mind:

• Only single primitives or groups can be added to the library. If you select more than one group, 
only the first group will be added to the library. To add both, either group them into one group or 
add them separately to the library.
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• The Perspective Camera cannot be added to the library.
• All applied materials and images are saved with the object.
• In Bryce 5 and 5.5, grouped Bryce Trees could be added to the library, but tended to crash Bryce 

when you tried to load them in the scene or import the saved OBP file. Bryce 6 has fixed this 
issue and grouped trees in the library no longer crash Bryce.

• Some Bryce 4 objects will crash Bryce 6 when the thumbnail is selected. This can only be fixed 
by importing the object into the Bryce 5/5.5 Objects Library, exporting, then importing into Bryce 
6.

To add an object preset:
1. Select the object or group in your scene that you want to add to the library.
2. Click the Triangle icon next to the Create button at the top of the Bryce window.

3. The Objects Library comes up with the selected object appears in the preview area of the Presets 
Object Library dialog.

4. Click a category name. The library switches to the category you selected. The new preset will be 
added to the category you select. 

5. Click the Triangle icon in the bottom-right corner of the thumbnail preview and choose a view 
option from the menu.

• Normal: is the default view of your selected object.  
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• Up Close: displays a close-up of your object. 

• Render With Neutral Sky: displays your object with  a flat sky, instead of the sky applied 
to your scene. When deselected, the current sky in the scene will affect the thumbnail 
preview.

6.  Set up the object location:  
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• Drag in the preview area to rotate the view of the object:

• Hold down the Spacebar and drag up, down, right,  or left to pan the object preview:

• Hold down Cmd/Ctrl and drag in the preview area  to zoom in and out of the preview:

• Press Alt and click in the preview area to reset  the preview to the default:

• Once you are happy with the preview image, click on Add to add the object
7. Once you are happy with the preview image, click the Add button at the bottom of the dialog. The 

Add Preset dialog appears.

©2003-2011 DAZ 3D, Inc. 486



Bryce 7 Artist Guide 03 Jan 2011

8. Enter a name for the new preset in the Preset Name field.
9. Enter a description of the preset in the Description field. This name and description will appear 

beneath the object preview whenever the preset is selected.

10. Click the OK icon. Your preset is added to the first available space within the current category.

Materials

To add a material preset to the Materials Presets Library along with any imported textures:
1. Select the object in your scene that has the material applied that you want to add to the library or 

click on the Edit Materials tool in the Edit Palette.

2. Click the Triangle icon next to the Edit button at the top of the Bryce window.

©2003-2011 DAZ 3D, Inc. 487



Bryce 7 Artist Guide 03 Jan 2011

3. The Materials Library comes up with the selected material in the Preview window.

4. Set up the preview of the material:
5. Click the Triangle icon in the bottom-right corner  of the thumbnail preview and choose a view 

option from the menu.
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• Normal: is the default view of your selected material. 

• Up Close: displays a close-up of your material. 

• Render With Neutral Sky: displays your object with  a flat sky, instead of the sky applied 
to your scene.

• When deselected, the current sky in the scene will affect the thumbnail preview, including 
haze and the sun's location.

• Render with Neutral Ground: displays the material  with a gray ground plane.

• When deselected, the material is applied to the ground plane as well as to the selected 
object.
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• Current Selection: displays the material on the  same object type that is selected in the 
Working window. If the current selection is an imported mesh, the thumbnail preview will 
default to a sphere.

• Actual Selection: displays the material on the  actual object selected in the Working 
window.

• Box: displays your material applied to a cube. 
• Sphere: displays your material applied to a sphere. 
• Cone: displays your material applied to a cone. 
• Cylinder: displays your material applied to a cylinder. 
• Terrain: displays your material applied to a terrain.  You might want to disable Render 

With Neutral Ground as terrain materials look better when placed on a ground plane with 
the same material.

• Ground: displays your material applied to an infinite   plane. 
• Torus: displays your material applied to a torus  object. 
• Pyramid: displays your material applied to a pyramid  object. 
• Circle: displays your material applied to a 2D circle object. 
• Square: displays your material applied to a 2D  square object.

6. Set up the preview of the object:
• Drag in the preview area to rotate the view of the material. 

• Hold down the Spacebar and drag up, down, right,  or left to pan the material preview. 

• Hold down Cmd/Ctrl and drag in the preview area to zoom in and out of the preview. 
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• Press Alt and click in the preview area to reset  the preview to the default.
7. Once you are happy with the preview image, click the Add button at the bottom of the dialog. The 

Add Preset dialog appears.

8. Enter a name for the new preset in the Preset Name field.
9. Enter a description of the preset in the Description field. This name and description will appear 

beneath the object preview whenever the preset is selected.

10. Click the OK icon. Your preset is added to the first available space within the current category.

Skies

To add a sky preset to the Sky Presets Library:
1. Create a new sky in the Sky Lab and using the Sky & Fog Palette.
2. Click the triangle icon next to the Sky & Fog text button at the top of the Bryce window

3. or click the arrow next to the preview area in the Sky Lab dialog. The Preset Skies Library 
appears.
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4. Click a category name. The library switches to the category you selected. The new preset will be 
added to the category you select. Click the Add button at the bottom of the dialog. The Add 
Preset dialog appears.

5. Enter a name for the new preset in the Preset Name field.
6. Enter a description of the preset in the Description field. This name and description will appear 

beneath the object preview whenever the preset is selected.

7. Click the OK icon. Your preset is added to the first available space within the current category.
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Textures

The Textures Library contains textures created in the Deep Texture Editor and can be used to create 
complex materials.
To add a texture preset to the Textures Library:

1. Access the Deep Texture Editor and generate a new texture.
2. Click on the Texture Library knob to the right of the Combination panel.

3. The Textures Library will come up. Select the category to save the texture to, then click on Add.

4. Enter a name and description for the texture then click on the OK icon. 
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The texture will be added to the library.

Brushes

The Brush Presets Library is new in Bryce 6 and is accessed from within the Terrain Editor. The brushes 
allow you to add frequently used shapes or special brushes to be used to paint terrains.
To add a brush preset to the Brush Presets Library:

1. In your paint program, create a new square image (i.e., 256x256, 512x512, etc.) with a black 
background. You can build a brush in color, but it will be converted to grayscale when imported 
into the Brush Library.
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2. Select a brush preset from the program or create your own image. The brush color should be set 
to white or a light gray.
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3. Save the image in one of the following formats:
• .SGI 
• .BMP 
•  .DIB  
• .EMF
•  .FPI  
• .FPX
• .GIF    
•  .JP2 
•  .JPE 
• .JPG   
• .MAC
• .PCT 
• .PSD    
•  PIC 
• .PNG   
• .PNT
• .TIF 

4. In Bryce, create a new terrain or symlat.
5. Click on the  button next to the selected terrain to enter the Terrain Editor.
6. Click on New to load a new terrain.
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7. In the Brush Palette, click on the Brush Tool.

8. The Brushes Library will open up.

9. Click on Add at the bottom of the library.
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10. The Open File dialog will come up. Locate your brush image, select it, and click on Open.

11. The brush will be imported into the library, ready to use.

12. To use the brushes, select the brush and click on the OK icon.
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13. Back in the Terrain Editor, adjust the brush size and flow as needed.

14. Paint on the Terrain Canvas or use the brush as a stamp to stamp the design on the Terrain 
Canvas.

Refer to the "Terrain Editor" section for more on working in the Terrain Editor.

Importing

Importing presets into the libraries is another way to add presets to your libraries.
To import a preset to any library:

1. Open the preset library you want to import into: Objects, Materials, Skies, Textures, or Brushes.
2. Select the category to which you want to import presets.

3. Click the Import button at the bottom of the dialog. The file Open dialog appears.
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4. Locate the file that you would like to import and click on Open.

5. The contents of the file are placed into the first available space in the current category if no object 
was selected 

or in front of any object selected when you clicked on Import:

6. Click on the OK icon to close the library.

Deleting Presets

To delete a preset from any library:
1. Open the preset library you want to delete from: Objects, Materials, Skies, Textures, or Brushes.
2. Select the category from which you want to delete presets.
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3. Click on the preset you want to delete:

4. or hold down Shift and select a continuous series of presets or hold down Cmd/Ctrl and select a 
discontinuous set of presets:

5. Click the Delete button at the bottom of the dialog.

6. The Confirm dialog will come up, choose Delete to remove the preset from the library or Cancel 
to leave it in.

7. Once deleted, the preset will no longer show up in the library, however, in the Objects Library, the 
object data is still in the OBP file for that category. If the category OBP file is too large after 
deleting several presets, you can export the remaining objects then replace the original OBP with 
the exported one to reduce the file size.

8. Click on the OK icon to close the library.

Exporting Presets

Exporting Presets

Importing and exporting presets is a handy way to exchange custom presets with other users and to store 
objects for later use. It can also be used to reduce the file size of a category when several presets have 
been deleted from the library.
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To export a preset from any library:
1. Open the preset library from where you want to delete, such as, Objects, Materials, Skies, 

Textures, or Brushes.
2. Select the category from which you want to export presets.
3. Select the preset or presets you wish to export. Hold down Shift and select a continuous series of 

presets or hold down Cmd/Ctrl and select a discontinuous set of presets.

4. Click the Export button at the bottom of the dialog. The save file dialog appears.

5. Enter a name for the file, navigate to where you want to save it, and click on Save. The file is to 
the location you selected with the correct extension for the preset type. If exporting objects to 
reduce the file size, name the exported file the same name as the one it will be replacing.

6. Click on the OK icon to close the library.
To replace a category OBP file with one you just exported, refer to "Recovering Disk Space in the 
Libraries."

Recovering Disk Space

When you delete a preset from a library, the preset is removed from the thumbnail previews, but not from 
the actual preset file. In order to reduce the file size and get rid of the deleted data, the remaining presets 
need to be exported in order to replace the original preset file.
There are two basic ways to recover disk space in the libraries:

1. Export presets, then cut and paste it over the original preset file
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2. Export presets with new name, delete original sub-category, then rename new file

Export and Paste Over Original

To recover disk space by exporting and pasting over the original file:
1. Select and export the presets that you want to keep into a temporary folder, saving the file with 

the same name as the original file.
2. Navigate to the folder where you saved the exported preset file, select the file, and cut or copy it.

3. Notice the file size on the example above is just over 13 MB. Navigate to the Bryce Presets folder 
then to the folder where the original file is located. 

Paste the new file into the folder, confirming on any replace messages.

In the example, the User.obp file is being replaced. Notice that the file size on the current version 
is over 17 MB. By exporting out the objects in the User category and copying it over the old 
version, 4 MB of disk space has been recovered. This may not seem like a lot, but a MB here and 
a MB there can start adding up very quickly.

Export and Delete Original

To recover disk space by exporting and pasting over the original file:
1. Select the presets that you want to keep and click on Export.
2. Navigate to the presets folder where the original file is located. Name the file the same as the 

original file but add a number to it. Click on Save.
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3. Quickly select another category, then switch back to the category you were just in. This refreshes 
the sub-category listing.

4. Select the original sub-category and click on the minus sign at the bottom of the listing. Confirm 
on Delete.
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5. The original sub-category will be gone and the new one left in the listing.

6. Since Bryce exports presets backwards, you may want to re-export the new file, so select all the 
presets in the new sub-category, click on Export, and give the file the same name as the original 
file. Click on Save.

7. Change categories, and then change back to the one you are working with. Both versions of the 
new sub-category are listed.
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8. Click on the first exported sub-category and click on the minus sign at the bottom of the listing. 
Confirm on Delete.

©2003-2011 DAZ 3D, Inc. 506



Bryce 7 Artist Guide 03 Jan 2011

9. Refresh the listing by switching categories and the new sub-category are listed.

Thumbnail Preview Options
Thumbnail Preview Options

The preview thumbnails in the Objects and Materials Libraries can be modified using various options in 
the library and by the selected sky and sun/moon settings.
The number of thumbnails viewable in the libraries has been increased in Bryce 6, with the Skies Library 
increased from six thumbnails across to seven across and the remaining libraries increased from six to 
ten thumbnails across.

• Materials Library Preview Options
• Objects Library Preview Options

Objects Library

In the libraries, you can change the thumbnail preview either before or after adding the item to the library.
1. Select the object in the working window and open the Objects Library
2. OR
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3. Open the Objects Library and select the item you want to change the thumbnail for.

4. Set up the preview of the object:
• Click the Triangle icon in the bottom-right corner  Normal: of the thumbnail preview and 

choose a view option from the menu.  is the default view of your selected object.

• Up Close: displays a close-up of your object. 

• Render With Neutral Sky: displays your object with  a flat sky, instead of the sky applied 
to your scene. When deselected, the current sky in the scene will affect the thumbnail 
preview.
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5.  Set up the object location:  
• Drag in the preview area to rotate the view of the object:

• Hold down the Spacebar and drag up, down, right,  or left to pan the object preview:
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• Hold down Cmd/Ctrl and drag in the preview area  to zoom in and out of the preview:

• Press Alt and click in the preview area to reset  the preview to the default:

6. Once you are happy with the preview image, click on Add to add the object

OR
7. If you are changing the thumbnail of an item already in the library, press Ctrl+Shift+click on the 

thumbnail in the library

and the thumbnail preview will be replaced with the new one:
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Materials Library

In the libraries, you can change the thumbnail preview either before or after adding the item to the library.
1. Select the object with the material applied to it in the working window and open the Materials 

Library

OR
2. Open the Materials Library and select the preset you want to change the thumbnail for.

3. Set up the preview of the material:
• Click the Triangle icon in the bottom-right corner  of the thumbnail preview and choose a 

view option from the menu.
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• Normal: is the default view of your selected  material.

• Up Close: displays a close-up of your material. 

• Render With Neutral Sky: displays your object  with a flat sky, instead of the sky 
applied to your scene.

©2003-2011 DAZ 3D, Inc. 512



Bryce 7 Artist Guide 03 Jan 2011

• When deselected, the current sky in the scene will affect the thumbnail preview, 
including haze and the sun's location.

• Render with Neutral Ground: displays the material  with a gray ground plane.

• When deselected, the material is applied to the ground plane as well as to the 
selected object.

• Current Selection: displays the material on  the same object type that is selected 
in the Working window. If the current selection is an imported mesh, the 
thumbnail preview will default to a sphere.

• Actual Selection: displays the material on  the actual object selected in the 
Working window.

• Box: displays your material applied to a cube. 
• Sphere: displays your material applied to a  sphere.
• Cone: displays your material applied to a cone. 
• Cylinder: displays your material applied to  a cylinder.
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• Terrain: displays your material applied to  a terrain. You might want to disable 
Render With Neutral Ground as terrain materials look better when placed on a 
ground plane with the same material.

• Ground: displays your material applied to an   infinite plane. 
• Torus: displays your material applied to a torus object. 
• Pyramid: displays your material applied to   a pyramid object. 
• Circle: displays your material applied to a 2D circle object. 
• Square: displays your material applied to a 2D square object.

• Set up the   preview of the material (see examples at bottom of page): 
• Drag in the preview area to rotate the view of the material. 

• Hold down the Spacebar and drag up, down, right,  or left to pan the material 
preview. 

• Hold down Cmd/Ctrl and drag in the preview area to zoom in and out of the 
preview. 

• Press Alt and click in the preview area to   reset the preview to the default. 
•  Example preview thumbnails: 

• Default view with sun control setting:
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• Up Close: 

• Up Close and Render with Neutral Ground  deselected:

• Up Close, Render with Neutral Ground/Sky  deselected, Plain Black 
Background sky applied, and sun moved:

4. Once you are happy with the preview image, click on Add to add the material to the library
5. OR
6. If you are changing the thumbnail of an item already in the library, press Ctrl+Shift+click on the 

thumbnail in the library
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7. and the thumbnail preview will be replaced with the new one:

Using Presets
Using Presets

The different types of presets all have their own use in Bryce. The following pages will show you how to 
use the presets.

• Adding Preset Objects to the Scene
• Applying Materials to Objects
• Applying Skies to the Scene
• Applying Textures in the DTE
• Applying Textures in the Materials Lab
• Using Preset Brushes in the Terrain Editor

Adding Preset Objects to the Scene

To add an object from the Presets Object Library to your scene:
1. Click the Triangle icon next to the Create button at the top of the Bryce environment. 

The Create Palette does not have to be active in order to do this.
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2. The Presets Object Library appears.

3. Click on the name of a category, (to the left of the thumbnails), to access the different libraries.
4. Click on the preset thumbnails to view preset names and descriptions.

5. Once you have decided which object to use, click on the OK icon to add the selected object to 
your scene. 

Remember, the Create palette does not need to be active for you to access the Objects Library.

Applying Materials to Objects
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The Materials Presets Library contains all the material presets available in Bryce. You can place them on 
your objects directly and edit them just as you would any other material.
To add a material from the Materials Presets Library to an object:

1. Select an object.
2. In the Working window, click the triangle icon next to the Edit text button at the top of the Working 

window. The Materials Presets Library appears.

3. Or, in the Materials Lab, click the triangle icon at the top-right of the Material Preview window.

4. Click one of the Category names along the left side of the dialog.

5. Click the thumbnail of the preset you want to add.
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When you click on a preset thumbnail, you may notice that the preset thumbnails look different 
than the preview window. This is because the preset thumbnails may have added with the neutral 
sky deselected so that the current scene sky settings would affect the material. 

Refer to "Thumbnail Preview Options - Materials Library" for examples showing the difference 
using a neutral sky or a sky preset can make to the preview.

6. Click the OK icon to add the selected material to your object.
You can also select presets in one motion by clicking the Materials Presets icon then dragging directly to 
the desired material preset and releasing the mouse button. You can also drag over the category names 
to change categories into the category's presets, and then release the mouse button.

Applying Skies to the Scene

To add a sky from the Preset Skies Library to your scene:
1. Click the triangle icon next to the Sky & Fog text button at the top of the Bryce window.

OR
2. Click the arrow next to the preview area in the Sky Lab dialog.
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The Preset Skies Library appears.
3. Click on the preset thumbnails to view preset names and descriptions until you find the sky you 

want to use in your scene.
4. Click the OK icon to add the selected sky to your scene.

The Sky & Fog palette does not need to be active for you to access the Preset Skies Library. 
You can also select presets in one motion by clicking and holding the triangle icon, dragging directly to 
the desired preset, and releasing the mouse button.

Applying Textures in the DTE

To apply a texture from the Textures Library in the Deep Texture Editor:
1. In the Deep Texture Editor, click on the top button on the right-hand side of the combination 

window. The "Texture Library" tool tip will show in the bottom left corner of the Deep Texture 
Editor.
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2. The Textures Library will come up. Select a texture and click on the OK icon.

3. The selected texture will be loaded in the Deep Texture Editor. Click on the OK icon to return to 
the Materials Lab.

Applying Textures in the MatLab

©2003-2011 DAZ 3D, Inc. 521



Bryce 7 Artist Guide 03 Jan 2011

To apply a texture from the Textures Library in the Materials Lab:
1. In the Materials Lab, click in a channel to load a random texture.

2. Click on the top right button of the component window and select a texture from the fly-out menu.

OR
3. Press Shift and click on the same button to open the Textures Library.
4. In the Textures Library, select a texture and click on the OK icon.
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5. The selected texture will be loaded in the Materials Lab.

6. Click on the OK icon to return to the Working window.

Using Preset Brushes in the TE

See "Using the Preset Brushes" for information on how to use the brushes in the Terrain Editor and 
"Adding Presets to the Brushes Library" for information on creating and adding your own brushes.
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Laboratories & Editors
Laboratories & Editors

Bryce has several laboratories and editors that let you do everything from creating terrains to editing the 
speed of animations. Each editor is like a separate room in Bryce. When active, the lab/editor takes over 
the interface, completely replacing the Working window (except for the torus and mesh editors).

• Materials Lab
• Deep Texture Editor
• Sky Lab
• Terrain Editor
• Light Lab
• Tree Lab
• Animation
• Torus Editor
• Mesh Editor

Materials Lab

Materials Lab
The Materials Lab (also known as the MatLab) is where you will create and edit the materials to apply to 
your objects. This unique editor lets you combine a wide variety of components and channels to create an 
infinite number of different surfaces and volumes.
There are two types of materials you can create. The first is surface materials, which define the surface 
properties of an object.  The second is Volume materials, which define the properties of an object's 
volume as well as its surface.
When you are creating volume materials, the settings in the Materials Lab change. Some of the surface 
material settings are replaced by volume effects settings.
To display the Materials Lab:

1. Create an object. 
2. Access the Materials Lab: 

• Click the  button next to the selected object. 
• OR choose Objects > Edit Material from the menu. 
• OR click on the Edit Material tool in the Edit Palette. 

The contents of the composer depend on the material currently applied to the object. If there is no 
material, the default material's settings appear.
Select an option below for more information on using the MatLab:

• A Quick Tour of the Materials Lab
• Working in the MatLab
• Materials
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A Quick Tour of the Materials Lab
The Materials Lab is set up like a visual chart that lets you see all the different channels that make up 
your material. At a glance, you can see all the settings for each material channel and the texture 
components used to drive channel values.

Material Mode Toggle
In the top left corner is the mode toggle button. This button lets you switch between surface material and 
volume material. The buttons also indicates what type of material you are creating. Surface is enabled by 
default. When you toggle to Volume, the channels in the lab change to display the volume channels.
Material Preview Window 
On the left side of the Materials Lab is the Material Preview. This little window shows you what your 
material will look like when it is applied to an object. The preview updates as you adjust the channels.
The Materials Grid
The center of the Materials Lab is called the Materials Grid. This is where you combine values, colors and 
textures to set channel values. The Materials Grid is divided into three sections each containing logical 
groups of channels.

• The Color channels group contains all the material channels that define the colors that appear on 
the object surface when it is struck by light. Each channel in the Color group has a color oval next 
to its title. This oval lets you quickly set a color for the channel. 

• The Value group contains all the channels that define how the object's surface or volume reacts 
to light. In other words, they control whether the object is shiny, metallic, bright or dark. 
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• The Optics group contains all the channels that define any optical effects associated with the 
object. When you are creating volume materials, the Optics group is replaced by the Volume 
group. This group contains all the channels that define the appearance of an object's volume. 

All of the channels in these three groups have sliders on the left side of each row. The sliders let you 
quickly set the value of each channel. Values can be used in conjunction with textures or on their own. In 
the case of the Refraction channel, you must use a value. Each channel is divided into four columns: A, 
B, C, and D. These columns represent texture components you can use to set the value of the channel. 
At the top of each column is a Frequency slider. This slider lets you quickly set the frequency of a texture 
component. Setting the frequency is the same as scaling the texture.
When a texture component indicator appears in a column, it means that a component is being used to 
drive the value of the channel. The column in which the indicator appears indicates which texture 
component is being used. For example, if a texture component indicator appears in column A of the 
Ambience channel, component A is being used to drive the Ambience value.
Texture Component Windows 
Along the right side of the lab are the Texture Component windows. These four windows are labeled A, B, 
C, and D (shown from top to bottom in this image). When a texture component is active, these windows 
display a preview of the texture and provide access to texture editing tools. The four Texture Component 
windows correspond to the four columns in each channel in the Materials Grid.
Animation Controls
Along the bottom of the Materials Lab are the Animation controls. These controls let you animate between 
textures or animate the properties of a single texture over time

Working in the MatLab
Working in the MatLab

This section describes how to use the Materials Lab to create and store materials.
• Building Materials
• Using the Material Preview Area
• Materials Presets Library
• Animating Materials

Building Materials

Building Materials

A material is a combination of values, colors and textures applied through fourteen different channels. 
You build materials by selecting components (colors, values, or textures) and combining them on the 
Materials Grid.

• Creating a New Surface Material
• Creating a New Volume Material
• Using and Activating Components
• Copying and Pasting Materials

Creating a New Surface Material

To create a new surface material:
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1. Select an object and click on the  button next to the object. The Materials Lab will come up. 
2. Set the material channels to define the properties of your material. Remember, channels can be 

set using values, colors or texture components. You may want to experiment with different setting 
to see the results of your changes. 

3. If you are using texture components, you can: 
• Edit the scale, position or rotation of the texture using the texture transformation controls. 
• Edit the makeup of the texture using the Deep Texture Editor. 
• Set a mapping mode for the texture. 

4. Choose a shading mode for the material by clicking the triangle icon at the top of the Materials 
Lab and choosing a mode from the menu. 

5. Click the OK icon. The new material is applied to the selected object. 

Creating a New Volume Material

To create a new volume material:
1. Select an object and click on the button next to the object. The Materials Lab will come up. 
2. Click the toggle button to switch to Volume. 
3. Set the material channels to define the properties of your material. Remember, channel values 

are applied to the object's volume not its surface, so adjust the material's channels accordingly. 
4. If you are using texture components, you can: 
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• Edit the scale, position or rotation of the texture using the texture transformation controls. 
• Edit the makeup of the texture using the Deep Texture Editor. 
• Set a mapping mode for the texture. 

You should always use a texture component in the Base Density channel. 
5. Choose a shading mode for the material by clicking the triangle icon at the top of the Materials 

Lab and choosing a mode from the menu. The shading modes for volume materials are different 
from those for surface materials. 

6. Click the OK icon. The new material is applied to the selected object. 

Using and Activating Components

To activate a component in the Materials Grid, click an empty channel column. A component window 
appears.
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To use a component in a specific channel, in a material channel, click the column that corresponds to the 
component you want to use.

To switch between components, click in a new column.

To combine a component with a value:
1. In a material channel, click an empty column. 
2. Drag over the value control for the channel or enter a new value in the value field. 

Copying and Pasting Materials

The Materials Lab has its own dedicated clipboard that lets you store materials. You can have an object in 
your clipboard then enter the Materials Lab and copy a material without disturbing the contents of your 
objects clipboard.
To copy a material to the Materials clipboard, click the Copy button below the Material Preview window. 

To paste a material to the Materials clipboard, click the Paste button below the Material Preview window.
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Using the Material Preview Area

There are several different ways you can see the effects of your material on an object. 
To switch preview modes, click the triangle at the bottom of the material preview and choose an option 
from the menu:

• Normal: displays your object as it looks in your scene. This is the default view of your selected 
object. 

• Up Close: displays a zoomed-in view of your object. 

• Render With Neutral Sky: displays your object against a plain sky. When this option is disabled, 
your preview contains the current sky settings. This option makes it easier to see the material 
without being distracted by patterns in the sky. 

• Render With Neutral Ground: displays your object with a plain ground. When disabled, the ground 
in your preview has the same texture as the object. 

First image below is with the neutral sky and ground option selected, second image is with both 
options deselected. 

• Current Selection: displays the material on the currently selected object type (i.e., box, sphere, 
etc.). This is the default object selected when you enter the Materials Lab. 
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• Actual Selection: displays the selected object exactly as it appears in the your scene. 

• Cube: displays the material applied to a cube. 

• Sphere: displays the material applied to a sphere. 

• Cone: displays the material applied to a cone. 

• Cylinder: displays the material applied to a cylinder. 
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• Terrain: displays the material applied to a randomly generated terrain object. 

• Ground: displays the material applied to an infinite plane. 

• Torus: displays the material applied to a torus object. Torus objects are good for displaying 
material properties like altitude changes, slope and height changes, and metallicity. 

• Pyramid: displays the material applied to a pyramid. 

• Circle: displays the material applied to a 2d disc. 

• Square: displays the material applied to a 2d face. 

To change the view angle of the preview area, drag the Preview area in the direction you want to view it 
from. The preview switches to wireframe as you move it. The angle of the preview does not affect the 
angle of the object in your scene.
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Materials Presets Library

Materials Presets Library

Material presets are predefined materials. Presets contain channels values that simulate a wide variety of 
commonly used surfaces. Presets are stored in the Material Presets Library.
Presets are a great way of understanding how materials are made. You can open one of the presets and 
see what channel and components were used to create the final material.

• Using the Materials Presets Library
• Material Quick-Select

Using the Materials Presets Library

The Materials Presets Library contains all the material presets available in Bryce. You can place them on 
your objects directly and edit them just as you would any other material.
To add a material from the Materials Presets Library to an object:

1. Select an object.

2. Access the Materials Library in one of the following ways: 
• In the Working window, click the triangle icon next to the Edit text button at the top of the 

Bryce environment. 

The Materials Presets Library appears. 

• Or, click on the  button, then on the Edit Materials tool. 
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The Materials Lab will open; click the triangle icon at the top-right of the Material Preview 
window. 

• Or, click on the  button next to the selected object. 

The Materials Lab will open; click the triangle icon at the top-right of the Material Preview 
window. 

3. Click one of the Category names along the left side of the dialog or click on the triangle icon at 
the bottom left of the library to choose a different category. 
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4. Click the thumbnail of the preset you want to add. 

5. Click the OK icon to add the selected material to your object. 
6. Render to see the result.

Material Quick-Select

You can also select presets in one motion by left-clicking, then holding on the Materials Presets icon while 
dragging directly to the desired material preset and releasing the mouse button. You can also drag over 
the category names to change categories into the category's presets and then release the mouse button.
To Quick-Select a material:

1. Select an object in the scene. 
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2. Left-click-hold on the Material Presets triangle. The Materials Library will come up.

3. Without letting up on the mouse, drag the cursor over the categories until the one you want is 
displayed. 

4. Still holding down on the mouse, drag the cursor over the preset thumbnails, then let up on the 
mouse when the material you want to apply is selected. 

The material will be applied to the object. 
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Please note that you cannot change between main categories using this method.

Animating Materials

Animating Materials can add an exciting new dimension to your materials - time. Using the Animation 
Controls, you can interpolate between textures over time or change the properties of a single texture over 
the course of an animation.
The animation tools are a great way of adding life to your scene. Instead of creating an animation with 
simple motion, you can create subtle effects like changing a cube from water to ice or changing the 
seasons on a mountain.
Refer to "Animating Materials" for complete instructions on animating materials.

Materials
Materials

Materials are what bring your Bryce environment to life. A material defines the surface properties of an 
object in your scene. It has the power to turn a bunch of polygons into an island or the peaks of the 
Himalayas. You can also alter the basic function of an object. A simple cylinder becomes a pillar, a tree 
trunk or a metal pipe, just by adjusting the properties of the material applied to it.
In Bryce, a material is not just a Picture that is wrapped around an object; it is a truly 3D surface. The 
material properties you assign to an object are applied to the whole object - inside and out.
Bryce's volume materials let you apply a material to the interior of the object as well as to its surface. The 
Volume Material controls let you set how the entire object's volume reacts to its environment.

• Material Structure
• Understanding Surface Material Channels
• Understanding Volume Material Channels
• Understanding Material Components
• Alpha Channels
• Surface Material Channels
• Volume Material Channels
• Material Components
• Shading Modes
• Shading Mode Modifiers

Material Structure
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A material is made up of fourteen channels. Each of these channels defines a different property of an 
object's surface. When you combine all the channels together, you get a material. New materials are 
created by adjusting the values for each channel.

There are two types of materials you can create in Bryce. First, surface materials, which define the 
properties of an object's surface..  The second, volume materials, which define the properties of an 
object's volume.

Understanding Surface Material Channels

Understanding Surface Material Channels

The fourteen channels of a surface material each represent a different surface property. These properties 
simulate different physical properties of a surface and the combination defines how the object's surface 
interacts with light in the Bryce environment. To understand how the channels work, you need to 
understand a little about how you perceive light and color.
The color and size of an object are determined by how the light that hits the object is reflected back to 
your eye. Objects appear green because they reflect green light. An object appears shiny because it 
reflects light back at you.
Objects appear transparent when light passes through their surface, hits the objects behind it, and is then 
reflected back through the surface. Bryce's material channels simulate all these behaviors.

When you set a channel value, you are setting how your object's surface interacts with the light that hits it, 
whether that light is from a direct source like the sun, or an indirect source like light reflected off other 
surfaces.
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When you are creating volume materials, your settings not only control how light interacts with the surface 
of the object, but also how it interacts with the object's volume.
The effects of the channels are additive, meaning that each value you set directly affects all the other 
values. If you set the Diffuse Color to yellow and the Ambient Color to blue, the object will have a 
greenish tint.

Channels are interdependent. For example, you will not see the effects of the Transparent Color if the 
object is not transparent or does not have a transparency map applied in the Alpha Channel.
When you are using these channels, it is important to understand the physical property they're simulating. 
Only then can you make meaningful adjustments to the component values.
For example, if you set both Transparency and Reflection to 100, you will get an unusually bright object 
that does not look very realistic. The reason for this is that the object is emitting more light than it is 
receiving, something it could not do in reality.

Since material channels simulate real-world surface properties, you should try to keep channel values 
within a realistic range. For example, in the image above, Transparency and Reflection are both set to 
100. With these settings, you are saying that 100% of the light that hits the object passes through its 
surface and 100% of the light that hits the object is reflected off its surface. The result is an object that 
emits more light than it receives because it is reflecting the light that hits it as well as the light from behind 
it.
In reality, an object can only reflect a portion of the light that is passing through it. Therefore, 
Transparency and Reflection values should always add up to 100.
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A good rule of thumb to keep in mind while you are setting these channels is that the Transparency and 
Reflection channels should always add up to 100 and the Diffusion and Ambience values should also 
always add up to 100.

Each surface material is made up of fourteen channels, divided into three groups:
• Color Channels

• Diffuse Color  
• Ambient Color  
• Specular Color  
• Transparent Color  
• Specular Halo  
• Volume Color

•  Value Channels
• Diffusion 
• Ambience  
• Specularity  
• Metallicity  
• Bump Height 

• Optics Channels
• Transparency  
• Reflection 
• Refraction 
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Color Channels

The Color group contains all the channels that control the color reflected off an object's surface.
The channels in the Color group are Diffuse Color, Ambient Color, Specular Color, Transparent Color, 
and Volume Color. 

Diffuse Color, Ambient Color, and Specular Color define the colors the surface reflects when direct light 
hits it. For example, Diffuse Color defines the color that is reflected in all directions when direct light hits 
the object and Specular Color is the color that appears in the object's highlight.
These color channels are directly related to the Diffusion, Ambience, and Specularity channels. Diffusion, 
Ambience, and Specularity control how light reflects off the object, while Diffuse Color, Ambient Color, 
and Specular Color control the color of that light. So, for example, if you selected yellow as the Diffuse 
Color, the object appears yellow. The intensity of the yellow color is controlled by the Diffusion channel. 
Refer to "Diffuse Color," "Ambient Color," and "Specular Color" for more information.
Transparent Color sets the color of any light that passes through the surface of the object and Specular 
Halo controls the size of the highlight that appears when an object has a shiny surface. 
Refer to "Transparent Color" and "Specular Halo" for more information. 
The remaining color channel, Volume Color, controls the color of the interior of the object. Refer to 
"Volume Color" for more information.

Value Channels
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The second group of channels, the Value group, controls how much light affects an object. The channels 
in the Value group are Diffusion, Ambience, Specularity, Metallicity, and Bump Height.

Diffusion, Ambience, and Specularity define how the surface interacts with direct light. They let you 
control how much direct light affects the surface of an object. In a physical environment, these channels 
control how shiny, dark, or bright the object appears. 
Refer to "Diffusion," "Ambience," and "Specularity" for more information.
Metallicity is related to Reflection. It determines how much reflected light is filtered through the Diffuse 
Color. 
Refer to "Metallicity" for more information.
Bump Height controls the height of any bumps or dents on the object's surface. 
Refer to "Bump Height" for more information.

Optics Channels

The Optics group of channels controls the intensity of optical effects produced by the object's surface. 
The channels in the Optics group are Transparency, Reflection, and Refraction.

Transparency and Reflection channels control how indirect light interacts with the object's surface. In a 
physical environment, these channels control how transparent or reflective the object appears. 
Refer to "Transparency" and "Reflection" for more information.
Refraction is directly related to Transparency. The Refraction channel sets how much the light that 
passes though the object is bent. 
Refer to "Refraction" for more information.

Understanding Volume Material Channels

Understanding Volume Material Channels

Surface Materials define the properties of the surface of an object. The interior of the object is empty. If 
you were to fly through the object you would see one layer of material, emptiness, and then another layer 
of material. A Volume Material is applied to the entire object, both inside and out. If you were to fly 
through a volume material you would be surrounded by material.
When you are setting channel values for a Volume Material, you are setting up how light will interact with 
the object's volume. Channels control whether the interior of an object is bright, dark, shiny, or 
transparent.
In most cases the interior of an object will be filled with a texture. If so, the channels control the surface 
properties of the elements within the texture.
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For example, if you apply blue spots as a Volume Material, you get a volume filled with blue spheres. The 
channels then control whether those spheres are bright, dark, shiny, or dull. When the interior of an object 
is filled with a texture, the material channels control the surface properties of the elements within the 
texture.
Volume Materials are made up of thirteen channels, divided into three groups: 

• Color Channels
• Diffuse Color
• Ambient Color
• Specular Color
• Transparent Color
• Specular Halo
• Volume Color

• Value Channels
• Diffusion
• Ambience
• Specularity

• Volume Channels
• Base Density
• Edge Softness
• Fuzzy Factor
• Quality/Speed

The channels in the Color and Value groups work exactly as they do for surface materials, except that the 
channel settings are applied to the object's volume instead of its surface.

Volume Channels
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The Volume channels control special volume properties of the object's interior.

Base Density controls the density of the object. This channel defines how much material there is in the 
interior of an object. As a result, Base Density controls how much light passes into the object. A solid 
object does not allow any light to pass through it, while less dense objects allow more light in. 
Refer to "Base Density" for more information.
Edge Softness, Fuzzy Factor, and Quality/Speed control the appearance of texture elements within the 
material. Edge Softness and Fuzzy Factor control the quality of the edges and sharpness of the texture, 
while Quality controls the render quality of the material. 
Refer to "Edge Softness," "Fuzzy Factor," and "Quality/Speed" for more information.

Understanding Material Components

Each Bryce material channel can contain up to three components that determine the channel's setting. A 
component can be a color, a texture or a numerical value. A texture can be either a 2D texture (Picture) or 
a 3D texture.
Each Bryce material channel contains components that determine its settings. You can have up to three 
texture components in a channel, and some channels let you use four textures and a value as 
components.

Colors can only be used in the Diffuse, Ambient, Specular, Specular Halo, Transparent, and Volume 
channels. Values are used in the Diffusion, Ambience, Specularity, Metallicity, Bump Height, 
Transparency, Reflection, Refraction, Base Density, Edge Softness, Fuzzy Factor, and Quality/Speed 
channels.
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When you are using a texture as a component, the information in the texture's channels is used as the 
value of the material channel. For example, if you are using a texture to set Diffuse Color, the texture's 
color channel is used.

If you are using a texture to set the Diffusion value, the texture's alpha channel determines the Diffusion 
intensity.
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Components are combined using one of three modes: Mode A, Mode AB, and Mode ABC. In Mode A, 
only one component is used to set the channel's value. 

In Mode AB, two components are combined to set the channel's value, based on altitudes. The values 
from texture A are applied at low altitude and values from texture B are applied at higher altitude.
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In Mode ABC, the values of two textures, A and B, are blended based on the alpha channel of texture C.
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When you are using textures as a component, you can choose from a number of preset textures or you 
can open the Deep Texture Editor and create your own textures.
In some channels, you can use both a texture and a value. In this case, the value determines how much 
of the texture's value is used to drive the channel. For example if you apply a texture to the Bump Height 
channel, the texture sets the shape of the bumps and the value sets how prominent those bumps appear.
In this example, the shape of the bumps on the object is set by the texture component in the Bump Height 
channel, but the height of those bumps is set by the Bump Height value of 100.

Alpha Channels

One of the outputs a texture component can produce is an Alpha channel. The Alpha channel is a 
grayscale representation of the texture pattern or grain. When you use a texture as a component in a 
material channel, these grayscale values are used to map surface properties. White areas in the Alpha 
channel represent 100% of the effect and black areas represent 0%. 
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Images, or 2D textures, also contain an Alpha channel. In images, the Alpha channel acts as a mask for 
the image. The image's Alpha channel is used in the same way as a texture's Alpha channel.

Surface Material Channels

Surface Material Channels

This section provides details on each of the Surface Material Channels.
• Diffusion
• Ambience
• Specularity
• Specular Halo
• Metallicity
• Bump Height
• Transparency
• Reflection
• Refraction

Diffusion

Diffusion

Diffusion determines how much direct light is reflected diffusely, or scattered, in all directions. The small 
arrows projecting off the surface of the object illustrate how diffusion works.

©2003-2011 DAZ 3D, Inc. 550



Bryce 7 Artist Guide 03 Jan 2011

When light hits an object with diffusion set to 100% (right image), all the light that hits it is reflected back 
scattered in all directions. This gives the object a flatly lit appearance. If the object's diffusion is set to 0% 
(left image), no light is reflected off its surface so the object appears black. Diffusion controls how much 
light is diffusely reflected off the object's surface.

• Diffuse Color
• Setting Diffusion Using a Texture

Setting Diffuse Color

Diffuse Color acts like a filter through which all the diffuse light passes. When light hits the object, the 
amount of light that is reflected diffusely is determined by the Diffusion channel setting, and the color of 
that light is set by the Diffuse Color channel.
This graphic shows how diffuse light passes through the Diffuse Color.
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When Diffusion is set to a value greater than zero, the Diffuse Color appears wherever the object is hit by 
direct light. Diffuse Color is the color of diffusely reflected light.

Be careful when using pure constant colors as the Diffuse Color because you may not get the results you 
are expecting. If you use a pure color, only that color is reflected off the object. So if you are using 100% 
green, only green light is reflected off the surface. This does not cause a problem when the object is hit by 
white light because there is green in white. However, if you use 100% red light on the object, it will appear 
black, since there is no green in 100% red, so no light is reflected off the object.

Setting Diffusion Using a Texture

When you assign a texture to the Diffusion channel, the texture's alpha channel determines which areas 
of the surface have high diffusion and which have low diffusion. Bright areas in the alpha channel have a 
high diffusion value and darker areas have low diffusion values.
When you use a texture to set the Diffusion channel, the grayscale values in the texture's alpha channel 
determine the diffusion of the objects.
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If you are using a texture to set Diffuse Color, the texture's color channel is used and the value in the 
Diffusion value determines the intensity.
Examples:

• Diffusion value = 100 
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• Diffusion value = 50

• If you are using a texture to set the Diffusion value, the texture's alpha channel determines the 
Diffusion intensity.

Ambience

Ambience

Ambience simulates the effects of light hitting the object from all directions. The Ambience value controls 
the amount of light that is reflected off the surface uniformly. The large arrows represent ambient light 
hitting the object's surface. The smaller arrows represent the light reflected off the object's surface.
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When Ambience is set to a value higher than zero, the object will reflect light from all over its surface, not 
only from the area hit by light. This makes the object look brighter.
The higher the Ambience value, the brighter an object appears. At 100% (right example), the object 
appears unnaturally bright, regardless of the light source. If you want to create a realistic effect, the sum 
of the Ambience and Diffusion values should add up to 100. The left example has Ambience set to 0%.

An object's Ambience is directly related to the general ambience of the environment. So, the ambient 
value you set for the object is directly affected by the Ambient Color you set in the Sky & Fog palette.
The Ambient Color in the Sky & Fog palette controls how much ambient light is available in the 
environment. The Ambience channel controls how much of the available ambient light is reflected off the 
object's surface.
Therefore, if you set the Ambient Color in the Sky & Fog palette to black, or 0% ambience, then the 
Ambience channel value has no effect. If you set the Ambient Color to white, or 100% ambience, the 
Ambience channel value will control how much of the available light is reflected off the object's surface.

• Setting Ambient Color
• Setting Ambient Color Using a Texture
• Setting Ambience Using a Texture

Setting Ambient Color

Ambient Color is the color that is reflected off the surface of an object regardless of where the light source 
hits the object. The Ambient Color is directly linked to the Ambience channel setting. If the Ambience is 
set to zero, the Ambient Color is invisible.
Ambient Color is the color that appears no matter where light strikes the object.
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The Ambient Color channel is also related to the Ambient Color you set in the Sky & Fog palette. The 
Ambient Color of the environment is added to the Ambient Color of the object, so if your environment is 
blue and your object's Ambient Color is yellow, your object appears green.

Setting Ambient Color Using a Texture

When you assign a texture to the Ambient Color channel, the color channel in the texture is used as the 
Ambient Color. In other words, the texture's color is applied to any area of the object that is in shadow.
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Setting Ambience Using a Texture

When you assign a texture to the Ambience channel, the grayscale values from the texture's alpha 
channel determine which areas of the surface have high ambience and which have low ambience. Bright 
areas in the alpha channel have high ambience values, and darker areas have low ambience values.

Generally, it is best to set Ambience using a value. However, you can get some interesting effects using 
textures instead. For example, if you use a splotchy texture, you will get, mixed in with normal surface 
areas, areas that appear to glow regardless of external light.

Specularity

Specularity

Specularity controls how much light is reflected back from the surface of the object directly at the viewer. 
Since the direct reflection creates a highlight on the object, you can think of Specularity as the channel 
that determines the intensity of the highlight that appears on the object or the "shininess" of the object.
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The higher you set the Specularity, the shinier the object appears. When the Specularity is set to zero, the 
object appears dull. This example shows Specularity set to 0% (left) and 100% (right).

• Setting Specular Color
• Setting Specular Color Using a Texture
• Setting Specularity Using a Texture

Setting Specular Color

Normally, the color of an object's highlight would reflect the color of the light source. However, using 
Specular Color you can set a specific color for your highlight, as shown here. Specular Color is directly 
linked to the Specularity channel. If the Specularity is set to zero, the Specular Color is invisible.
By adding Specular Color, you can make it appear as though a colored light is shining on the object.
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Setting Specular Color Using a Texture

When you assign a texture to the Specular Color channel, the texture's color channel is used as the 
Specular Color. In other words, the texture's color is applied to the object's highlight.

Setting Specularity Using a Texture

When you assign a texture to the Specularity channel, the grayscale values in a texture's alpha channel 
are applied to the object's highlight. Bright areas of the alpha channel increase the intensity of the 
highlight, and darker areas decrease the intensity. The alpha channel may also create patterns in the 
highlight.
When you use a texture to set the Specularity channel's value, the highlight's intensity is determined by 
the texture's alpha channel values.
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Specular Halo

Specular Halo

The Specular Halo channel lets you control the size of the Specular highlight.
The size is controlled by the luminance value of the component you select. Brighter colors (left) create 
larger highlights and darker colors (right) create smaller highlights.
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Colors are expressed as RGB (Red, Green, and Blue) values. Specular Halo channels use the values 
from each of these channels to set the size of the highlight. If the values are all in balance (that is, all the 
same), the highlight appears uniform. However, if one value is higher that the rest (for example, R=200, 
G=100, B=100), you will get a highlight with a slightly colored ring (for example, a red ring).

Depending on the component you use in this channel, you may be able to set each color value differently 
to create different highlight effects. The easiest way to use this channel is with a color. When using a 
color, try picking more desaturated colors. These colors produce results that are more predictable 
because the difference between RGB values is less. Check out the Specularity Lesson series in the Misc 
> Basic category in the Preset Materials Library to see Specular Halo in action.

• Setting Specular Halo Using a Texture

Setting Specular Halo Using a Texture

When you assign a texture to the Specular Halo channel, the RGB value of the texture's color channel is 
used for the Specular Halo.
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Metallicity

Metallicity

The Metallicity channel value acts as a filter for reflected light. This value controls how much of the 
reflected light is filtered through the Diffuse Color. At 50% (left), half the reflected light is tinted with the 
Diffuse Color; at 100% (right), all the light that is reflected is tinted.

Metallicity is linked to Reflection. If Reflection is set to zero, the Metallicity channel has no effect.
Metallicity makes objects look metallic because it tints the color of reflections. If you want to create 
specific types of metals, you need to adjust the Diffuse Color. For example, to create gold use a yellow 
Diffuse Color.

• Setting Metallicity Using a Texture

Setting Metallicity Using a Texture

When you apply a texture to the Metallicity channel, the texture's alpha channel is used to determine the 
intensity of the Diffuse Color. Lighter areas of the alpha channel increase the intensity of the color, and 
darker areas decrease the intensity.

Bump Height
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The Bump Height controls the height of bumps in an object's surface. The bumps on an object's surface 
are determined by the texture's Bump channel. The Bump Height channel is linked to the Bump channel 
in the texture. If you use a texture without a Bump channel, the Bump Height channel has no effect. You 
can enter negative values (bottom image shows Bump = -100%) in this channel, which turns bumps into 
dents.

Transparency

Transparency

The Transparency channel controls how much light can pass through the object's surface.
The higher the Transparency value, the more of the surrounding environment is visible through the 
object's surface. If there is no other light being reflected, an object set at 100% Transparency appears 
invisible.

Transparency controls how much of the surrounding environment is visible through the object's surface. 
To create a realistic transparent object, you need to pay attention to details. You will need to combine the 
effects of the other channels to simulate a realistic object.
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For example, transparent bubbles all have highlights, so you will need to add Specularity. Balloons have a 
flatter surface so you will need to add more Diffusion to the surface. Glass has a refraction effect 
associated to it, so you will need to add Refraction to the surface. 
These examples show an object with 0% (left), 50% (middle), and 75% (right) transparency.

Setting Transparency Color

The Transparent Color channel determines the color of the transparent areas of your object. Light is 
filtered through this color as it passes through the object's surface. As a result, anything you can see 
through your object is tinted with the Transparent Color you select.

Keep in mind that the Transparent Color interacts with the other colors in the material. If the Diffuse Color 
is white, then the Transparent Color takes precedence. If the Diffuse Color is yellow, and the Transparent 
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Color is red, the object appears orange. However, when using Refraction, the Transparent Color blends 
with the Diffuse Color. The Transparent Color tints everything you see through the surface of your object. 
This sample shows Transparent Color applied to the object.

Transparent Color is linked to the Transparency channel. If the Transparency is set to zero, the 
Transparent Color is invisible.

Setting Transparency Color Using a Texture

When you assign a texture to the Transparent Color channel, the texture's color channel is applied to the 
transparent areas of your object.

Setting Transparency Using a Texture

When you apply a texture to the Transparency channel, the texture's alpha channel is used to determine 
which areas of the object are transparent. Lighter areas of the alpha channel are not transparent while 
darker areas are.
You can create some interesting effects using textures. For instance, a checkerboard texture will result in 
an object that is alternately transparent and solid. This example shows a checked texture applied to the 
Transparency channel.
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The final look of the Transparency channel is determined by the Shading mode. When the material is 
applied using normal shading, Transparency creates an optical effect.

When the material is applied using Blend Transparency mode, Transparency creates a punch-out effect, 
as shown here. The areas of the surface that are 100% transparent are completely ignored during 
shading so that they appear as gaps or holes it the surface. Any areas less than a 100%, result in a 
normal transparency effect.

Note that when using Blend Transparency, the Transparency value is set to 0.
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Reflection

Reflection

The Reflection channel controls how much light, direct or indirect, is reflected off the object's surface. 
Unlike diffusion, which scatters light, reflection directs light back at its source, giving the object a mirror-
like appearance.

The higher the Reflection setting, the more reflective the surface. At 50%, half the light that hits the 
object's surface is reflected; at 100%, all light is reflected. As you increase the Reflection value, the color 
of the object changes, since you can see more of the environment in the object's surface.

• Setting Reflection Using a Texture
Examples:

• Reflection = 0
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• Reflection = 50

• Reflection = 100 

Setting Reflection Using a Texture

When you apply a texture to the Reflection channel, the texture's alpha channel is used to determine 
which areas of the object are reflective. Lighter areas of the alpha channel are reflective, while darker 
areas are not.
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Refraction

The Refraction channel determines whether light bends when it passes through the surface of an object. 
Higher Refraction settings produce slight reflections as some of the light is bent directly back at its source. 
Higher Refraction settings also change the color of the object's surface as the colors reflected from the 
environment affect the object's color.
The Refraction value is what makes transparent surfaces look like glass. As you increase the Refraction 
value, the edges of the object will become reflective. This simulates the effect of light being refracted so 
sharply that it does not penetrate the object's surface. 

In these examples you can see how the edges become more reflective as you increase the Refraction 
value. The higher you increase the Refraction value, the more the Diffuse Color is blended with the 
Transparent Color. The higher the value, the more Diffuse Color is visible in the object's surface. Any light 
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that is visible through the surface of the object is then tinted through both the Diffuse Color and the 
Transparent Color. The examples below show a range of Refraction values from 0% to 300%.
Refraction values are expressed as 100 x Refraction Index value. The Refraction Index contains 
refraction values for specific types of surfaces. For example, the Refraction Index of water is 1.3; this 
value is expressed as 130 in the Materials Lab.
Robin Wood has an excellent tutorial on refraction along with a nice listing of the refraction index of 
gemstones, metals, liquids, and other transparent objects. Once at her site, click on Tutorials, then select 
General 3D from the popup listing. Link to her site is located in appendix E.
Refraction is linked to Transparency. If Transparency is set to zero, the Refraction channel has no effect. 
Examples:

• Refraction = 0 

• Refraction = 50 
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• Refraction = 120 (both); Diffuse Color = Pink (right)

• Refraction = 150 (both); Diffuse Color = Pink (right) 

• Refraction = 200 
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• Refraction = 300 

Volume Material Channels

Volume Material Channels

Volume Materials use most of the same channels as surface materials. These channels all work the same 
as they do for surface materials. The only difference is that the channels control the properties of the 
object's volume, not its surface.
In addition to the channels already discussed, Volume Materials have several specialized channels. 

• Volume Color
• Base Density
• Edge Softness
• Fuzzy Factor
• Quality/Speed

Volume Color

The Volume Color channel controls the color applied to the interior of an object. Everything inside the 
object will appear tinted with this color as all light is filtered through the Volume Color.
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The Volume Color interacts with the Transparent Color. If your surface is transparent, light is tinted by the 
Transparent Color and the Volume Color.
The Volume Color tints everything inside the object. This is an example of Volume Color applied to the 
object's interior.

Volume Color is an excellent way of creating underwater light effects.

Base Density

Base Density

Base Density controls how dense the object is. In areas where the object is very dense, no light passes 
through the object. Where the object is less dense, more light passes through its volume. Base Density 
works like Transparency in 3D space. Areas that are less dense appear to be more transparent. 
This example shows Base Density set to 100% (left) and 10% (right).

High values create very solid objects like rocks, while lower settings create less dense objects like clouds. 
You should use this channel cautiously. The more transparent objects are, the more time they take to 
render.

• Setting Base Density Using a Texture

Setting Base Density Using a Texture

When you use a texture to set the Base Density channel, the Alpha channel is used to determine which 
areas of the object are solid and which are empty.
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Edge Softness

Edge Softness controls the softness of the edges of the silhouettes of objects with a volume material. For 
example, a sphere with a low Edge Softness value will have a "hard" silhouette, meaning the edges of the 
sphere show clearly.  A high Edge Softness value will almost totally obscure the edges of the sphere. 
This example shows an object with an Edge Softness of 0% (left) and 100% (right).

This channel is useful for obscuring the general shape of an object.

Fuzzy Factor

Fuzzy Factor controls the dullness or sharpness of a material. Values greater than 100 adjust the dullness 
of the material and values less than 100 adjust the sharpness of a material. At 100, there is no dullness or 
sharpness applied. 
As you increase the dullness of your object, it becomes less dense, so you may have to increase the 
Base Density to compensate. Likewise, as you increase the sharpness of the object it becomes denser. 
You can use this channel to smooth sharp-looking clouds or sharpen dull stone textures. 
Examples:
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• Fuzzy Factor = 0 

• Fuzzy Factor = 100 

• Fuzzy Factor = 200 

©2003-2011 DAZ 3D, Inc. 575



Bryce 7 Artist Guide 03 Jan 2011

• Fuzzy Factor = 300

Quality/Speed

Quality/Speed controls the render quality of the texture. This channel represents the inverse relationship 
between render quality and rendering speed. As you increase the render quality of the material, you 
decrease the speed at which it is rendered. As you increase the speed at which a material is rendered, 
you decrease its quality.
The material loses detail as the quality decreases. Detail is introduced as quality increases. For still 
images you probably want to increase the quality of the material and sacrifice speed, since the scene only 
has to be rendered once. For animations, you probably want to sacrifice quality since the scene will have 
to be rendered once for each frame in the movie.
Examples:

• Quality/Speed = 0
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• Quality/Speed = 50

• Quality/Speed = 100 

Material Components

Material Components

This section describes the various components you can use to set a Material Channel Value. It also 
describes how to set the parameters for each component.

• Color Components
• Value Components
• Texture Components
• Texture Mapping Modes
• Mapping Mode Modifiers
• Transforming Textures

Color Components

A Color Component is an RGB color that is directly applied to a channel. Colors can only be used in the 
Color channels: Diffuse, Ambient, Specular, Specular Halo, and Volume.
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When using a color in these channels, textures cannot be used in combination.  When choosing a texture 
component for any of the Color channels, the color oval appears blank. The Volume channel can only be 
set with a color.

To use a color as a component, in the Materials Lab, click the color oval in one of the channel rows on the 
Material Grid and choose a color from the palette. 

The selected color appears in the color oval.

Value Components

Value components are numerical values you use to set the intensity of a channel. Values can only be 
used in the Value, Optics, or Volume channels.
A value is indicated by either the numerical field in the left side of the channel in the Material Grid, or the 
slider that extends out from the channel. The sliders let you quickly set the value of a channel, and the 
numeric field shows the current setting.

©2003-2011 DAZ 3D, Inc. 578



Bryce 7 Artist Guide 03 Jan 2011

Values can be used with textures. In this case the value sets how much of the texture is applied to the 
channel. For example, if you use an orange-colored texture to set the Diffuse Color channel, the value 
would indicate how much of the texture color is used as the Diffuse Color.
A value of 100 means that all the texture information is used in the channel; a value of 0 means that none 
of the texture is used.
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Not all channels use values. The Color channels only use colors or textures. The Refraction channel can 
only be set with a value.

To use a value as a component, in the Materials Lab, drag the slider next to the channel whose value you 
want to set. As you drag, the numerical value appears in the number field. The Bump Height channel let 
you set negative values.

You can also click in the numeric field and manually enter a value.

Texture Components
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Texture Components

When using a texture as a component, Bryce extracts values from the texture to use as a value for the 
material channel. There are two types of texture components: Pictures and 3D textures.
Pictures are images imported either from the Pictures Editor or from another application. 3D textures are 
procedural textures generated by Bryce and stored in the Texture Library.
Up to four textures can be assigned as components for a material. These textures can be any 
combination of Pictures and 3D textures. Each texture component is assigned a letter: A, B, C, or D. The 
texture you assign to a component is used throughout the material, so the texture you assign as 
component A in the Diffusion channel is the same component A used in the Ambience channel and so on.

When you are setting channel values, you can mix and match components. For example, you can assign 
component A to Diffusion and component D to Ambience. You can also combine textures within the same 
channel using the blend modes AB and ABC. In this case, the texture you assigned to A is blended with 
the textures assigned to B and C to set a material channel value. 

• The Texture Component Window
• 3D Textures
• 2D Textures
• Combining Components

The Texture Component Window

The Texture Component Window displays the attributes of a selected texture component. You can have 
up to four windows visible in the Materials Lab. The six buttons on the Texture Component Window let 
you set the type of component, the texture-mapping mode, and access the texture transformation controls 
and the Deep Texture Editor.
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To use a Texture as a component, click a column in the material grid. A Texture Component Window 
appears. The component window corresponds to the columns in the grid, so if you click in column A in the 
grid, texture component A becomes active.

3D Textures

3D Textures
3D Textures have three different types of outputs: Color, Alpha channel (value), and Bump. These 
outputs are used differently by the material channels.
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Color channels use the texture's color to set the value of the channel. For example, if you use a texture in 
the Diffuse channel, the colors in the texture appear wherever the object reflects light diffusely.
When you use a texture to set the value of a Color channel, the color information is used to set the 
material channel value. The example below shows Diffuse Color set using a color (left) and using a 
texture (right).

Value, Optics, and Volume channels use the Alpha channel information from a texture to set the value of 
the material channel. For example, when you use a texture to set Specularity, the texture's Alpha channel 
information determines which areas of the object are shiny. As a result, you will see the pattern of the 
texture on the object.
When you use a texture to set the value of an Intensity channel, the Alpha channel information is used to 
set the material channel value. In the example below, Specularity was set using a color (left) and a texture 
(right).

The Bump information in a 3D texture is used only by the Bump Height channel. The Bump channel in the 
texture determines the pattern of bumps or dents in the object. In fact, you will not be able to see the 
effects of the Bump Height value unless you assign a texture to the channel. Bump channel information 
from a texture is used to determine the pattern of bumps or dents in an object. You must assign a texture 
to the Bump Height channel to see the bumps or dents.
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• Using a 3D Texture as a Component
Using a 3D Texture as a Component
To use a 3D Texture as a component:

1. Load an object and click on the  button to enter the Materials Lab.
2. In the Materials Lab, click in a channel column. A randomly selected texture appears in the 

Texture Component Window.

3. If you want to change this texture, click the triangle button next to the texture name at the top of 
the window

and choose a preset texture from the menu.  You can also press Shift+click on the triangle to 
access the Texture Library directly instead of a listing of the textures.
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4.

Note: To access a different main category from the Texture Library via the menu, you will need to 
enter the Texture Library, select a category, then exit the library. The new category will then be 
available from the menu. 

The texture you selected appears in the Component window.

OR
5. Click on the pink Texture Source Editor button on the left-hand side of the window to enter the 

Deep Texture Editor.

2D Textures

2D Textures
2D Textures are Pictures you have created in another application or ones you select from the Pictures 
Editor. The data in the channels of these Pictures are used as values in the material channels.

• Loading a New 2D Texture
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• Replace Current 2D Texture Using Load Button
• Replace Current 2D Texture Using Copy Paste

Loading a New 2D Texture
To load a new 2D texture as a component, without overwriting one already in the editor:

1. Load an object and click on the  button to enter the Materials Lab.
2. In the Materials Lab, click in a channel column. A texture appears in the texture component 

window. 

3. In the Component window, click the P button at the bottom of the Component window. The button 
changes the component to a 2D Picture. 

4. A default Picture appears in the Component window.

To change the Picture, click the pink button at the top of the Component window. The pink button 
displays the Pictures Editor. 
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5. Click an image square to load an image or if the image you want is not in the library:  Click in an 
empty square.
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6. The Load Image dialog appears. 

7. Navigate to the folder where the image is located, select it, and click on Open.

The image will be loaded in the into the first image box. If an alpha channel is saved with the 
image, it will be loaded into the second image box. 
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8. To load an alpha channel separately, click on the Load button above the middle box.

9. The Load Image dialog appears. Find the alpha channel image, select it, and click on Open. 
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The alpha channel/mask will be loaded into the second image box. 

10. Click on the OK icon to exit the Pictures Editor. You will be returned to the Materials Lab where 
you will see the image in the component window. Notice that the alpha channel/mask is not 
"working" but that is easy to fix. 

11. If you loaded an image in the alpha channel, click in the column next to Transparency. 
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Make sure the amount is at zero (0).

12. Click on the Material Options triangle to access the menu. 

13. Select Blend Transparency from the menu. 

14. The Material Preview should now show the texture with the alpha channel applied. Click on the 
OK icon to exit the Materials Lab.
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15. Render the scene to see the result.

Replace Current 2D Texture Using Load Button
While clicking on a blank square adds a new Pictures Editor texture, a texture already in the editor can 
also be replaced by either loading a new texture or by copying an image from a paint program and 
pasting into the editor. 
To replace a 2D texture using the Load button:

1. In Bryce, open the Pictures Editor, click on the square containing the image you want to replace.
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2. Click on Load above the image window. The Open dialog will come up. 

3. Locate and select the image you want to load. Click on Open. 

4. The image will be loaded into the window you selected. Notice that the image was replaced in the 
square below.
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5. Click on the OK icon to exit the editor or load an image in the alpha channel if needed. 
Caution: Once you load the image, you cannot get the original image back by clicking on the Close icon 
and canceling the operation. So be sure this is what you intend to do before you do this. 
Replace Current 2D Texture Using Copy/Paste
While clicking on a blank square in the Pictures Editor adds a new texture, a texture already in the editor 
can also be replaced by either loading a new texture or by copying an image from a paint editor and 
pasting into the editor. 
To load a new 2D texture as a component, by copying from a paint program and pasting into the editor:

1. Load or make an image in your favorite paint program (i.e., Paint Shop Pro, Photoshop, Painter, 
Dogwaffle, etc.). 

2. Copy the image to place it in the clipboard.
3. In Bryce, open the Pictures Editor, click on the square containing the image you want to replace.

4. Click on Paste below the image window.

5. A popup will come up asking if you are sure you want to delete the image. Click on Delete.
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The image will be loaded into the window you selected. Notice that the image was replaced in the 
square below.

6. Click on the OK icon to exit the editor or load an image in the alpha channel if needed. 
Caution: Once you click on Delete and load the image, you cannot get the original image back by clicking 
on the Close icon and canceling the operation. So be sure this is what you intend to do before you 
confirm the deletion.

Combining Components

Combining Components
You can combine material components using one of three blending modes:

• Mode A
• Mode AB
• Mode ABC
• What About D?

Mode A
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In Mode A, only one component is used to set the value of a channel. The component can be a value, a 
Picture, or a 3D texture.

Mode AB
In Mode AB, two textures are blended together based on altitudes. At the lowest altitudes, the values from 
texture A are used; at higher altitudes, texture B is used to set the value of the channel.
Altitude is based on the distance between the ground level and the highest object in your scene.
When you use this mode, an object's surface material is a blend between two texture components. 
Texture B appears at the bottom of the object and Texture A appears at the top. In between is a blend 
between texture B and texture A. Bryce creates the blend by interpolating between the two textures.
For example, if you use Mode AB in the Diffuse Color channel, the color in texture A appears at the 
bottom of an object's surface, and the color from texture B appears at the top. A color gradient between 
color A and color B appears in the middle of the object
Mode AB can be used to create snow covered peaks on terrains or murky depths in infinite water slabs.
To use Mode AB to blend textures, in the Materials Lab, Ctrl+click the B column of a channel. Component 
indicators appear in both the A and B columns of the channel.
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Mode ABC
In Mode ABC, two textures, texture A and texture B, are blended based on the alpha channel of texture C.
In this mode, the alpha channel from texture C acts like a map that tells Bryce where to apply the values 
from texture A and texture 
B. The white areas of the alpha channel use values from texture A.  Black areas in the alpha channel use 
values from texture B. Gray areas in the alpha channel use a combination of both textures.
To use Mode ABC to blend textures, in the Materials Lab, Ctrl+click the C column of a channel. 
Component indicators appear in the A, B, and C columns of the channel. 
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What About D?
When Component D is used along with any other combination of textures, it is used to add a new element 
to the material. It is not combined with the other components.
This allows you to use Components A, B, and C to drive the color of the material and use Component D 
to drive a different value, such as bump or transparency.
The example below shows a material with the Diffuse color driven by A and B, and an entirely different 
texture in D driving the bump.
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Texture Mapping Modes

Texture Mapping Modes

Once you have decided on a texture to use as a component, you need to decide how the texture is 
mapped onto your object. The appearance of the texture can change dramatically depending on how it is 
applied to the object.
Each texture you apply can have a different mapping mode. When you are mixing textures (Mode AB or 
Mode ABC), you can choose which portions of your textures you want to combine.
To select a mapping mode for a texture:

1. In the Materials Lab, click a channel. A random material will be applied. 

2. If you will be using a 2D image, load a 2D Texture to replace the 3D one. 
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3. Click the current Mapping Mode title to access the Mapping Mode Options.

4. Choose a mapping mode from the menu. 
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• Object Space
• World Space
• Parametric
• Parametric 
Scaled
• Sinusoidal
• Spherical
• Cylindrical
• Reflection Map
• Random
• Object Top
• Object Front
• Object Side
• Object Cubic
• World Top
• World Front
• World Side
• World Cubic

Object Space

In this mapping mode, textures are scaled proportionally to the size of your object. If you change the size 
of your object, the texture scale changes with it. The texture also rotates along with the object. This 
means that the texture does not appear to move as you reposition or rotate the object.
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World Space

In this mode, the texture is applied throughout infinitely large 3D space, and only a small portion is applied 
to your object. This means that the texture appears to change as you move your object, since the object 
is moving through the texture in 3D space.

Parametric

In this mode, the texture is applied onto the object as if it were a decal. For example, if you use this 
mapping mode on a cube, one iteration of the texture is placed on each face.
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Parametric mode applies the texture as a 2D decal. The texture is mapped onto the object so it rotates 
and scales as the object is scaled or rotated. This mode works best with 2D Picture textures.

Parametric Scaled

This mode works like the World Space mode, only in 2D. Textures mapped using this mode are not 
scaled with the object.

Use this mode when you want to map a 2D Picture onto constructed objects like buildings.

Sinusoidal

In this mode, the texture is applied as in a map projection usually used to show the entire surface of a 
spherical object, such as the earth, moon, or celestial map. 
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Spherical

In this mode, a 2D projection of your texture is mapped onto a virtual sphere that surrounds your object. It 
is then projected from the sphere onto your object.
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Cylindrical

In this mode, your texture is mapped onto the front of your object, wrapping around the right and left sides 
all the way to the back. Edge pixels going to the center appear on the top and bottom of your object.

Reflection Map
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In this mode, a 2D projection of your texture is applied to a virtual sphere that surrounds your scene. The 
texture is then reflected off of the sphere and onto your object. (Issue 16)
This mode works best on objects with irregular surfaces. It also works well with terrains. 
The image below shows a sphere with reflection mapping (left), world space (middle), and parametric 
(right) mapping applied 

Random

This mode randomly applies a 2D projection of the texture all over the surface of your object.
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Object Top

This mode applies a 2D projection of the texture to the top of your object. The texture rotates and scales 
along with the object.

Object Front

This mode applies a 2D projection of the texture to the front of your object. The texture rotates and scales 
along with the object.

©2003-2011 DAZ 3D, Inc. 607



Bryce 7 Artist Guide 03 Jan 2011

Object Side

This mode applies a 2D projection of the texture to the side of your object. The texture rotates and scales 
along with the object.

Object Cubic

This mode applies a 2D projection of the texture to all sides of your object. The texture rotates and scales 
along with the object.
This is most clearly seen in the second image below where the Leo image is applied using Object Cubic 
mode. The image is seen in its entirety on all sides of the objects.
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World Top

In this mode a 2D projection of the texture is applied to the object from directly above it. If you move your 
object or rotate it, the texture does not move with the object; it remains constant while the object moves 
through it.
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World Front

In this mode a 2D projection of the texture is applied to the object from the world front. If you move your 
object or rotate it, the texture does not move with the object; it remains constant while the object moves 
through it.

World Side
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In this mode a 2D projection of the texture is applied to the object from the world side. If you move your 
object or rotate it, the texture does not move with the object; it remains constant while the object moves 
through it.

World Cubic

In this mode a 2D projection of the texture is applied to the object from all world sides. If you move your 
object or rotate it, the texture does not move with the object; it remains constant while the object moves 
through it.
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Mapping Mode Modifiers

Mapping Mode Modifiers

You can modify the mapping modes in the following ways: 
• Symmetric Tiling
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• Repeat Tiling
• Scale Picture Size
• Centered Transforms
• Decal Colors
• Alpha Scaling
• Picture Interpolation

Symmetric Tiling

When you tile a texture onto an object in symmetrical tiling mode, each repeated instance of your texture 
is tiled horizontally and vertically. as needed to seamlessly produce a symmetrical pattern over the 
surface of the object.
In Symmetrical Tiling mode, textures are seamlessly tiled across the object.
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Repeat Tiling

Unlike symmetrical tiling, in which a seamless tiled pattern is achieved by flipping the texture horizontally 
and vertically, Repeat Tiling repeats your texture across the surface of your object without any alteration 
in orientation. The number of instances of the texture depends on the scale applied to the texture.

Scale Picture Size

This mode modifier only affects Picture textures. When selected, the image behaves like a sticker placed 
on the surface of the textured object. Unless Scale Picture Size is selected, the Picture will repeat itself 
across the surface in a similar way to Repeat Tiling.
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Centered Transforms

Centered Transforms works with parametric mapping modes to force the transformation of the textures to 
be applied around the center of the object surface.
This option is not available ("greyed out") unless a parametric mapping mode is selected.

Decal Colors

Decal Colors blends the color of a texture with the affected component's base color. It uses the texture's 
alpha channel to control the amount of blending. This can make decalcomania effects easier to achieve.
The image below shows the same checked pattern used on previous pages, but with Decal Colors 
selected.
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Alpha Scaling

Normally, if you drive a component's value with a texture, the texture's alpha channel will set the value 
without regard to the amount that was set using the component's slider. With Alpha Scaling turned on, the 
amount set with the slider will "scale" the amount provided by the texture's alpha channel. This gives you 
more subtle control over the influence of the texture on the material component's value.
Alpha Scaling works with Diffusion, Ambience, Specularity, Metallicity, Transparency, and Reflection. It 
has no effect on Bump Height since bump is not driven by alpha channels.
The image below shows Diffusion set at 25, 50, and 75, with the second row using Alpha Scaling. Notice 
how the top row does not show any difference in diffusion without Alpha Scaling selected.

Picture Interpolation

This mode modifier is enabled by default. It interpolates the Picture file you are using, allowing the Picture 
file to be applied smoothly to an object. With Picture Interpolation disabled, the image may appear to be 
pixelated or jagged.
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The image below shows two cubes with the same texture applied. The cube on the right has Picture 
Interpolation deselected. 

Transforming Textures

Transforming Textures

Since a 3D texture exists in three-dimensional space, it can be transformed along the X, Y, or Z axis - just 
like a 3D object. Using the texture Transformation Tools, you can scale, position, or rotate your texture.
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The final look of the transformation depends on the mapping mode you use to apply the texture to the 
object. In some modes, texture transformations may not be very noticeable, while in others, like 
Parametric, transformations can have a large impact on the look of the material.
You may find it necessary to experiment with different settings to get the results you want. If you find that 
the texture is not reacting the way you want it to, try changing the mapping mode.
The transformation tools give you very fine control over the final appearance of the texture.

• Scale
• Rotation
• Position

Texture Scale

Using the Scale Control, you can control the frequency of the texture. Increasing the scale of a texture 
decreases the frequency of the pattern, since it does not have to be repeated as many times to cover the 
surface of the object.
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Since a 3D texture exists in 3D space, you can change its size in all three axes.
• Adjusting the scale in X changes the size of the texture along the X axis.
• Adjusting the scale in Y changes the size of the texture along the Y axis.
• Adjusting the scale in Z changes the size of the texture along the Z axis.

This example shows the X axis (top row), Y axis (middle row), and Z axis (bottom row). From left to right 
on each row, the scale values are 0%, 45%, and 90%. 

The texture can also be scaled by dragging the channel slider up or down. Dragging the slider up 
increases the texture size while dragging it down decreases the texture size.
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Texture Rotation

Using the Rotation Control, you can control the angle of the texture on the object's surface. You can 
create very different texture effects depending on the texture's orientation.

Since a 3D texture exists in 3D space you can change its orientation in all three axes.
• Adjusting the rotation in X changes the angle of the texture along the X axis.
• Adjusting the orientation in Y changes the angle of the texture along the Y axis.
• Adjusting the orientation in Z changes the angle of the texture along the Z axis.

This example shows the X axis (top row), Y axis (middle row), and Z axis (bottom row). From left to right 
on each row, the rotation values are 0°, 45°, and 90°.

 

Texture Position

Using the Rotation Control, you can control the angle of the texture on the object's surface. You can 
create very different texture effects depending on the texture's orientation.
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Since a 3D texture exists in 3D space you can change its orientation in all three axes.
• Adjusting the rotation in X changes the angle of the texture along the X axis.
• Adjusting the orientation in Y changes the angle of the texture along the Y axis.
• Adjusting the orientation in Z changes the angle of the texture along the Z axis.

This example shows the X axis (top row), Y axis (middle row), and Z axis (bottom row). From left to right 
on each row, the rotation values are 0°, 45°, and 90°. 

Shading Modes

Shading Modes

Shading refers to the process of applying material channel values to an object. When an object is shaded, 
the different values in the material are applied to the object. The shading modes available in Bryce 
determine how material channels are applied to create different effects.
Using a material, you can define whether a surface is shiny, smooth, or opaque. 
Using a shading mode, you determine how those properties are applied to the object. 
The shading mode cannot only determine how the material is applied to the surface of the object, but how 
it is applied to the object's volume as well. 
To choose a shading mode, click the triangle icon next to the material type buttons at the top of the 
Materials Lab. 
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• Surface Material Shading Modes
• Volume Material Shading Modes

Surface Material Shading Modes

Surface Material Shading Modes

This section explains the Surface Material Shading Modes.
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• Normal
• Blend Transparency
• Fuzzy
• Light

Normal

Normal mode applies the values of the material without modifying them in any way. Objects are shaded 
according to the values you set in the material channels. This mode has no special effects; it simulates a 
real-world appearance using the material channel values. This is the default mode and is appropriate for 
most objects.

Blend Transparency
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In Blend Transparency mode, visibility is controlled by Transparency. When this mode is active, areas of 
the object that are 100% transparent are ignored. Transparent areas are not shaded and do not cast 
shadows. These areas appear as gaps or holes in the object's surface.

This mode lets you create punch-outs when using a texture. The lower cage in this example was created 
by using blend transparency to "punch-out" areas of the object's surface (the upper was created using 
normal shading).
When the material is applied using Normal mode, Transparency creates an optical effect.

When the material is applied using Blend Transparency mode, Transparency creates a punch-out effect, 
as shown here. The areas of the surface that are 100% transparent are completely ignored during 
shading so that they appear as gaps or holes it the surface. Any areas that are less than a 100% result in 
a normal transparency effect.
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Fuzzy

Fuzzy mode changes the effective transparency based on the thickness of the object. As a result, objects 
appear fuzzy on the edges and solid at the center.
Since Bryce uses depth information to synthesize this blurry effect, it is not available for 2D objects such 
as Squares or Disks.
Use the Transparency setting to adjust the degree of fuzziness. 

The image below shows the material with Transparency at 0:

And with transparency increased to 15:
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Light

Light is a very specialized shading mode best used to create visible lighting effects. Objects shaded with 
this mode appear transparent and self-illuminating.
Only the Diffuse, Ambient, and Transparent Color channels are used to determine the color of the light. 
All other channels are ignored.
This mode is useful for creating point lights without the rendering overhead that comes with true volume 
light objects (that is, light-sensitive volume materials).

The image below shows a material applied to the Diffuse Color channel with the Light shading mode 
selected:

Volume Material Shading Modes
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Volume Material Shading Modes

This section explains the Volume Material Shading modes.

• Flat Shading
• Basic Shading
• Full Shading
• Light Sensitive
• Uniform Density
• Sky Integration

Flat Shading

Flat Shading mode is designed for clouds, gases, and other self-luminous gaseous materials. Flat 
Shading mode does not shade an object, meaning that light sources have no effect on the color or 
brightness of the object.
When this mode is active, Diffusion, Ambience, Specularity, Ambient Color, Specular Color, and 
Transparency Color have no effect.
The color of the material is determined entirely by the Diffuse Color channel.
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Basic Shading

Basic Shading mode is designed to apply shading and light effects to the exterior surface of a volumetric 
object without affecting the interior. When this mode is active, volumetric objects are shaded as if they 
have a surface material applied to them rather than the actual volume material.
In this mode, light sources have a limited effect on the color and brightness of an object. Only the exterior 
surface of the object will be affected by light sources; light and shadows will not be generated within the 
object.

Full Shading
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Full Shading mode is designed for hard edged, sharp objects like rocks. When Full shading mode is 
active, the visible portions of the material are shaded and can be affected by light sources.
Since light sources can affect portions of your material, shadows will appear within the object. This can 
greatly increase rendering time. If you do not need to see shadows in the object, make sure the Receive 
Shadows filter is disabled. Usually you should disable this filter unless you are creating very specialized 
effects.

Light Sensitive

Light Sensitive mode is designed for creating visible light effects such as light beams. Light Sensitive 
mode does not shade objects, but the particles in your material are sensitive to light.
In this mode, Density does not control density as much as it sets the light sensitivity of material particles. 
Higher values create brighter particles and lower values create darker particles. To get the best results for 
light objects, use the Additive blend mode.
The color of the particles is determined entirely by the Diffuse Color channel. The result is like shining a 
light through a volume. If you were shining a light through a cloud material, you would be able to see the 
clouds within the light cone.
When this mode is active, Diffusion, Ambience, Specularity, Ambient Color, Specular Color, and 
Transparency Color have no effect.
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In this example, the Light Sensitive mode was used to apply material inside the sphere on the right (left 
image). When the sphere is lit by a light source, the particles of the material become visible (right image).
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Uniform Density

Objects can have varying densities. By default, objects have a density that varies from center to surface. 
The object is most dense at the center and becomes less dense as you approach the surface. You can 
control the starting point of this variation in density by using the Edge Softness control.
However, you may want to create objects that do not vary in density. Uniform Density mode sets the 
object to have a consistent density throughout the object. The density at the starting point is used 
throughout the object. This results in harder-looking objects and faster rendering times.

The image below shows two spheres with Uniform Density selected. The sphere on the left has the Edge 
Softness set to 100, while the sphere on the right has the Edge Softness set to 5.

Sky Integration

Sky Integration mode is designed to increase the realism of volume objects in scenes that have hazy or 
foggy atmospheres. When Sky Integration mode is active, the sky effects such as haze and fog are taken 
into account when the volume object is rendered. This helps blend objects realistically into the 
atmosphere.
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This mode is very useful for creating realistic cloud objects or fog objects.

The image below shows two spheres with a cloud texture applied. The sphere on the right has Sky 
Integration enabled. On these small objects, it is not easy to see the difference, but the sphere on the 
right shows a slight difference in how it is blended into the sky.

Shading Mode Modifiers

Shading Mode Modifiers

Shading Mode Modifiers are not shading modes, but they modify an existing shading mode. When you 
select a modifier it remains enabled until you disable it. You can also apply more than one modifier at the 
same time.

• Additive
• Cast Shadows
• Receive Shadows
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• Self Shadows
• Distance Blur
• Sampling Blur
• Volume Blend-Altitude
• Volume Blend-Distance

Additive

When the Additive modifier is active, material channels are applied to the environment behind the object 
instead of to the object's surface.
If you put an object on a bright background, it appears almost white. For best results, set your Ambient 
Color control to zero and render against a dark, plain background. Objects with this shading mode 
modifier selected will not cast shadows.
This mode is very useful for creating planets and quarter moons, light beams, and ghost images.

Cast Shadows

The Cast Shadows modifier prevents an object from casting shadows. The object's surface still reacts 
normally with light but it does not cast any shadows.
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Receive Shadows

The Receive Shadows modifier prevents an object's surface from accepting shadows cast by objects 
around it. The object itself will cast a shadow, but it will not accept shadows from other objects.
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Self Shadows

The Self Shadows modifier prevents an object from casting a shadow onto itself, yet still shadow all the 
other elements of the scene.
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The image on the left shows the bottom torus with Self Shadows enabled while the image on the right 
shows the same torus with Self Shadows disabled. The arrow shows where the difference is between the 
two.

Distance Blur

The Distance Blur modifier is designed to minimize the problem created by highly bumpy textures fading 
into infinity (i.e., the horizon). Often, moiré-like patterns appear in these cases as the pixels try to resolve 
the infinitely receding high frequencies of bumpy water or grooved sand, and so on. The Distance Blur 
modifier fades the bumpiness well before it hits the horizon.
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The images below show the same material on the ground plane, but the image on the right has Distance 
Blur enabled.

Sampling Blur
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The Sampling Blur mode is only available when using a Volume Material and helps to reduce rendering 
artifacts. This option should always be selected when using Volume Materials.

Example:

Volume Blend-Altitude

The Volume Blend - Altitude modifier gradually blends in the Volume color based on Altitude. Areas at 
lower altitudes are tinted with the 100% Volume Color; as you move higher up, less of the Volume Color 
is added.
This modifier can be used to create a sense of depth in an infinite water slab. If you blend between a light 
Diffuse Color and a darker Volume Color, you can create the illusion of depth as you sink deeper into the 
water. 
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The images below show a water slab with the Volume Blend - Altitude enabled in the image on the right.

Volume Blend-Distance

The Volume Blend - Distance modifier blends the Diffuse and Volume Colors of your material based on 
the distance from the camera.
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Areas that are closer to the camera will be tinted less with the Volume Color. As you move further away, 
more of the Volume Color is visible. This modifier is excellent for creating underwater depth effects. If you 
blend a darker Diffuse Color with a lighter Volume Color in an infinite slab, you can simulate the effects of 
murky water on distant objects.

The images below show a water slab with the Volume Blend - Distance enabled in the image on the right.
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Deep Texture Editor

Deep Texture Editor 
You can edit the makeup of an existing texture or create a completely new texture using the Deep Texture 
Editor. This editor uses some rather complex texture-generation concepts to create textures for Bryce. 
You can either choose to learn all these concepts to create your textures precisely, or use the editor as a 
type of lab where you combine random settings and see the results. 
The Deep Texture Editor (DTE) can be used in two ways: by working with equations and algorithms or by 
exploring and experimenting. 
If you are comfortable with equations and algorithms, the Deep Texture Editor gives you the freedom to 
create any textural pattern or surface you can imagine. 
For those who do not want to calculate, the Deep Texture Editor can be used as a large palette. Take a 
little of this and little of that, blend them all together and see if you like the result. You will find that 
experimenting with these deep functions can produce unexpected results. 
When experimenting with the Deep Texture Editor, you may inadvertently create a very complex texture 
that could add considerably to your rendering time. However, this is an easy pitfall to avoid. The last 
section of this chapter gives you some tips on reducing the complexity of your textures. Refer to "Tips for 
Speeding up Textures" for more. 
See the topics below for more on accessing and working in the DTE:

• A Quick Tour of the DTE
• Accessing the DTE
• Working in the DTE
• Textures

 

A Quick Tour of the DTE 
The layout of the Deep Texture Editor is a visual representation of the texture creation process. The three 
components along the top combine to form the final texture, shown in the middle. The layout makes the 
editor very easy to use. Along the top of the editor you will see the preview options. These three icons let 
you choose how you want to display the component. 
Below the preview control on the left, you will see the Component Selector. This tool lets you choose the 
number of components you want to use to build your texture. 
The rest of the editor displays the component window. The three windows along the top represent the 
three components you can use in a texture and the center window represents the combined texture. 
TIP: When you are just exploring the editor, set all the component outputs to Alpha. This lets you see the 
effects of your changes more clearly. 
The three buttons along the bottom of the editor let you display the three editing palettes. 
The palettes let you control the noise, phase, and filtering applied to the texture. 
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You can access the Noise and Phase Editors from within the Noise and Phase Palettes. 
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Accessing the DTE
Accessing the DTE 

The Deep Texture Editor can be accessed from multiple locations depending on what is selected or what 
lab is currently active.

• From the Edit Palette
• From the Light Lab
• From the Materials Lab
• From the Objects Menu
• From the Sky Lab
• From the Terrain Editor
• From the Tree Lab

From the Edit Palette 

To access the Deep Texture Editor from the Edit Palette: 
1. Make sure the Edit palette is visible. If it is not, click the Edit button at the top of the Bryce 

window.  

2. Click on the Edit Materials tool to open up the Materials Lab. If an object is selected, you can 
modify its material. 

OR
3. Click on the triangle next to the Edit Materials tool and choose Edit 3D Solid Textures from the 

menu.

 

From the Light Lab 

To access the Deep Texture Editor from the Light Lab: 
1. Select a light source.
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2. Click the  button next to the selected light source. The Light Lab will come up. 
3. Click the radio button next to Use Gel, the Image and Procedural buttons will activate: 

4. Click on the Procedural button, the Materials Lab will come up. 
5. In the Materials Lab, click on one of the columns in the grid to activate a component window: 

6. Click the Pink button at the top of the window, the Deep Texture Editor comes up. 

 

From the Materials Lab 

To access the Deep Texture Editor from the Materials Lab: 
1. Select an object.  
2. Click on the  button next to the selected object. The Materials Lab will come up.
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3. In the Materials Lab, click on one of the columns in the grid to activate a component window: 

4. Click the Pink button at the top of the window, the Deep Texture Editor comes up. 

 

From the Objects Menu 

To access the Deep Texture Editor from the Objects Menu, choose Objects > Edit 3d Textures from the 
menu or press Opt/Alt+M. The Deep Texture Editor will come up. 

©2003-2011 DAZ 3D, Inc. 645



Bryce 7 Artist Guide 03 Jan 2011

You do not have to have an object selected before choosing this command. 
 
 

From the Sky Lab 

To access the Deep Texture Editor from the Sky Lab: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears. 

3. Click on the Cloud Cover tab. 

4. On the Cloud Cover tab, click on Edit under the selected cloud layer type: Stratus or Cumulus. 
The radio button next to the cloud type must be selected for the Deep Texture Editor to come up 
for that cloud type.  

 

From the Terrain Editor 

To access the Deep Texture Editor from the Terrain Editor: 
1. Select a terrain or symlat object in your scene. If none are available, display the Create palette by 

clicking the Create button at the top of the Bryce window. 

2. Click the Terrain tool or the Symmetrical Lattice tool. The default terrain or symlat appears in your 
scene.  
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3. Click on the  button next to the selected terrain/symlat. The Terrain Editor appears. 
4. In the Editing Tools dialog, make sure that the Elevation tab is selected. 
5. Press Shift+click on the Picture button. The Deep Texture Editor comes up.

 

From the Tree Lab 

To access the Deep Texture Editor from the Tree Lab: 
1. Select a tree object in your scene. If no trees are available, display the Create palette by clicking 

the Create button at the top of the Bryce window.  

2. Click the Tree Object tool. The default tree appears in your scene.  

3. Click on the  button next to the selected tree. The Tree Lab appears. 
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4. Click the Material button at the bottom of the Branch/Trunk or Foliage section.

5. Click the Edit button to the right of the Material button. The Materials Lab appears.  

6. In the Materials Lab, click on one of the columns in the grid to activate a component window: 

7. Click the Pink button at the top of the window, the Deep Texture Editor comes up. 

 

Working in the DTE
Working in the DTE 

This section describes how to use the Deep Texture Editor to create and store textures. 
• Building Textures
• Using Drag & Drop in the DTE
• Changing Component Preview
• Randomizing Textures
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• Previewing Textures
• Undoing Changes
• Saving Textures

Building Textures 

A texture is a combination of components. You build textures by designing or editing components (i.e., 
colors, noise, phase, or filters) and combining them using Blend Modes. 
To build a texture: 

1. Display the Deep Texture Editor. 
2. Click the Component Selector to choose the number of components you want to use to build the 

texture. The component windows become active.

3. In the first component window, click one or more of the Output buttons to choose an output type.  

4. If your component contains color, click one of the color circles and choose a color to apply to the 
texture. You can choose up to three colors for each component. 
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5. Click the triangle icon below the color circles and choose a Color Blending Mode for your colors.  

6. Click the Noise button at the bottom of the editor. The Noise Palette appears. 

7. Adjust the noise in the component by:  
• Dragging the Noise Slider on the Noise Palette to increase or decrease the amount of 

noise in the component.  

• Click the top left corner of the palette to display the Noise Editor, then use the editor 
controls to design or edit the noise in the component. 
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8. Click the bottom-right button on the Component Window. The Phase Palette appears. 

9. Adjust the phase in the component by:  
• Dragging the Phase Slider on the Phase Palette to increase or decrease the amplitude of 

the phase in the component.  

• Click the top left corner of the palette to display the Phase Editor, then use the editor 
controls to design or edit the phase in the component. 

10. Click the Filtering Button at the bottom of the editor. The Filtering Palette appears. 
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10. Choose a filter to apply the component noise.

10. Adjust that filter's variables. 

10. Repeat steps 3 through 12 for each component in the texture. As you edit the noise, phase, or 
filter of the remaining components, make sure you move the component indicator at the top of each 
palette to be sure you are editing the right component's attributes.  
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10. Click the text above Component 1 and choose a Blend Mode from the menu. 

10. If you have more than two components, click the text above Component 2 and choose a second 
blend mode. The result of blending all the components appears in the Combination Window. 
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10. Click the color circles in the Combination Component Window, and choose colors for the final 
texture.
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10. You can also choose a Blending Mode. 

10. If you want to change the noise of combined component, display the Noise Palette. If it is already 
displayed, make sure the component indicator is on the fourth component. 

10. If you want to change the phase of combined component, display the Phase Palette. If it is 
already displayed, make sure the component indicator is on the fourth component.  

10. If you want to change the filter of combined component, display the Filtering Palette. If it is 
already displayed, make sure the component indicator is on the fourth component.  
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10. Click the OK icon at the bottom of the editor. The texture appears in one of the component 
windows in the Materials Lab. 

 

Using Drag & Drop in the DTE 

The Deep Texture Editor lets you drag and drop component elements between component windows. This 
a quick way of copying elements between components. For example, if you were setting up a red, green, 
and blue separation of the colors in your texture, you could drag the same elements to all three 
component windows and change the Color Blending mode. 
To drag and drop between windows, drag from the window you want to copy to the window where you 
want the elements to appear. Release the mouse button to drop the component elements. The elements 
you drop into a window replace the existing elements. 
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Changing Component Preview 

Each component window has a preview of the component's elements. You can choose to display the 
elements mapped onto a flat surface, a cube or a sphere. Displaying the component on a cube makes it 
easier to see 3D noise and phase changes. 
To choose a preview mode, click the flat surface, cube, or sphere in the top-right corner of the editor. 

Examples: 
1. Flat (default):  
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2. Cube: 

3. Sphere:

 

Randomizing Textures 

A quick way of designing a texture without going into designing noise or filters is to create random 
components. The Randomize Buttons in the component windows let you randomize the elements in the 
component window. The type of output you choose for the component determines what part of the 
component is randomized. 
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This is an excellent way of exploring the editor. Just randomize the components elements and combine 
them to see what happens. 
To randomize component elements, click the knob in the bottom-right corner of the component window. 

 

Previewing Textures 

Textures can be previewed in a larger format in the Deep Texture Editor. You can preview the texture in a 
small preview or over the entire screen. 
To preview the texture in small format: 

1. Click in the Combination Component window.  

The preview will come up covering the Deep Texture Editor area.  
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2. Click on the window to close the preview.  
3. To change the Display Mode, click on one of the Display Mode buttons at the top right of the 

Deep Texture Editor.

4. Then click in the Combination Component window.  

To preview the texture over the entire window: 
1. Press the Spacebar and quickly click in the Combination Component window, letting up on the 

Spacebar immediately after clicking in the window. This may take a bit of practice to get the 
preview to show and stay up. Change the Display Mode if needed.
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The preview will come up covering the entire screen.  
2. Click on the window to close the preview.

 

Undoing Changes 

The Reset Control lets you undo all the changes you have applied to a component and returns to the 
component displayed when you first entered the editor. 
To reset a component, click the knob in the top-left corner of the component window. You can also click 
on the Cancel icon to exit the Deep Texture Editor without applying the changes. 

 

Saving Textures 

You can save your texture as part of texture list so you can access it quickly from the Materials Lab. 
To save a texture: 

1. In the Combination Component Window, click the knob in the top-right corner of the component 
window. 
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The Textures Library appears.
2. Change categories if needed and select the sub-category to save the texture to.

3. Click on Add. The Add Presets dialog comes up.  

4. Enter a name for the new texture, and a description if you want, then click on the OK icon. 

The new texture is added to the library. 
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The texture list can then be accessed from the Materials Lab. 

Please note that if you need to access the Installed texture category or another category from the Texture 
Library, you will need to change categories in the library before it can be accessed from the texture list in 
the Materials Lab.
 

Textures
Textures 

One of the things that makes Bryce so unique is its Materials. A Material can bring any object to life, and 
Textures are the power behind the Material. A Material can make your object shiny, dull, or transparent, 
but the Textures within that Material are what make it look like wood, rock, water, or clouds. 
Textures define the color, pattern, or bumps within a Material. A Material can contain up to four Textures. 
By altering the make-up or pattern of a Texture you can dramatically alter the appearance of a Material. 

• Texture Structure
• Component Output
• Component Elements
• Combining Components
• Tips for Speeding Up Textures

Texture Structure

Texture Structure 
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A Bryce Texture can be made up of three Components. These Components contribute the raw patterns or 
Textures within a Texture. Each Component can then contribute one of three types of Output to the final 
Texture. These Outputs are then combined to create the final Texture. 
The following diagram shows the structure of a Texture. 

Within each Component is a combination of colors and noise that create a pattern. The shape of the noise 
inside a Component is determined by the phase of the noise and the filter applied to it. The filter can 
create coherent patterns, random spots, or anything in between. Refer to "Noise," "Phase," and "Filtering" 
for more on noise, phase, and filtering.
The following diagram shows the structure of a Texture including the structure of a Component. 
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A Component can contribute one of three types of output to the final Texture: Color output, which 
determine the colors in a Texture, Alpha output, which determines the bright and dark areas in a Texture, 
and Bump output, which determines the size and pattern of bumps in the Texture. 
The Component can contribute any combination of outputs. So you can have a final Texture that contains 
Color output, Alpha output, and Bump output, or it can have all Color output or all Bump, or any 
combination of the three. 
The outputs in a Texture are used by the material, so the type of output you have in a Texture depends 
entirely on how you want to use the Texture in the material. For example, if you are using the Texture as 
a bump map for the Bump Height channel in a material, you would probably want all the Components to 
contribute only Bump output. 
A Texture can contain up to three Components. It can be made up of all three Components or just one, 
depending on the type of Texture you want to create. The more Components you use, the more complex 
your Texture.  
Components are combined using Blend Modes. These modes can create a wide range of effects. The 
way Components are combined to create the final Texture is determined by the Blend Mode you select. 
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Components are combined differently depending on how many you use. If you use one or two they are 
combined according to the blend method you select. If you use three, the first two Components are 
combined, and the resulting Texture is then combined with the third Component to create the final 
Texture. 
When you use three Components, the first two Components (C1 and C2) combine to create a hybrid 
Texture which is then combined with the third Component (C3) to create the final Texture. So they're 
combined using the formula (C1+C2)+C3=FINAL. 

The Texture Components are combined together to form the final Combination Texture. The final Texture 
can have its own color scheme, noise, phase, or filter. Any changes you make to the combination Texture 
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changes the final Texture. These types of operations are called Global changes. Refer to "Global 
Changes" for more on global changes.
The end result of the Global changes is the final Texture which can then be used in the Materials Lab to 
create a Material.
See the following topics for more information on texture structure:

• Components vs Texture Components
• Understanding Component Structure
• Components and Output

Components vs. Texture Components 

Before you get any deeper into the discussion of texture structure you should understand a little 
terminology. 
A texture is a part of a material. It can be used to drive any of the material's channels. When you use a 
texture in a material, it is called a material component. 
The texture itself also has components. It can be made up of up to three components that determine the 
look and color of the texture. The components that make up a texture are called components.  
The difference between components and texture components may be a bit confusing. Just remember that 
when you are talking about a texture, you are dealing with components. When you are working with 
materials, you are using texture components. 

 

Understanding Component Structure 

A texture can have up to three components. When combined, the components create the final texture. A 
component consists of noise and color. 
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A component can have up to three colors. The combined texture can also have a different set of three 
colors which is added to the colors from the components. In total your texture can contain up to twelve 
colors. 
The noise in a component is made of base Noise which is modified by the Phase, which controls the 
complexity of the noise, and the Filter, which determines the shape or pattern of the noise. 

 

Components and Output 

A component's output type determines what type of information it is going to contribute to the final texture. 
The Output type also determines the component's structure. A component that does not have a Color 
output will not contain any color information. The same is true for the two other types of output. If there's 
no Alpha or Bump output, then there's no Alpha or Bump information in the component.
See "Component Output" for more on component output.
 

Component Output

Component Output 

The main purpose of creating a component is to use it as part of a material which will then be applied to 
an object. How and what a texture contributes to a material is determined by the type of output it 
produces. 
A texture can produce three different types of output: Color, Alpha, and Bump. 
When you apply a texture to a material, you can see the output types in the Texture Component Window 
in the Materials Lab. 
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The three boxes in the Texture Component Window in the Materials Lab represent the three output types 
available for a texture. 
If a texture does not produce a particular output, the box appears gray. Refer to "Texture Components" 
for more on using textures in materials. 
In the Deep Texture Editor, the output type for a component is indicated by the three output buttons along 
the right side of the Component Window. 

See the following topics for more information on component output:
• Assigning Output Types
• Color Output
• Alpha Output
• Bump Output

Assigning Output Types 

A texture can produce all three output types or only one. The number of output types for the final texture 
depends on the output you assign to the components. A component can produce one or all three types of 
outputs. 
You can assign more than one component to the same output type. If you do have more than one 
component with the same output type, the output information will be blended to produce a final output. For 
example, if you have two components that produce color output, when you combine them the colors from 
both components are blended together and the result is applied to the final texture. 
In order to produce an output type, a final texture must contain at least one component that produces the 
type of output you want. For example, if you want your final texture to contain color output, at least one of 
its components must produce color output. 
Each output type contributes something different to the final material. 

• Alpha Output
• Color Output
• Bump Output

Color Output 

Color output is used by the color channels of a material. The color values you assign to a texture's 
components are combined to form a final texture. The combined values are then used to drive the Diffuse, 
Ambient, Specularity, Specular Halo, or Transparency Color channels. 
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The colors in a texture usually appear in the form of a pattern or grain. When you assign the texture to a 
material, this pattern appears in the final material.  
The texture in this example was applied to the Diffuse Color and Ambient Color channels of the object's 
material. You can see how the color pattern in the texture appears in the material. 

To assign Color output to a texture:
1. Display the Deep Texture Editor.
2. In the desired component window, click the C button on the right side of the component window. 

The output mode is active when it is a light gray color.  

 

Alpha Output 

Alpha Output is used by the various Intensity and Optic channels of the material. When a texture's Alpha 
Output is assigned to a material, it is used either to determine an effect's intensity or as a guide map for 
combining multiple textures. 
When there is only one texture component in a material channel, the texture's Alpha Output is usually 
used to determine the intensity of a channel effect. For example, if you assign a texture to the Diffuse 
channel, the texture's Alpha Output is used to determine which areas are the most diffuse and which are 
the least diffuse. The texture in this example was applied to the Diffuse channel of the object's material. 
You can see how the alpha pattern in the texture controls the diffuse intensity on the object's surface. 
To assign Alpha output to a texture: 

1. Display the Deep Texture Editor. 
2. In the desired component window, click the A button on the right side of the component window. 

The output mode is active when it is a light gray color.  
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Bump Output 

The Bump Output is used only by the Bump Height material channel to determine the pattern and height 
of the bumps in a material. The texture in this example was applied to the Bump Height channel of the 
object's material. You can see how the bump output in the texture controls the pattern of bumps on the 
object's surface. 
To assign Bump output to a texture: 

1. Display the Deep Texture Editor. 
2. In the desired component window, click the B button on the right side of the component window. 

The output mode is active when it is a light gray color.  

 

Component Elements

Component Elements 

A Texture is made up of Components. Each of those Components can contain several elements that 
determine the color, pattern, grain, or bumps in the Component. 

• The Component Window
• Color
• Color Blending Modes
• Noise
• Phase
• Filtering
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The Component Window 

You can have up to three components in your texture. As you activate components, a Component 
Window becomes active. Each window displays a preview of the component elements. The Component 
window displays the selected component and its current attributes. 
The three buttons on the Component Window let you access the Noise Palette, the Filtering Palette, and 
the Phase Palette. The buttons along the right side of the window indicate the type of output produced by 
the component. 
To activate a component: 

1. Display the Deep Texture Editor. 
2. Click the Component Selector in the top-left corner of the editor.  

The Component Selector lets you pick how many components you want to use to build your texture. The 
selector lets you choose from 1, 2, or 3 components. 
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Color

Color 

The Colors in a component determine its color scheme. Each component can have up to three colors. 
Colors can be chosen using the Color Picker or the Color Dialog. 
The color in a component is affected by the noise, filter and phase. You can create some very interesting 
patterns of color by modifying the noise. The color pattern created by the changes in the noise is applied 
directly to the final texture. So even if Color is the only output type for the component you will still see a 
pattern in your final texture. 
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When the Color Output is selected for a component, only the color information is combined with the other 
components. Also, when you apply the texture to a material, the colors in the component contribute to the 
colors used in the Color channels of the material. 
If the Color Output is not active for a component, changing the colors or Color Blending Modes has no 
effect. 

• Activate Color Output
• Choosing a Color Model
• Choosing Colors
• Mixing Colors

Activate Color Output 

To activate Color Output for a component:
1. Display the Deep Texture Editor.
2. In the desired component window, click the C button.

An output type is active when the button appears light gray.  

Choosing a Color Model 

There are two color models you can use to create colors in the components: RGB and HLS. RGB 
combines red, green, and blue to create color. HLS combines Hue, Lightness, and Saturation values to 
create color. The method you choose depends on the final output of your Bryce scene. RGB works best 
for most types of output. 
To choose a color model: 

1. Display the Deep Texture Editor. 
2. In the desired component window, make sure the C button is active. 
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3. Click the triangle icon in the lower left corner of the window and choose a either RGB or HLS from 
the menu.  

 

Choosing Colors 

To choose colors for a component: 
1. Display the Deep Texture Editor. 
2. In the desired component window, make sure the C button is active. 

3. Click one of the color indicators along the left side of the component window and choose a color 
from the palette. The three color indicators along the left side of the window display the colors 
used in the component. 
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Mixing Colors 

To mix colors for a component: 
1. Display the Deep Texture Editor. 
2. In the desired component window, make sure the C button is selected.  

3. Opt/Alt+click the one of the color indicators along the left side of the component window. The 
Color dialog appears. 
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4. Choose a color model by clicking one of the buttons along the bottom of the dialog. 

5. Enter color values or adjust the sliders to mix a new color.

6. Click the OK icon.  

 

Color Blending Modes

Color Blending Modes 

There are several blending modes you can use to create a color scheme.
To choose a Color Blending Mode: 

1. Display the Deep Texture Editor.

©2003-2011 DAZ 3D, Inc. 677



Bryce 7 Artist Guide 03 Jan 2011

2. In the desired component window, make sure the C button is active. 

3. Click the triangle icon in the lower left corner of the window and choose a blending mode from the 
menu. 

See the following for examples of each color mode:
• None
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• Red or Hue
• Green or Light
• Blue or Saturation
• Spline Interpol
• Linear Interpol 2
• Linear Interpol 3
• Randomized
• Earth Map
• Banded
• Perturbed
• Interferences
• Interpol + Interferences
• Altitude
• Spline with Snow
• Slope
• Orient

None 

This option deactivates the color blending mode. No blending is applied to the components. 

 

Red or Hue 

When the RGB model is used, this mode outputs only red color values. 

When the HLS model is used, only Hue values are output.  

©2003-2011 DAZ 3D, Inc. 679



Bryce 7 Artist Guide 03 Jan 2011

This mode, and the Green or Light and Blue or Saturation mode, are available so that you can separate 
color values among the components. For example, you could set each component to output one of the 
different color values. 

Green or Light 

When the RGB model is used, this mode outputs only green color values. 

When the HLS model is used, only Lightness values are output. 

 

Blue or Saturation 

When the RGB model is used, this mode outputs only blue color values. 
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When the HLS model is used, only Saturation values are output. 

 

Spline Interpol 

This mode creates a blend between all the colors in the component. This is what a color blend looks like 
using Spline Interpol. 

Linear Interpol 2 

This mode creates a linear blend between the first two colors selected for the component. This is what a 
color blend looks like using Linear Interpol 2. 
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Linear Interpol 3 

This mode creates a linear blend between all the colors in the component. This is what a color blend 
looks like using Linear Interpol 3. 

Randomized 

In this mode the three colors are blended and then applied randomly throughout the component. This is 
what a color blend looks like using Randomized. 

 

Earth Map 

In this mode extra colors are generated according to the contours of the component's bump map. The 
three colors you selected for the component are applied to the middle range of the bump map. Blue is 
applied to the lowest bump values and white is applied to the highest values to simulate polar caps. Earth 
Map is excellent for creating planets. This is what a color blend looks like using Earth Map. 
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Banded 

In this mode colors are applied in bands. The bands are determined by color values. Colors with the 
lowest value (i.e., dark colors) are applied to the bands furthest from the center, colors with middle range 
values are applied next and colors with the highest values (i.e., bright colors) are applied closest to the 
center. This is what a color blend looks like using Banded. 

Perturbed 

In this mode colors are applied in irregular patterns. This is what a color blend looks like using Perturbed. 

 

Interferences 

In this mode the red, green, and blue values of the first color in the component are used to create a 
repeating pattern around the contours of the component's noise. This is what a color blend looks like 
using Interferences. 
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Altitude 

In this mode, a white layer is added above the colors at high altitudes. Any portion of the object below 
ground is automatically colored blue. Altitudes are based on the object's height. This is what a color blend 
looks like using Altitude. 

Interpol + Interferences 

This mode is a combination of Linear Interpolation and Interferences. This is what a color blend looks like 
using Interpol + Interferences. 

 

Slope 

In this mode the three colors are applied to the object depending on its slope. This is what a color blend 
looks like using Slope. 
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Spline with Snow 

This mode performs a spline interpolation of the colors in the component, but adds a white layer above 
the colors at high altitudes. Altitudes are based on the object's height. This is what a color blend looks like 
using Spline with Snow. 

 

Orient 

In this mode the three colors are applied to the object according to its eastwest orientation. This is what a 
color blend looks like using Orient. 

 

Noise

Noise 
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Noise is the background turbulence that creates the basis for texture patterns. In audio terms you can 
think of noise as the background static that you hear on old recordings. Sound is layered on top of this 
noise to create music. Like in audio, you layer other functions on top of the noise in your texture to create 
the final pattern or look of your texture. 
There are two ways of creating noise: the Noise Palette or the Noise Editor. The Noise palette can 
increase or decrease the amount of noise in any of the texture components. However, using the palette, 
you can only edit the existing noise. The Noise Editor is much more powerful than the Noise palette. It 
contains controls for creating noise from scratch. 

Noise Palette 

To display the Noise palette and adjust the current noise: 
1. Display the Deep Texture Editor. 
2. Either click the Noise button at the bottom of the editor or click the Noise button in the top-left 

corner of on any of the component windows.

The Noise palette appears.  

3. Select which component to adjust by clicking in one of the indentations of the Component 
Indicator. The first three indentations are for Components 1, 2, and 3, while the fourth one is for 
the Combination (final) Component.  

4. Move the mouse over the red ball in the Frequency slider. The cursor changes to a double-ended 
arrow. 
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5. Left-click on the ball and drag right to increase the noise. 

If you reach the end of the slider and the noise is still not enough, let up on the ball and it will 
return to the center (or 0). The new setting becomes the baseline and you can drag the ball again 
to increase the noise frequency even more.  

6. Left-click on the ball and drag left to decrease the noise.  

If you reach the start of the slider and the noise is still not enough, let up on the ball and it will 
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return to the center (or 0). The new setting becomes the baseline and you can drag the ball again 
to decrease the noise frequency even more.  

7. You can also click on the arrows at each end of the Noise Frequency slider to adjust the 
frequency without having to let up on the mouse continually, however, the numeric indicator will 
always show 1 or -1.

 

Noise Editor

Noise Editor 
To display the Noise Editor: 

1. Display the Deep Texture Editor. 
2. Either click the Noise button at the bottom of the editor or click the Noise button in the top-left 

corner of on any of the component windows. 

The Noise palette appears.  
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3. Select which component to adjust by clicking in one of the indentations of the Component 
Indicator. The first three indentations are for Components 1, 2, and 3, while the fourth one is for 
the Combination (final) Component.  

4. Click the top-left corner of the palette. The corner turns a slightly brighter green as you pass your 
cursor over it. 

The Noise Editor comes up. 

See the following topics for more on creating and adjusting noise:
• Creating Noise
• Noise Dimensions
• Noise Type
• Noise Orientation
• Noise Frequency
• Noise Octaves
• Noise Modes

 
Creating Noise 
The Noise Editor is the tool you will use to create noise with a component or combined texture. The noise 
creation process involves several steps: 
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1. Choose the number of dimensions in the noise.  
2. Choose a Noise Type. This will give the basis for creating a noise pattern or grain. 
3. Adjust the frequency of the noise. 
4. Adjust the direction of the noise.  
5. Apply a modifier to your noise, by choosing a Noise Mode.

The following sections describe the various parts of the editor and how to use them in the noise creation 
process. 
 
Noise Dimensions 
Textures in Bryce can exist in 3D so your noise can have up to three dimensions. Noise dimensions 
determine which axes you can use to adjust the orientation and frequency of the noise. It is easier to see 
the number of dimensions for your noise if you use a cube in the Noise Preview. These three examples 
show the difference between 1D (left), 2D (middle) and 3D (right) noise. 

To choose the number of dimensions for your noise: 
1. Display the Deep Texture Editor. 
2. Display the Noise Editor. 
3. Click one of the Dimension buttons at the bottom of the editor.  

 
Noise Type 
There are 50 different types of noise available in the Noise Editor. Random noise is the default (RND). 
Each noise
type provides you with a different basic pattern to start your texture. Some are more linear or geometric 
while others are 
more random. 
More complex noise types require more rendering time. The time it takes to render the preview is a good 
indication of 
how long the final texture will take to render. You should use the more complex noise types cautiously. 
The best way of choosing a noise type is to apply a few to your component and see how they look. 
Remember that this
noise is only the basis of the texture. You can still edit this noise using the other controls in the editor, so 
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do not discard a 
noise type because it is not perfect. The other controls can help you fine-tune the noise. 
To choose a noise type: 

1. Display the Deep Texture Editor. 
2. Display the Noise Editor. 
3. Click the Type field at the top of the editor and choose a noise type from the menu.  

Below are examples of the 50 Noise Types available along with examples:  
 

Nothing

Sine

Square

Triangle
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RND Discrete

RND Linear

RND Continuous

RND Saw

Vortex Noise

Fractal

Turbulence
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Spots

Fract Stone

Triangles Discrete

Square Lines

Sparse RND Paths

RND Lines

Waves
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Liquid

Linear Sine

Stucco Noise

Stone Cliff

Multifractal

Leopard

Techno
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Distance Origin

Time Random

Value

Gradient

Weird Value

Weird Gradient

Voronoi Distance1
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Voronoi Distance2

Voronoi Distance3

Voronoi Distance4

Voronoi DistSq1

Voronoi DistSq2

Voronoi DistSq3

Voronoi DistSq4
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Voronoi D2-D1

Voronoi D2sq-D1sq

Voronoi D3-D2

Voronoi D3sq-D2sq

Voronoi D4-D3

Voronoi D4sq-D3sq

Voronoi ID1
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Voronoi ID2

Voronoi ID3

Voronoi ID4

Distance Squared

Noise Orientation 
Noise Orientation controls the direction of the noise. When you adjust the noise orientation, you change 
how the noise is laid out within the texture. When you apply a texture, the direction of the noise within the 
texture remains constant regardless of the orientation of the object. Since noise can exist in three 
dimensions, you adjust the direction of the noise in the X, Y, or Z axis. This example shows rotation in X 
(left), XY (middle), and XY (right). 

The number of dimensions in the noise determines how many axes you can use to adjust the orientation. 
For 1D noise you can only use the X axis. With 2D noise you can use both the X and Y axes. For 3D 
noise you can use all the axes. 
You can edit the noise orientation using the Direction numerical fields. The fields let you enter precise 
angles for noise orientation. You can also use the scroll arrows to set the angle in increments. Changing 
noise orientation can dramatically change the look of your noise. You will see just how different your noise 
can look when you rotate it along a single axis. 
To change the orientation of noise: 

1. Display the Deep Texture Editor. 
2. Display the Noise Editor. 
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3. Click one of the Dimension buttons at the bottom of the editor.  

4. Drag over the XY field in the Direction area to set the noise angle in the X and Y axes. Drag left to 
decrease the value or right to increase it. 

5. Drag over the YZ field in the Direction area to set the noise angle in the Y and Z axes.  

6. You can also drag over the scroll arrows to speed up the increase/decrease or click on the arrows 
to increment the values by one number at a time. 

 
Noise Frequency 
Noise Frequency determines how often the pattern within a texture repeats. Frequency is like scaling the 
noise. Higher frequencies decrease the scale of the noise so you can see the pattern more often. Lower 
frequencies increase the scale of the noise so the pattern repeats less often. 
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You can change noise frequency using the Frequency fields. The fields let you enter numerical values to 
adjust the noise frequency along the X, Y or axis. You can also adjust the values using the scroll arrows. 
The number of dimensions in the noise determines how many axes you can use to adjust the frequency. 
For 1D noise you can only use the X axis. With 2D noise you can use both the X and Y axes. For 3D 
noise you can use all the axes. If you try to adjust the axis frequency for a 2D noise, your changes will 
have no effect. 
Adjusting the frequency can radically change the look of your noise. If you adjust the frequency in 
separate axes, you can achieve even more interesting effects. This example shows frequency settings of 
10 (left), 50 (middle), and 100 (right). 

In this example, the noise frequency was changed in only the Y axis (X=10, Y=80, Z=10). 

To change the frequency of noise: 
1. Display the Deep Texture Editor. 
2. Display the Noise Editor. 
3. Click one of the Dimension buttons at the bottom of the editor.  

4. Drag over the X field in the Frequency area to set the noise frequency in the X axis. Drag left to 
decrease the value or right to increase it.  
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5. Drag over the Y field in the Frequency area to set the noise frequency in the Y axis. 

6. Drag over the field in the Frequency area to set the noise frequency in the axis.  

7. You can also drag over the scroll arrows to speed up the increments.
Noise Octaves 
Noise Octaves are like musical octaves. In a musical scale, if you play F and then F an octave down, you 
are playing the same note, only it sounds lower. If you play both notes at the same time, the sound is 
more complex than if you played only one note. The same is true of noise. When you add an octave to 
noise it becomes more complex but the type of noise remains the same. These examples use Square 
noise to show the effects of increasing octaves from 0 (far left) 1 (second from left) to 2 (second from 
right) and 3 (far right). Increasing the octaves adds processing time to the component. 
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To change the number of octaves: 
1. Display the Deep Texture Editor. 
2. Display the Noise Editor. 
3. Click one of the Dimension buttons at the bottom of the editor.  

4. Drag over the Octaves field. 

 
Noise Modes
Noise Modes 
Noise Modes modify the octaves of a noise. As you add complexity by increasing the octaves, the Noise 
Modes let you modify the additional noise so that it produces different effects. 
Many of the Noise Modes use dark and light values to modify the existing noise. Also, you may not see 
the effects of the modes if the Octave is set to 0. 
To choose a Noise Mode: 

1. Display the Deep Texture Editor. 
2. Display the Noise Editor. 
3. Click the Mode field at the top of the editor and choose a mode from the menu.
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There are 13 noise modes available: 
• Standard
• Irregular
• More Irregular
• Maximum
• MultiFractal
• With Rotation
• Minimum
• Multiply
• Difference
• Minimum90
• Maximum90
• Auto-Phased
• Displaced Max

Standard 
Standard mode adds a new octave to the noise at half the frequency and twice the amplitude. This is the 
default mode. In this example, Standard mode was applied to RND Continuous noise. 

 
Irregular 
Irregular mode adds a new octave to the noise at half the frequency and twice the amplitude. However, in 
this mode higher frequency noise is modified more than the rest. The end result is that more detail is 
added to the noise. In this example, Irregular mode was applied to RND Continuous noise. 
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More Irregular 
More Irregular mode works exactly like Irregular except that this mode is more intense. In this example, 
More Irregular mode was applied to RND Continuous noise. 

 
Maximum 
When two components are combined using Maximum, the two components are compared and the one 
that is lighter becomes the result. 

 
MultiFractal 
In MultiFractal mode, lighter areas create higher contrast noise. In this example, MultiFractal mode was 
applied to RND Continuous noise.

With Rotation 
In With Rotation mode, each additional octave is rotated. With Rotation mode it is easier to see linear 
noise types. In this example, With Rotation mode was applied to RND Linear noise. 
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Minimum 
Minimum mode uses only the lowest values, or darkest areas, to produce the modified noise. In this 
example, Minimum mode was applied to RND Continuous noise. 

 
Multiply 
In Multiply mode all the values in the noise are multiplied together. The results is a darker noise. In this 
example, Multiply mode was applied to RND Continuous noise. 

 
Difference 
In Difference mode all the values in the noise are evaluated. All the values that are equal create black 
areas. When the values are different, the lower value becomes darker. The more octaves you have in the 
noise, the darker the modified noise. Difference works even at 0 octaves. In this example, Difference 
mode was applied to RND Continuous noise. 

 
Minimum90 
Minimum90 mode repeats the noise at a 90° angle from its original orientation and combines the original 
and copy using only the lowest values. In this example, Minimum90 mode was applied to RND 
Continuous noise. 

 
Maximum90 
Maximum90 mode repeats the noise at a 90° angle from its original orientation and combines the original 
and copy using only the highest values. This mode is good for creating woven patterns. In this example, 
Maximum90 mode was applied to RND Continuous noise. 
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Auto-Phased 
Auto-Phased mode automatically introduces phase shifts into the noise. In this example, Auto-phased 
mode was applied to RND Continuous noise. 

Displaced Max 
Displaced Max mode creates a copy of the noise, displaces noise by a small amount, and then lightens 
any areas where the two overlap. This mode is good for creating stone textures. In this example, 
Displaced Max mode was applied to RND Continuous noise. 

 

Phase

Phase 

Phase introduces turbulence into your noise. The phase displaces the grain or patterns within the noise. 
When you design the phase, you are creating a displacement map along which the noise will be modified. 
You can control how the phase interacts with your noise using the Phase Palette. You can design your 
phase using the Phase Editor. The Phase palette controls the amplitude. The Phase Amplitude controls 
the intensity of the displacement. As the amplitude is increased, there is more interference with the 
original noise. 
You will not have to increase the amplitude very much before you start seeing the phase pattern you 
designed interfere with the existing noise. In fact, it is probably a good idea to keep the phase amplitude 
low so that the phase pattern does not overwhelm the noise. 
This graph shows how the phase interacts with the noise at different amplitude settings. 
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The Phase Editor looks a lot like the Noise Editor. It has the same type of tools and they work exactly like 
they do in the Noise Editor. The difference is that you are using noise patterns, orientations, frequencies, 
and modes to design how the basic Noise will be displaced. Using the Phase Editor you can perform 
several functions: 

• Create 1D, 2D, or 3D phase
• Change the type of noise
• Change the frequency of the phase
• Change the orientation of the phase
• Change the noise octaves
• Change the noise modulations

While the Phase Editor lets you create the noise pattern or grain within the phase, the Phase Palette 
controls how that phase is applied to the component or the combined texture. 
 

Phase Palette 

To display the Phase palette:
1. Display the Deep Texture Editor. 
2. Click the Phase button at the bottom of the editor or the bottom-right corner of any of the 

component windows.  
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The Phase palette appears.  

3. Select which component to adjust by clicking in one of the indentations of the Component 
Indicator. The first three indentations are for Components 1, 2, and 3, while the fourth one is for 
the Combination (final) Component.

4. Move the mouse over the green ball in the Amplitude slider. The cursor changes to a double-
ended arrow.  
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5. Left-click on the ball and drag right to increase the amplitude up to 1000.  

6. Left-click on the ball and drag left to decrease the amplitude down to 0.  

7. You can also click on the arrows at each end of the Amplitude slider to adjust the amplitude 
manually. 

 

Phase Editor

Phase Editor 
To display the Phase Editor: 

1. Display the Deep Texture Editor. 
2. Click the Phase button at the bottom of the editor or the bottom-right corner of any of the 

component windows.  
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The Phase palette appears.  

3. Select which component to adjust by clicking in one of the indentations of the Component 
Indicator. The first three indentations are for Components 1, 2, and 3, while the fourth one is for 
the Combination (final) Component.

4. Click the top left corner of the palette. The corner turns green as you pass your cursor over it.  

The Phase Editor comes up. 

See the following topics for more on creating and adjusting phase:
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• Creating Phase
• Phase Dimensions
• Phase Noise Type
• Phase Noise Orientation
• Phase Frequency
• Phase Noise Octaves
• Phase Noise Modes

 
Creating Phase 
Phase is designed using the Phase Editor. The phase creation process involves several steps:

1. Choose the number of dimensions in the phase.  
2. Choose a Noise Type. This gives the basis for creating a phase pattern or grain.
3. Adjust the frequency of the noise. 
4. Adjust the orientation of the noise.  
5. Apply a modifier to the noise by choosing a Noise Mode. 

You will notice that many of the steps for creating the phase are the same as those for creating noise. 
That is because you are creating noise. The difference is that instead of applying the noise to the texture, 
the noise you create for the phase is used to displace the existing noise. 
The following sections describe the various parts of the editor and how to use them in the phase noise 
creation process. 
 
Phase Dimensions 
Just like noise, you can set the dimensions of the phase. The number of dimensions determines which 
noise axes will be displaced when you apply the phase. For example, if you apply a one-dimensional 
phase to a three-dimensional noise, only the X axis of the noise will be displaced. It is easier to see the 
number of dimensions for your phase if you use a cube in the Phase Preview. In this example, a 1D 
phase (left) was applied to a 3D noise (right) to create the result (bottom). 
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To choose the number of dimensions for your phase:
1. Display the Deep Texture Editor. 
2. Display the Phase Editor.
3. Click one of the dimension buttons at the bottom of the editor. 

 
Phase Noise Type 
There are 50 types of noise available in the Phase Editor. Random Noise is the default (RND). Each 
noise type provides you with a different basic pattern for the phase. The noise types available in the 
Phase Editor are the same as those in the Noise Editor. 
To choose a noise type: 

1. Display the Deep Texture Editor. 
2. Display the Phase Editor. 
3. Click the Type field at the top of the editor and choose a noise type from the menu. 

Below are the 50 Phase Noise Types available: 
• Nothing  
• Sine 
• Square  
• Triangle  
• RND Discrete  
• RND Linear 
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• RND Continuous  
• RND Saw 
• Vortex Noise 
• Fractal  
• Turbulence 
• Spots 
• Fract Stone  
• Triangles Discrete  
• Square Lines 
• Sparse RND Paths 
• RND Lines 
• Waves  
• Liquid  
• Linear Sine  
• Stucco Noise  
• Stone Cliff  
• Multifractal  
• Leopard 
• Techno 
• Distance Origin  
• Time Random
• Value 
• Gradient  
• Weird Value 
• Weird Gradient 
• Voronoi Distance1 
• Voronoi Distance2 
• Voronoi Distance3 
• Voronoi Distance4 
• Voronoi DistSq1 
• Voronoi DistSq2 
• Voronoi DistSq3 
• Voronoi DistSq4 
• Voronoi D2-D1 
• Voronoi D2sq-D1sq 
• Voronoi D3-D2 
• Voronoi D3sq-D2sq 
• Voronoi D4-D3 
• Voronoi D4sq-D3sq 
• Voronoi ID1 
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• Voronoi ID2 
• Voronoi ID3 
• Voronoi ID4 
• Distance Squared  

Phase Noise Orientation 
Phase Noise Orientation controls the direction of the noise within the phase. The number of dimensions in 
the phase determines how many axes you can use to adjust the orientation. You can edit the noise 
orientation using the Direction numerical fields. The fields let you enter precise angles for noise 
orientation.
You can also use the scroll arrows to set the angle in increments. Like frequency, changing the 
orientation of the phase noise in only one or two axes can create some very interesting results. In this 
example, the phase noise orientation was changed in only the Y-axis and then applied to 3D noise. 
To change the orientation of phase noise: 

1. Display the Deep Texture Editor. 
2. Display the Phase Editor. 
3. Click one of the dimension buttons at the bottom of the editor. 

4. Drag over the XY field in the Direction area to set the noise angle in the X and Y axes. Drag left to 
decrease the value or right to increase it. 
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5. Drag over the YZ field in the Direction area to set the noise angle in the Y and Z axes. 

6. You can also drag over the scroll arrows to speed up the increments. 
Phase Frequency 
Phase Frequency determines how often the pattern within the noise repeats. Frequency is like scaling the 
noise. Higher frequencies decrease the scale of the noise so you can see the pattern more often. Lower 
frequencies increase the scale of the noise so the pattern repeats less often. You can change phase 
noise frequency using the Frequency numerical fields. The fields let you enter numerical values to adjust 
the noise frequency along the X, Y, or Z-axis. You can also adjust the values using the scroll arrows. 
The number of dimensions in the phase determines how many axes you can use to adjust the noise 
frequency. For 1D phase you can only use the X axis. With 2D phase you can use both the X and Y axes. 
For 3D phase you can use all the axes. Adjusting the frequency of the Phase noise disproportionately can 
have some very interesting effects on your noise. 
To change the frequency of phase noise: 

1. Display the Deep Texture Editor. 
2. Display the Phase Editor. 
3. Click one of the Dimension buttons at the bottom of the editor.  

4. Drag over the X field in the Frequency area to set the phase noise frequency in the X axis. Drag 
left to decrease the value or right to increase it.  

©2003-2011 DAZ 3D, Inc. 715



Bryce 7 Artist Guide 03 Jan 2011

5. Drag over the Y field in the Frequency area to set the Phase noise frequency in the Y axis. 

6. Drag over the Z field in the Frequency area to set the Phase noise frequency in the Z axis.  

7. You can also drag over the scroll arrows to speed up the increments 
 
Phase Noise Octaves 
Phase Noise Octaves work exactly like the noise octaves. They introduce an extra level of complexity to 
the noise. Refer to "Noise Octaves" for more on octaves. 
To change the number of octaves: 

1. Display the Deep Texture Editor. Display the Phase Editor. 
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2. Click one of the dimension buttons at the bottom of the editor. 

3. Drag right over the Octaves field to increase the octaves, drag left to decrease. 

 
Phase Noise Modes 
Phase Noise Modes work exactly like the noise modes. They modify the octaves of a noise. Refer to 
"Noise Modes" for more on modes. 
To choose a Phase Noise Mode: 

1. Display the Deep Texture Editor. 
2. Display the Noise Editor. 
3. Click one of the dimension buttons at the bottom of the editor. 
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4. Click the Mode field at the top of the editor and choose a mode from the menu.

There are 13 noise modes available: 
• Standard 
• Irregular  
• More Irregular 
• Maximum  
• Multi-Fractal  
• With Rotation  
• Minimum  
• Multiply 
• Difference 
• Minimum90 
• Maximum90 
• Auto-Phased 
• Displaced Max 

 

Filtering

Filtering 

The Filter you apply to the Noise in a component can change the entire look of the noise. The filter refines 
the noise so that it has more or less detail, increases its contrast, applies it only at high altitude, or 
changes its spatial orientation. Whatever the change, the filter has a profound effect on the final look of 
your texture. 
Filters are expressed as equations with variables. When the equation is applied to the noise, it changes 
some aspect of the noise. You can control how the equation affects the noise by changing the values of 
the variables. The filter only affects the Noise. 
The Phase cannot be altered using a Filter. The Phase is blended with the Noise. 
Filters are edited using the Filtering Palette. 
The palette displays the current filter and provides tools for editing the filter graph. 

Filtering Palette 
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Filters are equations which have variables. Each equation can have up to three variables labeled a, b, 
and c. The values for each variable are displayed at the bottom of the palette.  
Generally, a controls the intensity of the filter effect while b controls the overall height. In some filters a 
and b may stand for other things. For those filters that use it (Quantize and Snow Puddles), c controls the 
number of steps between values or the height required for snow to appear. 
There are two ways you can adjust a filter: by changing the variable values or by changing the shape of 
the graph (which automatically changes the variable values). The method you use depends on how much 
you know about a particular filter. If you are not sure what the filter does, change the graph - it is a much 
more intuitive way of working. 
To display the Filtering palette and edit the current filter:

1. Display the Deep Texture Editor. 
2. Click the Filter button at the bottom of the editor or the bottom-right corner of any of the 

component windows.  

The Filter palette appears. 

3. Select which component to adjust by clicking in one of the indentations of the Component 
Indicator. The first three indentations are for Components 1, 2, and 3, while the fourth one is for 
the Combination (final) Component  
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4. If the current filter is set to None, left-click hold on the filter name and select a filter from the list. 
See "Choosing a Filter" for examples of each filter.

5. Left-click hold over the Filtering graph area. The cursor changes to a four sided arrow. Drag over 
the filter and the shape of the graph changes as you drag.

6. Notice that the variables also change as you move the graph.
• Dragging horizontally changes the value of a.
• Dragging vertically changes the value of b. 

7. To change variable values: 
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• Display the Filtering palette. 
• Left-click hold over the variable field you want to change. The cursor changes to a 

double-ended arrow. Drag left to reduce the value or right to increase it. The shape of the 
graph changes as you adjust the values.  

• Please note that if the filter equation does not include the c value, then adjusting that 
value will not affect that particular filter.

 

Choosing a Filter

Choosing a Filter 
Each filter available in the Filtering palette offers something unique. The best way of choosing which filter 
you want to use is to apply it to a component and see what happens. 
To choose a filter:

1. Display the Deep Texture Editor. 
2. Display the Filtering palette. 
3. Click the Filtering Equation area and choose a filter from the menu. 

There are fourteen filters available. 
• None
• Quantize (Xa+b, c)
• SawWave(Xa+b)
• Sin(aX+b)
• Abs(aX+b)
• (X pwr a)+b
• Gaussian(a(X+b))
• Clip aX+b
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• Xb+a(Altitude-Slope)
• X(a*Slope+b)
• X(a*Altitude+b)
• X(a*Orientation+b)
• Smooth Clip aX+b
• Snow Puddles

None 
This option deactivates the filter. No filtering is applied to the component. 

 
Quantize (Xa+b, c) 
This filter works like a Posterize effect. When it is applied, gray values jump from one value to the next, 
creating a blocky stair-step type of effect.
In this filter, a and b control the contrast and height, while c controls the number of levels between white 
and black. Notice in the images below how the c value affects the levels. 

In this example, Quantize (right) was applied to RND Continuous noise (left). 

SawWave(Xa+b) 
When the graph for this filter has only a small curve, it acts like a contrast filter. As it approaches the 
height limits (set by b), it bounces back on itself. This creates high-contrast breaks in the noise. For color 
output use this filter to get areas of high-contrast alternating color. 
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When you set the value of a to a high number you will get areas with a larger amount of noise.

   
In this example, Saw Wave (right) was applied to RND Continuous noise (left). 

 
Sin(aX+b) 
This filter creates noise that appears as large number of lines that are oriented in the same direction. Use 
this filter to generate wood grains. 

The a variable controls the number of lines. Higher values create a better effect. 
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In this example, Sine Wave (middle) was applied to RND Continuous noise (left). In the far right example, 
the a variable for Sine Wave was increased. 

 
Abs(aX+b) 
This filter works like a Difference effect. When it is applied, you will get more light areas in your noise and 
a higher level of detail in a bump map.  

To get additional bump information using this filter, set a to 2 and b to -1. 

In this example, Absolute (right) was applied to RND Continuous noise (left). 

(X pwr a)+b 
This filter smoothes out the darkest areas of your noise. However it has less effect on lighter areas and no 
effect on white. 
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In this example, XPower (right) was applied to RND Continuous noise (left). 

Gaussian(a(X+b)) 
This filter smoothes out darker areas of your noise and makes lighter areas noisier. White areas become 
the noisiest. 

In this example, Gaussian (right) was applied to RND Lines noise (left). 

Clip aX+b 
Clip is probably the filter you will use most. It is a contrast filter. The a variable controls the contrast and b 
controls the overall brightness. 
For a low contrast effect make the wave in the graph smaller. Decrease the value of a to reduce the size 
of the wave and increase b to move the wave up.
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Using this wave, all the values will be expressed as mid-gray. For a high contrast effect, adjust the wave 
so that it hits both the top and bottom edges of the preview.  

Increase the value of a and make b negative to move the curve down. 

To invert the colors in your noise, make a negative and increase b. 
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In these examples, different levels of Clip were applied to Linear Sine noise. The black and white versions 
show the contrast/brightness changes when Color is disabled. 

Xb+a(Altitude-Slope) 
This filter applies noise only at certain combinations of slope and altitude. The Altitude Minus Slope filter 
works on the slope and altitude of an object in World Space. In these examples, Altitude Minus Slope was 
applied to Voronoi DistSq4 and then to objects in a scene. 
When a is positive and b is negative, noise is applied at high altitudes and on flat surfaces. 
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When a is negative and b is positive, noise is applied at low altitudes and on steep slopes. 

X(a*Slope+b) 
This filter applies noise based on an object's slope. Slope can range anywhere from flat and horizontal to 
steep and vertical. This is an excellent filter to use if you want to isolate a texture to vertical cliffs or flat 
surfaces. 
In this filter, a determines the steepness of the noise (-4 is flat, 4 is vertical). The b variable controls the 
starting point of the transition. 
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To place noise on vertical surfaces make a=4 and b=2. 

To place noise on flat surfaces make a=-4 and b=1.5. 

The Slope filter works on the slope of an object in World Space. In this example, the default Slope 
(bottom) was applied to Fract Stone noise (top) and then to objects in a scene. 
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X(a*Altitude+b) 
This filter modulates the scale of the noise according to an object's altitude.  
In this filter, a determines how fast the noise is scaled by altitude. A lower value creates a gradual 
transition, while higher values create sharper transitions. 
To apply noise at higher altitudes make sure a is positive. At high altitudes b controls the transition. The 
higher the transition, the lower the number. So, at high altitudes b should be a negative number. 

To apply noise at lower altitude, reverse the variables so that a is negative and b is positive. 
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The Altitude filter works on the altitude of an object in World Space. In this example, Altitude (bottom) was 
applied to RND Continuous noise (top) and then to objects in a scene. 

 
X(a*Orientation+b) 
This filter applies noise based on an object's east-west orientation. 
In these examples, Orientation was applied to Voronoi ID2 noise and then to objects in a scene. 
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Smooth Clip aX+b 
This filter works exactly like the Clip filter. It is also a contrast filter, except that this filter smoothes out the 
transitions between darks and grays. The a variable controls the contrast and b controls the overall 
brightness. 
In these examples, Smooth Clip was applied to Linear Sine noise. 
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Snow Puddles 
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This filter turns noise into snow patches. Snow is applied according to an object's slope and altitude. 
The a variable controls how much the noise interferes with the smoothness of the snow. 
When a=0 the noise does not interfere at all so the snow is perfectly smooth.  

When the a value is higher, the snow starts looking like the noise. The b variable shifts the altitude or 
snow level. It sets where the snow begins. The c variable controls how steep an object has to be before 
the snow appears on its surface. The higher the number, the flatter an object has to be before snow 
appears on its surface. 
In these examples, Snow Puddles was applied to RND Continuous noise and then to objects in a scene. 
The a, b, and c variables are varied to show how different values affect the material.
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Combining Components

Combining Components 
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The Deep Texture Editor gives you unparalleled control over the look and feel of each one of the 
components that make up a texture, but the control does not stop there. The Deep Texture Editor also 
lets you control how those components are combined to create the final texture. 

• Blend Modes
• Global Changes

 

Blend Modes

Blend Modes 

Components are combined using Blend modes. These modes are filters applied to the components to 
determine how the properties in each component are combined with the other components' properties to 
form the final texture. 
The number of blend modes you can use varies depending on how many components you are using to 
build the texture. If you are using only one component, the properties in the component are applied 
directly to the final texture. When you are using two components, they're blended using a single blend 
mode, and the result is then applied as the final texture. 
When you are using three components, the first two components are blended together using a blend 
mode, then the result of that blend is combined with the third component using a second blend mode. The 
result of all the blending is then applied as the final texture. 
This diagram explains when the blend modes are applied as you combine components to form a texture. 

Depending on the Blend mode, the different types of output can affect each other during the combination 
process. So its possible that the Bump output of one component may affect the Color output of another. 
To apply a blend mode: 

1. Display the Deep Texture Editor. 
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2. Click the text above Component 1 to choose a Blend Mode to combine components 1 and 2.

3. Click the text above Component 3 to choose a Blend Mode to combine the results of Component 
1 and 2 with 3. 
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There are nineteen blend modes you can use to combine your components: 
• Parallel
• Combine
• Average
• Multiply
• Maximum
• Minimum
• Add
• Subtract
• Blend V1
• Blend V2
• Blend Slope
• Blend Altitude
• Blend Orientation
• Fast Slope
• Blend Random
• Blend Minimum
• Blend Maximum
• Procedural
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• Difference

Parallel 

This mode does not blend components. Use it when each component has a different output type. If two 
components share an output type, only the first output will be applied to the final texture. 
For example, if Component 1 has output = Color and Bump, and Component 2 has output = Color and 
Alpha, only the color from Component 1 will be applied to the texture. 
The texture below shows an example of this with a randomized combination. Both Component 1 and 2 
have the Color output but if the Color output is disabled, as in the second image, you can see that it 
makes no difference in the final output. 
The Parallel mode took the color from Component 1 and the Alpha and Bump from Component 2, 
throwing out the color from Component 2. 
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Combine 

Combine is a blend mode for colors only. When you use this blend mode, the first color in Component 2 is 
used as an alpha channel. Wherever that color appears in Component 2, it is replaced with the colors 
from Component 1. 
For example, lets say Component 2 has Yellow, Green, and Blue and Component 1 has Orange, Purple, 
and Black as its color scheme. When you combine them using the Combine blend mode, Yellow 
disappears from Component 2. Everywhere that Yellow appeared, you will see Orange, Purple, and 
Black. 
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Average 

Average is a normal blend mode where all the component values are mixed with equal weight. So if one 
component is white and the other is black, the result is gray. This is a good all-purpose blend mode to use 
for creating textures. 

Multiply 

When you use this blend mode to combine components, you will get a darker result. In this mode, when a 
black component is combined with a gray component, the result is black. When a gray component is 
combined with a white component, the result is gray. When two shades of gray are combined, the result is 
proportionally darker. In the case of Bump output, this mode will flatten most areas since black is flat and 
darker values create flatter bumps. 

©2003-2011 DAZ 3D, Inc. 741



Bryce 7 Artist Guide 03 Jan 2011

 

Maximum 

When two components are combined using Maximum, the two components are compared and the one 
that is lighter becomes the result. 

 

Minimum 
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This mode is the opposite of Maximum. When two components are combined, they're evaluated and the 
darker areas of both are combined to produce the result. 

Add 

Add combines colors so that they appear dramatically lighter. However, it does not have the same effect 
on Bump output. 

Subtract 
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When you combine grayscale components using Subtract, they tend to turn out black or very dark. When 
you use it with colored components, the result is brilliant colors that tend to compliment the original colors. 

 

Blend V1 

The Blend v1 blend mode lets you use the first component as an alpha channel for blending. When you 
choose Blend v1, the noise in the first component is used as an alpha channel to blend the two 
components. To use the noise in the second component instead, use Blend v2. 

Blend V2 
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The Blend v2 blend mode lets you use the second component as an alpha channel for blending. When 
you choose Blend v2, the noise in the second component is used as an alpha channel to blend the two 
components. To use the noise in the first component instead, use Blend v1. 

Blend Slope 

Using Blend Slope, components are combined according to an object's slope. The first component is 
applied to areas that are flat and the other is applied to areas that are steep. 

Blend Altitude 
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This mode blends components according to an object's altitude. The first component appears at low 
altitudes and the second appears at high altitudes. 

Blend Orientation 

In this mode, one component is applied in all directions, while the other is applied in only one direction. 
You can use this mode to simulate things like moss that only grow on one side of a tree. 

Fast Slope 
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Fast Slope works exactly like Blend Slope except that the transition from one component to the other is 
more abrupt. 

 

Blend Random 

This mode introduces an extra layer of noise and uses it as an alpha channel for combining the two 
components. Component 1 appears in some areas of the new noise, and Component 2 appears in other 
areas. Since this mode adds another layer of noise, you are also adding more processing time. 

Blend Minimum 
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Blend Minimum works the same as Minimum except that it creates blurring at points of sharp transition. 
When Blend Maximum is applied to Bump output, the resulting bump map will have mostly low areas with 
very few high points. 

Blend Maximum 

Blend Maximum works the same as Maximum, except that it creates blurring at points of sharp transition. 
When Blend Maximum is applied to Bump output, the resulting bump map will have many high points and 
few deep pits. This mode works best on Bump output. 

Procedural 
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Procedural Blend combines two components so that the color and values of Component 1 are applied to 
Component 2 based on the gray values in Component 2. In essence, the Alpha output from Component 2 
is used as a guide for blending. 
Where Component 2 is light, Component 1 is not applied. Where Component 2 is dark, Component 1 is 
made darker. Where Component 2 is gray, Component 1 is applied without change. This mode usually 
results in more saturated colors. 

 

Difference 

Difference finds the difference between the noise in the two components and displays the result. This 
mode only works on output of like types. So if Component 1 has Alpha and Color output while Component 
2 has only Alpha, the two Alpha outputs are combined and the Color output is left unchanged. 
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Global Changes

Global Changes 

The component window in the center of the editor, called the Combination component, represents the 
final combined texture. Any changes you make to this final component are considered global changes 
since they affect the entire texture. 

The Combination component can have its own color scheme, filter, noise pattern, or phase. These 
attributes are applied to all the component elements. For example, the Combination noise values affect 
the noise within each component.
Global changes give you a way of applying a last layer of complexity to your texture. 

• Global Colors
• Global Noise Filter
• Global Phase
• Global Filtering

Global Colors 
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The colors in the Combination component interact with the combined colors in the three components. 
They act as a final color filter for the texture. After the colors in each component are combined, they are 
blended with the combination component colors to produce the colors in the final texture. 
You can also apply a final Color Blending method to the combination component. The Blending method 
you apply to the combination component is applied on top of the other modes used in the components. 
For example, if you choose Altitude in the Combination component, the texture color is applied using the 
blend modes in the components and then also applied by altitude. The example below shows a texture 
containing a texture with different Color Blending modes in it. 
To add colors directly to a texture: 

1. Click the top color circle in the Combination component window and choose a color from the 
palette. The color circles in the Combination component window let you apply colors directly to 
the final texture. 

2. Repeat for each of the other two color circles.  
 

Global Noise Filter 

When you change the noise in the Combination component, (i.e., globally) it applies to all the components 
equally. So if you increase the noise in the final component, the noise in each of the components 
increases. Likewise, when you decrease the noise globally, the noise in each individual component 
decreases. Global noise can be different than component phase, so you can introduce a completely 
different type of noise into the texture. 
Use this option cautiously. The more noise you introduce into your texture, the longer it takes to render 
and draw. If you introduce too much complex noise patterns into a texture, you may find your render time 
increased significantly. You can adjust global noise in the same way you would for a single component, 
using the Noise Palette or the Noise Editor. 
To adjust noise globally: 

1. Click the top left button in the Combination Component window. 
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The Noise palette appears.  
2. Either drag the slider to adjust the noise value

or click the top left corner of the Noise palette to display the Noise Editor. 

Note: If the Noise palette will not come up, click in the Component Indicator for one of the other 
Components, then click on the top left corner of the Noise palette. Once the Noise Editor comes 
up, move the Component Indicator back to the last position.  

3. Use the editor's controls to design the global noise pattern or grain.  

 

Global Phase 

As you adjust the Global Phase value, new phase is introduced into each of the components. Global 
phase can be different than component phase, so you can introduce a completely different type of phase 
into the texture. 
You can adjust global phase in the same way you would for a single component using the Phase palette 
or the Phase Editor. 
To adjust phase globally: 

1. Click the bottom-right button in the Combination Component window.  
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The Phase palette appears. 
2. Either drag the slider to adjust the phase amplitude

or click the top left corner of the Phase palette to display the Phase Editor. 

3. Use the editor's controls to design the global phase. 

 

Global Filtering 

The Filter affects the final look of the noise within a component. The Global Filter affects the look of the 
combined noise. The Global Filter is applied to the noise in the Combination component. The global filter 
only affects the noise, not the phase in the component. Any of the filters you used in the components can 
be used as the global filter. 
Use this option cautiously. The more complex the noise in your texture, the longer it takes to render and 
produce. If you introduce too much complexity, you may find your render time increased significantly. 
To filter noise globally: 
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1. Click the top-right button in the Combination Component window.  

The Filtering palette appears. 
2. Choose a filter and adjust its variables to create the desired effect. 

 

Tips for Speeding Up Textures

Tips for Speeding Up Textures 

Textures can be the most powerful effects you create in Bryce. They can also be the most costly. The 
more complex the texture, the longer it takes to calculate and the longer it takes to apply to an object, 
which finally increases the rendering time. When you are creating the texture, you always have to keep in 
mind that it is part of a material, which is part of an object. All these parts can contribute to the rendering 
time.
The material that contains the texture may have several complex attributes of its own, like Transparency 
and Reflection. The size of the object may also contribute to the rendering time.
Consider the effect of applying a complex texture to a complex material onto an infinite plane. The time to 
calculate this object would be staggering. A good rule of thumb when working with complex objects and 
textures is to make the texture element as simple as possible.
These tips are meant only as a precaution to prevent you from inadvertently creating a huge texture. That 
does not mean that you shouldn't use the more complex features as well, after all they were created for a 
reason. You should just use them cautiously.

• Speeding Up Noise
• Speeding Up Phase
• Speeding Up Filtering
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Speeding Up Noise 

Use a simpler noise type. Some noise types (like Vortex) require more time to process than others.  
Restrict the amount of noise you add to each component. In fact, not all the components need to have 
noise. 
Watch the frequency of the noise. Higher frequency noise requires more time to calculate then lower 
frequency 
noise. 
Watch the number of octaves in the noise. Each octave adds another level of complexity.  
 

Speeding Up Phase 

When you are designing the phase, you may want to use simpler noise.
Cut down on the number of phase types you combine. If each component has a different type of phase, 
combining them can increase calculation times.
Watch the amplitude of the noise. Higher amplitude phase takes much longer to calculate.
Apply Global Phase cautiously. This is the quickest way of increasing the complexity of your texture 
because global phase introduces more complexity into each component simultaneously.
 

Speeding Up Filtering 

Filtering introduces complexity or detail into the noise of a component. Make sure that you aren't using a 
filter 
unnecessarily. Not all noise needs filters. 
Be careful when you apply a Global Filter as this adds even more complexity to the noise.  

Sky Lab

Sky Lab
The Sky Lab button provides access to the Sky Lab dialog. This dialog contains controls for fine-tuning 
environmental effects like clouds, rainbows, and sun and moon rings.
Click the Sky Lab button, which looks like a cloud with a rainbow, in the Sky & Fog palette to display the 
Sky Lab dialog. You can also click the triangle icon below the memory dots and choose Sky Lab from the 
menu.
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The dialog contains four tabs:
• Sun & Moon   contains controls for positioning the sun and moon as well as adding effects like 

rings and horizon illusions.
• Cloud Cover   contains controls for editing cloud textures and setting up cloud animations.
• Atmosphere   contains controls for rainbows, visible lights, and color blending. 
• IBL   contains controls for adding an HDRI image and managing the effect.

You can preview your changes in the Sky Lab dialog.
To view the different preview options, click the downward pointing triangle at the lower corner of the 
preview area. You can also change the camera position in the preview area. To change the position of the 
camera, drag the preview. To orbit around the scene, drag the preview in the direction you want to move 
the view of your scene.
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Sun & Moon Tab

Sun & Moon Tab
The Sun & Moon tab contains controls for positioning the sun and moon as well as adding effects like star 
fields, rings, and horizon illusions.
See the topics below for more on using the options available on the Sun & Moon tab:

• Star Fields  
• Comets  
• Moon Phases  
• Sun/Moon Visible  
• Sun/Moon Size  
• Sun/Moon Rings  
• Shadows  
• Ambient Color  
• Sky Dome Color  
• Working With the Sun & Moon  

©2003-2011 DAZ 3D, Inc. 757



Bryce 7 Artist Guide 03 Jan 2011

Star Fields

Star Fields

Bryce lets you create night skies complete with stars and comets by using the Sky Lab.
Stars appear in the night sky and are affected by the moon's brightness and color. They are also infinitely 
distant, i.e., they do not get closer as you move the camera. In this example, you can see how the moon 
affects the color and intensity of the stars around it.

You can create a star field that is based on a randomly generated star map or a star field based on the 
stars we see from the Earth.

• Random Star Field  
• Earth-based Star Field  
• Customizing Star Fields  
• Star Field Glow  

Random Star Field

To add a Star Field based on a random star map:
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1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Celestial option.

5. Enable the Random Field option. This will create a star field based on a randomly generated star 
map.

6. You can get a different random configuration of stars by Opt/Alt+clicking the Random Field 
button. Pressing Shift+clicking the Random field button generates the default random star field.

7. Enable the Stars option. Adjust the Intensity and Amount as needed. 

8. Set the Ambient and Sky Dome colors to black.

9. Click the OK icon to exit the dialog. 
Note: When selecting the Random Star Field, all stars will have the same brightness level.
Examples:
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• Default Random Star Field:

• A Random Star Field (by using Option/Alt+clicking the Random Field button):

• Another Random Star Field:
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Earth-based Star Field

To add a Star Field based on Earth's star map:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Celestial option.

5. Enable the Custom Field option.

6. Enable the Star option. Adjust the Intensity and Amount as needed. 

7. Set the Ambient and Sky Dome colors to black.

8. Click the OK icon to exit the dialog. 
Examples:
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• Earth-based Star Field:

• Random Star Field with same Intensity and Amount settings: 

 

Customizing Star Fields

Customizing Star Fields

After you have generated your star field, you can customize certain parameters of the star field. You can 
control the intensity of the stars, the amount of stars that are visible, and the portion of the star field that is 
visible in your scene.

• Star Field Position Control  
• Star Field Intensity  
• Star Field Amount  

Star Field Position Control

The Star Field Position Control lets you choose which portion of the star field is visible in your scene. The 
control works like a trackball, with the stars of the northern hemisphere on one side and the stars of the 
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southern hemisphere on the other. As you drag over the control, the star field moves in the direction you 
drag.
To set the Star Field Position:

1. Apply the settings for either a Random or Earth-Based Star Field.
2. Move the mouse cursor over the Star Field Position Control then left-click and drag to change the 

position.

3. Render the scene to check the star position, modify as needed.
Setting Star Field Position for Earth-Based Star Fields:
When you enable the Celestial option, the Star Field Position Control has the "sun" in the center. If you 
rotate the camera to have all rotation angles at 0°, you will see the Earth sky at a Right Ascension (RA) of 
6h (hours) with the horizon at a Declination of 0°. You will see the constellation of Orion near the center of 
the screen, the lower part of which is below the horizon. A bit higher up and to the right, you will notice the 
constellation of Taurus with the beautiful Pleiades.
If you push the Position Control upwards, the stars nearer to the North Pole appear. If the "Sun" just 
disappears over the top of the control, the sky of the North Pole is shown with Polaris - the North Star - in 
the center. Similarly, moving the control downwards opens up the sky to the south. Note that the star field 
is as you would see it on a cloudless dark night, not like on a star map, which shows the sky with left and 
right sides swapped as if seen in a mirror. 
If you move the control from the center to the right, the RA decreases towards 0h and if you move the 
control to the left, the RA increases towards 12h. The faintest stars shown are those with a magnitude of 
6. This is what we can see with the unaided eye on a clear dark night. The Milky Way and other rather 
bright Deep Sky objects like Nebulae or Galaxies are not in the star map and hence are not shown.
The image below is the star field generated with the position control in the center:

The image below shows the change in the star field after dragging the trackball to the right:
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And after dragging the trackball to the left and up:

 

Star Field Intensity

Changing the Intensity of a star field lightens or darkens the visible stars. When you are using a star field 
based on the stars we see from Earth, changing the intensity lightens and darkens the stars uniformly; 
their relative intensities do not change.
To change the Intensity of a star field:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.
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4. Enable the Celestial option.

5. Enable the Random or Custom Field option.

6. Enable the Stars option.

7. Drag the Intensity slider or enter a value in the Intensity field.

8. Set the Ambient and Sky Dome colors to black.

9. Click the OK icon to exit the dialog.  
Examples:
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• Intensity = 54

• Intensity = 100

Star Field Amount

You can increase or decrease the number of stars in the star field by changing the Stars Amount. When 
you change the amount, new stars are not generated. Instead, stars that are usually too dim to see 
become more visible.
To change the Amount of visible stars in a star field:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.
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4. Enable the Celestial option.

5. Enable the Random or Custom Field option.

6. Enable the Star option.

7. Drag the Amount slider or enter a value in the Amount field.

8. Set the Ambient and Sky Dome colors to black.

9. Click the OK icon to exit the dialog.  
Examples:
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• Amount = 3000

• Amount = 6000

Star Field Glow

Haze and the Color Perspective directly affect the color of the glow around the stars. This allows you to 
find some really neat effects in the sky.
To add a glow around the stars, set up the star field as shown in the previous pages, then do the 
following:

1. Delete the ground plane.
2. On the Sun & Moon tab, set the Star Intensity to a fairly high amount, between 60 and 100, and 

the Amount to a very large number. 
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3. Make sure that Sun/Moon Shadows are enabled and set the Ambient and Sky Dome colors to 
white.

4. Change to the Atmosphere tab, then disable Fog and enable Haze and Color Perspective. Set 
the Haze color to white. Drag over the RGB buttons to adjust the colors. You will need to know 
what the RGB settings are for the color you want, which you can get from some of the available 
color pickers.

The Sky Preview should now look something like this:
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5. Click on the OK icon to close the Sky Lab.
6. Double-click on the Trackball to open the Camera & 2D Projection dialog. Change the settings as 

shown below.

7. Click on the OK icon to close the dialog.
8. Render the scene.
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9. Adjust the Haze settings and Color Perspective colors to get a different view.

10. Render to see the differences.

11. Adjust the camera settings to similar settings shown below to get a "warp speed" effect.
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12. Render to see the results.

Thanks to Clay Hagebusch for showing how to get this effect.

Comets
You can add Comets to your night skies but since comets are not a common sight in the night sky, you 
will usually only
need one or two comets per star field.
To add Comets to a night sky:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Celestial option.

5. Enable the Random Field option. This will create a star field based on a randomly generated star 
map. You can only add comets to a star field that is based on a randomly generated star map.
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You can get a different random configuration of stars by Op/Alt+clicking the Random Field button. 
Shift+clicking the Random field button generates the default random star field.

6. Enable the Stars option. Adjust the Intensity and Amount as needed.

7. Enable the Comets option.

8. Adjust the intensity and amount of comets by dragging the Intensity and Amount sliders or 
entering a value in the Intensity and Amount fields.

The number of comets is spread around the sky dome, so setting the amount to 1 or 2 means you 
will need to adjust the Star Field Position Control until you find the comets. Setting the amount 
higher gives you a better chance of finding the comets faster. 

9. Set the Ambient and Sky Dome colors to black.

10. Click the OK icon to exit the dialog.  
Examples:
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• Amount = 20

• Amount = 75

Moon Phases

Moon Phases

The Moon Phases Control simulates different aspects of the moon as it orbits the earth. The moon phase 
is a visual clue
to the time of the month. In an animation, you can use the moon phase to simulate the passage of a time.
The phase is controlled using the Moon Phase Controls in the Sky Lab palette.
To set the Moon's Phase:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Sun & Moon tab.

4. Enable the Moon Phase option. 

 
5. Left-click+drag over the Moon Phase control. The phase changes as you drag. 

6. Adjust the Moon Brightness and Sharpness and Moon Texture if needed.
7. Click the OK icon to exit the dialog.  

Examples based on settings in step 5 above:
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Moon Brightness & Sharpness

Moon Brightness and Sharpness

The moon is directly affected by the light reflected from the earth. The brighter the reflection, the brighter 
the moon's shadow. In Bryce this effect is controlled by the Earthshine setting which makes the moon 
brighter or darker. (Issue)
A realistic moon does not have sharp edges and may appear blurry on hazy nights. The Softness control 
lets you set the moon's edge softness to give a more realistic feel.

• Moon Shadow  
• Moon Edge Softness  

Moon Shadow

To set the brightness of the moon's shadow:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 
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2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Moon Phase option. 

5. Drag the Earthshine slider right to increase the brightness and left to decrease it or enter a value 
in the Earthshine field.

6. Click the OK icon to exit the dialog.  
Examples:

• Earthshine = 15
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• Earthshine = 50

Moon Edge Softness

To set the moon's edge softness:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Moon Phase option. 

5. Drag the Softness slider right to soften edges or left to sharpen them or enter a value in the 
Softness field.

6. Click the OK icon to exit the dialog.  
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Examples:
• Softness = 30 

• Softness = 100 

Moon Texture

Previous versions of Bryce provided a default Moon texture that was applied by enabling the Texture 
option under Moon Phase. Bryce 6 includes this option but introduces the ability to add your own texture 
to the moon. This new feature means you could add a face to the moon or a texture that looks like a 
distant planet.
To add a texture to the moon:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Sun & Moon tab.

4. Enable the Moon Phase option. Adjust the moon phase if needed.

5. Under Moon Phase, enable the Texture option. This will load the default moon texture. To add a 
different image, click on the Edit button.

6. The Picture Editor will come up. Click on the first empty square.

7. The Open file dialog will come up. Locate the texture you want to load and click on Open.

©2003-2011 DAZ 3D, Inc. 780



Bryce 7 Artist Guide 03 Jan 2011

The image will be loaded in the Picture Editor.

8. Click the OK icon to exit the dialog. 
9. In the Sky Lab, make sure that the Sun/Moon Size is enabled and set a Disk Size.
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10. Click the OK icon to exit the dialog. 
11. In the Bryce Working Window, adjust the moon's location until it is visible in the scene, then 

render. 

Sun/Moon Visible

Sun/Moon Visible

Showing the sun or moon in your scene can provide interesting scenes with beautiful colors, however, 
there may be times when you need the shadows that are visible when the sun or moon is up, but you do 
not want the sun or moon to actually be visible in the scene. You could disable the sun/moon but then the 
shadows would also be disabled. The solution to this is to disable the Sun/Moon Visible option. Of course, 
to show the sun or moon in the scene, enable the Sun/Moon Visible option.
To set the Sun/Moon visibility:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to hide the 
sun/moon.
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Note: Disabling Sun/Moon Visible will automatically disable the Sun/Moon Size and Halo Rings 
options.

5. If the Sun/Moon Visible option is enabled, adjust the Disk Intensity and Glow Intensity as needed.
6. Click the OK icon to exit the dialog. 

Examples:
• Sun/Moon Visible enabled. 

• Sun/Moon Visible disabled - notice that shadows are still visible without having to add additional 
lights. 

Disk Intensity

Disk Intensity controls the intensity of the interior portion of the sun/moon disk itself. A higher value will 
make the sun/moon disk more visible in your scene while lowering the intensity will make the disk fade 
into the sky dome or clouds. This setting only comes into play if the sun or moon is visible in the scene at 
the time of render. This also applies to reflections of the sun/moon that might be in the scene.
To set the Sun/Moon Disk Intensity:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 
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2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to hide the 
sun/moon.

5. Drag the Disk Intensity slider right to increase the intensity or left to decrease it or enter a value in 
the Disk Intensity field.

6. Click the OK icon to exit the dialog. 
7. If you do not see any changes to the Disk Intensity when rendering, lower the Glow Intensity.

Examples: 
• Disk Intensity = 25; Glow Intensity = 50
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• Disk Intensity = 75; Glow Intensity = 50

• Disk Intensity = 100; Glow Intensity = 50

* Thanks to Wolfiesden for the disk intensity description

Glow Intensity

Glow Intensity controls the intensity of the halo or glow around the outside the sun/moon disk, not the 
interior portion of the disk. A higher value will bleed more of the glow color into the sky dome color. This 
has the effect of changing the dome color as it nears the location of the sun/moon disk. 
A typical example of a high setting here is an average Earth sunset, the sky can fade from a yellowish 
near the sun to a deep blue/purple away from the sun. Another example, think about looking at headlights 
of an automobile at night under different haze situations. If the night air has a lot of moisture or haze there 
will be a glow around the actual lights because the moisture scatters some of the light in random 
directions, this equates to a high Glow Intensity. On a clear night, there will be limited glow, because of 
the lack of scattering, making the edges of the lights more defined which equates to a low Glow Intensity. 
At low settings, the sun/moon disk must be visible in the scene to see this effect, at higher settings, the 
Glow Intensity can affect the sky even when the sun/moon disks are not directly visible in the scene. 
To set the Sun/Moon Glow Intensity:
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1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to hide the 
sun/moon.

5. Drag the Glow Intensity slider right to increase the intensity or left to decrease it or enter a value 
in the Glow Intensity field.

6. Click the OK icon to exit the dialog.  
Examples: 

• Disk Intensity = 100; Glow Intensity = 50
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• Disk Intensity = 100; Glow Intensity = 75

• Disk Intensity = 100; Glow Intensity = 100

* Thanks to Wolfiesden for the glow intensity description

Sun/Moon Size
The size of the sun or moon can affect the overall mood of your scene, especially when simulating a 
sunset's horizon illusion. The Disk Size can be used alone to modify the size of the sun and moon but the 
Horizon Illusion is dependent on the Disk Size.
If you have ever watched a sunset, you probably noticed that the sun appeared to get larger as it 
approached the horizon. The same is true for the moon. At certain times of the month it appears huge. 
This illusion can be simulated using Sun/Moon size. When the illusion is active, the sun or moon will 
appear to grow larger as it approaches the horizon. 
To change the size of the Sun or Moon as it approaches the horizon:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 
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2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to hide the 
sun/moon.

5. Enable the Sun/Moon Size option.

Note: To disable the Sun/Moon Size, disable Sun/Moon Visible to hide the sun/moon and disable 
the size option at the same time, or just disable the Sun/Moon Size option.

6. In the Sun/Moon Size area, enter a value in the Disk Size field or drag the slider to set the overall 
size of the sun/moon anywhere in the sky.

7. Enter a value in the Horizon Illusion field or drag the slider to set multiplier used to determine how 
much larger the sun or moon gets as it approaches the horizon.

8. Click the OK icon to exit the dialog.  
Examples:
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• Disk Size = 25; Horizon Illusion = 5 

• Disk Size = 25; Horizon Illusion = 25

• Disk Size = 10; Horizon Illusion = 25 
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• Disk Size = 35; Horizon Illusion = 25

Sun/Moon Rings
If you look directly at the sun on a hazy day, you will be able to see rings surrounding it. These rings are 
created by the reflection off ice particles in the air. In Bryce, you can use the Sun/Moon Rings to create 
this effect.
This effect creates concentric circles around the image of the sun or moon. Using the Sky Lab palette, 
you can set the radius of the rings and add a secondary ring to increase the effect. The color of the rings 
is controlled by the color of the sun/moon.
To add Sun/Moon rings:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to hide the 
sun/moon.
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5. Enable the Halo Rings option.

6. In the Rings area, enter a value in the Intensity field or drag the slider to set the brightness of the 
ring.

7. Enter a value in the Radius field or drag the slider to set the radius of the ring.

8. If you want to add a secondary Sun/Moon ring, enable the Secondary Ring option. (Issue)

9. Click the OK icon to exit the dialog.
Examples:
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1. Intensity = 50; Radius = 50

2. Intensity = 100; Radius = 25 

3. Intensity = 100; Radius = 50
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4. Intensity = 100; Radius = 100

Shadows

Shadows 

All the objects in your scene cast shadows. Using the Shadow control you can set the intensity and color 
of all the shadows in your scene.
As you change the value of the Shadow control, the brightness of shadows changes.
In the images below, the shadow on the left is set to 25%, the one on the right to 90%.

The Shadow control is not the only control for shadows. The position of shadows is dependent on the 
position of the sun. Since the sky interacts directly with objects in the scene, the color of the sun also 
affects the color of shadows.
The object's material properties also affect the color of shadows. Semi-transparent or transparent objects 
with a transparency color will change the color of the object's shadow. In addition, volume materials can 
dramatically change the shape and color of shadows. Use the Shadows control to set the color and 
intensity of shadows in your scene.
By default, the Clouds in Bryce do not cast shadows. If you want the cloud layer to cast shadows on the 
ground below, enable the Cloud Shadows option. Refer to "Cloud Cover" for more on this option.
To set shadow intensity numerically:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Sun & Moon tab.

4. Enable the Sun/Moon Shadows option.

Note that if you disable the Sun/Moon Shadows option, all shadows in your scene will also be 
disabled: shadows from light sources in the Light Lab and those in the IBL tab.

5. Click the Sun/Moon Shadows field, then enter a value or drag the slider. This field governs the 
intensity of all shadows rendered in your image. The range is 1 to 100.

6. Enable Shadow Softness and set the Intensity as desired if needed.
7. Click the OK icon to exit the dialog.

You can also set shadow intensity and color using the Sky & Fog Palette:

Soft Shadows

When you adjust the softness of a shadow, you blur or sharpen the shadow's edges. Soft shadows blend 
more smoothly with the background.
To enable soft shadows:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.
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4. Enable the Sun/Moon Shadows option.

5. Enable the Soft Shadows option and set the softness of the shadow. The range is 0 to 100.

6. Click the OK icon to exit the dialog.  
Examples:

• Soft Shadows at 0 or disabled:

• Soft Shadows at 50:
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• Soft Shadows at 100:

Sun Intensity Diffuse and Specular

Sun Intensity Diffuse 

The principal light source is the sun. It is powerful on a cloudless dry day and less bright on a damp and 
cloudy day. The Bryce sun therefore has an intensity control called Diffuse.
To set Sun Diffuse numerically:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Enter a value or drag the slider to set the Sun Diffuse value. 100 is the value that is compatible to 
all earlier versions of Bryce which did not feature this control. The range is -999 to 999. This 
means that the sun can also have a negative brightness like the other lights in Bryce – but not in 
nature.

Note that doubling the Sun Intensity Diffuse value also doubles the brightness of the sun light as 
if it were a radial.

Examples:
There is an additional faint radial at left above the sphere which casts no shadows.
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• Sun Intensity Diffuse 100 (compatible setting to earlier versions):

• Sun Intensity Diffuse 200 (double bright sun):
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• Sun Intensity Diffuse 0 (no sunlight) the bit of light at left is from the radial:

• Sun Intensity Diffuse -100 (note that shadow gets inverted; shadow gets bright) the radial helps to 
make the negative shadow visible in this example:

Sun Intensity Specular

If you employ materials that use the Specular channel, the sunlight can create a blurry reflection on that 
object just like a Radial from the Light Lab does. It is possible to control the brightness of the glossy spot 
the sun creates on that object. 
To set Sun Specular numerically:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Sun & Moon tab.

Enter a value or drag the slider to set the Sun Specular value. 100 is the value that is compatible to all 
earlier versions of Bryce which did not feature this control. The range is -999 to 999. This means that 
Specular can also be negative, which makes from a shiny glossy spot a dark spot.

Examples:

• Sun Intensity Specular 100 (compatible setting to earlier versions):

• Sun Intensity Specular 0:

©2003-2011 DAZ 3D, Inc. 799



Bryce 7 Artist Guide 03 Jan 2011

• Sun Intensity Specular -100:

Ambient Color
The Ambient Color is the color of all the light that surrounds the objects in your scene. Light from the sun 
interacts with ambient color to produce the color for both highlights and shadows.
Ambient Color is used as the source color for material Ambience. The Ambient Color tints the surfaces of 
all objects in your scene that have some level of ambience. Any other color you apply to the object's 
surface is mixed with the Ambient color to create the final surface color. For example, if the Ambient Color 
is red, any color you assign to an object's surface ambience is mixed with red. Refer to "Ambience" for 
more on material ambience.
To set Ambient Color:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Click the Ambient color swatch below the Sun/Moon Shadows option and choose a color from the 
color picker.

For realistic effects, at noon or in the afternoon, ambient color should be a little blue to get nice 
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blue-ish shadows. At dawn, you can set Ambient Color to red or pink, and at night you can set it 
to gray-blue.

5. Click the OK icon to exit the dialog.
You can also set the ambient color using the Sky & Fog Palette:

Sky Dome Color
Sky Dome Color lets you create a color wash over your scenes, even if there is no sunlight present. This 
color simulates the natural effect that occurs when you have color in the sky even though the sun has set. 
Sky DomeColor lets you create late afternoon or evening scenes. The Sky Dome Color control in the Sky 
Lab lets you choose a color from either the color picker or the color dialog.
For late afternoon and early evening realism, try using a touch of orange or yellow. This will create a cast 
of color over your entire scene, regardless of the position or color of the sun or moon.
To set Sky Dome color:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 
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2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Click the Sky Dome color swatch below the Sun/Moon Shadows option and choose a color from 
the color picker.

5. Click the OK icon to exit the dialog.
You can also set the sky dome color using the Sky & Fog Palette:

Examples:
• Sky Dome Peach
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• Sky Dome Blue

Working with the Sun & Moon

Working with the Sun & Moon

Working with the Sun

The sun is the source of all natural light in your scene. Its attributes have a profound effect on the look of 
your scene. The intensity and color of the sun affects all the colors of all the objects in the scene; Sunlight 
color tints all the other visible colors.
The position of the sun controls the time of day in your scene. If the sun is above the horizon, it is day; if it 
is below, it is night, and if it is at the horizon, it is sunrise or sunset. The sun can be animated just like all 
the other elements of your Bryce scene. You can create time-elapsed effects by changing the position of 
the sun over the course of an animation.

Working with the Moon

The moon is normally the most prominent object in the night sky. In a night scene it provides all the 
natural light in the environment. Like the sun, the moon's attributes can greatly affect the final look of your 
scene. Its position in the sky affects all the angles and intensities of all the shadows in the scene.
The brightness is affected by the illumination reflected off the earth. The brighter the earthshine, the 
brighter the moon appears. Unlike the sun, the moon has phases which simulate the effects of the moon's 
shadow becoming more or less prominent during a month.
The moon's position and phases can be animated using the Animation controls and the timeline.
Refer to "Animating Sun or Moon Position" for more on animating the moon.
See the following topics for more on working with the sun and moon:
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• Positioning the Sun  
• Positioning the Moon  
• Linking the Sun to the Camera  
• Disabling Sunlight  
• Sun/Moon Color  
• Switching Between Sun & Moon  

Positioning the Sun

Positioning the Sun

The sun position control sets the direction your natural light is coming from whether it is sunlight or 
moonlight. The position can be set using the Sun control in the Sky & Fog palette or in the Sky Lab. The 
control works like a trackball, with the sun (bright) at one end and the moon (dark) at the other.
You can think of the control as a compass: if the highlight on the Sun Control sphere is positioned at 12 
o'clock, the light comes from the north, and so on. As you change the position of the sun, the "time of day" 
changes. When the sun position is closer to the edges of the control, the sun appears closer to the 
horizon, making the scene darker. When the sun is in the center of the control, the sun shines from 
directly above the sun, like it would at high noon.
The colors in your sky will change depending on the position of the Sun Control, or the "time of day..." just 
like in the real world. The angle of the shadows changes as the sun changes. If your object is shiny, and 
there are no other light sources, the position of the sun controls where the highlight appears. In this 
example, you can see the effects of the sun's position on several reflective and shiny objects.
You can position the sun manually and with precision on the Sky & Fog Palette and in the Sky Lab. You 
can also position the sun numerically in the Sky Lab.

• Positioning the Sun Manually  
• Positioning the Sun with Precision  
• Positioning the Sun Numerically  

Positioning the Sun Manually

To position the sun manually: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Use the Sun Controls on the palette or click on the Sky Lab button. The Sky Lab appears.

3. In the Sun Controls area, drag the larger highlight area in the Sun Position Controls to the 
position where you want the light to originate. You can position the sun, or the moon, on the 
horizon as you like by nudging the Sun Control until the light is visible in your scene.
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Positioning the Sun with Precision

To position the sun with precision:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Hold down Ctrl+Opt/Alt and double-click the Sun control.

3. Continue holding down Ctrl+Opt/Alt and in the working window, click where you want to position 
the sun. A yellow asterisk will show up where you click indicating where you placed the sun.

And the result:

Positioning the Sun Numerically

To position the sun numerically:
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1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field controls the east-
to-west position of the sun. The range is 0 to +360. 

4. Enter a value in to the Altitude field. The Altitude field controls the height of the sun relative to 
your scene. The range is 90 to +90. Positive values are above the horizon, negative values 
below.
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5. Check the results to see if any further changes are needed. 

6. Click the OK icon to exit the dialog.

Positioning the Moon

Positioning the Moon
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The moon is positioned at the same time as the Sun. The two are always at opposite ends of the sky, so 
wherever the sun is positioned, the moon is directly opposite. In the Sun/Moon control on the Sky & Fog 
palette and in the Sky Lab, the moon's position is represented by the smaller highlight portion of the Sun 
Position trackball.
You can position the moon manually by using the Sun/Moon control, or numerically by specifying values 
in the Sky Lab. You can also position the moon exactly where you want it to appear in your scene.
You can position the moon manually and with precision on the Sky & Fog Palette and in the Sky Lab. You 
can also position the moon numerically in the Sky Lab.

• Positioning the Moon Manually   
• Positioning the Moon with Precision   
• Positioning the Moon Numerically  

Positioning the Moon Manually

To position the moon manually:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Use the Sun Controls on the palette or click on the Sky Lab button. The Sky Lab appears.

3. In the Sun Controls area, drag the larger highlight area in the Sun Position Controls to the 
position where you want the light to originate. You can position the sun, or the moon, on the 
horizon as you like by nudging the Sun Control until the light is visible in your scene.

Positioning the Moon with Precision

To position the moon with precision:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Day/Night Toggle to display the moon icon. 
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3. Hold down Ctrl+Shift+Opt/Alt and quickly double-click on the Sun control. 

4. Continue holding down Ctrl+Shift+Opt/Alt and in the working window, click where you want to 
position the moon. A blue asterisk will show up where you click indicating where you placed the 
moon. If you have trouble placing the moon this way, place the sun, then click on the Day/Night 
Toggle to switch to the moon.

And the result:

Positioning the Moon Numerically

To position the moon numerically:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 
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2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Day/Night toggle to display the moon icon.

4. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field controls the east-
to-west position of the sun/moon. The range is 0 to +360, and the default value is 60. The moon 
will be positioned exactly opposite these values, so you can invert them to position the moon 
numerically or place the Sun behind the camera so that the moon appears in front of it.

5. Enter a value into the Altitude field. The Altitude field controls the height of the sun/moon relative 
to your scene. The range is -99 to +99. Positive values are below the horizon, negative values 
above. 
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6. Check the results to see if any further changes are needed. 

7. Click the OK icon to exit the dialog.

Linking the Sun to the Camera

Normally, you would have to reposition the sun every time you changed the camera to maintain a certain 
effect or sunlight angle. However, if you apply the Link Sun to Camera option, your sun will track the 
camera. The position of the sun relative to the camera remains the same no matter where the camera is 
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positioned. This way you can set up the sun position once and then not worry about losing the effect as 
you move the camera. This feature can also be very useful when you are animating your scene.
To link the sun to the camera:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Click the Link Sun to View button. When this option is enabled, your sun will always remain in the 
same position relative to the camera. Wherever you move the camera the sun will follow. This is 
an easy way of seeing how a sunset will look against different skylines.

Disabling Sunlight

You can remove the sunlight in your scene by disabling it. When the sunlight is disabled, the sun remains 
in the scene, but does not throw light. The only light visible in your scene comes from individual light 
sources. (The scene will still be illuminated.)
When using image-based lighting, the sun will need to be disabled. 
To disable the sunlight:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.
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4. Click the Disable Sun Light button.

Sun/Moon Color

Light in nature is not usually visible until it strikes an object. When you are using normal light, a purple 
sunlight color will not paint your entire sky purple, but objects in your scene will reflect purple. When you 
are using Visible World, choosing purple will paint your entire scene purple.
To set the Sun Color:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Sun & Moon tab.

4. Left-click-hold on the Sun Color Swatch and select a color from the color palette that comes up. 

5. Click the OK icon to exit the dialog. 
Examples:
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• Sun Color = White

• Sun Color = Pink

• Sun Color = Red

You can also set the sun/moon color using the Sky & Fog Palette:
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Switching Between Sun & Moon

Your sky normally contains two bodies: the sun and the moon. There is always one body visible in your 
sky. At night it is the moon and in the day it is the sun. The two bodies are connected and always remain 
at opposite ends of the sky. As you move the sun you are also moving the moon. This means that when 
the sun dips below the horizon in front of you, the moon is rising behind you.
The link between the sun and the moon can be seen by positioning the sun at the horizon in front of the 
camera. If you turn the camera 180°, you will see the moon just rising over the horizon as well.
To switch between night and day:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Day/Night Toggle button in the top-left corner of the Sun Position Controls. 

The Sun/Moon Control in the Sky Lab is linked to the same controls in the Sky & Fog Palette.

Cloud Cover Tab

Cloud Cover Tab
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The Cloud Cover Tab contains controls for adding, controlling, and animating clouds.
• Setting Cloud Types  
• Editing Cloud Textures  
• Setting Cloud Motion  
• Setting Cloud Cover  
• Setting Cloud Height  
• Setting Cloud Color
• Setting Frequency & Amplitude  
• Cast Shadows  
• Linking Clouds to the Camera  
• Using a Fixed Cloud Plane  
• Spherical Clouds  

Setting Cloud Types

Setting Cloud Types

There are two types of clouds you can add to your Bryce environment: Cumulus and Stratus.
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Cumulus clouds are generally found at lower altitudes and appear thicker and fluffier. 
The cloud types in the Cloud tab are arranged in a way that shows which type is at a higher altitude and 
which is at a lower altitude: Stratus above and Cumulus below.

Cumulus clouds are thicker, darker clouds at a lower altitude. These clouds will take on tints of Sunlight 
color, Ambient color, or Cumulus color.
Stratus clouds appear at higher altitudes and appear thinner and more wispy. The sky in this scene uses 
Stratus clouds. 

Stratus clouds are bright white, thin, clean clouds that appear at high altitudes. These clouds are very 
responsive to Sunlight color and Sky Dome color, and less responsive to Cumulus color or Ambient color.
Using both cloud types at once creates a more realistic sky.
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Deselecting both cloud types creates a clear sky. 

Cumulus Clouds

Cumulus clouds are thicker, darker clouds at a lower altitude. These clouds will take on tints of Sunlight 
color, Ambient color, or Cumulus color.
Also note that the Cloud Height influences Haze. The higher the clouds are set – even if Cumulus are 
deselected after setting the Cloud Height – the higher up the Haze reaches. The picture above shows a 
low Cumulus Cloud Height setting and the Haze is narrow and concentrated at the horizon.
To add Cumulus clouds to a sky:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.
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4. Activate the Cumulus Clouds option.

Stratus Clouds

Stratus clouds are bright white, thin, clean clouds that appear at high altitudes. These clouds are very 
responsive to Sunlight color and Sky Dome color, and less responsive to Cumulus color or Ambient color.
To add Stratus clouds to a sky:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Activate the Stratus Clouds option.

 

Editing Cloud Textures

Editing Cloud Textures
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Clouds in Bryce are created using a procedural texture with a cloud pattern. The color, position, size, and 
pattern within the texture determines the final look of the cloud in your sky. You can edit this texture using 
either the Sky Lab palette, or for more complex editing, you can use the Deep Texture Editor.
The texture used for a cloud can come from either the Bryce Texture Library or you can create your own.

• In the Sky Lab  
• In the DTE  

In the Sky Lab

To edit cloud textures in the Sky Lab:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Activate either the Stratus or Cumulus cloud type, or both.

5. Click the grey + or -Turbulence buttons to increase or decrease the amount of noise in the 
texture. Increasing the Turbulence creates a more dense pattern within the texture.

Note: The turbulence of the original texture is the lowest setting for that texture. The turbulence 
can only be increased then decreased back down to the original setting.

6. Click the blue + or -Complexity buttons to increase or decrease the amount of detail in the 
texture. Increasing the Complexity increases the complexity of the patterns within the texture.
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Note: The complexity of the original texture is the highest setting for that texture. The complexity 
can only be decreased then increased back up to the original setting.

7. Click the Reset button to restore the original settings if you want to start over. 

8. Click the Edit button to enter the Deep Texture Editor to adjust or change the cloud texture.

9. Click the OK icon to apply your changes. 
Examples: 
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• Above: Stratus - Original; Increased Turbulence; Decreased Complexity 

• Below: Cumulus - Original; Increased Turbulence; Decreased Complexity 

In the DTE

To edit cloud textures in the Deep Texture Editor:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Activate either the Stratus or Cumulus cloud type, or both.

©2003-2011 DAZ 3D, Inc. 822



Bryce 7 Artist Guide 03 Jan 2011

5. Click the Edit button below the type of clouds you want to edit.
6. Click the Edit button. The Deep Texture Editor appears. The cloud texture and its components 

appear in the component windows. If you are not familiar with using the Deep Texture Editor you 
may get some very unpredictable results which may result in clouds that do not look much like 
clouds. Before you start editing the clouds texture you may want to refer to "The Deep Texture 
Editor" for more instructions on how to use the editor.

7. If you want to add additional turbulence to the cloud texture, adjust the texture's Noise: 
• Click the Noise button at the bottom of the editor. The Noise control appears. The Noise 

control lets you adjust the frequency of the noise in any of the texture's components. 
• At the top of the Noise control, click the button associated with the component you want 

to edit. 
• Adjust the Noise slider to increase/decrease the frequency of the noise in the texture. 

8. If you want to change the colors of a component, click one of the color indicators in the 
component window and choose a new color.

9. If you want to add more complexity to the texture, adjust its Phase: 
• Click the Phase button at the bottom of the editor. The Phase control appears. The 

Phase control lets you adjust the amplitude of the phase in any of the texture's 
components. 

• At the top of the Phase control, click the button associated with the component you want 
to edit. 

• Adjust the Phase slider to increase/decrease the amplitude of the phase. 
10. If you want to change the pattern in the texture, apply a filter: 

• Click the Filter button at the bottom of the editor. The Filtering control appears. The 
Filtering control displays a graphical representation of the filter applied to your texture. By 
changing the equation of the filter to the value of the variables, you can change the 
patterns within the cloud texture. 

• At the top of the Filtering control, click the button associated with the component you 
want to edit. 

• Change the filter equation and variable values to adjust the filter applied to your texture. 
Filtering is a rather complex operation. Try experimenting with different equations and 
see what happens. 

11. Click the OK icon to exit the editor.

Setting Cloud Motion

Setting Cloud Motion

When setting up animations, you can set the speed and turbulence of clouds as well as specify the 
direction of motion.
Please note that these controls only work during animations. They have no effect on still images.

• Setting Cloud Speed  
• Setting Cloud Turbulence  
• Setting Direction of Motion  
• Reset Cloud Speed Turbulence  

Setting Cloud Speed
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To set cloud speed for animations:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Activate either the Stratus or Cumulus cloud type, or both.

5. Drag the slider or enter a number in the Speed field.

Setting Cloud Turbulence

To set cloud turbulence for animations:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.
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4. Activate either the Stratus or Cumulus cloud type, or both.

5. Drag the slider or enter a value in the Turbulence field. 

Setting Direction of Motion

To set the direction of motion for animations:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Activate either the Stratus or Cumulus cloud type, or both. 

5. Drag the Cloud motion control to specify the angle of motion.
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Reset Cloud Speed & Turbulence

To reset the Cloud Speed & Turbulence to zero for animations:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Click on the large center sphere in the Cloud motion control. Both Speed and Turbulence will be 
set to zero.

Setting Cloud Cover
Cloud Cover controls the quantity of clouds you can see in the sky. A high coverage means that there is a 
very dense cloud layer, and a low setting means that there are very few clouds in the sky.
Cloud cover also indirectly controls the brightness of the environment. The more cloud coverage you have 
in a sky, the darker the environment, since less sunlight can pass through the clouds. Adjusting cloud 
coverage changes the quantity of clouds but not the frequency. You can think of it as adjusting the 
volume on a radio without changing the station.
The Cloud Coverage control in the Sky Lab lets you interactively set the quantity of clouds in the sky.
For example, you can see how the clouds change in these skies as the cloud coverage value changes.
To set cloud coverage numerically:
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1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Activate either the Stratus or Cumulus cloud type, or both.

5. Drag the slider or enter a value in the Cloud Cover field.

You can also set Cloud Cover in the Sky & Fog Palette.

Setting Cloud Height
The height of your clouds has an impact on the appearance of your sky. Greater heights will result in 
smaller, more distant cloud formations, as well as a thicker band of haze at the horizon. Lower heights 
result in larger, more languorous cloud formations and a thinner band of haze at the horizon. The Cloud 
Height controls in the Sky & Fog palette let you interactively set the height of the cloud layer in the sky. 
For example, you can see how the clouds change in these skies as the cloud altitude value changes from 
10% to 90%.
There are two things to remember when working with this control. First, the Cloud Height will affect the 
size of your Haze band, if you have a haze setting greater than zero. The higher the altitude, the wider the 
haze region will be on the horizon. Second, remember to lower your altitude setting if you are creating a 
nighttime scene. Since high altitudes increase the size of the horizon Haze region, the sky will be too 
unnaturally bright for realistic night scenes.
To set cloud height numerically:
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1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Drag the slider or enter a value in the Cloud Height field.

You can also set Cloud Height in the Sky & Fog Palette.

Setting Cloud Color
There is only one way to set the Cloud Color and it is for the Cumulus only.

Setting Frequency & Amplitude
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The Frequency and Amplitude control lets you set the types of cloud formation you will see in your sky. By 
combining these two controls you can change your clouds from light and fluffy to dark and brooding. Use 
Frequency and Amplitude to control the types of cloud formations in your scene.
This graph shows the effects of different Frequency and Amplitude settings on a sky. Frequency values 
range from 2 at the top to 150 at the bottom. The Amplitude values range from 50 at the left to 500 on the 
right.
To set Frequency and Amplitude numerically:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Drag the slider or enter a value in the Frequency field. The Frequency field controls the frequency 
(scale) of cloud formations in your scene.

5. Drag the slider or enter a value in the Amplitude field. The Amplitude field controls the amplitude 
(edge softness) of clouds in your scene.

Drag right to increase the Amplitude amount, drag left to decrease the amount.

You can also set Cloud Frequency & Amplitude in the Sky & Fog Palette.

©2003-2011 DAZ 3D, Inc. 829



Bryce 7 Artist Guide 03 Jan 2011

Holding the left hand mouse button down and dragging the mouse up and down changes the Amplitude, 
moving the mouse left and right changes the Frequency.
Amplitude and Frequency setting of Stratus and Cumulus are taken from how they were set and then are 
altered together. If they were different to begin with, they will also be different afterwards.

Cast Shadows
By default, the Clouds in Bryce do not cast shadows. If you want the cloud layer to cast shadows on the 
ground below,
enable the Cloud Shadows option.
To have the clouds cast shadows:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.
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4. Activate either the Stratus or Cumulus cloud type, or both.

5. Enable the Cast Shadows option.

Linking Clouds to the Camera
If you move the camera view during an animation, the clouds in your environment will appear to zoom by, 
creating a kind of time-lapsed effect. If you want the clouds to appear fixed as you move the camera, link 
the cloud in the sky to the camera view. This way, wherever the camera moves the clouds will follow so 
that they seem to remain stationary.
To link clouds to view:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Click the Link Clouds to View button.

Refer to "Animating Skies" for more on animating skies.

Using a Fixed Cloud Plane
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As you move higher up in a Bryce environment, the cloud pattern shifts, so that it appears as if you are 
getting closer to the clouds. If you want to counter this effect, you can use the Fix Cloud Plane option to 
freeze the cloud pattern so that it does not change as you move higher up.
To use a fixed cloud pattern in your sky:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.

4. Activate either the Stratus or Cumulus cloud type, or both.

5. Enable the Fixed Cloud Plane option.

Spherical Clouds
Selecting Spherical Clouds consolidates high frequency clouds, creating rounder more dense clouds. 
Works for both
stratus and cumulus.
To enable Spherical Clouds:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Cloud Cover tab.
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4. Activate either the Stratus or Cumulus cloud type, or both.

5. Enable the Spherical Clouds option.

6. Click the OK icon to exit the dialog. 
Examples: 

• Stratus Clouds, Spherical Clouds disabled:

• Stratus Clouds, Spherical Clouds enabled:
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• Cumulus Clouds, Spherical Clouds disabled:

• Cumulus Clouds, Spherical Clouds enabled:

• Stratus & Cumulus Clouds, Spherical Clouds disabled
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• Stratus & Cumulus Clouds, Spherical Clouds enabled:

Atmosphere Tab

Atmosphere Tab
Environmental effects controls are located on the Atmosphere tab of the Sky Lab dialog.
The elements in a sky aren’t constant; the sky is always changing, reflecting weather patterns or the time 
of day. If it rains, there’s a rainbow. If it is night, there are stars. If it is sunset, the sun looks bigger. If you 
look right at the sun on a hazy day, you will see rings around it. Sometimes, if it is hazy enough you can 
even see the sunlight streaking out of the clouds. All these illusions are called environmental effects and 
the Sky Lab palette contains all the controls you will need to add them to your scene.

• Fog  
• Haze  
• Rainbows  
• Blend with Sun  
• Volumetric World  
• Color Perspective  
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Fog

Fog

Fog can add an element of sensuality, mystery, and even realism to your scenes. It acts like a thin layer 
of cloud close to the ground.
Using Fog you can create the illusion of depth without having to add distant objects. Fog can create a 
sense of depth in your scene.
In this scene, the fog was used to add depth to the road as it moves away from the camera. Notice how 
the feeling of depth was created without the addition of background objects.

You can set intensity, height, and color attributes for the fog.
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The fog acts as a global layer covering the entire scene. Its color and intensity are the same throughout 
the scene. Localized fog can be created by adding a volume cloud material to a plane or sphere within the 
scene.
To enable Fog:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Enable the Fog option.

5. Adjust the Fog Color, Density, Thickness, and Base Height as needed.
6. Click the OK icon to exit the dialog.

Fog Color

To set Fog color:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.
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4. Enable the Fog option.

5. Click the color swatch above the Density slider and choose a color from the color picker.

Refer to "Blend with Sun" for information on blending the fog color with the sun.
Examples:

• Fog Color = Peach
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• Fog Color = Green

 

Fog Density

Fog Density sets the amount of fog rendered in the image. It works along with Fog Thickness to create 
the fog. Fog Density can be set from 0 to 100% with a default value of 0%.

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Enable the Fog option.
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5. Drag the Density slider or enter a value in the Density field.

Examples:
• Fog Density = 0

• Fog Density = 15, Thickness = 5
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• Fog Density = 25, Thickness = 5

• Fog Density = 75, Thickness = 5

• Fog Density = 100, Thickness = 5
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Fog Thickness

Like Fog Density, Fog Thickness sets the amount of fog rendered in the image. It works along with Fog 
Density to create the fog. Fog Thickness can be set from 0 to 100% with a default value of 0%.

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Enable the Fog option.

5. Drag the Thickness slider or enter a value in the Thickness field.

Examples:
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• Fog Thickness = 0, Density = 0

• Fog Thickness = 5, Density = 5

• Fog Thickness = 5, Density = 10
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• Fog Thickness = 10, Density = 10

• Fog Thickness = 15, Density = 10

• Fog Thickness = 15, Density = 50
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• Fog Thickness = 15, Density = 75

• Fog Thickness = 15, Density = 100

Fog Base Height

Fog Base Height sets the height of the fog in your scene, assuming there is a value greater than zero in 
the field. The range is 0 to 100%, and the default value is 0%. It translates the entire atmospheric effect 
up or down without changing the density or thickness, however, the effect is more obvious with changes 
in thickness in addition to the height changes. Base Height provides control over density at low altitudes, 
such as in valleys. In early versions of Bryce, you had to move the entire scene up or down relative to the 
atmosphere.

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Atmosphere tab.

4. Enable the Fog option.

5. Drag the Base Height slider or enter a value in the Base Height field.

Examples:
• Fog Density = 5, Thickness = 25, Base Height = 25
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• Fog Density = 5, Thickness = 45, Base Height = 50

• Fog Density = 5, Thickness = 65, Base Height = 75

• Fog Density = 5, Thickness = 85, Base Height = 100

©2003-2011 DAZ 3D, Inc. 847



Bryce 7 Artist Guide 03 Jan 2011

Haze

Haze

Haze is the natural effect you see when a plane (like the ocean) stretches out towards the horizon. At this 
distant point a different color appears over the horizon and light becomes fuzzy. Haze creates the illusion 
of a distant horizon. In this scene, the haze is used to create the distinction between the water plane and 
the sky.
The Haze control lets you set the intensity and color of the Haze effect in your Bryce scene.
With haze set to zero, your horizon will have an unnaturally hard edge. Also note that the Cloud Altitude 
control will affect the height of this band of haze. The higher the altitude of the atmosphere, the wider the 
band of haze at the horizon.
Haze is applied to the entire scene equally. The haze always appears at the horizon.
To enable Haze:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Enable the Haze option.

5. Adjust the Haze Color, Density, Thickness, and Base Height as needed.
6. Click the OK icon to exit the dialog. 

Haze Color

To set Haze Color:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Atmosphere tab.

4. Enable the Haze option.

5. Click the color swatch above the Density slider and choose a color from the color picker.

Refer to "Blend with Sun" for information on blending the haze color with the sun.
Examples:

• Haze Color = Yellow

©2003-2011 DAZ 3D, Inc. 849



Bryce 7 Artist Guide 03 Jan 2011

• Haze Color = Blue

 

Haze Density

Haze Density, along with Thickness and Base Height, govern the amount of haze rendered into your 
scene. The range is 0 to 100, and the default value is 4. Density controls the density of the lower part of 
the atmosphere and affects the scattering of light around the sun.

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Enable the Haze option.
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5. Drag the Density slider or enter a value in the Density field.

Examples:
• Haze Density, Thickness, & Base Height = 25

• Haze Density = 50, Thickness & Base Height = 25
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• Haze Density, Thickness, & Base Height = 50

• Haze Density = 75, Thickness & Base Height = 50

• Haze Density = 75, Thickness =50, Base Height = 100

©2003-2011 DAZ 3D, Inc. 852



Bryce 7 Artist Guide 03 Jan 2011

Haze Thickness

Haze Density, along with Thickness and Base Height, govern the amount of haze rendered into your 
scene. The range is 0 to 100, and the default value is 4. Thickness scales the whole atmosphere up or 
down, with the density at "sea level" remaining unchanged. In earlier versions of Bryce, you had to move 
the entire scene up or down relative to the atmosphere.

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Enable the Haze option.

5. Drag the Thickness slider or enter a value in the Thickness field.

See "Haze Density" for examples of Haze Thickness used in conjunction with Density and Base Height.

Haze Base Height

Haze Base Height, along with Density and Thickness, govern the amount of haze rendered into your 
scene. The range is 0 to 100, and the default value is 4. Base Height provides control over density at low 
altitudes, such as in valleys. It translates the entire atmospheric effect up or down without changing the 
density or thickness. In earlier versions of Bryce, you had to move the entire scene up or down relative to 
the atmosphere.

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Atmosphere tab.

4. Enable the Haze option.

5. Drag the Base Height slider or enter a value in the Base Height field.

See "Haze Density" for examples of Haze Base Height used in conjunction with Density and Thickness.

Rainbows
In the real world rainbows appear after rainstorms as arcs of light displaying all the color in the spectrum. 
In Bryce a rainbow is an atmospheric effect that can be added to any sky. A rainbow is only visible if the 
sun is visible, meaning you cannot have a rainbow at night. As well, you can add a secondary rainbow to 
create the illusion of reflection.
Rainbows are linked to the sun. As the color or intensity of the sun changes, so does the rainbow. In 
addition, the position of the rainbow in the sky is dependent on the position of the sun. Rainbows appear 
to be infinitely distant from the camera. You cannot approach them by moving the camera, so the pot of 
gold is always just out of reach.
To add a rainbow to your sky:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.
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4. Enable the Rainbows option.

5. Drag the slider or enter a value in Radius field in the Rainbow area. This value sets the width of 
the rainbow and can be set from 0 to 100 with the default value of 33.33.

6. Drag the slider or enter a value in the Opacity field. This controls the rainbow's transparency and 
can be set from 0 to 100 with the default value of 30.

7. If you want to add a secondary rainbow to your sky, enable the Secondary Bow option. By 
default, the Secondary Bow option is enabled when you enable the Rainbow option. Disable it to 
only have one rainbow in the scene.

Examples:
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• Radius = 33.33, Opacity = 30

• Radius = 45, Opacity = 45

• Radius = 75, Opacity = 65
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• Radius = 100, Opacity = 100

• Radius = 45, Opacity = 75, Secondary Bow enabled

 

Blend with Sun

Blend with Sun

Since fog remains constant throughout the scene, you may get some odd looking results when you are 
creating a sunset or sunrise. In these cases the sun is very close to the ground plane where the fog 
exists, so the fog should react to the sunlight. The Blend with Sun feature lets you create exactly this 
effect. As the sun approaches the Fog, the color and intensity of the fog changes to interact with the color 
of the sun.
Since the Haze always appears at the horizon it should change color as the sun sets or rises. The Blend 
with Sun feature lets you simulate this effect. When the two elements are linked, the haze color and 
brightness change depending on the position of the sun. This creates very realistic looking sunsets. When 
you are using this feature to create sunsets, you should choose the haze color carefully so as to create a 
natural-looking color scheme.
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See the following topics for individual instructions on blending fog and haze with the sun:
• Blend Fog  
• Blend Haze  

To blend the fog and haze with the sun:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Enable the Blend with Sun option. Blend Haze and Blend Fog will be automatically enabled.

5. Enter a value in the Color field or drag the slider to set how much of the fog and haze color is 
blended with the sun.

6. Enter a value in the Luminance field or drag the slider to set the intensity of the fog and haze 
color when it is blended. To get the best effect, set both these fields to 100.

Examples: 
• Blend Color with Sun = 50; Blend Luminance with Sun = 100
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• Blend Color and Luminance with Sun = 50:

• Blend Color and Luminance with Sun = 100

Blend Haze

To link Haze to the Sun controls:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Click the Blend with Haze button. Blend Haze and Blend Fog will be enabled automatically. Leave 
the Blend Fog enabled to increase the haze effect.
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5. Enter a value in the Color field, or drag the slider, to set how much of the haze color is blended 
with the sun.

6. Enter a value in the Luminance field, or drag the slider, to set the intensity of the haze color when 
it is blended. To get the best effect, set both these fields to 100.

7. Enable the Haze option, change the color of the haze if you want (the better to see the effect). 
Enable the Fog option as well if the Blend Fog option was left enabled under Blend with Sun.

8. Adjust Fog and Haze Density, Thickness, and Base Height as needed.
9. Click on the OK icon to close the dialog.  

Examples:
• Blend with Sun disabled:
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• Blend with Haze enabled:

• Blend with Haze enabled, sun lower over horizon:

 

Blend Fog

To link Fog color to the Sun controls:
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.
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4. Click the Blend with Sun button. Blend Haze and Blend Fog will be enabled automatically. 
Disable Blend Haze if you wish.

5. Enter a value in the Color field or drag the slider to set how much of the fog color is blended with 
the sun. 

6. Enter a value in the Luminance field or drag the slider to set the intensity of the fog color when it 
is blended. To get the best effect, set both these fields to 100.

7. Enable the Fog option, change the color of the fog if you want (the better to see the effect). 

8. Adjust Fog Density, Thickness, and Base Height as needed.
9. Click on the OK icon to close the dialog.  

Examples:
• Blend with Fog disabled: 
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• Blend with Fog enabled: 

• Blend with Fog enabled, sun higher over horizon: 

Volumetric World
The Volumetric World effect simulates the effects of particles in the air being illuminated by light sources. 
In Bryce this effect turns all the light sources in your scene into visible light sources.
Sunlight also becomes visible so that any color you applied to the sun appears everywhere in the scene. 
Visible sunlight is volumetric, meaning that it is affected by all the objects within it.
Although Volumetric World is a very beautiful effect, it is also a time consuming one. It will add 
considerably to your scene's rendering time.
To add visible sunlight to your scene:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.
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3. Click the Atmosphere tab.

4. Enable the Volumetric World option.

5. Drag the Quality slider or enter a value in the Quality field. Values can be set from 0 to 100 with 
the default value of 50.

6. Drag the Density slider or enter a value in the Density field. Higher values result in brighter, more 
visible sunlight. Values can be set from 0 to 100 with the default value of 50.

7. Click the OK icon to exit the dialog.
Examples:

• Volumetric World disabled, Render Time = 0:11
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• Volumetric World enabled, Density & Quality = 50, Render Time = 3:45

• Volumetric World enabled, Density = 100, Quality = 50, Render Time = 3:26

• Volumetric World enabled, Density =50, Quality = 100, Render Time = 7:20
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Color Perspective
Color perspective is the change in color with distance that characterizes the appearance of distant scenes 
in Nature: Dark areas turn blue and light ones yellow to orange to red.
In Bryce you can make things change any color you like with distance. Color perspective is half of aerial 
perspective, while the other half is the loss of contrast with distance. Color perspective controls the rate at 
which the red, green, and blue components of the atmosphere come in with distance. 
In Nature, the atmosphere is white or a pale shade of gray. The blue component of that shade comes in 
faster than the green, which in turn comes in faster than the red. This is because the Earth's atmosphere 
scatters blue light more efficiently than green, and red least efficiently of all. The net result is that as a 
dark area recedes into the distance, it will turn blue before it turns white or pale gray in the far distance. 
Similarly, white areas will turn yellow, then orange, then red with increasing distance.
The default values of color perspective are very delicate: if you change them, expect unpredictable 
results!
To set the color perspective:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the Atmosphere tab.

4. Click the Color Perspective button.

5. Drag over the RGB controls or enter a number in the field to control the rate at which the red, 
green, and blue components of the atmosphere come in with distance. 

Examples:
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• Color Perspective Disabled:

• RGB = 79 2 30:

• RGB = 0 1 88:
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Sky Lab's IBL Tab

Image Based Lighting Tab
Bryce 6.0 introduced Image-Based Lighting (IBL) which uses an image to light your Bryce scene in 
addition to traditional Bryce lighting. Bryce 6.1 added the Orientation Control, Falloff options, Radius 
slider, and a completely different IBL algorithm. The IBL tab for Bryce 6.3 is identical to the one in Bryce 
6.1. In Bryce 7.0 Pro there are many more controls available; IBL has much improved.
Please note that because of the extreme differences between the Bryce 6.0 and Bryce 6.1/6.3 algorithms, 
there is no easy conversion method from HDRI scenes created in Bryce 6.0 to the same scene in Bryce 
6.1/6.3. Great care has been taken to leave IBL in Bryce 7.0 compatible to Bryce 6.1 and 6.3.
The IBL tab contains controls for adding an HDRI image, setting the quality and intensity, the HDRI Effect, 
Falloff and Radius, and whether to render the image as the scene background or not.
Bryce 7.0 Pro features a saturation control for the light emitted. Usually, light shines from the outside onto 
the scene, this direction can be reversed so that the light shines from the center outside into the scene. 
Shadow intensity and softness can be controlled for the light from the HDRI. The HDRI can be specular 
convolved directly in Bryce to produce a blurred reflection map. The amount of depth of field (DOF) can 
be adjusted for the HDRI rendered as background.
And there is more. An HDRI can be created from a Bryce sky and exported in different formats and 
projections as HDRI or as tone-mapped LDRI. An HDRI loaded externally or created from the sky can be 
saved in the Sky Library. Objects in the scene can be selectively excluded or included from the effects of 
the light from the HDRI. 
See the following topics for more on understanding and using IBL:

• IBL in a Nutshell  
• Using IBL  
• IBL Examples  
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Links to sites providing HDRI Maps/Information:
• HDRI FAQs   
• Wikipedia article   - has links to other sites on HDRI, some with maps for download 
• HDRIMaps.com   
• Thread at C4D Cafe   with lots of links and text
• Debevec Light Probes   - several free HDRI files that can be used in Bryce
• Horo > Raytracing   - several free HDRI files that can be used in Bryce, other free resources, hints 

and tips, Bryce and HDRShop tutorials.
• OpenFootage   – free HDRI panoramas in low and high resolution.

Bryce IBL in a Nutshell
Traditionally, a Bryce scene is lit by the sun and/or one or several lights. The Light Lab lets you configure 
the properties of those lights. The appearance of materials may change dramatically depending on the 
setup of the lights, their position, color, and intensities.
Image based lighting is a completely different approach to illuminating a scene. Here, a very high dynamic 
range image is mapped on the inside of a huge imaginary sphere surrounding the whole Bryce world. It is 
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a spherical panorama, 360° wide and 180° high, all around the scene, including sky and ground. The 
bright parts of the picture are so bright that they actually radiate light and thus illuminate the scene from 
all around and can even cast shadows. It does not matter whether that sphere is invisible in the render or 
the HDR image is rendered as a backdrop.
Image based light simulates the physics of light quite accurately. IBL was developed to render with 
natural light. If image based light is used exclusively to light a scene and the Specularity channel in the 
Materials Lab is used to make an object glossy, there is a Specularity control in the IBL tab that needs to 
be adjusted to make the effect visible. Otherwise, the sun if enabled, or a radial nearby will create the 
glossiness. Another means is to substitute the Specularity channel by the Transparency channel and use 
the new Specular Map feature in the IBL tab to blur the reflections.
Just like a scene lit by no other means than the Bryce sun may give very pleasing results, the same is 
true when using image based light exclusively. However, this exclusivity also means limitation. Consider 
using image based light in conjunction with the traditional Bryce light sources. Then you have all the 
options you need to make your artwork look as extraordinary as you wish.
If you render the HDRI as background you might be disappointed by its blurriness. Please keep in mind 
that this is a picture projected on the inside of a sphere and the camera "looks" only at a small portion of 
it. A huge HDRI is needed to render crisp and sharp. The narrower the camera field of view (FOV) is set 
and the larger the document size, the larger the HDRI needs to be. The limit is computer memory, and 
this is reached quite soon.
The backdrop may also appear with a contrast too pronounced, either shadows are black or bright parts 
are burned out. Bryce 7.1 features a global tone-mapping operator that can rectify this and produces a 
pleasing backdrop from the HDRI loaded.
A blurry background is not necessarily a bad thing. Think of depth of field (DOF). The problem here might 
be that the blurriness of the backdrop HDRI is wrong compared to the blurriness of the objects. Here, 
background DOF will be the means to correct that.
Art is about freedom of expression and emulating reality may not be the only goal. Bryce has a tradition to 
give the artist much freedom of expression. Negative lights - light suckers - do not exist in reality neither 
do refraction indices below 1 (smaller than 100 in Bryce). The newest addition to these impossibilities is 
the HDRI from Inside. The HDRI image is tiny and invisible and is in Bryce's world centre. It creates IB 
light from the inside out. The term "Singularity" comes to mind. It can be used to light the inside of a room 
and gives unprecedented possibilities to create abstracts.

Using IBL
Currently, Bryce will only import an HDRI in the Radiance *.hdr format. Bryce 6 was limited to the angular 
(light probe) projection - or any square ratio hdr-picture. New with Bryce 7.0 is the support for the 
spherical or latitude/longitude projection. This HDRI has an aspect ratio of 2 (wide) to 1 (high). 
Below are examples of different projections. Top left: vertical cross (3:4); top right: horizontal cross (4:3); 
bottom left: angular map (1:1); bottom right: spherical (2:1). Only the lower two projections can be loaded, 
but all can be exported.
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If you try to open an .hdr file in a format that Bryce cannot use (neither aspect ratio 1:1 nor 2:1, e.g. a 
vertical or horizontal cross which have an aspect ratio of 3:4 or 4:3, respectively), you will get the 
following error message:

HDR images can be compressed or uncompressed. Bryce only accepts those compressed with the run 
length encoding (RLE) scheme. If Bryce cannot read the file, this error message pops up:
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Click on OK and load an HDR file compatible with Bryce.
To use Image Based Lighting:

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the Bryce window. 

2. Click the Sky Lab button. The Sky Lab appears.

3. Click the IBL tab.

4. Enable the Use HDRI Image option.

By default, when you enable the use of an HDRI image, Bryce disables the Sunlight and turns off 
any Atmospherics that were selected, like Fog and Haze.

5. Click on Open..., the Open dialog comes up. Locate and select an .hdr image, click on Open.

 

The HDRI preview thumbnail will look similar to the following, along with the image showing in the 
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Sky preview thumbnail (this is not the hdr-file selected above):

• The Sky Preview shows the HDRI as seen from the Directors camera because it is set to 
"Render Against Neutral" by default. If set to "Render in Scene", it will show the HDRI as 
seen by the camera selected. In the example above, "Render in Scene" was selected. 
Click on the arrow below the preview to access the viewing options.

• The Sky Preview is rendered with only 16 lights and at a higher quality setting things may 
not appear in the right light even if Full Rendering is enabled. Because of this, the view in 
the Sky Preview may not be exactly the same as the actual scene.

• The file name of the HDRI loaded is indicated above the HDRI preview (here Conf-
Room2.hdr).

• The HDRI loaded in the example above is in the angular map projection and looks almost 
like a mirror ball; aspect ratio 1:1.
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• If the HDRI loaded is in the spherical or latitude/longitude projection with an aspect ratio 
of 2:1, it is squashed into the square preview as the example below shows. The Sky 
Preview on the right shows it rendered against neutral, i.e. form the Directors camera.

6. To create an HDRI from the Sky, enable the Use HDRI Image option (step 4 above) and click on 
Use Sky.

7. The Render Sky dialog pops up and the Sky Resolution can be adjusted from 100 to 10,000 
pixels diameter by either dragging the slider left and right by holding down the left mouse button 
or by clicking into the numeric field between the slider and the word High, and entering the value.

8. The higher the Resolution, the longer it will take to render the sky; this can take several minutes. 
If a sky is used as an HDRI, a low resolution may suffice if it is not rendered as background and 
the Bryce sky is used as backdrop. The size of the HDRI has no impact on the quality of light it 
emits, but a great one if rendered as backdrop and on memory usage. A Progress bar opens.
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9. When the sky is finally rendered as an HDRI, the preview will be updated. The sky used is shown 
as the name of the loaded HDRI if it was loaded from the Sky Library.

 

10. Sometimes, using only the sky dome suffices. This will be the case if no light from below is 
needed. With only the sky dome, all lights are above the horizon and hence the Quality is 
doubled. To create an HDRI only from the Sky Dome, first click on Use HDRI Image (if not yet 
selected), then click on Sky Dome only and finally on Use Sky.

11. Again the Render Sky dialog will open. Do as outlined above in steps 7 thru 9. When the sky is 
finally rendered as an HDRI, the preview will be updated. The sky used is shown as the name of 
the loaded HDRI.
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12. The HDRI from the Sky can be generated without the sun if Sun/Moon Visible in the Sun & Moon 
tab is disabled. The HDRI will then only give ambient light without the sun as the main light 
source. If Sun/Moon Visible is enabled, Sun Intensity in the Sun & Moon tab will control the 
amount of light the sun in the HDRI will emit.

13. To use the IBL and have it rendered as background, enable the Use as backdrop option.

Clicking on the white arrow right of the word backdrop opens a submenu.

• Blend into background shows the HDRI as backdrop along with the settings of the Bryce 
sky, like sun, moon, stars, haze, etc. With the Transparency control, the HDRI backdrop 
can be faded out and the sky gets dark. If Use sky color is enabled, the HDRI fades into 
the Sky Color.

• Blend with sky shows the HDRI as backdrop but there are no clouds. Clouds and HDRI 
backdrop can be balanced with the Transparency control. More transparency fades the 
HDRI backdrop; the clouds get stronger but the sky darker. If Use sky color is enabled, 
the HDRI fades into the Sky Color.

• Add to sky adds the HDRI backdrop to the sky. There is no Transparency control. Sky 
and HDRI are added together.
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14. To use the IBL but not render the image as the background, disable the Use as backdrop option.

15. The Disable Sun Light option will automatically be enabled when an HDRI image is loaded, as will 
Fog and Haze. To use Fog and Haze, click on the Atmosphere tab and re-enable the options. Re-
enabling Fog and Haze will help add more realism to the scene.

16. If a Sky was used to create the HDRI, the sky settings are not changed. Haze and Fog, Clouds 
and the Sun Light stay enabled.

17. If Sun/Moon Visible is checked in the Sun & Moon tab, the sun will appear in the HDRI .
18. Adjust the IBL settings as needed.

• Orientation Control - Controls the orientation of the HDRI around the X, (Yaw) , Y (Pitch) 
and Z (Roll) axes.

• Yaw - degrees of rotation around X axis (0 thru 360 degrees)
• Pitch - degrees of rotation around Y axis (-90 thru +90 degrees)
• Roll - degrees of rotation around the Z axis (0 thru 360 degrees)
• The "cross" on the Roller Ball indicates where the horizon is on the HDRI sphere 

in the North position. The sun spot indicates the center of the light probe. Rotate 
the Roller Ball to rotate the HDRI around the light probe sphere. Holding down 
Cmd/Ctrl while rotating the ball to constrain the rotation to around the Yaw-axis 
only. The Yaw and Pitch values update as the ball is rotated and changing the 
numbers moves the ball to the appropriate orientation. Roll cannot be changed 
using the Roller Ball. The value has to be entered into the numeric field.
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Examples of different Yaw, Pitch and Roll settings. The HDRI preview will not 
reflect the changes. The Sky preview will show them if Render in Scene is 
selected.

• Quality -The number of lights used to render IBL. This control ranges from 16 to 4096 in 
the sequence 16 - 32 - 64 - 128 - 256 - 512 -1024 - 2048 - 4096. The example below 
shows three Quality settings. Render time about doubles with each step Quality is turned 
up.
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Quality 16 (lowest quality)

Quality 256 (default quality).
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Quality 4096 (highest quality)

• Saturation - This controls the color saturation of the light emitted from the HDRI. It does 
not alter the saturation of the HDRI rendered as background not even if the HDRI was 
tone-mapped. This control ranges from 0 to 100. Scenes made with Bryce 6.x will load 
with Saturation 100.

Left, Saturation 100, middle 50, right 0. HDRI rendered as backdrop.

• Intensity - This controls the exposure level of the HDRI rendered as background whether 
it is tone-mapped or not. If the Apply to light source is enabled, it is also a multiplier for 
HDRI Effect. Otherwise, it only controls the brightness of the background.
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Click on white arrow right of the Intensity slider. This control ranges from 0 to 100.
• Specularity controls the amount of specularity the HDRI creates on an object that has a 

material with specularity applied. Additionally, there is a compatible specularity option 
described below that enhances the effect. This control has a range of -1000 to 1000.

• HDRI Effect - This controls the light intensity when using an HDRI for IBL. This is just like 
changing the intensity of any light object in Bryce. This will only affect light intensity 
during IBL. It will NOT affect the look of HDRI rendered in the background. This control 
ranges from -999 to 999.

Click on the white arrow right of the HDRI Effect control to open the options for True 
Ambiance. These two options have only an effect if the scene is rendered premium with 
TA.

• True ambiance optimization makes the light sources large and thus easier for the 
feeler rays to find them.

• Ignore tone mapping uses the light sources of the loaded HDRI even if it was 
tone-mapped. If this option is deselected, the light sources of the tone-mapped 
HDRI are used.

• Radius controls the radius of the virtual sphere on which the HDRI is projected into. It is 
grayed out if Falloff is set to None (see below).

• A large HDRI needs considerable computer power and the controls may appear to react 
very sluggishly or not at all. Be patient or use a smaller HDR image (800 x 800 instead of 
1600 x 1600, for example).

• Transparency - controls to which amount an HDRI rendered as background is blended 
with the Bryce sky. The effect of this control depends on the mode set when Use as 
backdrop is selected. The range of the control is 0 (no transparency) to 100 (full 
transparency).

• Light From Inside maps the HDRI on an invisible tiny sphere in the Bryce world center. It 
cannot be enlarged, positioned or selected and the scene has to be built around it. This 
concerns only the light emitted by the HDRI. Saturation, Intensity, HDRI-Effect, Radius 
and Falloff: all controls work as described above. Since the HDRI is so small, setting 
Quality higher than 16 does not have any perceivable effect on the render. The HDRI can 
still be used as backdrop. It will not emit light and acts only as a background image. The 
brightness of the backdrop is controlled by Intensity while the light out of the world center 
is controlled by HDRI Effect.
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To enable Light From Inside, click on the dot. To disable, click again on the dot. Above at 
left enabled, at right disabled. HDRI From Inside toggles between light from inside and 
light from outside.

• Falloff - Determines the type of light falloff to be used. 
• None - light never falls off due to distance (Radius becomes irrelevant) - Default.
• Linear - light falls off as a function of distance.
• Squared - light falls off as a function of distance squared (much faster than 

Linear).
• Radius - This controls the distance of the lights from the HDRI measured from the center 

of the Bryce universe. This is only activated if Falloff is set to Linear or Squared. Radius 
and Falloff are additional controls to fine adjust the light emitted from the HDRI. They do 
not affect the brightness of the HDRI rendered as background.

• Cast Shadows - light emitted from the HDRI can cast shadows if this option is enabled. If 
IBL is used primarily to supply nice surround ambient light and the HDRI has no 
prominent light source, Cast Shadows can be disabled in most cases. This will speed up 
the render considerably.

• Softness - softens the edge of the shadows cast by the lights from the HDRI. 
This works independently from the Shadow Softness control in the Sun & Moon 
tab or from the settings in the Light Lab. Setting Softness higher than 0 will make 
a render very much slower. IBL shadow softness is very "expensive" particularly 
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if used with a high Quality setting. It is usually "cheaper" to use a higher Quality 
setting than soft IBL shadows.

• Intensity - controls the depth or darkness of the shadows cast by the HDRI. 
Sun/Moon Shadows in the Sun & Moon tab is a master control. If it is set to 50, 
shadows from the HDRI are not very dark even if Intensity is set to 100 in the IBL 
tab; best set the master control in the Sun & Moon tab to 100 to have full control 
over the shadow intensity in the IBL tab.

• Specular Map - blurs the HDRI loaded by specular convolving it so that it can be used as 
a reflection map when rendered as background to emulate specularity on a reflecting 
object. A small HDRI will nicely do. The size of the HDRI does not affect the time needed 
to convolve it. But since the result is blurred anyway, it does not make sense to use a lot 
of memory. The (Phong) Exponent can be set from 1 to 100. The lower it is set, the more 
blurred the resulting HDRI will become.

• Click on the button Specular Map to activate it.
• To adjust the Exponent, move the control right and left with the left mouse button 

pushed. The moment the mouse button is released, convolving starts. 
Alternatively, entering a value between 1 and 100 in the numeric field and hit the 
Return or Enter key starts the process.

Convolving takes one or more minutes. If the process is aborted by clicking on 
the X, the resulting HDRI is unfinished. If the specular map created does not look 
good, the original HDRI has to be loaded anew.

• A specular map can be used just as that: a blurred HDRI rendered as backdrop. 
In this case, Quality and HDRI-Effect can be set to minimum; the reflection is 
controlled by Intensity alone. This speeds up the render. If it is also required that 
the blurred HDRI emits light, then the Quality and HDRI-Effect must be set to 
give light and shadows as desired.
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Object is fully reflecting, HDRI is mirrored in it.

Specular Map with Exponent 100 used on reflecting object.
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Specular Map with Exponent 1 used on reflecting object.

• Background DOF - This control only works if the scene is rendered with premium settings 
with DOF (depth of field) enabled. It helps to adapt the blurriness of the HDRI rendered 
as backdrop to the blurriness of objects that are nearer at the camera. If DOF and 
Background DOF is used, a low resolution HDRI might suffice.

Scene without DOF.
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Scene with DOF, but no HDRI Background DOF. Looks wrong.

Scene with DOF and HDRI Background DOF at 50.
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Scene with DOF and HDRI Background DOF at 100.

• Exclude Objects - permits to exclude objects from being lit by IB light. This may come in 
handy if render intensive objects are in the scene that need not profit from the light 
emitted by the HDRI. Transparent and volume materials are notoriously slow to render 
under HDRI light. A similar control can be found in the Light Lab.

To exclude one or several objects or groups enable Exclude objects and open the drop 
down below. Here, select all objects and groups you wish to exclude from being lit by IBL. 
All non-selected objects and groups will receive light from the HDRI.

• Include objects - works like Exclude objects but instead of excluding objects, the objects 
to be included to receive IB light are selected. All non-selected objects will receive no 
light from the HDRI. Use the option that has fewer objects to be selected.

• Export Image... - the HDRI loaded or created from a Sky can be exported in different file 
formats, dynamic resolutions and projections. These exported HDRIs can be loaded into 
Bryce at a later date or used in another 3D application.
If the HDRI was tone-mapped, this image will be exported. Also, the Intensity setting will 
modify the brightness of the exported image. If exported as QTVR, the cylindrical (4 cube 
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sides) and the cubical (all 6 cube faces) projections are available. If there is no 
QuickTime installed or a version below 5, QTVR export will stop with this error message:

• Click on Export Image... The Save As dialog opens. Give the file a name (File 
name) and select the file type (Save as type).

• Then, select the pixel resolution (Format). Not all options shown below are 
available for all file types.
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• Finally select the projection (Type).

• Click on Save.
• If a Sky was used to create the HDRI, be aware of this: if the sun was set to 

visible in the Sun & Moon tab, the setting of the Sun Diffuse setting is taken in 
account if saved in an HDRI type, like HDR Image File *.hdr, OpenEXR *.EXR or 
TIFF Files *.tif provided 48 or 96 Bits Per Pixel was selected. The other file 
formats will convert the HDRI into a LDRI (low dynamic range image). The size of 
the exported HDRI is derived from the size of the HDRI loaded or the size with 
which the HDRI was created from the Sky.

©2003-2011 DAZ 3D, Inc. 889



Bryce 7 Artist Guide 03 Jan 2011

• Tone-map HDRI. The HDRI rendered as backdrop is often over saturated and looking 
bad in many respects because the full dynamic range is squashed into the LDRI range of 
the display. Tone-mapping uses intelligent algorithms to equalize the HDRI to give a 
pleasing and somehow accurate representation on the display. There are around 50 
different tone-mapping operators with up to 12 different controls each. Bryce has a global 
tone-mapping operator that automates everything and giving good, even very pleasing 
results.

• Click on the Tone map button. The larger the HDRI loaded is, the longer this 
process will take. There is a progress bar for reading the HDRI data and another 
for tone mapping.

• If the HDRI is rendered as backdrop, it will show the tone-mapped HDRI (now an 
LDRI) while the light is still emitted by the untouched HDRI.

The HDRI loaded.
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The same HDRI tone mapped.

• If a scene is loaded that contains a tone mapped HDRI, the HDRI is tone 
mapped while loading the scene. The progress is shown in the main GUI at the 
lower left corner.

• If an HDRI has been tone mapped once, deselecting the Tone map button 
restores the loaded HDRI. The Tone map button acts as a toggle, the HDRI 
needs not to be tone mapped again.

19. A sky with an HDRI can be saved in the Sky Library. The thumbnail shows if there is an HDRI 
included with an "H" at the lower right corner. Keep in mind that an HDRI can use quite a bit of 
memory and the library must not grow larger than 2 GB. If it does, all the saved skies are lost! 
Better create a new Library early.

When developing a scene, use a small low resolution HDRI, save the sky to the library with a 
small HDRI, save the scene with a small HDRI. Load a higher resolution HDRI only if it is 
mandatory for the final render.

20. Periodically exit the Sky Lab and check the scene in the Working window to see how it looks. It 
may take some time to get the right settings for your particular scene. Bryce lights can also be 
used to enhance certain areas of the scene. If a large high resolution HDRI is used, it may take 
several seconds until the Working window appears.

When checking the scene in the Working window, do not rely on the Nano-Preview for the lighting 
since it may not accurately preview the IBL-enabled image. Instead, render the scene, with or 
without AA, to get a better idea of the current settings. The preview in the IBL tab and in the 
Working window always renders the IBL with a Quality setting of 16.

21. To use a Sky together with an HDRI, first load the HDRI, then select the sky from the Sky Library. 
The Use HDRI will be unchecked but the HDRI is still loaded. Just click on Use HDRI to re-
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activate it. If a HDRI is loaded and Use HDRI unchecked, all Sky settings are lost and the default 
Sky is loaded.

Something else to be aware of:
• The Gamma between the Mac and PC differ slightly so sky settings from one system may not 

look the same on the other one. Selecting or deselecting the Gamma Correction in the Render 
Options dialog may help even up the gamma when rendering. It is highly recommended to 
disable Gamma Correction and compensate with more and brighter light. The result is a better 
contrast and a more dramatic render.

IBL Examples

Render HDRI as Backdrop

The new options of blending the HDRI as backdrop with the sky may appear a bit confusing at first. There 
are settings that make it appear that there is no difference, but there is. Therefore, a couple of simple 
renders follow to show the difference. Bryce 7.1 is capable to render all sky effects with the HDRI as 
backdrop: sun, moon, stars, comets, haze, fog, rainbows. First, the technical definitions:
Blend into background means that the HDRI is bended into the background gradient (Sky Color) and then 
the sky is rendered. If the Transparency control is moved from left to right, the sky (clouds, for example), 
does not change but the HDRI fades.
Blend with sky renders the sky first and then blends the HDRI into the background gradient (Sky Color). If 
Transparency is moved from 0 to 100, the sky (e.g. clouds) gradually appears while the HDRI fades. This 
can be considered as a Sky-HDRI mixer.
Add with sky adds sky to HDRI and then renders the result. This is the setting known from Bryce 7.0. 
There is no Transparency control available. Sky and HDRI are added and thus the light output is summed 
up.
The option Use sky color takes the sky color as background into which the HDRI is blended.

This is the reference scene with clouds. Haze and fog are disabled for clarity for all examples The Sky 
Color is dark blue as the inset shows.

Here, only the Sky Color was changed to red to make its effect obvious (see inset).
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Next, an HDRI is rendered as backdrop. The sphere at right has full specularity set in the Materials Lab 
and the Specular Halo is set to 242/242/242. The Bryce sun creates a glossy blob at the right side of the 
sphere at right (sun is at 120°). IBL Specularity is set to 0 and there is no glossy spot from the sun in the 
HDRI.

This is the same render as above but IBL Specularity is set at 750. If Compat(ible) Specularity is enabled, 
the same glossy spot at the left side of the sphere at right is created with IBL Specularity around 150. The 
sun in the HDRI is at 240°.
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The HDRI backdrop is very high contrast, the clouds are white blotches and the rock wall is lost in black. 
Here, we have the same settings (though Intensity was reduced) as above but the HDRI was tone 
mapped.

No changes from the previous render except that the blend mode is set to Blend into background with 
Transparency at 0. The clouds from the sky "interfere" with the background.
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Here, Transparency is set midway to 50. The backdrop gets darker and the sky (clouds) is unchanged. 
They are only more obvious because the background got darker.

The same setting as above, but Use sky color (which is set to red) is enabled. The HDRI background 
fades into red while the clouds remain unchanged.
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Instead of Blend into background, Blend with sky mode is used here. Transparency is set at 0. This looks 
exactly the same as four pictures up. Not much can be seen of a Bryce sky, there are no clouds visible.

Setting Transparency halfway to 50 shows a different result. The HDRI backdrop looks as faint as three 
pictures up but there are clouds from the sky visible - alas not at their full brightness. Sky and HDRI are 
mixed fifty-fifty. The HDRI will fade even more and the clouds get more pronounced as the Transparency 
slider is moved farther to the right towards 100.
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Same setting as above but with Use sky color enabled. This is not the same result as three pictures 
above. At first glance it looks the same, but the clouds are not so strong, they are as faint as in the picture 
above.

Here we have the third blend mode: Add with sky. Both the clouds from the Bryce sky and the HDRI 
backdrop are equally bright. The brightness of the backdrop can now be balanced with Intensity. It will not 
fade into any background; it will get brighter or darker.
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The final example shows the same setting as above with the Use sky option enabled. HDRI and sky are 
equally red. The picture almost looks as if sepia tones were used.

Of course, the red sky color is not the best choice for making a beautifully looking artwork but the effect of 
it is very obvious. Please note that the light cast on the 2D-Disk and on the sphere at right have not 
changed, only the backdrop and the sky.

IBL and True Ambience

There are new options if a scene is rendered with True Ambience (TA). A light source, whether this is a 
radial from the Light Lab or an HDRI, is a point light. TA works best if the light is a bright surface. The 
option to make the HDRI point lights large is True Ambience Optimization. Also, a tone-mapped HDRI has 
a lower contrast and this can be ignored for TA. The following example renders show the effect of using 
these new options.
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This is the reference scene. A red sphere with a high specularity setting on a white 2D-Disk and a mirror 
ball. The tone-mapped HDRI is rendered as backdrop. HDRI Effect is at 0, the sun is invisible and 
disabled. There is no light cast on the scene and therefore, 2D-Disk and red sphere are black. There is 
only the blurry spot, specularity from the sun in the HDRI.

Rendered Premium with TA. Neither True ambience optimization or Ignore tone mapping are enabled. 
The effect of TA is visible in the red from the red sphere on the 2D-Disk. The blurry blob remains.

Rendered Premium with TA. True ambience optimization is enabled, Ignore tone mapping is not. There is 
no glossy spot.
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Here, True ambience optimization is disabled but Ignore tone mapping is enabled. The lights from the 
original HDRI are taken as light source for TA.

The final example shows when both, True ambience optimization and Ignore tone mapping are enabled.

©2003-2011 DAZ 3D, Inc. 900



Bryce 7 Artist Guide 03 Jan 2011

The differences are subtle.

Animating Skies
Animating Skies

All the properties of a Bryce sky can be animated. This means that any attribute you can set in the Sky & 
Fog palette or the Sky Lab dialog can be animated using the Animation controls on the Timeline. This 
section assumes that you are familiar with the concepts and procedures involved in creating skies.
By changing the attributes in the Sky & Fog palette at different points in the timeline, you can animate 
everything from the position of the sun to the color of the clouds. For example, you can simulate changes 
in the time of day by changing the position of the sun over time.
There are several techniques you can use to add motion to your skies. You can animate all or some of 
the properties of your sky. You can activate and deactivate sky effects at different points in the animation. 
You can also animate the position of the sun or moon.
Sky animations are created using the Animation tools in the Working window and the Sky Lab dialog.

• Sun & Moon
• Clouds
• Sky & Fog Settings
• Environmental Effects

Sun & Moon

One of the most spectacular effects you can create using the scene's sky is elapsed time. In the great 
outdoors we perceive time in relation to the position of the sun and the brightness of the sky. By changing 
the position of the sun or moon you can simulate time passing in terms of days or months. In this 
example, the passage of time is simulated by the change in the sun's position.
Since all the elements in the sky are linked, the other properties of the sky like Ambient Light change as 
the position of the sun changes, adding to the realism of the effect.
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For the moon, you can also change its phases, so you simulate the passage of an entire month just by 
adjusting the moon attributes.
To animate Sun or Moon position:

1. Click the triangle icon in the Animation controls and make sure Auto-Key is enabled. 
2. Move the Current Time Indicator to the point in the Timeline where you want the sky to change. 
3. Adjust the position of the sun or moon using the Sun Position control in the Sky & Fog palette.
4. Move the Current Time Indicator to a different point on the timeline.
5. Change the position of the sun or moon again.
6. Continue moving the Current Time Indicator and changing the sun or moon position until you 

achieve the desired effect. 

Clouds

You can create the effect of wind in your environment by setting up cloud motion parameters. Based on 
your settings,
Bryce automatically moves the clouds in your environment to create motion.
Cloud motion parameters are set in the Sky Lab dialog. The Cloud Direction control lets you set the 
direction for cloud motion, while the other controls set the speed and distortion of the clouds.
To animate clouds:

1. Click the triangle icon in the Animation controls and make sure Auto-Key is enabled. 
2. In Sky & Fog palette, click the Sky Lab button. The Sky Lab dialog appears.
3. Click the Cloud Cover tab.
4. Move the direction indicator in the Cloud Motion controls to set a direction for the clouds as they 

move in the animation.
5. Adjust the speed control to set how fast the clouds move. You can also enter a speed value.
6. Adjust the Turbulence control to set how much the clouds will distort as they move. You can also 

enter a turbulence value.

Sky & Fog Settings

Animating Sky & Fog settings changes the properties of a sky over time. For example a scene can 
become cloudier, or darker during an animation. The intensity of the change depends on how many 
properties you adjust and the amount of each adjustment. In this example, the animation of approaching 
storm clouds was created by changing the Cloud Frequency and Amplitude value and the Cloud Color at 
different points in the Timeline.
Most Sky & Fog properties can be changed using the thumbnail controls. Other settings are available in 
the Sky Lab dialog.
You will not be able to see the effects of a sky animation until you render the entire animation.
To animate Sky & Fog settings:

1. Click the triangle icon in the Animation controls and make sure Auto-Key is enabled. 
2. Move the Current Time Indicator to the point in the Timeline where you want the sky to change. 
3. Adjust the sky's properties using the Sky & Fog palette controls. 
4. Move the Current Time Indicator to a different point on the Timeline.
5. Change the properties of the sky again.
6. Continue moving the Current Time Indicator and changing the sky's properties until you achieve 

the desired effect. 

©2003-2011 DAZ 3D, Inc. 902



Bryce 7 Artist Guide 03 Jan 2011

 

Environmental Effects

Many environmental effects like rainbows and fog are not permanent features of a sky. They appear for a 
brief time and then fade way. You can simulate this action by changing the properties of the 
environmental effects at different points along the Timeline.
Environmental effects controls are located on the Atmosphere tab of the Sky Lab dialog. You can also 
animate the various settings for an effect. For example, the radius of moon rings can increase or 
decrease during the course of your animation.
To animate environmental effects:

1. Click the triangle icon in the Animation controls and make sure Auto-Key is enabled. 
2. Move the Current Time Indicator to the point in the Timeline where you want the sky to change. 
3. Display the Sky Lab dialog: Atmosphere tab and change the properties of an effect. 
4. Move the Current Time Indicator to a different point on the Timeline.
5. Change the properties of the effect again.
6. Continue moving the Current Time Indicator and changing the effect's properties until you have 

the desired effect.
 

Terrain Editor

Terrain Editor
The Terrain Editor can be used to generate a grayscale image that is converted into a terrain object. It 
can also be used to edit an existing terrain.
Creating terrains in the Terrain Editor is a two-step process. First, generate the source of your terrain 
image by using the preset effects, painting an image using the paintbrush, or importing a Picture. Then, 
use the Terrain Editor's filtering tools to fine-tune the grayscale values in your terrain.
To access the Terrain Editor, you must have a terrain object in your scene. When the Terrain Editor 
opens, it temporarily replaces the screen and displays the current terrain in a two-dimensional preview 
and a three dimensional preview. The height map that was used to create the terrain is displayed in the 
Terrain Canvas.
You can also animate the creation of a terrain. Using the Animation controls available at the bottom of the 
editor, you can change the shape of your terrain object over time.

• A Quick Tour of the TE
• Accessing the TE
• Terrain Canvas
• 3D Preview
• Paintbrush Controls
• Editing Tools
• Animation Controls
• Speeding up the Terrain Editor
• Creating Terrains
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A Quick Tour of the TE
The Terrain Editor is divided into five sections:

• Terrain Canvas: displays the grayscale image used as a height map
• Terrain Canvas Tools: contains a Gradient Strip and Bracket for clipping operations, and 

controls for Color Mapping
• Terrain Canvas Options: contains options for setting the preview size and exporting the 

image and terrain mesh
• 3D Preview: displays a three-dimensional preview of the terrain you are working on
• Paintbrush Controls: let you adjust the paintbrush
• Editing Tools: let you generate and edit the terrain's height map 
• Animation Controls: let you set up key frames for animating the terrain

 

Accessing the TE
To open the Terrain Editor:
Select a terrain object in your scene. 
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Do one of the following:
1. Click the  button that appears next to the terrain object. 

2. Choose Objects > Edit Object.

3. Click the Edit button to open the Edit palette, and then click the Edit Terrain tool.

4. Press Cmd/Ctrl+E.

Terrain Canvas
Terrain Canvas

The Terrain Canvas displays the grayscale image that is used to create the terrain object. You can think 
of the Terrain Canvas as a top view of the terrain object you are creating. The Terrain Canvas is where 
you paint the height map for your terrain.
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You can also access a number of tools in the Terrain Canvas, including the Gradient Strip, the Clipping 
Bracket, controls for Color Mapping, the Zoom Area control, and the Brush Mode selector.
See the following for more on the Terrain Canvas tools and options:

• Terrain Canvas Tools
• Terrain Canvas Options

Terrain Canvas Tools

Terrain Canvas Tools

To access a Terrain Canvas Tool on the Terrain Canvas, click the menu icon at the top right of the 
Terrain Canvas.
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The Terrain Canvas Tool area will open up.
The right side of the Terrain Canvas tool area contains a Gradient Strip and Bracket for clipping 
operations. In the bottom right corner, you will find controls for Color Mapping. 
Refer to "Adding Color to Terrains" and "Clipping Terrains" for more on these tools.
Across the bottom of the Terrain Canvas tool area, you will find a Brush Mode selector and the Zoom 
Area controls. 
Refer to "Brush Behavior" and "Using the Zoom Area" for more on these tools.

Clipping Terrains

Clipping Terrains

Using the Terrain Editor's Clipping Controls, you determine which values in your terrain are rendered as 
the final terrain object. The Clipping Controls next to the Gradient Bar represent the render range for the 
terrain. Anything outside the range included in the brackets will not be rendered.
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You can use these controls to eliminate unwanted information from the terrain without altering its basic 
shape. For example, you can keep the main terrain while eliminating the black square on which it sits to 
create islands.

The clipping feature is particularly useful when editing a Symmetrical Lattice. The maximum lower range 
of the Clipping Bracket determines where the two halves of the Symmetrical Lattices are joined. The 
higher the clipping bracket, the smoother the seam.
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See the following topics for more on using the Clipping Bracket:
• Setting the Clipping Range
• Setting Terrain Solid
• Reset or Move the Clipping Bracket

Setting the Clipping Range

To set the clipping range:
1. Drag the top of the Clipping Bracket to set the maximum upper range. Any areas in the Terrain 

Canvas whose gray levels fall outside the bracket's maximum upper range will appear colored to 
indicate they will be omitted from rendering.
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2. Drag the bottom of the Clipping Bracket to set the maximum lower range. Any areas in the 
Terrain Canvas whose gray levels fall outside the bracket's maximum lower range will also 
appear colored to indicate they will be omitted from rendering.
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The out-of-range colors for upper and lower limits are different, to better enable you to distinguish 
upper and lower clipped areas at a glance. Upper out-of-range color is usually yellow and lower 
out-of-range is usually red, though the colors change for many of the color maps.

Setting Terrain Solid

Terrain objects are hollow, so if you clip the upper range off your terrain, you will be able to see through 
the top of the terrain to whatever is underneath. This is good for crater lakes but not good for a desert 
plateau.
To make the top solid, you should select Solid from the drop-down menu at the top right of the Terrain 
Canvas.
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Reset or Move the Clipping Bracket

To reset the Clipping Bracket. hold down Opt/Alt and click the bracket.
To move the entire Clipping Bracket at once, click the center of the Clipping Bracket and drag up or down. 
If the Clipping Bracket has not been shortened, then it will not move, you will need to drag the bracket up 
or down and then move the entire bracket.

©2003-2011 DAZ 3D, Inc. 912



Bryce 7 Artist Guide 03 Jan 2011

Adding Color to Terrains

Adding Color to Terrains

Color in the Terrain Editor is used as a visual aid to help you see the relationship between color values 
and altitude. 
This color only exists in the Terrain Editor and is not applied to the terrain object.
When you apply color in the editor, it maps a Gradient to the altitudes in your Terrain Canvas. For 
example, if you apply a gradient from blue to yellow, blue might represent the lowest altitude while yellow 
may represent the highest. Which colors are mapped to which altitudes is left completely up to you. 
Gradients can be extremely useful when you are filtering terrains, as they emphasize the differences 
between gray levels.

• Mapping Color to Terrains
• Applying Gradient to Diffuse Channel
• Removing Gradient
• Gradient Bar Modifiers

Mapping Color to Terrains

The Terrain Editor's color picker contains all the gradients you can apply to your terrain. The gradient you 
select is applied to both the Terrain Canvas and the 3D Preview.
Use the Color Picker button to choose a Color Gradient and the Gradient Bar to set Color Mapping. 
To map colors to your Terrain Canvas:

1. Left-click hold on the Color Picker button in the bottom right corner of the Terrain Canvas Frame.
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and drag over a gradient in the palette. As you drag over the Gradient Bars, the current bar is 
highlighted with a white border.

The gradient you select appears in the Gradient Bar and is mapped to the Terrain Canvas and 
the 3D Preview. 
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2. Drag the Gradient up or down to map the colors to altitudes. The colors at the bottom of the 
gradient represent the lowest altitude and those at the top represent the highest.
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3. To return to grayscale, click the Color/Grayscale toggle to switch back to the default gray 
gradient.

Applying Gradient to Diffuse Channel

Although gradients are meant to be used only in the Terrain Editor, you can apply the gradient to the 
terrain's Diffuse channel. The gradient then becomes the terrain's Diffuse color. This allows you to render 
the gradient with the terrain.
To add a gradient to a terrain's Diffuse channel:

1. Apply a gradient to the terrain in the Terrain Editor.
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2. Select Keep Gradient from the drop-down menu at the top right of the Terrain Canvas.

3. Exit the Terrain Editor and go into the Materials Lab. 

Terrains are created with a random material applied and in order to get the gradient to render on 
the terrain, the material has to be removed from the Diffuse channel. 

4. Remove any dot (or dots) from the Diffuse channel(s). You do not have to remove the other dots 
unless you do not want the original texture applied to those channels.

5. Exit the Materials Lab and render. The gradient will render on the terrain.

Some items to note about applying Terrain Editor gradients to the diffuse channel:
1. The original diffuse color will show in the color dot, not the gradient. 
2. Once applied, the gradients can be added to the Materials Library and applied to other terrains - 

Macs only. (PCs - Issue)

©2003-2011 DAZ 3D, Inc. 917



Bryce 7 Artist Guide 03 Jan 2011

Removing Gradient

To remove a gradient from a terrain's Diffuse channel:
1. Open the terrain in the Terrain Editor.
2. Click the Color/Grayscale toggle.

Gradient Bar Modifiers

The Gradient Bar has two modifiers:  
1. Opt/Alt+Click Gradient Bar resets the Gradient Bar. 
2. Cmd/Ctrl+F flips the colors in the gradient.

Using the Zoom Area

Using the Zoom Area

When the Zoom Area is active, only a small portion of your terrain is displayed in the 3D Preview. The 3D 
Preview displays the zoomed-in portion of your Terrain Canvas. You can use this feature to see small 
variations in the surface of your terrain. The Zoom Area can be moved to any point on your Terrain 
Canvas. You can always paint while the Zoom Area is active; in fact this is a nice way to paint in the 
Terrain Canvas while previewing a small section in the 3D Preview to observe details.
To turn the Zoom Area on or off, click the Zoom Area button in the Terrain Canvas tool area. 

The Zoom Area button will change to white and toggles a marquee on your Terrain Canvas.
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The area within the marquee will be displayed in the 3D Preview.

See the following topics for more on using the Zoom Area:
• Moving Zoom Area
• Resizing Zoom Area
• Scale Zoom Area to fill Canvas
• Scale Terrain to Zoom Area

Moving Zoom Area
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To move the Zoom Area:
1. Move your pointer over an edge of the Zoom Area marquee. The pointer changes to a hand tool.

2. Drag the marquee to a different area in the Terrain Canvas.

Resizing Zoom Area

To resize the Zoom Area:
1. Move the pointer over a corner of the Zoom Area marquee. The pointer changes to an arrowhead 

cursor.

2. Drag away from the center of the marquee to enlarge the Zoom Area or towards the center to 
shrink the area. 

Scale Zoom Area to Fill Canvas

To scale the Zoom Area to fill the Terrain Canvas,
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1. Activate the Zoom Area and move/resize it to where you want it on the Terrain Canvas.

2. Click the Crop button below the Zoom Area button in the Terrain Canvas tool area. 

3. The contents of your Zoom Area are scaled to fill the entire Terrain Canvas area. The Zoom Area 
contents replace the existing contents of the Terrain Canvas. This feature can be useful for 
creating new terrains from larger high-resolution terrains.
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4. Deactivate the Zoom Area tool so you can work on the new terrain.

Scale Terrain to Zoom Area

To fit the contents of the Terrain Canvas into the Zoom Area:
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1. Activate the Zoom Area and move/resize it to where you want it on the Terrain Canvas.

2. Click the Fit text button below the Zoom Area button in the Terrain Canvas tool area.

The entire contents of your Terrain Canvas are scaled down to fit into the Zoom Area marquee. 
The rest of the Terrain Canvas is filled with black.

©2003-2011 DAZ 3D, Inc. 923



Bryce 7 Artist Guide 03 Jan 2011

The resulting terrain will be shown in the 3D Preview:

Brush Behavior

The Paintbrush in the Terrain Editor paints elevations by default, but this is not the only way of painting 
using the brush. You can also set the brush to paint effects. This lets you apply elevation effects locally, 
or to increase/decrease existing gray levels in your Terrain Canvas.
The Brush Behaviors are located at the bottom left of the Terrain Canvas Tool. The Brush Behaviors are 
discussed a bit further down in the "Paintbrush Controls" section.

©2003-2011 DAZ 3D, Inc. 924



Bryce 7 Artist Guide 03 Jan 2011

Terrain Canvas Options

Terrain Canvas Options

To set the Terrain Canvas options:
1. Click the triangle icon in the top right corner of the Terrain Canvas. 

2. Choose an option from the menu. Click on the topic links below for more on using each option.

See the following topics for more on using the Terrain Canvas options:
• Set Preview Size
• Visible Brush
• Solid
• Smooth
• Keep Gradient
• Export Terrain Lab
• Export Image

Set Preview Size
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Set Preview Size: lets you change the size of the Terrain Canvas frame. You can choose from six preview 
sizes.
Changing the preview size allows you to work on the terrain in a variety of sizes. Just remember that as 
the canvas increases, so does the brush size so adjust the size of the brush before you start painting on a 
larger or smaller canvas.
To set the canvas preview size:

1. Click the triangle icon in the top right corner of the Terrain Canvas. 

2. Choose the Set Preview Size option from the menu, following the arrow to access the sub-menu 
where you can choose a size option.

Examples (size relative to a 1024x1280 monitor):
• 384x384
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• 512x512

• 960x960

Visible Brush

Visible Brush lets you turn the circle of the brush on and off. Sometimes the circle can get more in the 
way than a help but turning off the brush circles does not change the actual brush size, so remember that 
as you work.
By default, the brush circle is set to visible.
To turn off the brush circle:

1. Click the triangle icon in the top right corner of the Terrain Canvas. 

2. Select the Visible Brush option from the menu to deselect it.
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The brush circle will disappear leaving only the cursor cross visible. 

3. Select Visible Brush again to turn the brush circle back on.

Solid

Solid sets the terrain to a solid object instead of the default hollow setting. This is useful for plateaus and 
other terrain objects that you do not want to be hollow. See "Setting Terrain Solid" for help on using this 
option along with the Clipping Bracket.
To set a terrain to solid:

1. Click the triangle icon in the top right corner of the Terrain Canvas. 
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2. Choose the Solid option from the menu.

Smooth

Smooth allows a smooth rendering of the terrain. If this is not selected, the terrain is faceted, which may 
help create a more detailed terrain if needed.
By default, Smooth is selected.
To turn off the terrain smoothing:

1. Click the triangle icon in the top right corner of the Terrain Canvas. 

2. Choose the Smooth option from the menu.

The following images show the difference between a smoothed (left) and unsmoothed (right) terrain:
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Keep Gradient

Keep Gradient sets the current applied gradient to be the terrain's diffuse color. This also allows the 
gradient to remain selected when you exit, then re-enter the Terrain Editor. 
Refer to "Applying Gradient to Diffuse Channel" for more information on using this feature.
To enable the gradient as the diffuse color:

1. Apply a gradient to the Terrain Canvas. 
2. Click the triangle icon in the top right corner of the Terrain Canvas. 
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3. Choose the Keep Gradient option from the menu.

Exporting the Terrain

Exporting the Terrain

The previous section gave the overview of exporting a terrain. The next few pages will give additional 
details along with images and detailed descriptions of the different features of the Export Terrain Lab.
To export a terrain:

1. Click the triangle icon in the top right corner of the Terrain Canvas. 

2. Choose the Export option from the menu.

The Save As dialog will come up.
3. Select a file type from the Save as type menu. Selecting the OBJ format will export an material 

file (MTL) with the textures linked to the terrain. This allows you to import the OBJ file into another 
program without having to manually locate and apply the textures.
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4. Change the File name and click on Save.

The Export Terrain Lab will come up. The "Features of the Export Terrain Lab" will explain the 
different features of the lab so you can decide which options to use when exporting your terrain.

Export Terrain Lab

Export Terrain Lab
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The Export Terrain Lab allows you to convert Bryce terrains into polygonal meshes. The Lab provides you 
with full control over the level of detail in the polygonal mesh. You can adjust the number of polygons with 
real-time feedback so you can instantly see the resulting change to your mesh. In addition, the Lab allows 
you to manage the all-important texture maps so that your exported meshes retain the cool look as 
generated within Bryce.
To export a terrain:

1. Create a terrain and apply materials. 
2. Either select the terrain and go to File > Export Object or enter the Terrain Editor and click Export 

or press Ctrl+D (PC only). 
3. Choose the desired file format and target folder.

Please note that four of the file formats do not export via the Export Terrain Lab, they export 
immediately once you click on Save: RGM, Rayshade, DEM, and Videoscape.

4. Adjust the complexity of the mesh. 
5. Select material properties to be exported as image maps.
6. Select image map size. 
7. Click the OK icon to cause the tessellated mesh to be written to the exported file.

See the following topics for detailed instructions on exporting terrains:
• Exporting the Terrain
• Features of the Export Terrain Lab
• Exporting to MetaStream

Features of the Export Terrain Lab
Features of the Export Terrain Lab
The Export Terrain Lab is divided into two areas: 

• The Polygonal Mesh Previewer with Polygon Count Slider 
• The Image Map Controls
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See the following topics for more on these features:
• Mesh Previewer Inspection
• Previewer Display Modes
• Previewer Color Options
• Adjust Triangulation
• Handling Image Maps
• Exporting to Metastream

Mesh Previewer Inspection
The Mesh Previewer allows you to instantly examine the quality of the current tessellation by rotating the 
mesh, zooming in and out, and changing the display mode.

©2003-2011 DAZ 3D, Inc. 934



Bryce 7 Artist Guide 03 Jan 2011

• To rotate the mesh, click and drag in the previewer.

• To move the terrain in the preview window, press Spacebar+drag in the previewer.

• To zoom the mesh in and out, press Cmd/Ctl+click and drag forward to zoom in, back to zoom 
out.
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• To adjust the contrast of the mesh color, press Cmd/Ctrl+Opt/Alt+drag left to increase the 
contrast, drag right to decrease the contrast. 

• To adjust the lighting in the previewer, press Cmd/Ctrl+Shift+drag left to decrease the brightness, 
drag right to increase the brightness.

Previewer Display Modes
To change the Previewer Display Mode, select one of the buttons to the right of the previewer.
Available preview modes are: Wireframe, Shaded, Textured, and Textured With Wireframe Overlay.

Examples of the Preview Modes are shown below. 

©2003-2011 DAZ 3D, Inc. 936



Bryce 7 Artist Guide 03 Jan 2011

• Wireframe: 

• Shaded: 

• Textured: 
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Depending on the terrain size and material complexity, creating the preview maps can take a few 
seconds to several minutes. 

• Textured with Wireframe Overlay:

Wireframe Overlay can be used with either the Shaded or Textured preview. To turn off the 
wireframe overlay, click on the button again.

Previewer Color Options
The Color Swatches under the preview buttons adjust the color of the previewer background, the 
wireframe and shaded color, and the wireframe color for the wireframe overlay.

Examples of the Color Adjustments are shown below.
To adjust the colors of the preview background, wireframe, and the shaded preview, select the color 
swatches underneath the preview mode buttons.
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• Background Color - The top color swatch adjusts the color of the previewer background. Left-
click-hold on the color swatch and select a color from the color picker. Note that the color swatch 
shows the original color on the left side and the new color on the right side. If you decide to revert 
back to the original color, move the eyedropper over the left side of the swatch. 

Please note that you will only get the default color picker here. Wireframe and Shaded Color - 
The middle color swatch adjusts the color of the wireframe and the shaded preview.

• Wireframe Preview Color - When in Wireframe preview, the middle color adjusts the wireframe 
color.
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• Shaded Preview - The same color swatch adjusts the color of the shaded preview.

• Wireframe Overlay Color - The last color swatch adjusts the color of the wireframe when used as 
an overlay.

• Shaded Preview with Wireframe Overlay - The simplest wireframe overlay is used over the 
shaded preview. In the image below, you can see the default terra cotta shaded mesh overlaid 
with the dark grey wireframe color.

• Textured Preview with Wireframe Overlay - When in textured preview mode, the wireframe 
overlay is shown over the applied texture. The texture applied to the mesh will determine the 
color of the wireframe, so take a few moments to find the best overlay color.
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Adjust Triangulation
Adjust Triangulation
Webster's Dictionary defines tessellation as:
1 a: mosaic b: a covering of an infinite geometric plane without gaps or overlaps by congruent plane 
figures of one type or a few types
2: an act of tessellating : the state of being tessellated
Any shape can be used to create a tessellation, a triangle, square, hexagon, octagon, or a non-geometric 
shape (think Escher). Bryce uses triangles so "triangulation" and "tessellation" can be used 
interchangeably within Bryce.
You can create two types of tessellations in the Export Terrain Lab: Grid and Adaptive.
Grid tessellates the original height field with a grid. In order to achieve a good mesh representation of the 
source terrain, selecting Grid requires a large number of polygons. This method is suitable for geometric 
shapes.  
Adaptive achieves much lower polygon counts with good representation of the terrain. This is an excellent 
choice when the terrain models natural landscapes. The default triangulation method is Grid 
Triangulation. The initial tessellation is set to 7,938 polygons for the default terrain resolution (512). The 
default number of polygons and the range of polygons differs depending on the terrain resolution. For 
Adaptive, the allowable range of polygons is shown on the far left and right of the polygon slider.
To switch between Grid and Adaptive tessellations, click on the triangle to the left of the previewer and 
select the tessellation type.

You will get a Tessellating Progress dialog as the mesh is converted:
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When using Adaptive Triangulation, you can effectively double the number of polygons by selecting Add 
Polygons in the drop down menu at the right bottom corner of the previewer.

To adjust the polygon count, move the slider below the previewer. This changes the quality of your mesh. 
The number of polygons in the mesh is displayed in the right bottom corner of the previewer. Please note 
that the plus and minus symbols are not active and cannot be used to adjust the polygon count.

See the following for examples of tessellation:
• Tessellation Examples
• Shaded Tessellation Examples

Tessellation Examples
Examples of Grid and Adaptive Triangulation: 
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• Default Terrain, Grid Triangulation, 7938 Polygons:
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• Number of polygons increased to 9248:
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• Changed to Adaptive Triangulation reduces polygon count to 840:
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• Selecting Add Polygons increases count to 1654:
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• Selecting Add Polygons again increases the count to 3282:
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• And decreased to 648 polygons:

Shaded Tessellation Examples
Below are examples of different levels of triangulation for both Grid and Adaptive on a default terrain 
(512). 
A quick way to view the results of increasing or decreasing the polygon count is to drag the slider left and 
right. You will get a quick "animation" of the terrain as it is modified.
Grid:
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Adaptive:

©2003-2011 DAZ 3D, Inc. 949



Bryce 7 Artist Guide 03 Jan 2011

©2003-2011 DAZ 3D, Inc. 950



Bryce 7 Artist Guide 03 Jan 2011

©2003-2011 DAZ 3D, Inc. 951



Bryce 7 Artist Guide 03 Jan 2011

Handling Image Maps
Handling Image Maps
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The second area of the Export Terrain Lab deals exclusively with handling image maps. A large part of 
the appeal of Bryce terrains are Bryce materials, which consist of different significant properties. Each of 
these properties can be exported, along with their geometry, through the Export Terrain Lab.
The image map controls let you refine which of the material properties you wish to export by selecting out 
of the list of ten. By default any material properties of the terrain that use image maps will be exported. 
The image below shows the image map controls with the Diffusion Color, Ambient, Color, Diffusion, and 
Bump selected. If we go back into the Materials Editor, we'd see that the material is applied to these four 
channels.

Depending on the selected export file format, the image maps will be embedded within the export file. If, 
however, the export file format does not support embedding of image maps, they will be saved as 
separate image files in the same folder as the export file (such as an MTL file for OBJs). The filename of 
each separated image will be the name of the export file appended with the name of the appropriate 
material property.
Next steps:

1. Add or remove channels - In our example, there is only one material applied to four channels. If 
the program you will be importing the terrain into does not need some of the channels, click on 
the orange dot to deselect the channel you do not need. In most cases, the Diffusion Color and 
Bump are sufficient. In the image below, the Ambient Color and Diffusion have been deselected 
but notice that they are still white. This means that if you change your mind, you can reselect 
them. The greyed out items cannot be selected for this terrain since the Bryce material applied is 
not applied to those channels. 
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What About Clip?
2. Select an image size/resolution from the Size menu. The default is 512x512. 

Next, select what format to export the image as from the Format menu. The default is bitmap 
(BMP) but you can also select from JPEG, Mac PICTURE, Photoshop, and TIF formats

3. The final step is to save the terrain and the image maps, so click on the OK icon (or click on the 
Cancel icon to cancel the export). Bryce will save the mesh and images to your selected storage 
directory.
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What About Clip?
Good question. Clip was originally meant to be used for specific CAD output formats, unfortunately, the 
knowledge of how to use this option has been lost to time.

Exporting to MetaStream

MetaStream is format developed by MetaCreations allowing users to view objects in a browser and rotate 
the object within the viewer.
When exporting to MetaStream, you can select additional options: Clamp Minimum and Clamp Maximum. 
These options define the lowest and highest polygon counts within the multi-resolution mesh.
To export as MetaStream and apply the Clamps:

1. Click the triangle icon in the top right corner of the Terrain Canvas. 

2. Choose the Export option from the menu.

The Save As dialog will come up.
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3. Select the MetaStream file type from the Save as type menu.

4. Use the slider to set the desired lower polygon count.
5. Select Clamp Minimum from the options menu.
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6. Use the slider to set the desired higher polygon count.  
7. Select Clamp Maximum from the options menu.

8. Click on the OK icon to accept the changes and export the MetaStream file.
If Clamp Minimum and Clamp Maximum are set to the same amount, the MetaStream file will contain a 
single resolution.
To reset the Clamp Minimum and Clamp Maximum, select Reset Clamps within the Options menu.

Export Image

Export Image is a new feature in Bryce 6 and lets you export the terrain grayscale image for use in other 
programs. 
Refer to "Exporting 8-bit and 16-bit Pictures" for more on using this option.

3D Preview
3D Preview

The 3D Preview displays a terrain object based on the image in the Terrain Canvas. As you edit the 
terrain image, the preview updates to show the result of your changes. 
The preview of your terrain can be rotated so that you can see your terrain object from different angles. 

3D Preview Options

The 3D Preview has several options that control how the preview updates and displays. 
To set 3D Preview options, click the triangle icon in the top right corner of the 3D Preview and choose an 
option from the menu.
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See the following topics for more on using these options:
• Set Preview Size
• Flat Preview
• Rendered Preview
• Auto Rotate
• Real-time Linking
• Rip to Screen
• Manual Rotation & Zooming

Set Preview Size

Set Preview Size lets you change the size of the 3D Preview frame. You can choose from four preview 
sizes although the default size is 256x192

Flat Preview

Flat Preview is the default preview type. In Flat Preview, you see a basic rendered preview of the terrain 
using a plain grayscale material with basic shading and lighting.

©2003-2011 DAZ 3D, Inc. 958



Bryce 7 Artist Guide 03 Jan 2011

Rendered Preview

Rendered Preview displays a fully rendered view of the terrain, including any materials you have applied.

 

Auto Rotate

Auto Rotate sets the 3D Preview to rotate when it is in Flat Preview mode. The 3D Preview updates as it 
turns. To stop the Auto Rotate, deselect Auto Rotate from the menu.
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If Rendered Preview is selected, the Auto Rotate will not go into effect until you select Flat Preview.
To rotate the preview manually, see "Manual Rotation."

Realtime Linking

Real-time Linking connects all terrain editing to the 3D Preview. Every change you make is applied 
simultaneously to the Terrain Canvas and the 3D Preview.
When this option is not active, any updates you make to the terrain aren't shown in the 3D Preview 
window until after you let up on the mouse.

  

Rip to Screen

Rip To Screen displays a full-screen preview of your terrain.
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Clicking anywhere on the screen will return you to the main Terrain Editor. 
Use Cmd/Ctrl+W to toggle in and out of this mode. 
The 3D Preview size will affect the size of the terrain when ripped to screen.
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Please note that if you rip the 3d preview to screen then change to a different program, you will not be 
able to return to Bryce without manually shutting down the program and reopening it. Remember to click 
on the screen to reset the preview before changing to another program.

Manual Rotation & Zooming

In addition to using the Auto-Rotate in the 3D Preview window, you can also rotate and zoom the 3D 
preview manually. 

• To rotate the preview, left-click in the preview window and drag the mouse up, down, left, and 
right. 

• To rotate the preview in a continuous circular rotation, press Shift then left-click hold in the 
preview window. 

• Drag left slightly to rotate the preview to the left, drag right slightly to rotate the preview to the 
right.

• To rotate the preview in small increments, left-click-drag in short motions in the preview window. 
This rotates the preview in short jerky motions. To smooth it out, press Shift while dragging in 
short motions in the preview window.  

• To zoom the preview in and out, press Ctrl+drag forward and back.
• To reset the zoomed preview, press Alt+click in the preview window. Please note that if you 

rotated the preview prior to zooming, this will only reset it to the default size, not the default 
rotation. 

Paintbrush Controls
Paintbrush Controls

Although you can create some very spectacular terrains using just the elevation tools, there are times 
when you want to create a precise Terrain Canvas. The Terrain Editor's Paintbrush lets you paint any 
type of terrain you wish. Using the Paintbrush, you can recreate real-world topographical maps or design 
landscapes with specific contours.
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The Paintbrush Controls let you select the size, hardness, flow, and level of the Paintbrush, as well as 
control the resolution of the grayscale data.

See the following topics for more information on using the brush controls:
• Preset Brushes
• Size
• Hardness
• Flow
• Level
• Grid Selector
• Brush Behaviors

 

Preset Brushes

Preset Brushes

The Brush Presets Library is new in Bryce 6 and is accessed from within the Terrain Editor. The brushes 
allow you to add frequently used shapes or special brushes to be used to paint terrains. 
To access the Brush Library, left-click on the Brush Control.
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See the following topics for more information on using the Brush Library:
• Adding a New Brush
• Using the Preset Brushes
• Reverting to Default Brush

See "Libraries" for information on importing, exporting, and deleting brush presets.

Adding a New Brush

To add a brush preset to the Brush Presets Library:
1. In your paint program, create a new square image (i.e., 256x256, 512x512, etc.) with a black 

background. You can build a brush in color, but it will be converted to grayscale when imported 
into the Brush Library.

©2003-2011 DAZ 3D, Inc. 964



Bryce 7 Artist Guide 03 Jan 2011

2. Select a brush preset from the program or create your own image. The brush color should be set 
to white or a light gray.
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3. Save the image in one of the following formats:  .SGI .BMP .DIB .EMF .FPI .FPX .GIF .JP2 
.JPE .JPG .MAC .PCT .PSD .PIC .PNG .PNT .TIF

4. In Bryce, create a new terrain or symlat.
5. Click on the  button next to the selected terrain to enter the Terrain Editor.
6. Click on New to load a new terrain.
7. In the Brush Control Tools, click on the Brush Tool.

The Brushes Library will open up.
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8. Click on Add at the bottom of the library. 

9. The Open File dialog will come up. Locate your brush image, select it, and click on Open.

The brush will be imported into the library, ready to use.
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Using the Preset Brushes 

To use a preset brush:
1. In Bryce, create a new terrain or symlat.
2. Click on the  button next to the selected terrain to enter the Terrain Editor.
3. Click on New to load a new terrain. 
4. In the Brush Tools, click on the Brush Tool. The Brushes Library will open up.
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5. Select the brush you want to use and click on the OK icon to close the library. 

6. In the Terrain Editor, adjust the brush size and flow as needed.

7. Paint on the terrain or use the brush as a stamp to stamp the design on the terrain. 
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Reverting to Default Brush

To revert to the default brush:
1. In the Brush Control Tools, click on the Brush Tool. The Brushes Library will open up.

2. Select the Default Brush and click on the OK icon. The brush will revert to the default paintbrush.

Size

The Paintbrush Size Control lets you select the size of the Paintbrush.
To change the Paintbrush size, drag left or right over the Paintbrush size control. Dragging towards the 
center decreases the Paintbrush size while dragging away from the center increases the Paintbrush size.
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This control is hard to adjust precisely so take your time increasing and decreasing the brush size until 
you get the size you need.
Examples:

Hardness
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The Paintbrush Hardness Control lets you choose how hard to make the edges of the Paintbrush. A hard 
Paintbrush has sharp edges and will create a very vertical effect such as a cliff edge. A soft Paintbrush 
has feathered edges and will blend more with the existing terrain, providing a more gently sloping effect.
To change the paintbrush hardness, drag left or right over the Paintbrush Hardness Control. Dragging 
towards the center increases the hardness of the Paintbrush, while dragging away from the center makes 
the Paintbrush softer.

Examples:
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Flow

The Paintbrush Flow Control lets you set the density of the grayscale value being applied by the 
Paintbrush.
To change the Paintbrush Flow, drag left or right over the Paintbrush Flow Control. Dragging left 
decreases the flow, while dragging right increases the flow.

Examples:

Level

The Paintbrush Level Control lets you set the grayscale value of the Paintbrush. Darker values produce 
lower terrain while lighter values produce higher terrains. To change the Paintbrush Level, drag up or 
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down over the Paintbrush Level Control. A small red dot in the middle of the control indicates the current 
level.

Examples:

Grid Selector

The Grid Selector controls the resolution of the grayscale data in the terrain. The terrain's resolution 
determines the amount of detail in your terrain. The higher the resolution, the more detail appears in your 
terrain's surface. However, higher resolution values also increase the rendering time for your scene and 
require more memory.
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The highest resolutions should be reserved for terrains that are very close to your camera or where detail 
is important. For terrains that are far away, or where detail is not so important, lower resolutions are more 
appropriate.
To set the Terrain resolution using the Grid Selector, click the Grid Selector icon at the bottom of the 
Paintbrush Controls and choose a resolution from the menu. Brush sizes may appear to vary depending 
on your resolution, but in fact they remain proportional to the size of the Terrain Canvas.

Brush Behaviors

Brush Behaviors

The Paintbrush in the Terrain Editor paints elevations by default, but this is not the only way of painting 
using the brush. You can also set the brush to paint effects. This lets you apply elevation effects locally, 
or to increase/decrease existing gray levels in your Terrain Canvas. 
The Brush Behaviors are located at the bottom left of the Terrain Canvas Tool.
To access the Brush Behaviors, click on the triangle icon under Brush Behavior:.

See the following topics for more on Brush Behaviors:
• Modifying Brush Behavior
• Picking up Gray Levels from the Terrain
• Painting Elevations
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• Paint
• Unpaint
• Erode Terrains
• Darken Gray Levels
• Lighten Gray Levels

Modifying Brush Behavior

The Opt/Alt key can modify the behavior of the paintbrush on-the-fly. 
• In Elevation mode, Opt/Alt inverts the gray level. For example, if you are painting white, holding 

down Opt/Alt will paint black.
• In Paint Effect mode, the Opt/Alt key will toggle to Unpaint Effect mode. 
• Hold down Shift to constrain the pen movements to 45 degree steps. The default is to paint 

vertical, but with a bit of playing around, you can get it to paint horizontally and diagonally, but 
how it works is not as consistent as it should be.

• Click and hold down the mouse on the canvas then press Shift and drag up and down to 
paint a vertical line.

• Drag brush horizontally a short distance, then press Shift to continue painting 
horizontally. Do not let up on the mouse or it will start painting diagonally.

• Press Shift, then drag from left to right or right to left on the canvas to paint a diagonal 
line.

Rendered with edges visible:
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Rendered with edges solid:

Painting Elevations

To paint elevations:
1. Click the Menu icon on the Terrain Canvas to bring up the Terrain Canvas Tools.

2. Click the triangle icon below the Brush Behaviors heading and choose Elevation from the menu. 
The brush paints in shades of gray that are then used to generate altitudes. This is the default 
brush behavior. 
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3. Press Opt/Alt and paint on the canvas to invert the gray levels.
Examples:

Picking up Gray Levels from the Terrain

While you are painting, you may want to re-create a specific altitude in different parts of the terrain. If you 
have changed the brush settings, re-creating a specific altitude can be quite difficult. However, using the 
Height Picker tool, you can quite easily re-create altitudes by picking up gray levels from different parts of 
your image and applying them to the brush.
To pick up gray levels from the terrain image:

1. While holding down the spacebar, move the cursor over the Terrain Canvas and click the desired 
altitude color. The color is applied to the brush and the Level tool will update to reflect the new 
color. 
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2. Drag the brush over a different area of the canvas. The altitude color you picked up is applied to 
the new area.

©2003-2011 DAZ 3D, Inc. 979



Bryce 7 Artist Guide 03 Jan 2011

Paint

To apply an effect locally using the Paint Effect:
1. Click the Menu icon on the Terrain Canvas. 
2. Click the triangle icon below the Brush Behaviors heading and choose Paint Effect from the 

menu.
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3. Select a paint level from the Level tool.

4. Click the Elevation tab in the Editing tools palette. 

5. Hold down the Spacebar and click the Elevation effect you want to paint. 

The button next to the effect will turn yellow and the paintbrush will change to a circle with a 
double-cross in the center.
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OR

Click once on the effect you want to use, then press Cmd/Ctrl+Z to undo.
6. Drag the paintbrush over an area of your canvas. The chosen effect will be painted on the 

canvas.

7. Press Opt/Alt and drag on the canvas to switch to the Unpaint Effect.
8. Click the effect button again then press Cmd/Ctrl+Z to undo the last effect and turn off the effect 

but retain the changes you painted on the terrain.

Please note that if you turned on the paint effect by clicking on the effect then pressing 
Cmd/Ctrl+Z, you cannot turn off the paint effect using the above method. Instead, you must either 
choose another effect or change to a different brush behavior, neither of which will actually turn 
off the effect, or turn on painting as in step 4 and disable as in step 6.

Unpaint

To remove an effect locally using the Unpaint Effect:
1. Paint an effect on the canvas following the instructions in "Paint."
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2. Click the triangle icon below the Brush Behavior heading and choose Unpaint Effect from the 
menu.

3. Drag the paintbrush over an area of your canvas where you applied an effect locally. The terrain 
in that area will begin reverting to its original shape.

If you drag over an area where you did not paint an effect, nothing will happen.

Erode Terrains

To erode areas of your terrain:
1. Click the Menu icon on the Terrain Canvas. 
2. Click the triangle icon below the Brush Behaviors heading and choose Erosion from the menu.

3. Drag the paintbrush over the area you want to erode. The paintbrush applies the erosion effect to 
the area painted over. The erosion effect will increase as you continue to paint over an area.
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Minimum

The Minimum brush behavior uses the current gray level and darkens levels above that level to match the 
current level. Values below the current level setting are untouched. 
To darken gray levels use the Minimum effect:

1. Select a paint level from the Level tool.

2. Click the Menu icon on the Terrain Canvas.
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3. Click the triangle icon below the Brush Behavior heading and choose Minimum from the menu. 

4. Drag the paintbrush over an area you want to darken.

Maximum

To lighten gray levels using the Maximum effect:
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1. Select a paint level from the Level tool.

2. Click the Menu icon on the Terrain Canvas.
3. Click the triangle icon below the Brush Behavior heading and choose Maximum from the menu.

4. Drag the paintbrush over an area you want to lighten. In this mode, gray levels in your canvas 
that are below the current gray level are lightened to match the current level. Values above the 
current level setting are untouched. 
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Editing Tools
Editing Tools

The Editing Tools let you generate and edit the terrain’s height map and are organized into three tabs: 
Elevation: contains tools for generating terrains, and applying effects. Filtering: contains tools for fine-
tuning the gray levels in your Terrain Canvas. Pictures: contains tools for importing a Picture to use as a 
height map.
To access a tab, click the tab label. The tools associated with that tab move to the front. By default, the 
Elevation tools are in front.
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See the following topics for more on using the specific Editing Tools:
• Starting a New Terrain
• Inverting Terrains
• Undoing Operations
• Eroding Terrains
• Elevation Tools
• Filtering
• Pictures

Most of the tools in the Terrain Editor are displayed as control dots. These dots let you apply an effect or 
operation to the terrain gradually or at 100%.
To apply an editing tool to the Terrain Canvas:

1. Move the cursor over the tool you want to use.
2. Do one of the following:

• To apply an effect or operation at full strength, click the control dot once. Clicking a tool 
more than once applies the effect in 100% increments.

• To apply an effect gradually, click and drag left or right over the control dot.

Elevation Tab

Elevation Tools

The Elevation Tools are preset effects that apply calculations to your Terrain Canvas. 
The tools are divided into three categories on the Elevation tab along with general tools along the top: 

• General Tools: create new grayscale image, invert, undo, and erode
• Starting a New Terrain
• Inverting Terrains
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• Undoing Operations
• Eroding Terrains

• Source Generators: create basic terrain surfaces.  
• Basic Tools: edit the overall shape of your terrain. 
• Special Effects: add realism to your terrain's surface.

You can create a terrain by combining effects. For example, you can start off creating a basic terrain 
using the Fractal tool, then create realistic ridges by applying the Erode tool. From there you can fine-tune 
your terrain by applying Spikes, creating Mounds or adding Cross Ridges. Finally, you can define the 
basic shape of your terrain by blurring the edges.
To use an elevation tool:

1. Click the Elevation tab.
2. Click an Effect tool. 100% of the effect is applied to the Terrain Canvas. 
3. Click the tool again to increase the intensity of the effect.

Most elevation effects can also be applied gradually.
To apply an elevation effect gradually:

1. Move the pointer over an Elevation tool. The pointer changes to a two-headed arrow.
2. Click and drag to the left to increase the effect or click and drag to the right to decrease it.

Starting a New Terrain
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By default, when you open the Terrain Editor, the terrain you selected in the Working window appears in 
the Terrain Canvas. If you want to begin with a new, flat Terrain Canvas, use the New button.
To create a new Terrain Canvas:

1. Click the Elevation tab.
2. Either click the New button, or press Cmd/Ctrl+N.

A flat black image appears in the Terrain Canvas.

To gradually flatten your terrain, click and drag to the right over the New button.
The existing Terrain Canvas gradually fades to black. Many of the effects in the Elevation tab require 
grayscale values. If you apply these effects to a black map they may have no effect. 
To reset your terrain, hold down Ctrl and click the New button. The Terrain Canvas is reset to the terrain 
that appeared when you first opened the editor.

Invert
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Since the Terrain Editor uses brightness to determine altitude, you can change mountains into canyons 
by inverting the black and white values in your image.
To invert your terrain image:

1. Click the Elevation tab.
2. Click the Invert button, or press Cmd/Ctrl+I.

All the black areas of your image become white and white areas become black.
To gradually invert your terrain image click and drag to the right over the Invert button. The black areas in 
the Terrain Canvas progressively turn white.
Original terrain:

Inverted terrain: 
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Undoing Operations

You can reverse any effect you apply to your terrain using the Undo button. You can toggle between 
Undo and Redo by clicking the Undo button repeatedly.
To undo operations in the Terrain Editor, on the Elevation tab, click the Undo button, or press 
Cmd/Ctrl+Z. The last operation you applied is undone.

Eroded

Erosion simulates the effects of water erosion on your terrain objects. The calculations simulate rainfall 
and runoff based on the shades of gray progressing towards black. This effect works best on terrains that 
have large sloping areas.
The Eroded button simulates the effects of erosion over relatively short periods of time, like decades. To 
simulate the effects of centuries of erosion, use the Erode tool at the top of the Elevation tab.
To erode terrains:

1. Click the Elevation tab.
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2. Click the Erode button.

3. To gradually apply erosion, click and drag while the pointer is over the Erode button.
The upper image is what a terrain looks like before you apply the Erode effect. Notice that this image map 
has sloping areas that will make the erode effect more visible. The lower image is the same terrain after 
the Erode effect is applied. You can see how the surface now contains tracks created by running water.
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Source Generators

Source Generators

The Source Generators create basic terrain surfaces. They create the basis of your terrain and should be 
the first options used when creating your terrain.
See the following topics for details on using the Source Generators:

• Fractal
• Fractal Types
• Random Generators
• Tiling Terrains

• Eroded
• Picture
• Raise/Lower
• Sharpening
• Smoothing

Fractal

The Fractal tool creates terrains based on fractal patterns. It can be applied to an existing image and it 
can be applied gradually. 
To use the fractal tool:

1. Click the Elevation tab.
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2. Left-click on the triangle icon next to the Fractal effect.

3. Select a fractal type from the menu that comes up.
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See "Fractal Types" for examples of each fractal type.
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4. Click on the Fractal effect button to apply the effect 100% or drag right slowly to apply the effect 
in increments. 

5. If you do not like the effect, Undo the change or click the Fractal effect button again to see a new 
variation of the selected fractal type.

Fractal Types

Below are examples of the different fractal types available. Each type can produce multiple variations so 
the images below are just one example of many available for each type.
Bryce Classic

Ridged Multifractal

©2003-2011 DAZ 3D, Inc. 997



Bryce 7 Artist Guide 03 Jan 2011

Perlin Hills 

Rounded Dunes

Classic Fractal 
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Round Hills

Slick Rock

Ridges 
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Rolling Hills 

Alpine Valleys

Chaotic
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Pocked 

Crystalline 

Lava

©2003-2011 DAZ 3D, Inc. 1001



Bryce 7 Artist Guide 03 Jan 2011

Metamorphism 

Metamorphised

Fractured 
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Weathered Dikes 

Warped Slickrock 

Warped Ridges 
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Zorch 

Warped Zorch

Mordor 
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Shattered Hills 

Cauliflower Hills

Planet X
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Mud Cracks

Random Generators

Three options that are rarely used in the Terrain Editor (but should be used more often) are the Random 
Generators: 

• Random Extent which deals with how much surface the terrain extends over or the scale of the 
terrain's features 

• Random Position which deals with the position of the terrain within the entire "fractal terrain 
universe" 

• Random Character which deals with the look or character of the terrain
The Random Generators control the randomness of the terrain, so deselecting any one or more of them 
means that you turn off the randomness of that option.
To access these options, click on the triangle option next to Fractal and select any fractal type except for 
Bryce Classic.
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The options will be active and enabled near the bottom of the menu.
If Bryce Classic is selected, these options will be greyed out and not available.

So, if these options determine the randomness of the terrain extent, position, and character, then what 
good are they? Basically, if you find a terrain that you like the look of, you can turn off the options so that 
the feature you like is not changed.
To take advantage of the Random Generators:

1. Create a new terrain and enter the Terrain Editor. 
2. Set the resolution to 128. This allows you to get results more quickly. 
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3. Select any fractal type except for Bryce Classic.

4. Click on the Fractal button until you find a terrain that has a pleasing scale to the features.

5. Bring up the fractal menu and deselect Random Extent. Since we like the scale of the terrain, we 
want to keep the same scale as we continue. 

6. Click on the Fractal button again. Notice that even though the terrain changes, the overall scale 
remains the same. 
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7. Continue clicking on the Fractal button if you would like to see what else comes up. 

8. Once you have a terrain that you like the look of, deselect Random Character so the terrain 
retains the look you like.

9. Click the Fractal button and notice that even though the terrain changes, the basic look of the 
terrain remains the same. 
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10. Once you have a terrain that you are happy with, deselect Random Position as well.

11. Set the resolution to 512 or larger.

12. If you will be using the terrain in a larger tiled terrain group, click on the Fractal button one more 
time to redraw the terrain at the selected resolution. This is needed when tiling to ensure that the 
terrain matches up exactly with the other terrains.

©2003-2011 DAZ 3D, Inc. 1010



Bryce 7 Artist Guide 03 Jan 2011

13. Exit the Terrain Editor.  To use this terrain for tiling, continue to the section on "Tiling Terrains."

Tiling Terrains

Tiling Terrains allows you to generate a terrain, then tile "copies" of the terrain around the working window 
to create a larger terrain with no visible seams. You can tile terrains to the North, South, East, and West.
To tile terrains:

1. Build a new terrain following the instructions for the "Random Generators."

Note: Tiling terrains does not work for the Bryce Classic fractal terrain.
2. Exit the Terrain Editor.
3. Once back in the working window, press Cmd/Ctrl+D to duplicate the terrain.
4. With the duplicate terrain selected, press Shift+Up Arrow eight (8) times to move the terrain up to 

the North. You can also go into the Object Attributes dialog and enter the terrain size into the Z-
Position field to move it up the same amount as the terrain size. If you have resized the terrain, 
you will need to use the Object Attributes dialog to move the terrain up. 
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5. With the terrain still selected, go back into the Terrain Editor, make sure that all the Random 
Generators are deselected  and select Tile North.

6. Click on the Fractal button.
7. Exit the Terrain Editor. 

©2003-2011 DAZ 3D, Inc. 1012



Bryce 7 Artist Guide 03 Jan 2011

8. Render and you should see the terrains matching up at the seam.

9. If  you notice a slight gap between the two terrains, nudge the terrain back down a smidge by 
pressing Opt/Alt+Down Arrow key three or four times until the edges meet.
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10. Select the new terrain, duplicate and move North, East, or South.
11. Enter the Terrain Editor and choose to Tile based on the direction you moved the terrain and click 

on the Fractal button.
12. Repeat as needed, making sure that you select the terrain next to the new location. For example, 

if you move a terrain East and then want to go South, make sure you select the terrain you just 
moved. If you want to go West or South from the original terrain, select the original terrain, etc.

Caveat: When the terrain has been manually sculpted using the brush tool or by importing an image, the 
tiling options will not  work since clicking on the Fractal button will generate a fractal terrain overwriting the 
sculpted terrain. In this case, you can manually "tile" the terrain by doing the following:

1. After moving the terrain to the North, access the Object Atrributes and enter 180 in the Z-Rotate 
field to rotate the terrain around 180° on the Z-axis.
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2. Click on the OK icon to close the Terrain Editor. 
3. Click on the triangle icon under the Resize tool and choose Flip from the menu then nudge the 

terrain down as in step 7 above. 

4. Duplicate the second terrain and move it right, or to the East, by pressing Shift+Right Arrow eight 
(8) times, then selecting Tile East from the Terrain Editor (deselect Tile North). If that does not 
work, flip the terrain on the X-axis, then nudge it into place next to the second terrain.

5. Repeat by duplicating the third terrain, moving it down, and Tiling South (or flipping on the Z-
axis).
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Erode

This tool applies natural erosion to your terrain. It can be applied to either a blank image or an existing 
image. You can also gradually apply erosion to an image. The Eroded tool is a more intense version of 
the Erode tool. Notice that when animating this type of terrain, material is actually added to the terrain, not 
removed from it as you might expect.

To erode the terrain, click on the Erode button. You may need to click several times to get a noticeable 
effect, but the effect is much sharper than if you used the Eroded tool.
Original terrain:
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Eroded terrain:

Picture

This tool creates terrains from imported images. When you click this tool, the Open dialog appears. You 
can use this dialog to locate and load a Picture to use as a Terrain Canvas. 
Refer to the "Pictures Editor" for more information on loading Pictures.
Using this tool you can import an image map created in another application like Painter or Photoshop.
To load a Picture to use as a terrain:
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1. Click on the Picture button.

2. The Open dialog will come up. Locate and select the Picture you want to use in the Terrain Editor 
then click on Open.

The image will immediately be applied to the terrain. 
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Raise/Lower

This tool adjusts the brightness of your Terrain Canvas. 
To raise or lower the terrain, click and drag to the right to lower your height map or click and drag to the 
left to raise it. Single clicks gradually lower the map.

Examples:
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Sharpening

This tool sharpens the gray values in your Terrain Canvas. Click and drag left to increase sharpening and 
right to decrease it.

Examples:

Smoothing

This tool blurs the Terrain Canvas. Click and drag right to decrease the blurring effect or left to increase it.
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Smoothing is especially effective prior to using the Erode button, since the Erode algorithm works best 
when there are shades of gray in an image. If your canvas has too many sharp black to white transitions, 
the Erode may not be as effective.
Examples:

 

Basic Tools

Basic Tools

The Basic Tools edit the overall shape of your terrain and are located immediately below the Source 
Generators.

See the following topics for more on these tools:
• Basic Noise
• Slope Noise
• Height Noise
• Gaussian Edges
• Square Edges
• Round Edges

Basic Noise

This tool adds roughness to your terrain's surface by adding noise to the Terrain Canvas. Click and drag 
left to increase the noise and right to decrease it.
Examples:
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Slope Noise

This tool adds roughness to any sloping surfaces in your terrain. Click and drag left to increase the noise 
and right to decrease it. Slope Noise has no effect on flat surfaces. More noise is added to steep slopes.
Examples:

Height Noise

This tool adds small amounts of noise at lower altitudes and more noise at higher altitudes. Click and drag 
left to increase the noise and right to decrease it.
Examples:
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Gaussian Edges

This tool does not blur your map. It creates a "Gaussian curve" from dark to light, starting from the edges 
of your Terrain Canvas. This creates edges that gradually transition from dark to light, or start at the 
lowest possible altitude, and gradually progress into higher altitudes.
Gaussian Edges eliminates the seams between ground and terrain objects, when the ground plane and 
the terrain have the same surface material. You should apply this tool to any terrain that is going to be 
sitting on a ground plane in your scene.
Examples:

Square Edges

This tool creates an abrupt drop at the edges of your terrain. Use this tool when you have a terrain whose 
edges are not level, and you do not wish to use the Gaussian Edges tool for soft transitions.
You can add a slope to the square edges of your terrain by applying this tool gradually. Click and drag left 
to increase the slope and right to decrease it.
Example:
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Round Edges

This tool creates an abrupt circular drop at the edges of your terrain. You can add a slope to the round 
edges of your terrain by applying this tool gradually. Click and drag left to increase the slope and right to 
decrease it.
Example:

Special Effects

Special Effects

The Special Effect tools add realism to your terrain's surface. These tools, located below the Noise tool, 
apply filters to your terrain that act like image filters. They can change the look of the terrain without 
altering its basic shape.
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See the following topics for more on these tools:
• Spikes
• Mounds
• Dampen
• Equalize
• Posterize
• Mosaic
• Sawtooth
• Subcontours
• Blob Maker
• Relief Noise
• Raise Edges
• Subplateaus
• Cross Ridges
• Cross Ridges 2
• Bubble Ridges

Spikes

This tool adds spiky structures to your map. When you apply the right material to these structures they 
can look remarkably like trees when viewed from a distance or even grass.
Example:
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Mounds

This tool adds midsized splotches to your canvas. You can use this tool to create the appearance of 
stones or boulders under transparent water planes.
Examples:

Dampen

This tool works like a contrast control. It will push gray values towards either black or white depending on 
where the gray value falls in the black/white range. Less than 50% goes to black, greater than 50% goes 
to white.
Examples:

Equalize

This tool acts like the Equalize function you may have seen in 2D image editing applications. It 
redistributes gray values in your Terrain Canvas such that a full range from black to white is present in 
your canvas.
Examples:
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Posterize

This tool stratifies the gray levels in your Terrain Canvas, resulting in stair-stepped terrain structures. This 
is a good tool for creating desert plateaus.
Examples:

Mosaic

This tool is not a button on the Elevation tab. To use this tool, hold down Opt/Alt as you drag over the 
Posterize button. Mosaic creates highly pixelated square structures based on the gray content of your 
canvas.
This tool is excellent for instant cityscapes. Try adding one of the sci-fi city materials from the Preset 
Materials Library to a Mosaic terrain.
Example:
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Sawtooth

This tool modifies your Terrain Canvas based on a sawtooth waveform structure. The results look like 
desert canyons and icebergs.
Example:

Subcontours

This tool works like a contrast control with the threshold set almost at white. Most values are pushed to 
black while only the very lightest are pushed to white. Subcontours produces spiky peaks with very low, 
gently sloping contours.
Example:
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Blob Maker

This tool creates a smooth, circular structure within your existing Terrain Canvas. Click and drag left or 
right to change the size of the structure. Click and drag up and down to set the vertical location of the 
structure.

Examples:

Relief Noise

This tool acts like an emboss effect. It will emboss the grayscale data in your canvas and convert it to 
height information.
Examples:
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Raise Edges

This tool acts like an inverted version of the Square Edges tool. It creates abrupt increases in altitude at 
the edges of your terrain.
Examples:

Subplateaus

This tool smears your grayscale data in one direction while averaging the gray values. The result is 
natural structures not unlike those created by the Mounds effect, except that these structures are more 
directly related to your original gray data.
Examples:
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Cross Ridges

This tool creates sharp ridges in a cross pattern. It creates very interesting canal-like structures.

Example:

Cross Ridges 2

This tool is the inverse of the Cross Ridges tool. Instead of creating canals, it creates peaks.
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Example:

Bubble Ridges

Similar to the Blob Maker, the spherical structure this tool creates is of a consistent size. Dragging this 
button allows you to place the structure anywhere you like in your canvas.

Example:
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Filtering Tab

Filtering

The Filtering tab is divided into three areas: the Filtering Graph, the Preview area, and the Filtering 
Presets.
The Filtering graph displays your Terrain Canvas' gray levels as value inputs and outputs. You can edit 
this graph to adjust the gray level values in your canvas.
Next to the graph is the Preview area. This area shows you what your Terrain Canvas would look like if 
applied to the current Filtering graph. This area automatically updates as you make changes to the graph.
Along the top of the tab are the nine Filtering presets you can apply to the graph. Each preset represents 
a different predefined graph. They are designed to create specific changes in gray levels, like smooth 
gradients and abrupt transitions.

See the following topics for more on using filters in the Terrain Editor:
• How Filtering Works
• Altering the Filtering Graph
• Undoing Filter Changes
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• Softening Harsh Transitions
• Applying Filter Presets
• Applying Filter Changes
• Blending the Filtering Graph

How Filtering Works

The Filter area is essentially a graph that represents gray level input from black to white horizontally, and 
gray level output from black to white vertically.
The default diagonal filter creates a graph where all values input as black are also output as black, and all 
values input as white are also output as white. That is why your Terrain Canvas appears unchanged - 
none of its gray level values have been altered.
By dragging in this Filter area, you can remap the gray values in your Terrain Canvas.
To see how filtering works:

1. Generate your terrain.

2. Place your cursor (which changes to a Pen within the Filtering area) in the top left corner of the 
Filter Area. 
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3. Drag diagonally to the bottom right corner.
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4. Click Apply. 

As you can see in the Preview area, your Terrain Canvas is inverted. The original graph showed that all 
values input as black were output as black and all the values input as white were output as white.
The new graph you created now shows that all values input as black are output as white and all the 
values input as white are now output as black. In other words all the dark values are light and all the light 
values are dark.
In the new Filtering graph all values input at 0 are output at 255 and all values input at 255 are output at 
0.
This is a drastic example. In most cases you would adjust more selectively, like lightening the mid tone 
grays or darkening specific gray values. Remember that this graph represents your Terrain Canvas, so 
you are changing the shape of your terrain object as you adjust gray values.

Altering the Filtering Graph

The best way to start adjusting the Filtering graph is to determine the type of effect you want to create. 
For example, if your canvas is too dark, raise the value of the darker gray value inputs by drawing a ridge 
in the left side of the graph.
To alter the Filtering graph:
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1. Click the Filtering tab.

2. Drag your pointer over the area of the Filtering graph you want to adjust. When you drag over a 
black area, the pencil draws in gray; dragging over a gray area draws in black. Tracing over any 
lines you have drawn erases them. 

Undoing Filter Changes

To undo all changes to the Filtering graph:
1. Click the Filtering tab.
2. Click the Reset text button below the Filtering graph. The graph returns to the default Filtering 

graph.
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Softening Harsh Transitions

To soften harsh transitions in the graph:
1. Click the Filtering tab.
2. Click the Smooth text button below the Filtering graph. 

3. Click the Smooth button again to soften the transitions more or press the Smooth button 
continuously until the curve is smooth enough for your needs.

Applying Filter Presets

Filtering presets are provided to help you get started adjusting the Filtering graph. These presets are 
designed to provide different effects. The best way to understand these presets is to apply them to your 
graph and see what happens.
To apply presets:

1. Click the Filtering tab.
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2. Click one of the preset buttons along the top of the tab.

The current graph is replaced with the preset graph.

Applying Filter Changes

Although any changes you make to the graph are applied to the Preview area, they do not automatically 
affect your Terrain Canvas. You have to apply the changes before they affect the canvas.
You can temporarily apply your changes to the 3D Preview in real-time by holding down Ctrl as you click 
and drag over the Filtering graph. (Issue)
To apply the Filtering graph to the 3D Preview. click and hold the mouse button over the filter graph 
preview. The 3D Preview updates. When you release the mouse the 3D Preview switches back to the 
unfiltered terrain. (Issue)
To apply filtering changes to the Terrain Canvas, click the Apply text button beneath the Preview area.
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Blending the Filtering Graph

The Filtering Tab offers several ways of applying your Filtering graph to the Terrain Canvas. You can 
apply the graph directly or you can blend the graph with the canvas.
When you use a blending option you are essentially drawing a grayscale gradient and then blending it 
with your original canvas. The upper terrain in this image was altered by directly applying a filtering effect. 
The lower terrain was altered by blending a filtering effect with the original canvas.
To blend the Filtering graph with the Terrain Canvas:

1. Adjust the Filtering graph to achieve the desired effect. 
2. Click the triangle icon below the Filtering graph and choose an option from the menu.

• Horizontal: horizontally blends your Filtering graph, expressed as a grayscale gradient, 
with your Terrain Canvas. 
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• Vertical: vertically blends your Filtering graph, expressed as a grayscale gradient, with 
your Terrain Canvas.  

• Horizontal Add: horizontally blends your Filtering graph, expressed as a grayscale 
gradient, with your Terrain Canvas. This option uses a slightly different algorithm than the 
previous Horizontal option: it is not a traditional Additive, but an average of the existing 
terrain grayscale values with the maximum of the Terrain and Filter values.

• Vertical Add: vertically blends your Filtering graph, expressed as a grayscale gradient, 
with your Terrain Canvas. This option uses a slightly different algorithm than the previous 
Vertical option: it is not a traditional Additive, but an average of the existing terrain 
grayscale values with the maximum of the Terrain and Filter values.

3. Click Apply. 

Pictures Tab

Pictures

The Picture tab has three Picture squares and a blend control. The first two Picture squares let you load a 
Picture to use as a terrain and the third square shows you the result of combining the two Pictures. The 
blend control lets you specify how the Pictures are combined.

See the following topics for more on using Pictures in the Terrain Editor:
• Loading Pictures
• 8-bit and 16-bit Terrains
• Blending Pictures
• Applying Changes

Loading Pictures

You can load any two Pictures from your system. You can also paste images from the Clipboard. 
To load Pictures, 
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1. Click the Load text button above the Picture box into which you want to load the Picture. 

2. The Open dialog will come up. Locate the image you want to load, select it, and click on Open. 

3. From the Picture button in the Elevation tab, hold down the Opt/Alt key to load the Picture's color 
data directly into the 3D Preview. This allows you to see the interaction between the Picture and 
the grayscale-to-height interpretation of its luminance values. The color data is only for viewing 
purposes and will not render with the terrain. (Issue) 

To copy and paste a Picture into the Picture tab:
1. In another application, copy the Picture you want to use to the Clipboard.
2. In the Picture tab, click the Paste text button below the Picture box where you want the Picture to 

appear. When you use Cmd/Ctrl+V to paste from the Clipboard, the Picture always appears in the 
first square.
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8-bit and 16-bit Terrains

8-bit and 16-bit Terrains

New in Bryce 6 is the ability to import/export 16-bit grayscale images from the Terrain Editor. By default, 
Bryce creates terrains in 8-bit grayscale which can often be less smooth than needed but stores the 
images as 16-bit. Being able to import 16-bit grayscale images provides the ability to take advantage of 
Bryce's ability to store 16-bit and to add more detail to your terrains, with a much smoother surface.
Please note that you cannot convert 8-bit terrains to 16-bit in the Terrain Editor. Conversion between the 
two must be done in a paint program, like Photoshop or Paint Shop Pro. Just be aware that in some paint 
programs, like Paint Shop Pro, some of the tools (brushes, Picture tubes) may not work in 16-bit mode, 
only in 8-bit mode. You may need to create your image in 8-bit then increase it to 16-bit before saving it.
In addition, not all formats work the same between programs. For example, a 16-bit TIFF image exported 
from Paint Shop Pro X cannot be imported into the Terrain Editor, but the same image exported as TIFF 
from Photoshop, can be imported into the Terrain Editor.

• Creating 16-bit Pictures
• Loading 8-bit and 16-bit Pictures
• Exporting 8-bit and 16-bit Pictures

Creating 16-bit Pictures

The instructions below use Photoshop as the paint program.
To create 16-bit images for import into the Terrain Editor:

1. Open Photoshop and choose File > New from the menu. The New file dialog will come up. 
2. Enter a name, width, height, and resolution. Choose a color mode of Grayscale and select 16 bit 

from the pull-down menu. If your background color is black, set the Background Contents to 
Background Color.
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3. Click on OK to create the new image. The canvas title will indicate the color mode and bit size.

4. Paint your terrain or image using grayscale colors.
5. Save the image, selecting None for PNG Options and clicking on OK.

For Macs, when saving the images as TIF files, they need to be saved or converted to PC Byte 
Order.

Loading 8-bit and 16-bit Pictures

To load 8-Bit and 16-bit images into the Terrain Editor:
1. Create a terrain image in a paint program on a square canvas (i.e., 512x512, 256x256, etc.).
2. Open Bryce and create a terrain or symlat. 
3. Click on the  button next to the selected terrain to enter the Terrain Editor.
4. In the Terrain Editor, for 16-Bit images check the Terrain Resolution to make sure it is at least at 

512 - ultra fine, although 1024 massive resolution or higher is probably better. Just remember that 
if you downgrade the resolution later then upgrade it again, you will lose some resolution in the 
process. See the examples at the bottom of the page. 
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5. Click on the Pictures tab in the Editing Tools panel. 

6. In the Pictures tab, click on Load above the first window.
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7. The Open dialog will come up, locate and select your 16-bit PNG file. Click on Open.

8. The image will be loaded into the first window. Click on Copy under the first window, then on 
Paste under the second window.

9. The copy will be pasted into the second window. Click on Apply to load the image into the Terrain 
Canvas.
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10. The image will be loaded into the Terrain Canvas where you can modify it further if needed. 

Examples:
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• 16-Bit Image at 1024 resolution: 

©2003-2011 DAZ 3D, Inc. 1048



Bryce 7 Artist Guide 03 Jan 2011

• 16-Bit Image at 128 resolution:
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• 8-Bit 512 Resolution Rendered:

• 16-Bit 512 Resolution Rendered:
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• 16-Bit 1024 Resolution Rendered:

Exporting 8-bit and 16-bit Pictures

Sometimes, it is easier and/or more efficient to modify terrains in a paint program rather than in the 
Terrain Editor. 
There are three ways to export the terrain grayscale images from Bryce:

1. Copy the original image in the Terrain Canvas and paste into a paint program.
2. Copy the original image in the Pictures tab and paste into a paint program.
3. Export the terrain image and open in a paint program - new in Bryce 6

To copy the image using the Terrain Canvas:
1. Create a terrain or symlat.
2. Click on the  button next to the terrain to enter the Terrain Editor. 
3. Select the terrain resolution for the size you would like to work with in your paint program. For 

example, if you select 1024, then the grayscale image in your paint program will be 1024x1024, 
etc.

4. Modify the terrain to get your starting point, then press Ctrl+C.
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5. Minimize Bryce and open your paint program.
6. Paste as a new image. The image will have the same dimensions as the selected terrain 

resolution in the Terrain Editor and will be in 8-bit format.

7. Modify the terrain using the tools in the paint program and save the image.
8. Bring the image back into Bryce by doing one of the following:

• Load it into the Pictures tab by clicking on Load
• Copy it in the paint program and click on Paste in the Pictures tab
• Copy it in the paint program and press Cmd/Ctrl+V in the Terrain Canvas

Blending Pictures

Once you have a Picture in each of the first two squares, you blend them to create a third image that is 
used to create the new Terrain Canvas.
To blend Pictures:

1. Load Pictures into the first two squares. If you load only one Picture a white square is used as the 
second blend image.
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2. Click the triangle icon under the third Picture box and choose a Blend mode from the menu.

• Blend: compares each corresponding pixel from the first two squares, and displays an 
average of the two in the corresponding location of the third square. 

• Minimum: compares each corresponding pixel from the first two squares, and displays 
the darker of the two in the corresponding location of the third square. 

• Subtract: compares each corresponding pixel from the first two squares, subtracts the 
brightness value of one from the brightness value of the other, and displays the result in 
the corresponding location of the third square.

• Add: compares each corresponding pixel from the first two squares, adds the brightness 
value of one to the brightness value of the other, and displays the result in the 
corresponding location of the third square. 

3. Drag the pointer over the Blend control. Click and drag to the left to use more of the first image in 
the blend. Click and drag to the right to use more of the second image. 
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Applying Changes

Although the result of blending Pictures appears in the third Picture box, it is not automatically applied to 
your Terrain Canvas.
To apply a Picture to the Terrain Canvas, click the Apply text button beneath the third Picture square.
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And the Terrain Canvas will be updated:

Animation Controls
The Animation controls at the bottom of the editor let you create key frames for your terrain. Any change 
you make to the geometry of the terrain can be stored in a key frame and animated.
The Timeline that runs along the bottom of the editor displays the length of the animation. The Current 
Time Indicator within the timeline lets you set the current time of the animation.
The buttons in the Animation controls let you preview the animation. The buttons beside the Preview 
controls let you add and delete key frames from the Timeline. The Animation controls at the bottom of the 
editor let you create key frames for your terrain. Any change you make to the geometry of the terrain can 
be stored in a key frame and animated.
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Speeding up the Terrain Editor
To speed up performance on slower machines, disable both the Real-time Linking and AutoRotate 
options.
To speed up the Elevation effects, use the single-click method rather than the click-drag "dial in" method, 
as the latter can be quite slow.
The larger terrain grid sizes, such as Massive, Gigantic, and Planetary, require a significant amount of 
memory and computing power. Only use these terrain grid sizes when necessary. If you are working on a 
slower machine, you may experience problems such as "out of memory" errors.
When you create a terrain in your Bryce scene, a natural impulse is to immediately dress it up with a cool 
material and render it right away to see what it looks like. For serious composition, consider keeping your 
terrains free of textural attributes until the final stages, as procedural textures take longer to render than 
smooth shaded surfaces. This will keep you working rapidly on your composition. Then, before your final 
output, you can take some time to design textures for your terrain. Export lets you save a terrain in a 
variety of file formats. You can then import a saved terrain into another 3D application or a different Bryce 
scene.

Creating Terrains
Creating Terrains

You can create terrains in several ways. You can let the editor do all the work of generating a terrain 
based on a series of algorithms, you can use the editor's painting tools to create a custom image, or you 
can import an image into the editor.
When you generate a terrain, you use the Terrain Editor's Elevation tools, which include dozens of effects 
optimized for the purpose of heightening realism in Bryce terrains.
When you paint a terrain you use the editor's grayscale paintbrush to paint a topographical image. The 
image is then converted to a terrain object.
You can also create a terrain by importing a Picture into the editor. The Picture is converted to grayscale 
and used to generate altitude values.

• Creating Landscapes
• Animation & Terrain Editing

Creating Landscapes

When you are planning the shape of your terrain, keep in mind the kind of landscape you want to create. 
You do not have to create all the land in your scene as a single terrain. You can create complex 
landscapes by combining several terrain objects.
Before creating terrain objects, plan out the entire map of your landscape. Then you will be able to see 
where different terrain objects might be combined to create a single land mass.
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If you have more terrains in your scene, you will have a bigger scale for the environment. This gives you 
more resolution and a more realistic looking effect.
Before you start creating terrains you should map out all the land masses in your environment. You will 
then be able to see where you will need to combine more than one terrain to create a specific type of 
landscape. These images show an example of mapping and the final result.
Pay attention to where the camera is positioned in the scene. Terrains that are closer to the camera need 
to be more detailed than those off in the distance.

Animation & Terrain Editing

You can record the process of creating a terrain into an animation using the Animation controls. Refer to 
&rdquor;Animation” for more on animating terrains. Some of the Elevation tools can produce 
unpredictable results when they’re animated, so you may want to experiment with animating elevations 
before you create your final terrain.

Light Lab

Light Lab

Lighting is the primary consideration of any 3D image. Lighting is the tool that provides the most 
effective means of communicating the “story” within the scene, setting the mood, and informing us as 
viewers of what is important with emphasis and drama via highlights and shadows. 

Bryce 7 has a newly designed Light Lab interface.  Building on the solid foundations of the Light Lab 
interface of Bryce 6, Bryce 7 seeks place a new degree of control into the user’s hands. More control  
gives Bryce 7 users the ability to describe the effects of lights in very precise manners saving time in 
several ways. Ease of use has been maximized so that both new users and veteran users can quickly 
access what they need. 

Most importantly, the new lighting parameters increase the overall efficiency of the rendering process, 
resulting in much swifter renders that are higher in quality. Easily apply appropriate lighting for 
landscapes, interiors, abstracts, and even outer space scenarios with Bryce 7. The possibilities are 
endless.

Backward Compatibility

Much care has been taken to ensure as much backward compatibility as possible with previous versions 
of Bryce. In most cases, scene files saved in earlier installments of Bryce will look the same when 
rendered in Bryce 7, but there are a couple of exceptions.

• True Ambience (Global Illumination) has been greatly improved in Bryce 7. There are several 
changes to the way the feature has been implemented. In a nutshell, Bryce 7 True Ambience has 
been linked with the Diffuse Channel in the Material Lab, instead of being linked to the Ambient 
Channel as in previous versions. The result of this channel switching is a much more accurate 
Global Illumination simulation.  Since True Ambience has been linked to a different channel, it 
has become necessary to add a Legacy TA mode checkbox in the Render Options. This ensures 
that true ambience scenes from Bryce 6 and earlier will render the same in Bryce 7. If the user 
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decides to employ the new and improved True Ambience, simply uncheck the Legacy TA option. 
There have been other improvements to True Ambience as well including bump mapping 
support and mesh smoothing improvements. For this reason, even when working in Legacy TA 
mode, renders from Bryce 6 and earlier may look slightly different and in most cases better 
when rendered in Bryce 7. 

• True Parallel Lights have been introduced in Bryce 7. The Standard Parallel Lights (Legacy) of 
Bryce 6 and earlier were not truly parallel at all. So to remain compatible with previous versions, 
there are two types of parallel lights in Bryce 7. When files saved in Bryce 6 and earlier are 
imported into Bryce 7, the saved parallel lights are assumed to be in the Legacy format.

See the following topics for more on the Light Lab:
• Accessing the Light Lab  
• Light Preview  
• Light Attributes  

 
 

Accessing the Light Lab

To access the Light Lab:
1. Select a light object in your scene.
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2. Click the  button that appears next to its bounding box. The Light Lab will come up.

Light Preview
The Light Preview area displays the effects of any changes you make to the attributes of a light source. 
This preview can display the light against a neutral background or show the light in the scene. You can 
also choose between a faster, low-quality preview, and a slower, high-quality preview.
To set the preview options in the Light Lab, click the triangle icon at the bottom right corner of the preview 
area and choose a preview option: 

• Render in Scene displays your scene in the Preview area. This lets you see how the changes you 
make to the selected light will impact your entire scene.
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• Render Against Neutral displays the light against a flat background. This lets you isolate the light 
so you can clearly see subtle changes.

• Fast Preview lets you achieve faster updates.

• Full Rendering displays a high-quality rendered scene or light.

Light Attributes
Light Attributes

Bryce 7 Pro offers a wide variety of lighting tools catered to fit any situation. There are several 
improvements to basic light concepts as well as advanced lighting tools. 

See the following topics for more on setting the light attributes:
• Distant (New)     
• Parallel (New)  
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• Dome Lights (New)  
• 3D Fill -   Cluster (New)  
• Intensity  
• Edge Softness  
• Spotlight Spread  
• Cast Shadows  
• Light Color  
• Light Falloff  
• Visible Lights  
• Applying Gels  
• Saving Light Settings  
• Positioning Lights  
• Linking & Tracking with Lights  
• Animating Lights  

• Distant Light: (New Feature Bryce 7 Pro) 

Distant Lights are ideally described as standard point radials or point spotlights placed at an 
infinite distance away from World Center. Distant Lights coordinate with the Sky Lab for a 
new level of control over atmospheric interactions. 

Distant Lights are very similar in function to the Sky Lab Default Sunlight, but with a few key 
differences;

A. Distant Lights have 20x greater intensity than the Default Sunlight. 
Therefore, a Distant Light Diffuse intensity value of only 5 is equal to 
a Default Sunlight Diffuse intensity of 100.

B. A Distant Light’s maximum possible shadow intensity is relative to 
the value assigned to the Default Sunlight. The Default Sunlight 
Shadow Intensity Channel within the Sky Lab serves as a Master or 
Global Shadow Intensity controller informing all other lights in a 
Bryce scene, including all Lights types within the Light lab. 

C. Distant Lights can be selected as Visible Objects. Once Visible is 
enabled, Flares can be enabled using the Visibility Options. When 
Flares and Sky Interaction are combined a Sunspot is added at the 
center of the Flare.

D. Distant Lights are intended for use as multiple Suns. There is no limit 
to the number of Distant Lights or second suns that can be applied 
within a single scene. 

E. Note: Distant Lights are so great in distance that in order for their 
illumination to strike the objects within a scene the Falloff setting 
must remain at value “None.”

• Sky Interaction Color: Sky Interaction Color is independent of the Color assigned to 
the Light Properties. Sky Interaction Color describes the hue that will be applied to 
the Sky Lab clouds due to the Influence of this light source.

• Sky Interaction Intensity:  Distant Lights are designed to behave very much like the 
Default Sunlight in the way that they interact with the Sky Lab Cloud Effects. Distant 
Lights interact with the Skylab clouds and background sky color by means of the Sky 
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Interaction Intensity Channel.  The higher the value applied the more obvious the Sky 
Interaction Color will affect the Skylab clouds by shifting the hue. When Visible Flares 
and Sky Interaction are combined a fuzzy halo and sunspot of the Sky Interaction 
Color are applied at the exact position along the sky where the Distant Light 
illumination is emitted.

• Azimuth / Altitude: Just like the Default Sun, Distant Lights can be positioned along 
the sky background by using the Azimuth and Altitude numeric inputs. Distant Lights 
can also be positioned using the Roller-ball Object.

• Radial / Spot: Distant Lights can be switched between two modes, as Distant 
Radials or as Distant Spotlights.

•   True Parallel Lights (New Feature Bryce 7 Pro)

True Parallel Lights are modified and improved versions of the original Standard Parallel Light 
(Legacy). True Parallel Lights simulate the effect of linear 2D projection with perfect accuracy.

• Round / Square: True Parallel: Lights can have one of two forms, Round or Square. 
• Edge Softness:  
• Infinite Width: True Parallel Lights can be adjusted to any scale. However there are 

situations when it may be necessary to apply True Parallel Lights at an infinite scale. 
Infinite Width extends the True Parallel in all directions to infinity. 
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•
•
•
•
•
•
•
•

• Directional Control: The beam of light produced by True Parallel Lights can be 
focused toward any direction by enabling the Directional Control Option. Once 
enabled the Roller-ball and Azimuth / Altitude inputs used for the Distant Light can be 
used to precisely aim the beam of the True Parallel Light in any direction.

•   Dome Lights (New Feature Bryce 7 Pro)

Dome Light Theory 
(Simplified 2 Dimensional Conceptual Model Below)
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Dome Lights are three dimensional Cluster Formation Light sources. Dome Lights are 
comprised of multiple “virtual” point perspectives arranged around the perimeter of a 
determined three dimensional geometric shape, spherical or cubed. Dome Lights in essence 
behave as a group of multiple point radial lights which can be manipulated all at once. The 
total output Intensity of the Dome Light is distributed evenly among the various virtual point 
perspectives which comprise it. Dome Lights are very useful as realistic Indirect Lighting 
tools, but can be used as Key Lighting elements as well. Dome Lights can in some situations 
provide highly accurate soft shadow effects in less time than engaging genuine Soft Shadows 
as with a Standard Single Point Radial.

Rendered in Bryce 7 Pro. Lit with two Dome Lights. 

The scene is placed within the interior of an enlarged Dome 1, which is used as indirect 
lighting to fill in the shadows. Dome 2 is much smaller, and serves as the key light source. 
Notice the naturally softened shadows from the key light.

Note: Special consideration must be given before engaging genuine Soft Shadows with 
Cluster Formation Dome Lights and 3D Fill Lights. As a general rule, the higher the Quality 
setting of the Cluster Formation Light, the less likely that Soft Shadows will require engaging. 
At a properly generous Quality setting, Cluster Formation Light sources will provide natural 
soft shadows due to their three dimensional nature. However, when genuine Soft Shadows 
are indeed enabled for Cluster Formation Lights, the shadows cast by each virtual point 
perspective are softened individually as if each were an actual radial light source. This leads 
to a great deal of necessary calculations which results in extended render times.  In this 
manner, a Quality setting of 16 requires much less rendering time than a quality of 100, but 
when working with the Soft Shadows Option, the difference is several times more 
pronounced. The larger the physical size of the Dome Light, the wider or softer the resulting 
shadows it will provide.

• Sphere/ Cube: Dome Lights can be created in the shape of a Sphere or a Cube. 

• Distant Dome Light: Dome Lights can be of any physical size, including infinite. 
Dome Lights can be applied as Distant Light Domes by selecting the Distant button. 
When applied as Distant, Dome Lights provide excellent indirect illumination for entire 
landscape scenarios. Distant Dome Lights function in a manner somewhat similar to 
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that of Image Based Lighting; however with Dome Lights the same Color and 
Intensity information is shared by all of the virtual point perspectives comprising the 
Dome and the information they carry is not High Dynamic Range in nature. 

• Quality: The exact number of virtual point perspectives that comprise a Dome Light 
is known as its Quality. The more virtual point perspectives applied, the higher the 
Quality and the smoother the resulting light and shadows that will be produced. 
Higher Quality settings produce better light coverage and in turn require more 
computation time. 

A. Changes made to the Quality setting can at times appear to alter the 
intensity of the illumination expressed by a Dome Light, but indeed 
this is not what actually occurs. As more virtual point perspectives 
are included in the configuration, the total output intensity is better 
distributed among a greater number of virtual point perspectives. 
Sphere Dome Lights can range from a minimum of 16 to a maximum 
of 10,000 virtual point perspectives. Cube Dome Lights have a 
minimum of 24 virtual point perspectives and a maximum of 10,000.

• Bias: By default Dome Lights are actually full spheres of light created without any 
directional Bias, meaning that there are roughly the same number of virtual point 
perspectives placed in the northern hemisphere as there are in the southern 
hemisphere. Bias describes the degree of tendency of the virtual point perspectives 
to converge toward one hemisphere and away from another, becoming less spherical 
and more domelike in shape.

A. When Bias is set to a positive value, the virtual point perspectives 
begin to converge to a point at the pole of the northern hemisphere. 
As a result, a sort of “vacancy” is created at the southern pole. The 
higher the positive value, the greater the convergence of virtual point 
perspectives toward the northern pole.

Bias 0 Bias +25 Bias +50 Bias +75 Bias +100

B. In the same manner as the image example above, if a value of -100 
is applied as Bias, all of the virtual point perspectives will be 
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converged toward the southern pole of the Dome Light, arriving 
almost to a point.

C. Note: Bias polarity is aligned toward north and south. Dome Lights 
can be rotated in the Object Attributes tab and the Bias alignment will 
rotate with the Dome itself allowing east and west directional Biasing. 
However when applied as Distant Lights Domes, the polarity is 
restricted to north and south alignment regardless of the rotations 
applied within the Object Attributes tab.

D. Note: Virtual point perspectives have an impact on render time. 
When Dome Lights are applied as Distant, Bias can be used to make 
more efficient use of the virtual point perspectives. If the ground 
plane is present, it may tend to block the light emitted by the virtual 
point perspectives often located below the ground plane. To 
maximize on the benefits of the Dome Light, apply a Bias setting of 
+50 so that all of the virtual point perspectives will be placed above 
the ground plane where they can affect your scene. 

• Randomness: By default, the virtual point perspectives which comprise Dome Lights 
are spaced at an equal distance from one another around the perimeter of the Dome 
Light geometry. In some situations, the resulting shadows observed by this perfect 
arrangement can produce unwanted results. Randomness determines the degree of 
balance of shifting from perfectly ordered virtual perspective arrangements, to fully 
chaotic arrangements. Randomness can override Bias to a certain degree. In many 
cases, a certain amount of randomness is necessary to produce a realistic and 
natural result.

               

• Outward / Inward: Dome Lights by default radiate Illumination multi-directionally. 
There are circumstances however when it is best to assign a specific polarity to the 
outgoing illumination. Outward assigns all light rays to travel away from the geometric 
center of the Dome Light. Inward, instructs all light rays to travel toward the geometric 
center of the Dome Light. Polarizing the Light output of a Dome Light can often help 
make more efficient use of render time.

• Self Shadow: Dome Lights by default are hollow and allow light to penetrate the 
center with no obstruction. There are times when this condition is not ideal. When 
Self Shadow is selected, the Dome Light becomes solid in a virtual manner, self 
interacting, preventing light from one pole from exiting at the other pole. This is ideal 
for situations where the Dome Light is assigned as a Visible Object. 

•  3D Fill Lights (New Feature Bryce 7 Pro)

3D Fill Light Theory
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(Simplified 2 dimensional Conceptual Model Below)

3D Fill Lights are three 
dimensional Cluster Formation 
light sources. 3D Fill Lights are 
comprised of multiple virtual 
point perspectives arranged 
within the three dimensional 
volume of a determined 
geometric area, spherical or 
cubed. 3D Fill Lights in 
essence behave as a group of 
multiple point radial lights 
which can be manipulated all 
at one time. The total output 
Intensity of the 3D Fill Light is 
distributed evenly among the 
various virtual point 
perspectives comprising it. 3D 

Fill Lights are very useful as Indirect Lighting tools and will outperform Dome Lights in 
geometrically complex situations, making 3D Fill Lights ideal for complex landscapes and 
complex architectural renders. 3D Fills can be used as powerful Key Lighting elements as 
well. 3D Fill Lights can in some situations provide highly accurate soft shadow effects in less 
time than engaging genuine Soft Shadows as with a Standard Radial.

 

Conceptual Models Above:
As indirect lighting tools, 3D Fill Lights can often outperform Dome Lights especially when 
working with complex interiors, cityscapes and dense landscapes. The Dome Lighting Theory 
arranges point perspectives along the outer perimeter of the given area, and therefore can 
only act from a distance. When presented with the problem of a labyrinth, the “line of sight” 
limitation of Dome Light point perspective arrangements means that all of the light tends to 
gather along the outer walls of the labyrinth, blocked from reaching the centermost walls due 
to the first degree of obstruction. The 3D Fill Light by comparison, arranges the point 
perspectives within the volume itself, and this allows the “line of sight” to easily illuminate all 
of the internal walls of the labyrinth we well as the outermost walls, in a more or less evenly 
distributed fashion. Scaling is an important factor when working with 3d Fill Lights. 3D Fill 
Lights can literally round corners and leap over obstacles to provide excellent indirect lighting 
with the benefit of indirect shadow as well.

Note: Just as with Dome Lights, special consideration must be given before engaging genuine Soft 
Shadows with Cluster Formation 3D Fill Lights. As a general rule, the higher the Quality setting of the 3D 
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Fill Light, the less likely Soft Shadows will need to be enabled at all. At the properly generous Quality 
setting, 3D Fill Lights will provide natural soft shadows due to their three dimensional nature.  When Soft 
Shadows are enabled for Cluster formations such as Dome Lights and 3D Fill lights, the shadows cast by 
each virtual point perspective are softened individually as if each were a true individual radial light source. 
This leads to a great deal of necessary calculations which results in extended render times.  In this 
manner, a Quality setting of 24 requires much less rendering time than at Quality 125, but when working 
with Soft Shadows, the difference is several times more pronounced.  The larger the physical size of the 
Dome Light or 3D Fill Light, the wider or softer the resulting shadows it will produce.

• Sphere/ Cube: 3D Fill Lights can be created in the shape of a Sphere or a Cube. 

• Distant 3D Fill Light: 3D Fill Lights can be of any physical size, including infinite. 3D 
Fill Lights can be applied as Distant 3D Fill Lights by selecting the Distant option. 
When applied as Distant, 3D Fill Lights provide excellent indirect illumination for 
entire landscape scenarios. Distant 3D Fill Lights function in a manner somewhat 
similar to that of Image Based Lighting; however with 3D Fill Lights the same Color 
and Intensity information is shared by all of the virtual perspectives comprising the Fill 
and is not High Dynamic Range in nature.  

• Quality: The exact number of virtual point perspectives that comprise a 3D Fill Light 
is known as its Quality. The more virtual point perspectives applied, the higher the 
Quality and the smoother the resulting light and shadows that are produced. Higher 
Quality settings produce better light coverage and in turn require more computation 
time. The Quality setting can at times appear to alter the intensity of the illumination 
expressed by the 3D Fill Light, but indeed this is not what actually occurs. As more 
virtual point sources are included in the configuration, the total output intensity is 
better distributed among a greater number of virtual point perspectives.  A Sphere 3d 
Fill can range from a minimum of 27 to a maximum of 10,000 virtual point 
perspectives. Cube Dome Lights have a minimum Quality of 27 virtual point 
perspectives and a maximum of 10,000.

Quality 27 Quality 64 Quality 125 Quality 343 Quality 1000

      

• Bias: By default 3D Fill Lights are created with very little directional Bias, meaning 
that there are roughly the same number of virtual point perspectives placed in the 
northern hemisphere of the 3D Fill Light as there are in the southern hemisphere. 
Bias describes the degree of tendency of the virtual point perspectives comprising a 
3D Fill Light to converge toward one hemisphere and away from another, becoming 
less spherical and more like a dome.

A. When Bias is set to a positive value, the virtual point perspectives 
begin to converge to a point at the pole of the northern hemisphere. 
As a result, a sort of “vacancy” is created at the southern pole of the 
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3D Fill Light object. The higher the positive value, the greater the 
convergence of virtual point perspectives toward the northern pole. 
Notice that there is very little difference between 75% and 100%, as 
3D Fill Lights do not converge to a point.

Bias 0 Bias 25 Bias 50 Bias 75          Bias 100

B. In the same manner, if a value of -100 is applied as Bias, all of the 
virtual point perspectives will be converged toward the southern pole 
of the 3D Fill Light.

C. Note: Bias polarity is aligned toward north and south. 3D Fill Lights 
can be rotated in the Object Attributes tab and the Bias alignment will 
rotate with the 3D Fill itself allowing east and west directional 
Biasing.

D. Note: Virtual point perspectives have an impact on render time. 
When 3D Fill Lights are applied as Distant, Bias can be used to 
make efficient use of the virtual point perspectives. If the ground 
plane is present, it may block the light emitted by the virtual point 
perspectives often located below the ground plane. To maximize on 
the benefits of the 3D Fill Light, apply a Bias setting of +50 so that all 
of the virtual point perspectives will be placed above the ground 
plane where they can affect your scene. 

• Randomness: By default, the virtual point perspectives which comprise 3D Fill Lights are 
spaced at an equal distance from one another within the three dimensional volume  of the  3D 
Fill Light geometry. In some situations, the resulting shadows observed by this perfect spacial 
arrangement can produce unwanted results. Randomness determines the degree of balance 
of shifting between perfectly ordered virtual perspective arrangements, to fully chaotic 
arrangements. Randomness can override Bias and Distribution to a certain degree. In many 
cases, a certain amount of randomness is necessary to produce a realistic and natural look. 

In most cases the virtual point perspectives of 3D fill lights are contained within the boundary 
box of the light object. But when randomness is applied, virtual point perspectives can often 
end up outside of the boundary box indicated in wireframe.

Randomness 0     Randomness 25       Randomness 50        Randomness 75      Randomness 
100

• Distribution: Distribution describes the tendency of the virtual point perspectives to converge 
toward or away from the geometric center of the 3D Fill Light. This allows for precise handling 
of indirect lighting in geometrically complex scenarios. The higher the Distribution setting, the 
stronger the attraction toward the center. 

A. The default Distribution setting is 100. For most interiors, it is best to 
use Distribution settings that are on the lower end. This allows better 
overall coverage around most rooms. 
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Distribution 0    Distribution 100     Distribution 250      Distribution 500       Distribution 1000

B. Note: When virtual point perspectives happen to be placed very 
near geometry within a scene, often sharp areas of brightening 
occur called “hotspots.” Hotspots are caused by the relative 
distance Falloff of each of the individual virtual point perspectives 
behaving as if they were true Standard Radials. Hotspots are usually 
unwanted artifacts, and therefore must be overcome. There are a 
couple of considerations regarding hotspots:

o 1. As a general rule, the higher the Quality Setting, the less 
likely a hotspot will be observable.

o 2. Hotspots occur due to sharp Falloff settings. So selecting 
a Falloff of None is a good means of preventing the 
emergence of hotspots.

o 3. When working with Distant 3D Fill Lights, the Falloff 
Setting of “None” automatically prevents any risk of 
hotspots emerging.

o 4. For localized situations, hotspots can be smoothed and 
remedied without the need for  a None Falloff setting in the 
following manner:

 Instead of applying a Properties Color that is 
Uniform, it is recommended to select Gradient.

 Once Gradient is selected as the Color, one must 
reverse the default polarity of the Gradient sample 
so that the darkest part of the gradient is on the left 
hand side, instead of on the right. At smaller scales, 
this action alone can often prevent hotspots. 
However this alone fails at larger scales.

 In addition to reversing the polarity of the Gradient, 
sometimes it may be necessary to adjust the 
Gradient Range as well. Typically, increasing the 
Gradient Range from the default 51.2, to some 
higher value will begin to smooth out the hotspots 
more and more, and can be raised to any value up 
to and including 99999 to fit nearly any scaling 
reference. In this fashion, it should be possible 
remove all signs of hotspots at any scale.
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Default Uniform Reverse Gradient   Reverse Gradient + Range 200

Intensity

A. Diffuse : Diffuse Intensity governs the amount of brightening a Diffuse Enabled material surface 
experiences due to the influence of the given light source. The Light Lab Diffuse Intensity 
Channel communicates directly with the Diffuse Color Channel within the Material Lab for a 
combined Diffuse Illumination Effect. 

• Bryce 7 continues the powerful tradition of allowing you to apply Negative Intensity values to 
the Diffuse Intensity Slider, resulting in a complete reversal of brightening effects as indeed 
absorption or darkening occurs, as well as a complete reversal of generated hues. Negative 
Lights also produce Positive Shadows.

B. Specular : (New Feature Bryce 7 Std / Pro) Specular Intensity governs the amount of brightening 
a Specularity Enabled material surface experiences due to the influence of the given light source. 
The Light Lab Specular Intensity Slider communicates directly with the Material Lab by means of 
the Specular Color Channel and the Specular Halo Color Channel for a combined Specular 
Illumination Effect. 

Specularity is described simply as a highly blurred reflection of light. Reflections by nature are 
viewer dependant, meaning that a large part of what determines which areas of the surface are 
altered by the specular effect is the exact position of the camera in relation to the surface being 
observed, as well as the angle of the approaching light rays. 

•  Bryce 7 continues the powerful tradition of allowing Negative Intensity values for Specularity, 
resulting in a specular absorption effect as well as a complete reversal of generated specular 
hues. Negative Specular Lights also produce Positive Specular Shadows.

To adjust light Intensity in the Light Lab, drag the light Intensity control. Drag right to increase light 
intensity and
left to decrease intensity.
The default Intensity is 25, although the slider can be set from 0 to 999 for positive lights and from 0 to 
-999 for negative lights.
Positive settings will show up as gold on the slider, while negative settings will show up as blue.

Negative lights are good for removing light from an area, either to darken a specific spot or to lower the 
intensity of the positive lights without affecting shadow ambience. Used correctly, negative lights can 
increase the realism in your scenes.
Examples:

• Radial Light Intensity = 25
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• Radial Light Intensity = 50
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• Radial Light Intensity = -25

Edge Softness

The Edge Softness attribute lets you set the sharpness/softness of the edges of the spot projected by a 
light.
The default setting for Edge Softness is 0 with the slider having a range from 0 to 100.
To adjust a light's edge softness in the Light Lab, drag the Edge Softness control. 
Drag left to sharpen the edges and right to soften the edges, or enter an amount in the numeric field.

Please note that for radial lights, the Edge Softness control is disabled.

Examples:
• Intensity = 25; Edge Softness = 0
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• Intensity = 25; Edge Softness = 25

• Intensity = 25; Edge Softness = 50
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Spotlight Spread

The Spread of the Spotlight (also called the Half Angle) controls the size of the projected light cone. The 
size of the light's wireframe determines the spread of the light. The bigger the wireframe, the larger the 
spread.
To adjust the spread of a Spotlight:

1. Select a Spotlight in the Working window.

2. Drag one of its bounding box control points to set the wireframe's size. Increase the size to 
increase the spread and decrease the size to decrease the spread.

Examples:
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• Default spread:

• Increased spread:

• Decreased spread:
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Cast Shadows

Cast Shadows

By default, any light source in Bryce causes objects in its way to cast shadows. You can control the 
ambience and softness of a shadow to produce realistic-looking shadows or surrealistic effects.

• Shadow Ambience
• Soft Shadows

Shadow Ambience

When you change a Shadow's Ambience, you add a color to the shadow and can adjust the amount of 
the new color in the shadow.
The default setting is 0 for Shadow Ambience with the slider having a range of 0 to 100.
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To change a shadow's ambience:
1. In the Light Lab, ensure the Cast Shadows option is enabled.

2. In the Shadow Ambience area, click the Shadow Color swatch and choose a color from the color 
picker.

3. Drag the Amount control right to increase the amount of the new color or left to decrease the 
amount, or enter an amount in the numeric field.

4. Click on the OK icon to close the dialog.
You can also disable the shadow casting of a light source. This results in a light that illuminates surfaces 
but does not create shadows.
To disable shadow casting for a light source in the Light Lab, disable the Cast Shadows option.
Examples:

• Shadow Ambience = 21; Soft Shadows = 0; Color = Hot Pink
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• Shadow Ambience = 21; Soft Shadows = 81; Color = Hot Pink

• Shadow Ambience = 80; Soft Shadows = 81; Color = Hot Pink
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Soft Shadows

When you adjust the softness of a shadow, you blur or sharpen the shadow's edges. Soft shadows blend 
more smoothly with the background.
The default setting is 0 for Soft Shadows with the slider having a range of 0 to 100.

To adjust the softness of a shadow:
1. In the Light Lab, ensure the Cast Shadows option is enabled.

2. Drag the Soft Shadows control right to soften the shadow's edges or left to sharpen them, or 
enter an amount in the numeric field.
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3. Click on the OK icon to close the dialog. 
Examples:

• Shadow Ambience = 21; Soft Shadows = 0; Color = Hot Pink

• Shadow Ambience = 21; Soft Shadows = 81; Color = Hot Pink
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Light Color

Light Color

The Color of a light is different than the color of the Shadow Ambience. The light Color is the actual color 
of light that is cast by the light object, not the color of the shadow it casts.
There are two types of color that can be applied to a light:

• Uniform - which applies the same color over the entire light spread.
• Gradient - which applies a range of colors of the light spread.

Color - Uniform

When a Uniform Color is applied to a light, the selected color is applied to the entire spread of the light. 
No matter where the light falls, the light color will be the same.
To set a light's Color uniformly:

1. In the Light Lab, enable the Uniform option in the Color area.
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• Left Click on the color swatch to enable the Quick Color Picker. 
• Press Alt + Left Click to enable the RGB Color Picker. 
• Press Ctrl+Alt+ Left Click to enable the HTML Color Picker.

2. Click on the OK icon to close the dialog. 
Examples:

• Color = Yellow

• Color = Blue
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• Color = Green

Color - Gradient

Color - Gradient

Gradient Lights change color as they get further away from the light source, thus coloring surfaces along 
the way differently.
For example, when you apply a red-to-yellow gradient to a light, the resulting gradient light colors nearby 
surfaces red and distant surfaces yellow. The mid-range surfaces will reflect blends of red and yellow 
light. This feature is useful for creating custom light falloff patterns.
You can create a gradient in Bryce or on the PC, you can import a gradient created with another 
application (Photoshop 5.5 and earlier). Macs cannot currently import any gradients.
When you create or import a gradient, it is automatically applied to the active light.
The Light Lab lets you control the range and offset of gradients. You can also change a gradient's colors 
and transparency.
See the following topics for more on using light gradients:

• Import Gradient  
• Modifying Gradients  
• Gradient Range & Offset  
• Saving Gradients  
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Import Gradient

To import a gradient:
1. In the Light Lab, enable the Gradient option in the Color area.

2. Click on the Import button.

3. Locate the drive and folder where the gradient file (.grd) is stored.
4. Select the file and click on Open. 
5. Click on the OK icon to close the dialog.

Modifying Gradients

Modifying Gradients
To modify a Gradient, in the Light Lab, click the Edit button in the Color area.
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The Edit Gradient dialog appears.

The Edit Gradient dialog lets you edit gradients added to lights. You can change a gradient's colors and 
transition points, add colors to a gradient, or remove unwanted colors. You can also change the 
transparency of a gradient to create various light patterns.
The Gradient Preview is automatically updated as you edit a gradient.

See the following topics for more on modifying a gradient light using the controls in the Edit Gradient 
dialog:

• Modify Gradient Colors  
• Add Colors to Gradient  
• Delete Colors from Gradient  
• Change Transition Point  
• Change Gradient Transparency  
• Add Transparency Node  
• Delete Transparency Node  

Edit Gradient Dialog
Edit Gradient Dialog
The Edit Gradient Dialog provides the ability to modify the current gradient colors and transparency.
See the following topics for more on this dialog:

• Modify Gradient Colors  
• Add Colors to Gradient  
• Delete Colors from Gradient  
• Change Transition Point  
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• Change Gradient Transparency  
• Add Transparency Node  
• Delete Transparency Node  
• Gradient Range & Offset  
• Saving Gradients  

Modify Gradient Colors
To modify a Gradient's Colors:

1. In the Light Lab, click the Edit button in the Color area.

The Edit Gradient dialog appears.

2. In the Adjust area, enable the Color option.

3. Click a color node below the Gradient Control. A black arrow displays below the node indicating 
that the color node is selected.

©2003-2011 DAZ 3D, Inc. 1087



Bryce 7 Artist Guide 03 Jan 2011

4. Click the Color swatch, and choose a color from the color picker.

5. The Gradient Control and Gradient Preview will update to match the new color selection.

6. Repeat steps 3 and 4 to modify other colors in the Gradient. See "Add Colors to Gradient" to add 
more color nodes or "Delete Colors from Gradient" to remove color nodes.
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7. Click on OK to exit the dialog then on the OK icon in the Light Lab to return to the Bryce Working 
Window.

Add Colors to Gradient
The default Gradient has two color nodes which is usually sufficient for most renders, however, 
sometimes you need more colors, especially if the Range of the Light has been increased.
To add Colors to a Gradient:

1. Make sure that one of the Color Nodes is selected, then click the Add (+) button next to the 
Gradient control.

A new color node appears below the center of the Gradient control.

©2003-2011 DAZ 3D, Inc. 1089



Bryce 7 Artist Guide 03 Jan 2011

2. Click the Color Swatch, and choose a color from the color picker.

The Gradient Preview will update to show the new color.

3. If needed, drag the Color Node left or right to position it or click in the Location field and enter a 
number.
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4. Repeat steps 1 to 3 to add other colors.

5. Click on OK to exit the dialog then on the OK icon in the Light Lab to return to the Bryce Working 
Window.

Delete Colors from Gradient
When you no longer need a Color, you can remove it.
To remove a Color:

1. Select the Color Node you want to delete below the Gradient Box and click the Delete (-) button.
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The Color Node will be removed.

2. Repeat to delete any additional nodes.
3. Once you have deleted the Color Node(s), adjust the Location and Transition Point of any 

remaining Color Nodes as needed.

Change Transition Point
A Transition Point is an imaginary line between two colors in a gradient. Changing the Transition Point 
lets you change the ratio between the two colors and produce color blends dominated by one of the two 
colors.
To change a Transition Point in a Gradient:

1. In the Edit Gradient dialog, left-click on the Transition Node you want to adjust. The Node will turn 
black indicating that it is selected.
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2. Drag a Transition Point left to make the end color dominant or right to make the start color 
dominant. You can also change the transition point by typing values in the Location field.

3. Click on OK to exit the dialog then on the OK icon in the Light Lab to return to the Bryce Working 
Window.

Change Gradient Transparency
By default, all Gradients created in Bryce are fully opaque. You can change the Transparency of a 
Gradient to create light sources that fade in or out. You can also create complex transparency patterns by 
adding Transparency Nodes with various opacity values.
To change the Transparency of a Gradient:
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1. In the Light Lab, make sure Gradient is enabled then click the Edit button in the Color area.

The Edit Gradient dialog appears.

2. In the Adjust area, enable the Transparency option.

3. Click a Transparency Node below the Transparency control. A triangle appears below the 
Transparency Node indicating that the node is selected.
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4. Type a value in the Opacity field. The Gradient Preview will be updated to reflect the selected 
Opacity value.

5. If you want to adjust the Transparency between two Transparency Nodes in a Gradient:
• Left-click on the Transition Node you want to adjust. The Node will turn black indicating 

that it is selected.

• Drag the Transparency Node above the Transparency control to the left or right or enter a 
value in the Location field.
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6. See "Add Transparency Node" to add new Transparency Nodes or "Delete Transparency Node" 
to delete Transparency Nodes, then adjust as needed.

7. Click on OK to exit the dialog then on the OK icon in the Light Lab to return to the Bryce Working 
Window. 

Examples:
• Opacity = 25:

• Opacity = 75:
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You can also use the above procedure to change the Transparency of imported Gradients.
Add Transparency Node
To add transparency nodes:

1. Make sure that one of the Transparency  or Transition Nodes is selected, then click the Add (+) 
button next to the Transparency box.

A new Transparency Node appears below the center of the Transparency control.

2. Select a Transparency Node to edit and type a value in the Opacity field. Type a value in the 
Opacity field.

3. Drag the new Transparency Node to where you want to change the transparency.
Delete Transparency Node
When you no longer need a Transparency Node , you can remove it.
To remove a Transparency Node:

1. Select the Transparency or Transition Node you want to delete and click the Delete (-) button.
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The Transparency Node will be removed.

2. Once you have deleted the Transparency Node, adjust the Location and Transition Point of any 
remaining Transparency Nodes as needed.

Gradient Range & Offset

The Range of a gradient is the distance in Bryce units that the gradient spans. When a gradient light is 
this distance from its source, the gradient's end color is applied to the light (provided you have accepted 
the default offset value of zero).
The Offset of a gradient determines how the gradient colors will be applied to the light source. By default, 
the offset value is zero, which means that the light will start with the start colors of the gradient. When you 
increase the offset, intermediary gradient colors will be applied to the light at its source. The maximum 
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offset value of 100 results in a light source which begins with the end color of the gradient. See the last 
image on this page for an example of the Offset set to 100.
To change a gradient's Range in the Light Lab, click the Range control in the Color area, and type a value 
in the field. The Range can be set from 0 to 99,999.

To change a gradient's Offset in the Light Lab, click the Offset control in the Color area, and type a value 
in the field. The Offset can be set from 0 to 100.

You can also change a gradient's Offset by dragging the Offset button next to the Gradient preview.

Examples:
1. Range = 51.2; Offset = 0:
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2. Range = 25; Offset = 0:

3. Range = 100; Offset = 0:

4. Range = 100; Offset = 25:

5. Range = 100; Offset = 50:
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6. Range = 100; Offset = 55 - showing the center still a bit green, then changing to orange:

Saving Gradients

Once you have edited a Gradient, you can save the Gradient by adding the Light Object to the Objects 
Presets Library or by adding the Light Material to the Materials Presets Library.
Saving to the Objects Presets Library saves both the light and the material. The light can be loaded into 
the scene from the library with all settings intact.
Saving to the Materials Presets Library saves only the material. 
To use the saved Gradient material, apply the material to the light, then enter the Light Lab and enable 
the Gradient option to activate the Gradient.

True Ambience Optimization (New Feature Bryce 7 Pro)
Bryce 7 Pro builds on the power of Bryce 6 True Ambience, maturing it into a highly successful Global 
Illumination Solution. 

• The True Ambience Optimization checkbox located in the Light Lab is completely related to 
the new True Ambience Premium Effect Render Mode. Therefore, this feature is operational 
only when the Premium Effect True Ambience is enabled.

True Ambience Optimization converts a standard point light source into a glowing virtual 3 dimensional 
object that the True Ambience system can treat as a physically accurate light source. The virtual 3 
dimensional object is not visible within the final rendered image, but its “effects” are visible within the True 
Ambience lighting system as a reflection. In turn, most of the illumination power of such True Ambience 
Optimized light sources is derived from the physical size of the virtual light object itself. 

• In addition, the True Ambience Optimization Intensity Slider can be used to increase the 
number of bounces of light rays between surfaces when rendering with True Ambience for 
greater accuracy.  However, this slider is only operational when the Boost Light Option is 
Enabled in the Render Options.

©2003-2011 DAZ 3D, Inc. 1101



Bryce 7 Artist Guide 03 Jan 2011

• Maximum Ray Depth can be used to further improve the intensity of the overall True 
Ambience effect within the Render Options. Higher Ray Depth settings encourage more rays 
to be fired resulting in better quality output in some cases.

Light Falloff

Light Falloff lets you control the relationship between the intensity of a light and the distance from the 
light. In the real world, the farther you are from a light source, the less influence it has on the illumination 
of your surroundings. In other words, the greater the distance, the weaker the light. 

In Bryce there are four falloff types you can apply to a light:
• None (No Falloff) causes the intensity of the light to stay the same regardless of the distance.
• Linear Falloff causes the light's intensity to fall off at a constant rate. When you use this type of 

falloff, the light's range is rather large. This type of falloff is useful for creating outdoor lights like 
searchlights.

• Squared Falloff causes the light's intensity to fall off rapidly. When you use this type of falloff, the 
light's range is quite limited. This is useful for creating indoor lights, like lamps.
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• Ranged Falloff causes the light to change abruptly from full intensity to zero (no illumination) 
after a distance range you define.

To set a light's Falloff in the Light Lab, enable one of the following options: None, Linear, Squared, or 
Ranged. Selecting Ranged falloff will enable the Amount slider.

To define the Range of a light's Ranged Falloff:
1. In the Light Lab, enable the Ranged option in the Falloff area.
2. Drag the Amount control right to define a greater range or left to define a smaller range or enter a 

value in the Amount field. The default Amount is 10 but can vary from 0 to 9999.

Examples:
• Falloff - None

• Falloff - Linear
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• Falloff - Squared

• Falloff - Ranged = 10

• Falloff - Ranged = 100
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• Falloff - Ranged = 200

• Falloff - Ranged = 1000

Influence (New Feature Bryce 7 Std / Pro)

Bryce 7 users can now specify items which are to be illuminated by the output of a given light source. 
There are two options. By default, lights are all inclusive and will illuminate all objects within a scene. 
However if the user finds that this default condition is not feasible for a given situation, Influence can be 
controlled at will to fit any type of special circumstance.

A. Exclude: Items selected for Exclusion will not receive light information from this particular light 
source, nor will they receive shadows from this source. However, all other objects in the 
scene will remain lit by this light source. This tool is extremely useful as a time saver. For 
example; one could exclude the volumetric slab to speed the rendering of a landscape. The 
clouds would be excluded from receiving light, while the remainder of the scenario would 
remain illuminated.

B. Include: Items selected for Inclusion will be the only items being illuminated by this light 
source. Items which are not selected for Inclusion are assumed as Excluded. Once again, 
this is very useful as a time saver, allowing precise item by item control over illumination.
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Visible Lights

Visible Lights

Visible Lights make your light source visible in the scene, like the ball of light that appears around a 
lamppost on a foggy night.
There are two types of Visible Lights:

• Surface Visible Lights  
• Volume Visible Lights  

When you create a Surface Visible Light, the light from the object appears as a semi-transparent shape 
extending from the light source.
Surface Visible Lights have the same attributes as non-visible lights, so you can use the Edge Softness 
control to make the shape that extends from the light fuzzier at the edges, to give it a more realistic feel, 
or the Falloff options to adjust the range of the light.
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The properties within the light are controlled by the default Surface Material applied to the light object. 
The material can be edited in the Materials Lab. By changing the material, you can change the color of 
the light, the intensity of the light's color, and many other properties.
When you create a Volume Visible Light source, a preset Light-sensitive Volume Material is applied to the 
light source. This makes the light coming from the light source appear visible in the scene, so in the case 
of a spotlight, the light would appear as a cone. The light also becomes volumetric and reacts to other 
lights around it. Objects within the cone interact with the light. They can block it, reflect it, etc. Any 
textures applied to the light also have volume.
The material applied to the object is pre-defined for you, but you can edit its properties in the Materials 
Lab. By editing the material you can change the light's intensity, color, and transparency.
When you create a Volume Visible Light source, the light emanating from the light source is visible in the 
scene. This light has volume and interacts with the objects inside it.
The real difference between the two types of lights becomes apparent when you apply a gel to the light. In 
Surface Visible Lights, the gel texture is wrapped around the light cone like a skin. Making it semi-
transparent makes it look more real, but it does not make it interact fully with objects inside the cone.
On the other hand, Volume Visible Lights create a real illuminated volume. The texture gel exists 
everywhere inside the cone, and the objects within the cone are directly affected by the texture. The light 
also interacts with the surrounding light sources.
In this example, the same objects were first illuminated by a surface visible light (top) and then a volume 
visible light (bottom).

It is a good idea to choose to apply the Infinite Light option to both types of visible lights, as this option 
extends the light's range and gives the light a more realistic look.
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Surface Visible Lights

When you create a Surface Visible Light source, it appears as a semi-transparent object in the scene.
To create a Surface Visible Light:

1. Create a Light Source.

2. Click the  button that appears next to the light's bounding box. The Light Lab appears.
3. In the Render options area, enable the Visible Object and Surface options. A number of preset 

Surface material properties are applied to the light, creating a visible cone of light.
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4. If you want to extend the light's range, enable the Infinite Light option.

Volume Visible Lights

To create a Volume Visible Light: 
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1. Create a Light Source.

2. Click the  button that appears next to the light's bounding box. The Light Lab appears.
3. In the Render options area, enable the Visible Object and Volume options. A number of default 

Volume material settings are applied to the light source creating a softer visible cone of light.

4. If you want to extend the light's range, enable the Infinite option.

©2003-2011 DAZ 3D, Inc. 1110



Bryce 7 Artist Guide 03 Jan 2011

Editing Visible Light Materials

The materials applied to a Visible Light control many of its properties. Although these materials can be 
edited, just like any other object's material, you should keep in mind that when you are editing a light's 
material in the Materials Lab, you are changing how the light source will appear in the scene.
Any texture components you apply to the light's material will appear as gels.
For Surface Visible Lights, the light's material is a Surface material. For a Volume Visible Light the 
material is a Volume Material.
Refer to "Surface Material Channels" for more on editing Surface materials and "Volume Material 
Channels" for more on editing Volume materials.

Applying Gels

Applying Gels

Gels are filters placed directly in front of lights to change the colors cast by the light or to cast specific 
kinds of shadows.

In Bryce, you can use any image or procedural texture as a Gel. Once you have assigned a Gel to a light 
source, you will be able to see the pattern of the Gel on any object it shines on. For example, if you apply 
an image to a Square Spotlight, you can create a slide projector. You can apply an unusual texture across 
your entire scene by assigning a Texture Gel to a Radial Light.
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• Using an Image as a Gel
• Using an Procedural as a Gel

Using an Image as a Gel

To use an image as a Gel:
1. In the Light Lab, enable the Use Gel option.

2. Click the Image button.

The Picture Editor appears.
3. Choose an image from the Picture Library or click the Load button and load an image. Refer to 

"Pictures Editor" for more on the Picture Load dialog.
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4. Click the OK icon to close the dialog. The Picture is applied as a Gel.

When you apply a Gel to a Visible Light, the texture's pattern is visible throughout the visible light.

* Image Gels used are from the gel packages by Alex Aurichio.

Using an Procedural as a Gel
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To use a procedural texture as a Gel, you must select a preset that contains a texture. Preset materials 
that contain only color or optic information (such as many found in the Misc > Basic category) will have no 
effect.
If you selected a color other than white in the Light Lab, that color overrides colors from Texture Gels. 
However, the luminance patterns are still used.
To use a procedural texture as a Gel:

1. In the Light Lab, enable the Use Gel option.

2. Click the Procedural button.

The Materials Lab appears.
3. Select a material from one of the categories available.

4. Click the OK icon to close the dialog. The texture in the material is applied as a gel.
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Saving Light Settings

You can save up to five light settings using Memory Dots. This feature lets you experiment safely with 
various light attributes without losing your favorite light effects.
You can switch between different saved light settings to compare them. Also, you can reset the light 
settings to default at any time. When you no longer need a configuration of light settings, you can delete 
it.
The leftmost dot, slightly separated from the rest, is a quick way to return to the default Bryce sky.
There is no way to clear this dot. It will always contain the default light settings.
Memory Dots are saved with the scene, but not between sessions, so you may want to save your favorite 
lights as presets before ending a Bryce session.
When you click on a full dot to activate it, the saved setting becomes the current Light. When you no 
longer need a saved light setting, you can delete it by clearing the dot it is saved to.

• To save a light setting to a memory dot, click an empty dot.
• Empty dots appear gray - 
• Full dots appear green (blue in Bryce 5/5.5, teal in Bryce 3/4) - 

• To return to the default light, click the far left memory dot. The light returns to the default, 
regardless of how many changes you have made.

• To switch between saved light settings, click a full (green) dot.
• Active dots appear blue with a white dot in the middle - 
• To clear a full dot, Opt/Alt+click a full dot. The dot turns gray and a new sky setting can be saved 

to it.

Positioning Lights

Light wireframes can be edited exactly like any other object, either directly in the scene using its bounding 
box or indirectly using the tools in the Edit palette. 
Refer to "Repositioning Objects" for more on positioning objects.

Linking & Tracking with Lights
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Since lights act just like other objects, you can link them to other objects or have them track other objects 
in the scene.
In an animation, lights that track an object can create some very complex lighting effects. 
Refer to "Animating Techniques" for more on linking and tracking.

Animating Lights

You can animate lights by using the Animation Controls in the Light Lab. For example, you can animate a 
light's edge softness and intensity. 
Refer to "Animation" for more on the animation controls.

Tree Lab

Tree Lab
The Tree Lab lets you control the various attributes of tree objects. Using the tree lab, you can edit the 
trunk, branches, and foliage of a tree object to achieve a particular look. You cannot access the Tree Lab 
unless you have a tree object in your scene. When the Tree Lab opens, it temporarily replaces the screen 
and displays the currently selected tree object in the Tree Preview.
See the following topics for more on using the Tree Lab:

• Accessing the Tree Lab
• Editing Trees
• Min/Max Sliders
• A Quick Tour of the Tree Lab
• Branch/Trunk Settings
• Tree Settings
• Foliage Settings
• Saving Tree Lab Settings
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Accessing the Tree Lab
To access the Tree Lab:

1. Select a tree object in your scene.
2. Click the  icon that appears next to its bounding box or choose Objects > Edit Object from the 

Menu bar. The Tree Lab appears.

Editing Trees
In Bryce 5, the ability to create organic tree shapes was added. This lets you add realistic or fantasy trees 
to your scenes. You can then customize your trees in the Tree Lab by assigning materials, controlling the 
shape of the trees, and more.
Trees have four essential components: the overall shape, the trunk, the branches, and the foliage. How 
these elements are shaped and organized around each other defines the appearance of the tree.
The overall shape of trees varies greatly between species. In general, trees have several feet of trunk 
before they begin to branch out, and the branches eventually form a crown. The shape of the tree can 
vary greatly within these criteria. For example, the sugar maple has an almost spherical silhouette; a 
poplar tree has a cylindrical shape that tapers to a point at the top; and conifers such as pine trees have a 
triangular shape.
The width of the trunk generally indicates the age of the tree; however, different species of trees have 
different widths when mature. A birch tree, even when quite old, will not have as wide a trunk as an oak 
tree of the same age. The texture of the trunk can also be a good indicator of the species or age of the 
tree; the trunk generally becoming coarser with age.
The characteristics of branches, such as their thickness, how the branches are arranged on the trunk, 
how they are positioned relative to each other, and how they are affected by gravity can also vary greatly 
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between species. For example, a weeping willow tree has branches that begin growing upwards from the 
trunk but are so thin that gravity bends them towards the ground, giving the tree a distinctive, drooping 
appearance. Some species of conifers have symmetrically spaced and sized branches, giving them a 
very geometric appearance.
Finally, the foliage of the tree is probably the most obvious indicator of species. Species of trees have 
greatly varying leaf shapes and colors. Oak and ginkgo trees are both easily recognized by the distinctive 
shape of their leaves.
The variations in trees are virtually limitless. You need only look at the wide variation found in nature for 
inspiration when creating and customizing trees in Bryce.

Min/Max Sliders
The Tree Lab uses a unique kind of slider for setting some of the attributes of the trunk and branches. 
These sliders, called Min/Max sliders, let you set both the minimum and maximum values for an attribute 
using the same slider.

Bryce will choose a random value between the specified minimum and maximum when generating the 
tree.
To set the maximum value, drag the arrow below the Min/Max slider to the desired value. The Max slider 
cannot be set to less than the Min slider.

To set the maximum value numerically:
1. Click the field to the right of the Min/Max slider.
2. Type a value in the field.

3. To set the minimum value, drag the arrow above the Min/Max slider to the desired value. The Min 
slider cannot be set to more than the Max slider.

To set the minimum value numerically:
1. Click the field to the left of the Min/Max slider.
2. Type a value in the field.
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A Quick Tour of the Tree Lab
The Tree Lab is divided into four sections:

• Tree Preview: lets you preview changes to your tree.
• Branch/Trunk: lets you control the size of the tree trunk; the placement, number, and thickness of 

branches; and the materials used for the trunk and branches. 
• Tree: lets you control the overall shape of the tree, the randomness of the tree, and how gravity 

affects the tree. 
• Foliage: lets you control the overall shape of individual leaves, the scale and number of leaves, 

the distribution of the leaves, and the materials used for the leaves.

Branch/Trunk Settings
Branch/Trunk Settings
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You can use the Branch/Trunk settings located on the left side of the Tree Lab to control the thickness of 
the trunk and branches, the distribution of branches around the trunk, the number of segments, the 
number of branches per segment, the starting and ending angles of the branches, and the texture used 
for the trunk and branches.

See the following topics for information on using these options:
• Trunk Thickness
• Branch Thickness
• Number of Segments
• Branches Per Segment
• Branch Angles
• Trunk and Branch Texture

Trunk Thickness

The Trunk Thickness slider lets you specify a minimum and maximum width of the trunk, from 1 to 200. 
The minimum width controls the thickness of the twigs at the outermost reaches of the tree while the 
maximum width controls the base of the tree.
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To set the maximum trunk thickness, drag the arrow below the Trunk Thickness slider to the desired 
value, or type a value in the field to the right of the slider. The maximum trunk thickness can be set from 1 
to 200 but cannot be set thinner than the minimum trunk slider.
To set the minimum trunk thickness, drag the arrow above the Trunk Thickness slider to the desired value 
or type a value in the field to the left of the slider. The minimum trunk thickness can be set from 1 to 99 
but cannot be set thicker than the maximum trunk slider 

Examples:
• Minimum = 1, Maximum = 148

• Minimum = 99, Maximum = 148 - notice how the upper sections became thicker as the minimum 
slider increased
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Branch Thickness

The Branch Thickness slider lets you specify a minimum and maximum percentage width for the 
branches, from 1 to 100. This setting does not control the actual width of the branches; it is the 
percentage width of child branches. For example, if the branch thickness is set to 50%, each child branch 
will be 50% of the width of the parent branch it is spawned from.

To set the maximum branch thickness, drag the arrow below the Branch Thickness slider to the desired 
value or type a value in the field to the right of the slider.
To set the minimum branch thickness, drag the arrow above the Branch Thickness slider to the desired 
value or type a value in the field to the left of the slider.
Examples:

• Minimum & Maximum = 50
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• Minimum = 70, Maximum = 95

Number of Segments

Each branch of the tree is divided into a number of segments. Each segment is a location on a "parent" 
branch where "child" branches will be formed. The number of segments can be set from 1 to 20.

To set the maximum number of segments, drag the arrow below the Segments slider to the desired value, 
or type a value in the field to the right of the slider.
To set the minimum number of segments, drag the arrow above the Segments slider to the desired value, 
or type a value in the field to the left of the slider.
Examples:
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• Segments = 6-10, Branches per Segment = 4-7
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• Segments = 7, Branches per Segment = 4
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• Segments = 10, Branches per Segment = 4

Branches per Segment

The Branches Per Segment slider lets you specify how many "child" branches will be formed in each 
branch segment.

To set the maximum number of branches per segment, drag the arrow below the Branches Per Segment 
slider to the desired value, or type a value in the field to the right of the slider. The maximum number of 
branches per segment can be set from 1 to 20.
To set the minimum number of branches per segment, drag the arrow above the Branches Per Segment 
slider to the desired value, or type a value in the field to the left of the slider. The minimum number of 
branches per segment can be set from 1 to 4.
Examples:

• Segments = 6-10, Branches per Segment = 4-7
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• Segments = 7, Branches per Segment = 4
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• Segments = 10, Branches per Segment = 4

Branch Angles

The starting and ending angles for branches help determine the overall shape of a tree.
The branch start angle is the angle of the branch at the thickest part of the tree. The slider can range from 
0 to 180.

The branch end angle is the angle of the branch at the thinnest part of the tree. The slider can range from 
0 to 180.

To set the branch start angle, drag the Branch Start Angle slider. Drag right to increase the angle and left 
to decrease it.
To set the branch end angle, drag the Branch End Angle slider. Drag right to increase the angle and left 
to decrease it.
Examples:
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• Branch Start Angle = 25, Branch End Angle = 50
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• Branch Start Angle = 50, Branch End Angle = 50
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• Branch Start Angle = 75, Branch End Angle = 75
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• Branch Start Angle = 75, Branch End Angle = 150

Trunk and Branch Texture

You can use a uniform color, an image, or a material as the texture for the trunk and branches of a tree. 
All the branches and the trunk of the tree will have the same texture; you cannot vary the texture for the 
branches and the trunk.

To use a uniform texture:
1. Click the Uniform button at the bottom of the Branch/Trunk section.
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2. Click the Uniform Color swatch and choose a color from the color picker.

To use an image texture:
1. Click the Image button at the bottom of the Branch/Trunk section.

2. Click the Edit button to the right of the Image button. The Pictures Editor appears. Refer to 
"Pictures Editor" for more on the Pictures Editor.

To use a material texture:
1. Click the Material button at the bottom of the Branch/Trunk section.

2. Click the Edit button to the right of the Material button. The Materials Lab appears.

3. Select a material from the lab and click on the OK icon to return to the Tree Lab.

Tree Settings
Tree Settings
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You can use the tree shape settings to set the overall shape of a tree and how the tree is affected by 
gravity. You can set the amount of randomness for the tree, ensuring that even with the same settings, no 
two trees will look alike. You can also use the Tree Lab's memory dots to store settings as you 
experiment with different tree attributes.

See the following topics for information on using these options:
• Tree Shape
• Gravity
• Randomness

Tree Shape

The overall shape of a tree varies greatly for different species of trees. Using the Shape drop down list, 
you can choose a species of tree for the overall shape of the tree.

1. To choose a tree shape, click the Shape drop down list and choose a species of tree.

2. You can also select a tree shape by pressing Opt/Alt and clicking on the Default button.

3. The Open file dialog will come up where you can navigate to the Presets/Treeshapes/Installed 
folder and select a tree shape.
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There are 60 tree shapes available:
• Acacia
• American Plum
• Apple
• Aspen
• Austrian Pine
• Bald Cypress
• Bamboo
• Baobab
• Basswood
• Beech
• Birch
• Black Walnut
• Cedar of Lebanon
• Coconut Palm
• Common Ash
• Common Holly
• Common Juniper
• Common Lime
• Date Palm
• Dogwood
• Douglas Fir
• Elm
• Eucalyptus
• Fir Tree
• Giant Sequoia

©2003-2011 DAZ 3D, Inc. 1135



Bryce 7 Artist Guide 03 Jan 2011

• Ginkgo
• Hemlock
• Hornbeam
• Horse Chestnut
• Italian Cypress
• Japanese Maple
• Joshua Tree
• Magnolia
• Mangrove
• Monkey Puzzle
• Mountain Ash
• Norfolk Island Pine
• Norway Maple
• Norway Spruce
• Papaya
• Poplar
• Red Oak
• Rhododendron
• Russian Olive
• Sassafras
• Scotts Pine
• Seagrape
• Silver Maple
• Spruce
• Sugar Maple
• Sumac
• Sweet Gum 
• Sycamore
• Tamarack
• Tulip Tree
• Weeping Willow
• White Cedar
• White Oak
• White Pine
• Yew

Gravity

The branches and leaves of a tree can be affected by gravity. When gravity is high, the branches of a tree 
will droop and the leaves will be oriented towards the ground. When gravity is low, the same branches 
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may be more upright, and the leaves may be oriented in all directions. The Gravity slider lets you specify 
how much gravity will be applied to a tree. The slider can be set from 0 to 100.

To set the gravity amount, drag the Gravity slider right to increase the amount of gravity and left to 
decrease it, or enter a value in the field.
Examples:

• Gravity = 5

• Gravity = 25
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• Gravity = 50

• Gravity = 100

Randomness

Trees in nature are not perfectly shaped. Two trees of the same species growing under identical 
conditions will vary greatly from one another. In Bryce, you can control the randomness of a tree so that, 
even with the identical settings, no two trees will be identical.
The randomness setting affects both branch angles and leaf angles. The slider can be set from 0 to 100.
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To set a value for randomness, drag the Randomness slider right to increase the amount of randomness 
and left to decrease it, or enter a value in the field.
Once the randomness has been set, the tree will need to be saved to the tree presets folder since 
copying or duplicating the tree will not activate the randomness.
See "Saving Tree Presets" and "Access Pre-Generated Trees" for information on how to save and use 
tree presets.
Examples:

Foliage Settings
Foliage Settings

You can use the foliage settings to control the appearance of the leaves on a tree. Using the foliage 
settings, you can choose a leaf shape, size, and quantity, and determine how the leaves are distributed 
on the branches. You can also specify a texture for the leaves.
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See the following topics for information on using these options:
• Foliage Shape
• Foliage Scale
• Number of Leaves
• Foliage Distribution
• Foliage Texture

Foliage Shape

The leaves of different species of trees have different shapes. The Shape setting lets you choose a leaf 
shape from a drop down list.
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1. To choose a leaf shape, click the Shape drop down and choose a species of tree from the list.

2. You can also select a leaf shape by pressing Opt/Alt and clicking on the Default button.

3. The Open file dialog will come up where you can navigate to the Presets/Leaves/Installed folder 
and select a leaf shape.

There are 61 foliage shapes available:
• Acacia
• American Plum
• Apple
• Aspen
• Austrian Pine
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• Bald Cypress
• Bamboo
• Baobab
• Basswood
• Beech
• Birch
• Black Walnut
• Cedar of Lebanon
• Coconut Palm
• Common Ash
• Common Holly
• Common Juniper
• Common Lime
• Date Palm
• Dogwood
• Douglas Fir
• Elm
• Eucalyptus
• Fir Tree
• Giant Sequoia
• Ginkgo
• Hemlock
• Hornbeam
• Horse Chestnut
• Italian Cypress
• Japanese Maple
• Joshua Tree
• Magnolia
• Mangrove
• Monkey Puzzle
• Mountain Ash
• Norfolk Island Pine
• Norway Maple
• Norway Spruce
• Papaya
• Poplar
• Red Oak
• Rhododendron
• Russian Olive
• Sassafras

©2003-2011 DAZ 3D, Inc. 1142



Bryce 7 Artist Guide 03 Jan 2011

• Scotts Pine
• Seagrape
• Silver Maple
• Spruce
• Sugar Maple
• Sumac
• Sweet Gum
• Sycamore
• Tamarack
• Tulip Tree
• User Leaf
• Weeping Willow
• White Cedar
• White Oak
• White Pine
• Yew

Foliage Scale

You can control the size of the leaves on a tree using the Scale slider. The Scale slider measures the size 
of the leaves as a percentage of the size of the tree. The slider can be set from 1 to 20.

To choose the size of leaves, drag the Scale slider. Drag right to increase the scale and left to decrease 
it.
Examples:

• Scale = 5
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• Scale = 10

• Scale = 15

• Scale = 20

Number of Leaves
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The Number of Leaves slider lets you choose how many leaves will appear on each branch.

To set the number of leaves, drag the Number of Leaves slider right to increase the number of leaves and 
left to decrease the number of leaves, or enter a value in the field. The slider can be set from 0 to 20.
The number of leaves along with the scale will directly affect the length of the branches.
Examples:

• Scale = 4, Number = 7

• Scale = 8, Number = 15

©2003-2011 DAZ 3D, Inc. 1145



Bryce 7 Artist Guide 03 Jan 2011

• Scale = 10, Number 10

• Scale = 15, Number 5

Foliage Distribution

In nature, different species of trees have different arrangements of leaves. Some trees have leaves that 
are clustered together while others have leaves that spiral around a branch in an almost symmetrical 
pattern. Bryce offers five different leaf arrangements: Stacked, Staggered, Spiral, Bunched, and 
Coniferous.

To choose a leaf distribution, click the button beside one of the following options:
• Stacked: leaves are arranged in pairs on each side of the branch. If there is an odd number of 

leaves, a single leaf will be placed at the tip of the branch. 
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• Staggered: leaves alternate on each side of the branch. If there is an odd number of leaves, a 
single leaf will be placed at the tip of the branch. 

• Spiral: leaves are arranged around the branch in a spiral formation.  Bunched: leaves are 
clustered at the tip of the branch.

• Coniferous: leaves are placed along the middle of the branch. 
The image below shows examples of the different distribution options.

Please note that on trees that are densely populated with branches, segments, and/or leaves, the 
difference between some distribution options may not be very obvious. This is especially true for the 
staggered and spiral options. Decreasing the number of leaves or their scale will make the difference 
more obvious.

Foliage Texture

You can use a uniform color, an image, or a material as the texture for leaves of a tree. All the leaves will 
have the same texture; you cannot vary the texture of leaves.

To use a uniform texture:
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1. Click the Uniform button at the bottom of the Foliage section.

2. Click the Uniform Color swatch and choose a color from the color picker.

To use an image texture:
1. Click the Image button at the bottom of the Foliage section.

2. Click the Edit button to the right of the Image button. The Pictures Editor appears. Refer to 
"Pictures Editor" for more on the Pictures Editor.

To use a material texture:
1. Click the Material button at the bottom of the Foliage section.
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2. Click the Edit button to the right of the Material button. The Materials Lab appears.

3. Select a material from the lab and click on the OK icon to return to the Tree Lab.
You can only change the material of the leaves if you access the Materials Lab through the Tree Lab. If 
you select a tree and access the Materials Lab or the Materials Preset Library from the Edit palette and 
choose a material, the material will only be applied to the trunk and branches of the tree.

Saving Tree Lab Settings
The memory dots in the Tree Lab let you store your favorite Tree Lab settings. Using these dots you can 
safely explore many Tree Lab configurations without losing your favorite settings along the way. Memory 
dots appear at the bottom of the Tree Lab.
To save Tree Lab settings, in the Tree Lab, click on an empty dot (empty dots are gray). All the current 
Tree Lab settings are stored in the selected dot.
To switch to a saved Tree Lab setting, click on a full dot (full dots are green). The current settings are 
replaced with the settings stored in the dot. An active dot will be green with a white point inside it.
To reset Tree Lab settings to default, in the Tree Lab, click the leftmost memory dot. This dot always 
appears full.
To delete a saved Tree Lab setting, Opt/Alt+click on a full memory dot. The leftmost dot cannot be 
cleared.
Tree settings can be saved permanently using the Create palette.

Animation

Animation
Animation is the process of adding a fourth dimension to your scene - time. To create an animation, you 
arrange a scene then record your movements or transformations of objects over time. Bryce creates a 
motion path from your recorded movements and then generates an animation. 
You can animate almost anything in your scene: the motion of objects and the camera, object size and 
shape, object materials, terrain objects, and sky properties. (Issue)

• The Animation Process
• Creating Animations
• Animation Tools
• Recording Key Events
• Previewing Animations
• Animation Options
• Motion Paths
• Advanced Motion Lab
• Animating Techniques
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• Importing Animations from DAZ Studio
• QuickTime VR

The Animation Process
The Animation Process

Animation is a cooperative process between you and Bryce. You arrange objects and choose scene 
settings, and then make adjustments to the objects and scene over time. Bryce fills in the gaps between 
adjustments. When you play the animation, the illusion of motion is created. 
The steps to creating an animation are as follows: 

1. Create objects using the Create tools. 
2. Build a scene by arranging and transforming objects, lights, and the camera.
3. Adjust the position, orientation, or scale of objects. Each time you make an adjustment, you 

create a key event which indicates a point where an object property was changed.  
4. Adjust the shape or placement of the motion path. 
5. Adjust the speed at which the object moves along the motion path using the Advanced Motion 

Lab. 
6. Render the animation as a movie file. 
7. You can render the animation as a QuickTime/AVI movie file or as a set of frames. 

Refer to the following for more on the animation process:
• Time-Based Animation
• Animation and Motion Paths
• Animatable Properties
• Properties in the Sequencer

Time-Based Animation

In Bryce, key events are tied to real-world time increments (minutes and seconds) rather than individual 
animation frames. This means that you can create key events at specific points in time without worrying 
about the number of frames in your final animation. 
Bryce automatically creates all the frames necessary to move from one key event to another. If you 
change the frame rate, Bryce adjusts the number of the frames between key events to match the new 
frame rate.
For example, let's say your frame rate is set to 15 fps (frames per second) and then you set up two key 
events, one at 1 second and the other at 2 seconds. Bryce automatically fills in the 15 frames necessary 
to move from the key event at 1 second to the key event at 2 seconds. If you change the frame rate to 30 
fps, Bryce will add another 15 frames between the two key events to match the new frame rate.

Animation and Motion Paths

As you change the position, of an object, Bryce creates a motion path which shows you the path the 
object will take as it moves from one key event to another. 
You can edit an object's motion path to adjust its trajectory throughout the course of the animation. 
Refer to "Editing Motion Paths" for more on motion paths. 
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Animatable Properties

Each characteristic of an object or effect that can be animated is called a property. Most objects have 
many animatable properties. Properties like position, size, and orientation are common to all objects. 
Other properties are specific to certain types of objects. Lights have special properties like brightness, 
falloff, and gels. 
Skies have their own set of properties that control everything from cloud coverage to the time of day. 
The properties of individual objects can change depending on the material you apply. The color, texture, 
and density of an object can also be animated. 
Some properties can be animated directly in a specific editor. Object material properties can be animated 
from within the Materials Lab and terrain geometries can be edited from within the Terrain Editor. 

Properties in the Sequencer

Every time you change an object's property, it appears as a key event in the animation's Sequencer. In 
the Sequencer, each property of an object can be viewed on a separate timeline. You can expand an 
object's listing to see all the transformations or changes that have been applied to its properties. If you 
have not performed any transformations on the object, it cannot be expanded. Refer to "Property 
Timelines" for a complete discussion of the Sequencer. 
To expand a listing in the Sequencer: 

1. Make sure the Advanced Motion Lab is visible. If it is not, choose Objects > Advanced Motion Lab 
or click on the Motion Lab button. 
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2. Click on the object name to expand the listing. 

Creating Animations
Creating Animations

The Animation controls are the tools you will use most often when creating animations. The palette 
provides tools for most of the basic animation functions: 

• viewing the timeline 
• moving the current time 
• setting the length of the animation  
• specifying the Working Area 
• previewing the animation  
• recording key events 
• adding/deleting key frames  

The Animation controls appear at the bottom of the Working window as well as in the Terrain Editor and 
the Materials Lab.
The Animation controls are made up of three areas: 

• The Timeline, located at the top of the palette, displays a visual representation of the time in your 
animation. The indicator on the timeline (called the Current Time Indicator or Scrubber) 
represents the current time.  

• The Animation Preview Controls, located below the Timeline, let you preview your animation in 
the Working window. 

• The Key Frame Controls, located at the right edge of the palette, let you add and delete key 
frames. To display the Animation controls in the Working window: By default the Animation 
controls are located at the bottom of the Working window.  
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If the Selection palette appears at the bottom of the window, click the Time/Selection Palette toggle in the 
bottom-right corner of the Bryce window or press S. The button switches between the Selection palette 
and the Animation controls.  

• Setting Up an Animation
• Setting the Frame Rate

Setting Up an Animation

Before you start setting up key frames or adjusting the timeline, you should set up some general 
parameters for your animation. 
The Animation Setup dialog lets you set up the duration, the frame rate and whether you want to display 
animation time as SMPTE (i.e.; hours:minutes:seconds:frames) or frame numbers. See "Animation 
Setup" for more detailed information on the setup dialog.  
To set the duration of your animation numerically: 

1. Choose File > Animation Setup from the menu or double-click the Current Time Indicator. 

The Animation Setup dialog appears.  
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2. Click the Scale button. This switches to the Duration fields to set the duration of your animation. 

3. In the Duration fields, enter the total length of your animation in hours, minutes, seconds and 
frames. When you enter a duration, Bryce automatically calculates the number of frames in the 
animation, based on the current frame rate. The number of frames is displayed in the Frame # 
field. 
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4. Click on the OK icon to close the dialog. 

Setting the Frame Rate

The frame rate for your animation can have a large impact on the final quality of your rendered movie. A 
low frame rate is faster to render but may produce motion which is more jumpy, while a higher frame rate 
produces a much smoother motion. 
Bryce displays frames as frames per second (fps). Fifteen fps is usually good enough for motions 
displayed on a computer while 30 fps is standard for broadcast-quality video.  
To set the frame rate for your animation: 

1. Choose File > Animation Setup from the menu or double-click the Current Time Indicator (also 
called a Scrubber). 

The Animation Setup dialog appears.  
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2. Enter a frame rate in the FPS field. 

3. Click on the OK icon to close the dialog. 

Animation Tools
Animation Tools

Bryce's animation tools are designed to help you animate the properties of your scene. 
• Animation Controls
• The Timeline

Animation Controls

The Animation Controls let you record an animation and preview it in the Working window. You can also 
use the controls to change the current time or move to different points in time. 

The Timeline appears in four places in Bryce: the Working window, the Terrain Editor, the Sky Lab, and 
the Materials Lab. 
All four timelines represent the same time. The only difference is that when you are in an editor, you can 
only add frames for properties associated with that editor. For example, in the Terrain Editor you can only 
add key frames associated with terrain properties. 
When you preview a timeline in the Working window, you will be able to see all the changes in your 
scene, including any changes you may have made in other editors or in the Advanced Motion Lab. 

The Timeline
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The Timeline

The Timeline is a graphical representation of time. 

The light green (blue in v5/5.5) colored section of the Timeline represents the length of the Working Area. 
The Working Area can be used as a visual guide to help you isolate portions of your timeline. 
The dark green (blue in v5/5.5) colored section of the Timeline represents the current length of your 
animation. 
When you render the animation you can choose to render the entire timeline or just the Working Area. 
When you use the animation preview controls, only the Working Area is previewed. 
Refer to "Setting Up the Working Area" for more on the Working Area. 
The Current Time Indicator, also called the Scrubber, lets you move to different points in time. This is the 
main tool you will use to create animations. Every time you want to add a key event, you move the 
Current Time Indicator to a different point on the timeline. 

• Working with Time
• Setting Animation Range in the Timeline
• Setting Current Time for an Animation
• Time Dots
• Setting Up the Working Area
• Setting Timeline Scale
• Scaling Animation Duration

Working with Time

The light gray area in the Timeline is called the Available Time Area and it represents all time. This area is 
unlimited; you can scroll the time area infinitely. 

The white tick marks within the Timeline are visual cues that let you know when the time area is moving. If 
you move the Current Time Indicator off the screen, you will see these white ticks move along the time 
area. 
To scroll the time area, drag the Current Time Indicator off the screen to the right. You will see the white 
tick marks move along the time area to the left. 
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Setting Animation Range in the Timeline

The dark green (blue in v5/5.5) within the light gray area of the Timeline represents the total length of your 
animation. This area is usually hidden by the Working Area, so you may need to shorten the Working 
Area to adjust the Animation Range. 

The Animation Range is automatically generated as you set up key events. The time of the final key event 
automatically creates the limit of the Animation Range. However, you can manually extend or shorten the 
area to set the range of your animation. You cannot shorten the Animation Range below the last frame in 
the scene since you cannot have frames outside the Animation Range. 
To manually set the Animation Range, in the Timeline, drag the handle that appears at the end of the 
Animation Range to the point where you want the animation to end. The handle may be obscured by the 
Current Time Indicator, so you might have to move the indicator to a different position in order to see it. 

Setting Current Time for an Animation

The large green handle in the Timeline is called the Current Time Indicator (commonly called a Scrubber). 
It sets the current time of the animation. 
The Current Time Indicator is the most important tool of the Animation controls. When you are creating 
key events, the Current Time Indicator controls when the key event occurs in the animation. Refer to 
"Recording Key Events" for complete instruction on creating key events. 
As you move the Current Time Indicator, the Text Display Area shows you the current time. 
If you are using SMPTE time, the current time is displayed as Hours:Minutes:Seconds:Frame # (such as 
00:01:25:13). The Frame # changes as you change the frame rate for the animation. For example, at 15 
fps Bryce will insert 15 frames within each second. 

If you are using Frame Count, the number of the current frame is displayed.  
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You can also move to a specific point in time using the Animation Setup dialog. In this dialog, you can 
move to either a specific time or frame. 
To move to a specific frame manually: 

1. Drag the Current Time Indicator along the Timeline. As you drag, watch the Text Display Area. 
You will notice that the final number cycles through each frame in the second of animation time. 
So at 15 fps the final number will cycle through frame 0-14 between seconds. 

2. Release the mouse button when the Frame # reaches the desired frame.
The Current Time Indicator also controls which portion of your animation is being displayed in the 
Working window.
When the indicator is at the beginning of the animation, you are seeing the first frame of the animation in 
the Working window. When you move the indicator, the Working window displays a different portion of the 
animation. So, when you move the indicator to the center of your animation range, you are seeing what 
the animation looks like at the middle of the movie. 
To move the current time manually:

1. Drag the Current Time Indicator along the Timeline. 
2. Release the mouse button when the Text Display Area shows the desired time.

To move the current time numerically:
1. Choose File > Animation Setup. The Animation Setup dialog appears.  
2. In the Current fields, enter the hour, minutes, seconds and frame you want to move to. The 

Frame # field displays the number of the frame located at the specified time.

Time Dots

The Time Dots let you save positions on the timeline. You can use the dots to quickly jump between 
areas of the timeline you are working on. 
To save the position of the Current Time Indicator:

1. Move the Current Time Indicator to the position you want to save.  
2. Click on an empty Time Dot at the bottom of the Animation controls. A dot is empty when it 

appears white. 
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To move the Current Time Indicator to a saved position, click the Time Dot for the position you want to 
use. The current position appears green with a white dot. 
To delete a saved position, press Opt/Alt+click on a full Time Dot. A full dot appears green. 

Setting Up the Working Area

The light blue portion of the Timeline represents the Working Area. This area highlights the portion of the 
timeline you are currently working on. 

When you are previewing your animation, only the portion of the timeline within the Working Area is 
previewed. 
The Working Area is most useful when you are working on a long animations as it saves on preview time 
or when you are refining a specific portion of your animation. 
When you are rendering the animation, you can choose to render the entire animation or just the Working 
Area portion.
You can also use the Working Area to render out sections of the timeline while you are setting up the 
animation, and then render the entire Animation Range when you are creating the final animation. 
To set the range of the Working Area manually:

1. Click+drag either end of the existing Working Area. 

2. Release the mouse button when the Working Area is the desired length. The Working Area 
cannot be extended past the end of the Animation Range. 

To set the range of the Working Area numerically:
1. Choose File > Animation Setup or double-click the Current Time Indicator. 

The Animation Setup dialog appears. 
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2. Click the triangle icon at the top-left of the dialog and choose Working Range Low from the 
menu.  

3. Enter the starting time for the Working Range.

4. Click the triangle icon again and choose Working Range High.

5. Enter the ending time for the Working Range. 

6. Click on the OK icon to close the dialog. 

Setting Timeline Scale

The Scale Indicator at the right edge of the timeline let you adjust the scale the timeline. If you have a 
very long Timeline, you can use this control to scale it down so you can see the whole timeline at once. If 
you have a very short timeline, you can use the control to scale it up so it extends across the length of the 
palette.  

To set the scale of the Timeline, drag the Scale Indicator. 
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• Drag right to increase the scale. 

• Drag left to decrease the scale. 

The scale of the Timeline does not affect its length, only how it is displayed in the Animation Controls. 

Scaling Animation Duration

You can adjust the length of your animation, by scaling its duration to fit within a certain amount of time. 
For example, if you created an animation that is five seconds long but only want it to take up three 
seconds, you can scale the entire animation to last only three seconds. 
When you scale the animation, all the events in the animation are compressed or stretched to fit within 
the desired amount of time. If you increase the scale, the events are stretched out, so they take longer to 
complete. If you decrease the scale, the events are compressed so the action speeds up. 
To set the scale of the entire animation manually: 

1. Hold down Opt/Alt+drag the Animation Range Handle. 

2. Release the mouse button when the duration of the animation is the desired length. 

To scale the animation numerically:
1. Choose File > Animation Setup or double-click the Current Time Indicator. 

The Animation Setup dialog appears.  
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2. Click the Scale Animation button. 

3. Enter the desired animation duration in the Duration fields. 

4. Click on the OK icon to close the dialog. 

Recording Key Events

Recording Key Events
You can record key events by either enabling the Auto-Record mode or manually adding key frames. 
When you enable Auto-Record mode, every object transformation or change of property you perform is 
recorded as a key event. A key event can store any change in size, position, orientation, material 
property, sky property, light property or geometry. However, a key event can only store one change per 
property at a specific point in time for each object in the scene. This means that at a single point in time, 
you can only have one change in position, size, material, or geometry per object recorded as a key event. 
If you keep changing the same properties at the same point in time, the new changes replace existing 
changes. Only the last change you perform is recorded as the key event. To record more than one 
change in the same object's property you have to move to a different point in time. Then each change can 
be recorded as a separate key event and applied to the animation. 
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For example, if you move an object up and down at the same point in time, only the last transformation is 
recorded as the key event. However, if you move the object up at one point in time and then move the 
object down at a different point in time, both transformations are recorded. 
When Auto-Record mode is disabled, the animation system is off. This means that your changes are not 
recorded as key events and changes in the Timeline do not affect your view in the Working window. 
You can continue changing object and scene properties, but they will not be recorded as key events. If 
you want to record a setting or transformation you will have to manually add a key frame using the Add 
Frame button. 
Refer to "Auto-Record Mode" for enabling the automatic animation system.
Refer to "Adding & Deleting Key Frames" for more on manually adding and deleting frames.

Key Frame Controls

Key Frame Controls

The Key Frame Controls let you add and delete key frames in your animation. 

The Key Frame Indicator is only active when the current time is at a key frame. 

• Adding & Deleting Key Frames  
• Animation Options  

Auto-Record Mode

The Timeline options menu, located at the right edge of the controls, lets you enable or disable Bryce's 
automatic animation system. 

To enable or disable Auto-Record mode: 
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1. Click the triangle icon to the right of the controls and choose Auto-Key. 

2. The animation system is on when the option has a checkmark next to it.  

3. Choose the Auto-Key option again to turn off the automatic animation system. 

Adding & Deleting Key Frames

Adding & Deleting Key Frames

Usually you use the Auto-Record mode to add key frames to your animation, but there are some cases 
when you would need to force the system to create a key frame. For instance, if you accidentally make a 
number of changes while Auto-Record mode is disabled, you will have to create a key frame to store your 
changes or they'll be discarded when you move to a different point in time. 

• Key Frame Controls  
• Adding Key Frames  
• Deleting Key Frames  
• Adding/Deleting Frames in the Editors  

Adding Key Frames

The Add Key Frame (plus) button lets you add a key frame. 

When you are in Camera View, with nothing selected, the Add Key Frame automatically key frames the 
camera. In Director's View, it does not. It also keys the sky. 
In Auto-Key mode, Bryce automatically adds key frames for you but when you disable the mode, you will 
have to use Add Key Frame to add key frames at points in the timeline. 
If you have an object selected, Bryce only records the changes in property for the selected object. If you 
have nothing selected, Bryce only records the changes in the sky (i.e., changes you make in the Sky & 
Fog palette). 
You can also modify the Add Key Frame operation so that, for a selected object, only a specific property 
is recorded as a key event. 
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To add a key frame: 
1. Move the Current Time Indicator to the point where you want to add a key frame  

or 

If you need to force Bryce to overwrite an existing key frame, leave the Current Time Indicator 
where it is.  

2. Make any changes needed to the scene for the next key frame.
3. Click the Add Key Frame button. Any changes you made above are recorded in the key frame. 

To add a frame for a certain property:
1. Select an object and make the necessary changes for the next key frame.
2. Hold down the mouse button over the Add Key Frame button and choose an object property from 

the menu that appears.  

3. To add a key frame for sky properties: Make sure there is nothing selected and click the Add Key 
Frame button. or Hold down the mouse button over the Add Key Frame button and choose Sky 
from the menu. 
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4. Follow the menu arrow to key frame a specific sky property. 
5. Repeat to add key frames for the camera and sun.

Deleting Key Frames

The Remove Keyframe button deletes the current key frame event or a specific type of key event. 

In the Working window, deleting a key event deletes all the frames at the current time. In the editors the 
Remove Keyframe button only deletes key events for the properties associated with the current editor. 
As with adding frames, Bryce deletes frames differently based on your current selection. If you have an 
object selected, Bryce only deletes the changes in property for the selected object. If you have nothing 
selected, Bryce deletes the changes recorded for your scene's sky. 
You can modify the Delete Key Frame button's function so that only a certain type of object property is 
deleted. Adding or deleting frames will effect the shape of an object's motion path. 
To delete a key frame: 

1. Use the Animation Preview Controls to move through the key frames until you find the frame you 
want to delete. 

2. Click the Remove Keyframe button. 

All the properties recorded at that point in time are deleted. 
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To delete a frame for a specific object property:
1. Select an object.
2. Hold down the mouse button over the Delete Key Frame button and choose the object property 

from the menu that appears. 

To delete all keyframes at once (PC only), press Ctrl+Shift+Alt and click on the Remove Keyframe button. 
This will delete all keyframes for all objects, materials, skies, terrains, etc. with no option to get them back 
unless you revert to the saved version or open a backup file.

Adding/Deleting Frames in the Editors

When you add a frame in the editors, only the properties associated with the editor are recorded as a key 
frame. 
When you delete a frame in the editors only the properties associated with the editor are deleted. For 
example, if you delete a frame that contains position, material, and scale data in the Materials Lab, only 
the material data is removed from the key frame. 
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Previewing Animations

Previewing Animations
You can preview your animations using either the mini-preview in the nano-preview or by using the 
Animation Preview controls. Both of these methods allow you to see either a rendered preview or a 
storyboard. (Issue)

• Using the Movie Preview Window  
• Using the Storyboard Preview  
• Animation Preview Controls  
• Setting Previewing Options  

Using the Movie Preview Window
Using the movie preview window, you can see a rendered version of your animation quickly. 
To preview your animation:

1. Create an animation.  
2. Left-click+hold on the Preview Animation button to bring up the Preview Options menu.  

3. Deselect Storyboard if it is selected. 

4. Let up on the mouse to close the menu and click the Preview Animation button. The animation 
will preview in the Nano-Preview window. 
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Using the Storyboard Preview
Using the storyboard preview feature, you can review or navigate your animation, frame by frame. 
To view your storyboard: 

1. Left-click+hold on the Preview Animation button to bring up the Preview Options menu.

2. Select Storyboard if it is not selected.

3. Click on the Preview Animation button. 
4. All of the frames appear in a grid pattern as they are rendered. When the rendering is finished, 

the movie plays in the nano-preview. 
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5. You can stop the preview at any time by clicking the mouse. 
6. To exit movie preview mode completely, press the Esc key or redraw/render your scene or click 

on the Preview Animation button again.

Additional Features of the Storyboard

If you pause in the storyboard portion of the animation preview, you can perform various manipulations on 
your animation. 
You can:

• Click on a frame to select it. 
• Set the current time to that frame. 
• Drag the scrubber and move forward or backwards through the animation. 
• Double-click the corresponding storyboard image to render any of the frames. 

As you perform these manipulations, the animation updates in real-time in the movie preview window. 

Animation Preview Controls

The Animation Preview controls let you move between the key frames in your animation. 
The outermost buttons move to the beginning and the end of the animation. The inner buttons move to 
the next and previous key frames, and start or stop the preview. 
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When you play an animation, all the frames in the animation within the Working Area are displayed. The 
preview is shown in Wireframe display mode. 

Starts a quick animation preview.

Moves to the beginning of the Recorded Area.

Moves one key frame backward in the animation.

Shift+click moves one frame forward.

Stops the animation. 

Plays the animation.

Pauses the animation during play

Moves one key frame forward in the animation.

Shift+click moves one frame backward. 

Moves to the end of the Recorded Area.

Setting Previewing Options
There are three options you can use to alter the preview of your animation:

• You can preview the animation only once.  
• You can play the animation continuously. 
• You can cycle forwards and then backwards through the animation. 

To set a preview option:
1. Choose File > Animation Setup. The Animation Setup dialog appears.  
2. Enable a Play option: 

1. Once plays the animation only once. 
2. Repeat plays the animation continuously.  
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3. Pendulum plays the animation forwards then backwards, then forwards, continuously.  

3. Click on the OK icon to close the dialog. 

Animation Options
The triangle icon to the right of the animation controls displays the Timeline Options menu. This menu 
lets you turn the animation system on or off. 

When the animation system is enabled (Auto-Key selected), every change you make to the scene is 
recorded as a key event. Changes can include things like moving an object, changing a material, or 
changing the shape of a terrain. The Auto-Key option is only available on the Animation Palette in the 
Working window. 

When the animation system is disabled, your changes are not recorded. To record a key event you have 
to use the Add Key Frame button. In Bryce 6, the animation system is disabled by default. Previous 
versions of Bryce have the animation system enabled by default. 
This menu also contains the following: 
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• Ticker Marks - lets you select how Ticker Marks are displayed on the Timeline. 

• Play Mode - Provides options you can use to alter the preview of your animation. 
• Once - plays the animation only once 
• Repeat - plays the animation continuously 
• Pendulum - plays the animation forwards then backwards, then forwards, continuously  

• Time Display - Select whether to display the animation in SMPTE Time or as a Frame Count. 

Motion Paths

Motion Paths
A Motion Path is a visual representation of an object's trajectory as it moves through time. An object's 
Motion Path is automatically generated as you create key events. Each new key event adds a new point 
to the path. 
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The shape of the curve is determined by the interpolation performed by Bryce. In most cases Bryce tries 
to create smooth motion so the path is drawn as a curve. 
As you add key events, the curve is adjusted to include the new motion. As you add more key events to 
your animation, the path changes shape to include the new motion. Bryce always keeps the motion 
smooth, so each new point is added as a curve. 

Motion Paths exist in 3D space so they can be viewed from any angle. If you move the camera, you can 
see how the object moves along the X, Y, and Z axes. 
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The default state of the Motion Path can be difficult to see in a complex scene. You can give your Motion 
Path some extra depth by displaying it as a ribbon. 

The ribbon lets you see the motion path as a flat track running through the scene. 
By default, the Motion Path for an object only appears when the object is selected. Otherwise the path is 
invisible (including when selected as a preset in the Objects Library) and does not render in the final 
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animation. You can change the display mode of the motion path in the Animation tab of the Object 
Attributes dialog. 

• Show as Ribbon  
• Show When Selected  
• Show Always  
• Editing Motion Paths  
• Motion Path Modifiers  
• Moving the Path  
• Aligning Objects to the Path  

Show as Ribbon
The default state of the Motion Path can be difficult to see in a complex scene. You can give your Motion 
Path some extra depth by displaying it as a ribbon.

The ribbon lets you see the motion path as a flat track running through the scene. 
To show the Motion Path as a ribbon:

• Select the object. 
• Click the   button that appears next to its bounding box. The Object Attributes dialog appears.  
• Click the Animation tab. 
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• Enable the Show as Ribbon option and click the OK icon. 

Show When Selected
By default, the Motion Path for an object only appears when the object is selected. Otherwise the path is 
invisible and does not render in the final animation. You can change the display mode of the motion path 
in the Animation tab of the Object Attributes dialog. 
To display the path only when the object is selected: 

• Select the object. 
• Click the  button that appears next to its bounding box. The Object Attributes dialog appears.  
• Click the Animation tab.
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• Enable the Show Only when Selected option and click the OK icon. 

Show Always
By default, the Motion Path for an object only appears when the object is selected. Otherwise the path is 
invisible and does not render in the final animation. You can change the display mode of the motion path 
in the Animation tab of the Object Attributes dialog. 
To display the path at all times:
Select the object.

14. Click the  button that appears next to its bounding box. The Object Attributes dialog appears.
15. Click the Animation tab.
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16. Enable the Show Always option and click the OK icon.

Editing Motion Paths
Changing the shape of the motion path changes the trajectory of the object. The path acts like a Bezier 
curve. You can change its shape by dragging its control points. 
You do not have to be in Auto-Record mode to edit the path. The changes you make to the path's shape 
are applied directly to the path in real time. 
Changing the shape of a path does not affect when key events occur. A key event that occurs at 
00:00:01.00 will still occur at the same time regardless of where it is. 

©2003-2011 DAZ 3D, Inc. 1180



Bryce 7 Artist Guide 03 Jan 2011

The events on the path in this image occur at 00:00:00.00, 00:00:00.04, 00:00:00.08, 00:00:00.12, 
00:00:01.00, and 00:00:01.04. When you change the shape of the path, the direction in which the object 
travels changes, but all the events still occur at the same time they did in the original path. 
Since Bryce treats the motion path as a Bezier curve, you can edit it just as you would any curve in any 
2D illustration application. You can also display the curve's tangents which indicate the angle of the curve. 

When you display a path's tangents you can see the angles of its curve points. 
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Finer adjustments can be made to the curves by constraining the points to a specific axis.
17. Constrain to Y-axis - Click on point to select and without letting up on the mouse, press Opt/Alt 

and drag left or right.
18. Constrain to X-axis - Click on point to select and without letting up on the mouse, press 

Cmd/Ctrl+Opt/Alt and drag left or right.
19. Constrain to Z-axis - Press Cmd/Ctrl and drag left or right on the point

Note that only constrain to the Z-axis allows you to press the modifier keys before selecting the point. For 
the constrain to Y or X-axis, pressing the modifier key(s) first will lock the point in place until you do it 
correctly.
If the path is shown as a ribbon, pressing Opt/Alt or Cmd/Ctrl+Opt/Alt and dragging on the point will twist 
the ribbon but will not actually do anything to the object, i.e., the object will not twist around the path.

Motion Path Modifiers
There are a number of modifiers you can apply to the path to change the way motion occurs along the 
path.
Normally an object moves from the first key event on the path to the last over the course of the animation. 
If you want the object to move backwards along the path, or repeat its action, you would have to 
reposition the object and set up new key events. The modifiers let you create these types of effects 
automatically.
For example, if you wanted to animate the motion of a grandfather clock pendulum, you have to set up 
the forward motion and then the backward motion. 
However, using the Pendulum modifier you just have to set up the forward motion path since the modifier 
changes the object's behavior so that it moves forward then back along the same path during the course 
of the animation. All you have to do to see the new motion is extend the duration of the animation.
There are four modifiers available:

• Make One Shot restores the motion of the path to its original configuration, meaning the action 
along the path only occurs once. 

• Make Repeat creates a loop in the action. The motion on the path repeats continuously. 
• Make Pendulum creates a repeating cycle in the action along a path. The object will move 

forward on the path, then back and then forward continuously. 
• Make Circular closes the path to create a circular path. The object will move along the path and 

when it reaches the end, it'll swing around to the front of the path and start all over. 
To apply a modifier to a motion path: 

• Select the object.
• Click the  button that appears next to its bounding box. The Object Attributes dialog appears.  
• Click the Animation tab. 
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• Enable a modifier.  

• Extend the duration of the animation so you can see the change in motion. 

Moving the Path
You can also move the path by dragging it to a new location. When you drag the path, all the events on 
the path shift position. Changes in motion path position are not recorded as key events. 
To move a motion path: 

• Click on a section of the path that does not contain any control points. You have to click on a part 
of the path without control points, otherwise you will change its shape instead of moving it. 
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• Drag it to new location. 

• The object may not move with the path, but once the path is where you want it, press the Play 
button or the Last Frame button and the object will snap back on to the path.  

Aligning Objects to the Path
Normally, the orientation of an object remains fixed relative to world space as it moves from point to point. 
Using the Aligning option, you can have the object's orientation remain parallel to the path so that it 
reorients itself as it moves from point to point. 
You can use this option to create more realistic motion for objects that have a distinct front and back. 
The motion of this rocket looks rather unrealistic since it is rising and falling without pitching. 

If you align the rocket to its path, the rocket's nose tilts down as it moves down and up as it moves up. 
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There are two align options available:
• Do Not Align disables aligning. The shape of the curve has no effect on the object's orientation. 
• Align adjusts the object so that its orientation matches the shape of the path. 

To align an object to a motion path:
• Select the object. 
• Click the  button that appears next to its bounding box. The Object Attributes dialog appears.  
• Click the Animation tab. 
• Enable an alignment option and click the OK icon. 

Please note that if the motion path has tight curves, using the Align option may cause the object to flip as 
it goes around the curve. To avoid this, widen the curves on the path by moving points and/or adjusting 
the tangents. 

Advanced Motion Lab
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